Contents

Send Us Your Comments

Preface

1 India Local Inventory
   Miscellaneous Transactions Overview.......................................................... 1-1
   Inventory & WIP Transactions Overview..................................................... 1-1
   Organization Information............................................................................. 1-3
   Managing India Local Inventory.................................................................. 1-16
   RG - I Register Entry.................................................................................. 1-16
   RG 23 Register Entry.................................................................................. 1-20
   Apply Time Extension.................................................................................. 1-24
   Master Organization RG Consolidation....................................................... 1-25
   View Register Balance................................................................................ 1-26
   View Item Definition.................................................................................... 1-27
   Outside Processing Transaction.................................................................... 1-27
   Processing Inter Organization Transfer Transactions.................................. 1-31
   Reports........................................................................................................ 1-39

2 India Local Purchasing
   Defining Tax Overview................................................................................. 2-1
   Outside Processing Transactions................................................................... 2-6
   Receiving Corrections................................................................................... 2-21
   Mass Tax Update.......................................................................................... 2-22
   Transactions Handled.................................................................................... 2-23
   Encumbrance Accounting............................................................................. 2-26
3 India Local Payables

eTDS Returns .......................................................... 3-2
Bill of Entry (BOE) .................................................... 3-2
Capture Personal Ledger Account (PLA) Payment ................. 3-9
Tracking of Sales Tax Forms Issues ............................... 3-10
Third Party Taxes - Additions to Fixed Assets .................... 3-11
Defining TCS Authority ............................................. 3-12
Managing TDS Transactions ........................................ 3-12
Service Type Review ................................................ 3-21
Supporting Service Tax for Advance Receipts Payment ..... 3-23
Supporting Uptake of Point of Taxation for Service Tax ..... 3-32
BOE Invoices .......................................................... 3-47
PLA Invoices/Payment ............................................... 3-54
Using Sales Tax Declaration Forms - Issue Tracking .......... 3-56
India - FA Mass Additions ......................................... 3-65
Define Invoice Tolerance Limits .................................... 3-66
View / Resubmit / Delete Error Tax Lines ........................ 3-67
Importing Taxes to Payables and Receivables .................. 3-68
Reports ..................................................................... 3-72
Account Payables Standalone Invoice .............................. 3-86

4 India Local Order Management

Sales Order India Localized ........................................ 4-1
Fulfilled Orders India Localized ..................................... 4-6
Sales Order Returns India Localized ............................... 4-7
AR3A Form Receipt Tracking ....................................... 4-8
Concurrents ................................................................ 4-9
Managing Order Management Transactions ................... 4-17
Reports ..................................................................... 4-44
5 India Local Receivables
Transactions (Localized) Overview........................................................................ 5-1
Managing TCS Transactions.................................................................................... 5-4
TCS Settlement........................................................................................................ 5-7
Tracking of ST Forms Receipts.............................................................................. 5-13
AR 3A Form Receipt Tracking Overview................................................................. 5-14
RG Consolidation.................................................................................................... 5-17
Supplementary Transactions Overview................................................................. 5-20
Duty Drawback Processing...................................................................................... 5-39
TDS Certificates Received Overview..................................................................... 5-40
Setting Up Concurrent Programs.......................................................................... 5-42
Managing Receivables Transactions.................................................................... 5-53
Using Sales Tax Declaration Forms - Receipt Tracking......................................... 5-61
Reports................................................................................................................... 5-70

6 India Local Fixed Assets
Fixed Asset Depreciation Calculation................................................................. 6-1
Transactions........................................................................................................... 6-2
Reports................................................................................................................... 6-5

7 Trading Functionality
Trading Functionality Overview............................................................................ 7-1
Match Receipts Localized Overview.................................................................... 7-2
Transactions........................................................................................................... 7-5
Reports................................................................................................................... 7-15

8 India Local Projects
Projects Costing.................................................................................................... 8-1
Solution Flow.......................................................................................................... 8-1
Integrating with Purchasing................................................................................... 8-2
Integrating with Payables...................................................................................... 8-5
Integrating with Inventory..................................................................................... 8-9
India Local Projects Billing................................................................................... 8-9
Setting Up Projects Billing Tax Defaults and Preferences..................................... 8-10
Enter events or expenditures and distribute costs in Oracle Projects.................. 8-13
Generate draft revenue.......................................................................................... 8-13
Generate Draft Invoices......................................................................................... 8-13
Credit Memos and Foreign Currency Invoices....................................................... 8-20
9 India Local iP Procurement
   India Local iP Procurement Overview ................................................................. 9-1
   Processing iP Procurement Transactions .............................................................. 9-3
   Requisitions ........................................................................................................... 9-4
   Purchase Orders ..................................................................................................... 9-5
   Receiving ................................................................................................................ 9-6
   Reports .................................................................................................................... 9-8

10 India Local iSupplier
   iSupplier Overview .................................................................................................. 10-1
   Processing iSupplier Transactions .......................................................................... 10-4
   Buyer Actions ......................................................................................................... 10-9

11 India Local Advanced Pricing
   Advanced Pricing Overview .................................................................................... 11-1
   Assessable Value .................................................................................................... 11-2

A India Local Inclusive Tax
   India Local Inclusive Tax ....................................................................................... A-1
Send Us Your Comments

Part No. E48779-01

Oracle welcomes customers' comments and suggestions on the quality and usefulness of this document. Your feedback is important, and helps us to best meet your needs as a user of our products. For example:

- Are the implementation steps correct and complete?
- Did you understand the context of the procedures?
- Did you find any errors in the information?
- Does the structure of the information help you with your tasks?
- Do you need different information or graphics? If so, where, and in what format?
- Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your name, the name of the company who has licensed our products, the title and part number of the documentation and the chapter, section, and page number (if available).

Note: Before sending us your comments, you might like to check that you have the latest version of the document and if any concerns are already addressed. To do this, access the new Oracle E-Business Suite Release Online Documentation CD available on My Oracle Support and www.oracle.com. It contains the most current Documentation Library plus all documents revised or released recently.

Send your comments to us using the electronic mail address: appsdoc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle local office and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at www.oracle.com.
Preface

Intended Audience


This guide assumes you have a working knowledge of the following:

• The principles and customary practices of your business area.

• Computer desktop application usage and terminology.

If you have never used Oracle E-Business Suite, we suggest you attend one or more of the Oracle E-Business Suite training classes available through Oracle University.

See Related Information Sources on page x for more Oracle E-Business Suite product information.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Structure

1 India Local Inventory
2 India Local Purchasing
3 India Local Payables
Related Information Sources

This book is included in the Oracle E-Business Suite Documentation Library, which is supplied in the Release 12.2 Media Pack. If this guide refers you to other Oracle E-Business Suite documentation, use only the latest Release 12.2 versions of those guides.

Online Documentation

All Oracle E-Business Suite documentation is available online (HTML or PDF).

- **Online Help** - Online help patches (HTML) are available on My Oracle Support.

- **PDF Documentation** - See the Oracle E-Business Suite Documentation Library for current PDF documentation for your product with each release.

- **Release Notes** - For information about changes in this release, including new features, known issues, and other details, see the release notes for the relevant product, available on My Oracle Support.


Related Guides

You should have the following related books on hand. Depending on the requirements of your particular installation, you may also need additional manuals or guides.

**Oracle Alert User’s Guide**

This guide explains how to define periodic and event alerts to monitor the status of your Oracle E-Business Suite data.

**Oracle Application Framework Developer’s Guide**

This guide contains the coding standards followed by the Oracle E-Business Suite development staff to produce applications built with Oracle Application Framework.
This guide is available in PDF format on My Oracle Support and as online documentation in JDeveloper 10g with Oracle Application Extension.

**Oracle Application Framework Personalization Guide**

This guide covers the design-time and run-time aspects of personalizing applications built with Oracle Application Framework.


This guide covers the use of Adapter for Oracle Applications in developing integrations between Oracle E-Business Suite and trading partners.

Please note that the user’s guide can be found in the following documentation libraries:

- As part of the Oracle Fusion Middleware and SOA Suite in 11g, Oracle Fusion Middleware Adapter for Oracle Applications User’s Guide is available in the Oracle Fusion Middleware 11g Documentation Library.

- As part of the Oracle Application Server in 10g, Oracle Application Server Adapter for Oracle Applications User’s Guide is available in the Oracle Application Server 10g Documentation Library.

**Oracle Diagnostics Framework User’s Guide**

This manual contains information on implementing and administering diagnostics tests for Oracle E-Business Suite using the Oracle Diagnostics Framework.

**Oracle E-Business Suite Concepts**

This book is intended for all those planning to deploy Oracle E-Business Suite Release 12.2, or contemplating significant changes to a configuration. After describing the Oracle E-Business Suite architecture and technology stack, it focuses on strategic topics, giving a broad outline of the actions needed to achieve a particular goal, plus the installation and configuration choices that may be available.

**Oracle E-Business Suite CRM System Administrator’s Guide**

This manual describes how to implement the CRM Technology Foundation (JTT) and use its System Administrator Console.

**Oracle E-Business Suite Desktop Integration Framework Developer’s Guide**

Oracle E-Business Suite Desktop Integration Framework is a development tool that lets you define custom integrators for use with Oracle Web Applications Desktop Integrator. This guide describes how to define and manage integrators and all associated supporting objects, as well as how to download and upload integrator definitions.

**Oracle E-Business Suite Developer’s Guide**

This guide contains the coding standards followed by the Oracle E-Business Suite development staff. It describes the Oracle Application Object Library components needed to implement the Oracle E-Business Suite user interface described in the Oracle
E-Business Suite User Interface Standards for Forms-Based Products. It provides information to help you build your custom Oracle Forms Developer forms so that they integrate with Oracle E-Business Suite. In addition, this guide has information for customizations in features such as concurrent programs, flexfields, messages, and logging.

Oracle E-Business Suite Flexfields Guide
This guide provides flexfields planning, setup, and reference information for the Oracle E-Business Suite implementation team, as well as for users responsible for the ongoing maintenance of Oracle E-Business Suite product data. This guide also provides information on creating custom reports on flexfields data.

Oracle E-Business Suite Installation Guide: Using Rapid Install
This book is intended for use by anyone who is responsible for installing or upgrading Oracle E-Business Suite. It provides instructions for running Rapid Install either to carry out a fresh installation of Oracle E-Business Suite Release 12.2, or as part of an upgrade to Release 12.2.

Oracle E-Business Suite Maintenance Guide
This guide contains information about the strategies, tasks, and troubleshooting activities that can be used to help ensure an Oracle E-Business Suite system keeps running smoothly, together with a comprehensive description of the relevant tools and utilities. It also describes how to patch a system, with recommendations for optimizing typical patching operations and reducing downtime.

Oracle E-Business Suite Security Guide
This guide contains information on a comprehensive range of security-related topics, including access control, user management, function security, data security, and auditing. It also describes how Oracle E-Business Suite can be integrated into a single sign-on environment.

Oracle E-Business Suite Setup Guide
This guide contains information on system configuration tasks that are carried out either after installation or whenever there is a significant change to the system. The activities described include defining concurrent programs and managers, enabling Oracle Applications Manager features, and setting up printers and online help.

Oracle E-Business Suite User's Guide
This guide explains how to navigate, enter data, query, and run reports using the user interface (UI) of Oracle E-Business Suite. This guide also includes information on setting user profiles, as well as running and reviewing concurrent requests.

Oracle E-Business Suite User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle E-Business Suite development staff. It describes the UI for the Oracle E-Business Suite products and how to apply this UI to the design of an application built by using Oracle Forms.

This guide describes the high level service enablement process, explaining how users can browse and view the integration interface definitions and services residing in Oracle Integration Repository.

**Oracle E-Business Suite Integrated SOA Gateway Implementation Guide**

This guide explains how integration repository administrators can manage and administer the Web service activities for integration interfaces including native packaged integration interfaces, composite services (BPEL type), and custom integration interfaces. It also describes how to invoke Web services from Oracle E-Business Suite by employing the Oracle Workflow Business Event System, and how to manage Web service security, configure logs, and monitor SOAP messages.


This guide describes how system integration developers can perform end-to-end service integration activities. These include orchestrating discrete Web services into meaningful end-to-end business processes using business process execution language (BPEL), and deploying BPEL processes at run time.

This guide also explains how to invoke Web services using the Service Invocation Framework. This includes defining Web service invocation metadata, invoking Web services, and testing the Web service invocation.

**Oracle e-Commerce Gateway User’s Guide**

This guide describes the functionality of Oracle e-Commerce Gateway and the necessary setup steps in order for Oracle E-Business Suite to conduct business with trading partners through Electronic Data Interchange (EDI). It also describes how to run extract programs for outbound transactions, import programs for inbound transactions, and the relevant reports.

**Oracle e-Commerce Gateway Implementation Guide**

This guide describes implementation details, highlighting additional setup steps needed for trading partners, code conversion, and Oracle E-Business Suite. It also provides architecture guidelines for transaction interface files, troubleshooting information, and a description of how to customize EDI transactions.

**Oracle iSetup Developer’s Guide**

This manual describes how to build, test, and deploy Oracle iSetup Framework interfaces.

**Oracle iSetup User’s Guide**

This guide describes how to use Oracle iSetup to migrate data between different instances of the Oracle E-Business Suite and generate reports. It also includes configuration information, instance mapping, and seeded templates used for data migration.

**Oracle Report Manager User’s Guide**

Oracle Report Manager is an online report distribution system that provides a secure and centralized location to produce and manage point-in-time reports. Oracle Report
Manager users can be either report producers or report consumers. Use this guide for information on setting up and using Oracle Report Manager.

**Oracle Web Applications Desktop Integrator Implementation and Administration Guide**

Oracle Web Applications Desktop Integrator brings Oracle E-Business Suite functionality to a spreadsheet, where familiar data entry and modeling techniques can be used to complete Oracle E-Business Suite tasks. You can create formatted spreadsheets on your desktop that allow you to download, view, edit, and create Oracle E-Business Suite data, which you can then upload. This guide describes how to implement Oracle Web Applications Desktop Integrator and how to define mappings, layouts, style sheets, and other setup options.

**Oracle Workflow Administrator’s Guide**

This guide explains how to complete the setup steps necessary for any product that includes workflow-enabled processes. It also describes how to manage workflow processes and business events using Oracle Applications Manager, how to monitor the progress of runtime workflow processes, and how to administer notifications sent to workflow users.

**Oracle Workflow Developer’s Guide**

This guide explains how to define new workflow business processes and customize existing Oracle E-Business Suite-embedded workflow processes. It also describes how to define and customize business events and event subscriptions.

**Oracle Workflow User’s Guide**

This guide describes how users can view and respond to workflow notifications and monitor the progress of their workflow processes.

**Oracle Workflow API Reference**

This guide describes the APIs provided for developers and administrators to access Oracle Workflow.

**Oracle Workflow Client Installation Guide**

This guide describes how to install the Oracle Workflow Builder and Oracle XML Gateway Message Designer client components for Oracle E-Business Suite.

**Oracle XML Gateway User’s Guide**

This guide describes Oracle XML Gateway functionality and each component of the Oracle XML Gateway architecture, including Message Designer, Oracle XML Gateway Setup, Execution Engine, Message Queues, and Oracle Transport Agent. It also explains how to use Collaboration History that records all business transactions and messages exchanged with trading partners.

The integrations with Oracle Workflow Business Event System, and the Business-to-Business transactions are also addressed in this guide.

**Oracle XML Publisher Report Designer’s Guide**
Oracle XML Publisher is a template-based reporting solution that merges XML data with templates in RTF or PDF format to produce a variety of outputs to meet a variety of business needs. Using Microsoft Word or Adobe Acrobat as the design tool, you can create pixel-perfect reports from the Oracle E-Business Suite. Use this guide to design your report layouts.

This guide is available through the Oracle E-Business Suite online help.

**Oracle XML Publisher Administration and Developer’s Guide**

Oracle XML Publisher is a template-based reporting solution that merges XML data with templates in RTF or PDF format to produce a variety of outputs to meet a variety of business needs. Outputs include: PDF, HTML, Excel, RTF, and eText (for EDI and EFT transactions). Oracle XML Publisher can be used to generate reports based on existing Oracle E-Business Suite report data, or you can use Oracle XML Publisher’s data extraction engine to build your own queries. Oracle XML Publisher also provides a robust set of APIs to manage delivery of your reports via e-mail, fax, secure FTP, printer, WebDav, and more. This guide describes how to set up and administer Oracle XML Publisher as well as how to use the Application Programming Interface to build custom solutions.

This guide is available through the Oracle E-Business Suite online help.

**Oracle E-Business Suite Upgrade Guide: Release 12.0 and 12.1 to 12.2:**

This guide provides information for DBAs and Applications Specialists who are responsible for upgrading Release 12.0 and 12.1 Oracle E-Business Suite system (techstack and products) to Release 12.2. In addition to information about applying the upgrade driver, it outlines pre-upgrade steps and post-upgrade steps, and provides descriptions of product-specific functional changes and suggestions for verifying the upgrade and reducing downtime.

**Oracle Advanced Global Intercompany System User’s Guide:**

This guide describes the self service application pages available for Intercompany users. It includes information on setting up intercompany, entering intercompany transactions, importing transactions from external sources and generating reports.

**Oracle Advanced Collections User Guide:**

This guide describes how to use the features of Oracle Advanced Collections to manage your collections activities. It describes how collections agents and managers can use Oracle Advanced Collections to identify delinquent customers, review payment history and aging data, process payments, use strategies and dunning plans to automate the collections process, manage work assignments, and handle later-stage delinquencies.

**Oracle Advanced Collections Implementation Guide:**

This guide describes how to configure Oracle Advanced Collections and its integrated products. It contains the steps required to set up and verify your implementation of Oracle Advanced Collections.

**Oracle Assets User Guide:**
This guide provides you with information on how to implement and use Oracle Assets. Use this guide to understand the implementation steps required for application use, including defining depreciation books, depreciation method, and asset categories. It also contains information on setting up assets in the system, maintaining assets, retiring and reinstating assets, depreciation, group depreciation, accounting and tax accounting, budgeting, online inquiries, impairment processing, and Oracle Assets reporting. The guide explains using Oracle Assets with Multiple Reporting Currencies (MRC). This guide also includes a comprehensive list of profile options that you can set to customize application behavior.

**Oracle Bill Presentment Architecture User’s Guide:**

This guide provides you information on using Oracle Bill Presentment Architecture. Consult this guide to create and customize billing templates, assign a template to a rule and submit print requests. This guide also provides detailed information on page references, seeded content items and template assignment attributes.

**Oracle Cash Management User Guide:**

This guide describes how to use Oracle Cash Management to clear your receipts, as well as reconcile bank statements with your outstanding balances and transactions. This manual also explains how to effectively manage and control your cash cycle. It provides comprehensive bank reconciliation and flexible cash forecasting.

**Oracle Credit Management User Guide:**

This guide provides you with information on how to use Oracle Credit Management. This guide includes implementation steps, such as how to set up credit policies, as well as details on how to use the credit review process to derive credit recommendations that comply with your credit policies. This guide also includes detailed information about the public application programming interfaces (APIs) that you can use to extend Oracle Credit Management functionality.

**Oracle Customer Data Librarian User Guide:**

This guide describes how to use Oracle Customer Data Librarian to establish and maintain the quality of the Trading Community Architecture Registry, focusing on consolidation, cleanliness, and completeness. Oracle Customer Data Librarian has all of the features in Oracle Customers Online, and is also part of the Oracle Customer Data Management product family.

**Oracle Customer Data Librarian Implementation Guide:**

This guide describes how to implement Oracle Customer Data Librarian. As part of implementing Oracle Customer Data Librarian, you must also complete all the implementation steps for Oracle Customers Online.

**Oracle Customers Online User Guide:**

This guide describes how to use Oracle Customers Online to view, create, and maintain your customer information. Oracle Customers Online is based on Oracle Trading Community Architecture data model and functionality, and is also part of the Oracle Customer Data Management product family.
Oracle Customers Online Implementation Guide:
This guide describes how to implement Oracle Customers Online.

Oracle E-Business Suite Multiple Organizations Implementation Guide:
This guide describes the multiple organizations concepts in Oracle E-Business Suite. It describes in detail on setting up and working effectively with multiple organizations in Oracle E-Business Suite.

Oracle E-Business Tax User Guide:
This guide describes the entire process of setting up and maintaining tax configuration data, as well as applying tax data to the transaction line. It describes the entire regime-to-rate setup flow of tax regimes, taxes, statuses, rates, recovery rates, tax jurisdictions, and tax rules. It also describes setting up and maintaining tax reporting codes, fiscal classifications, tax profiles, tax registrations, configuration options, and third party service provider subscriptions. You also use this manual to maintain migrated tax data for use with E-Business Tax.

Oracle E-Business Tax Implementation Guide:
This guide provides a conceptual overview of the E-Business Tax tax engine, and describes the prerequisite implementation steps to complete in other applications in order to set up and use E-Business Tax. The guide also includes extensive examples of setting up country-specific tax requirements.

Oracle E-Business Tax Reporting Guide:
This guide explains how to run all tax reports that make use of the E-Business Tax data extract. This includes the Tax Reporting Ledger and other core tax reports, country-specific VAT reports, and Latin Tax Engine reports.

Oracle E-Business Tax: Vertex Q-Series and Taxware Sales/Use Tax System Implementation Guide
This guide explains how to setup and use the services of third party tax service providers for US Sales and Use tax. The tax service providers are Vertex Q-Series and Taxware Sales/Use Tax System. When implemented, the Oracle E-Business Tax service subscription calls one of these tax service providers to return a tax rate or amount whenever US Sales and Use tax is calculated by the Oracle E-Business Tax tax engine. This guide provides setup steps, information about day-to-day business processes, and a technical reference section.

Oracle Embedded Data Warehouse User Guide:
This guide describes how to use Embedded Data Warehouse reports and workbooks to analyze performance.

Oracle Embedded Data Warehouse Implementation Guide:
This guide describes how to implement Embedded Data Warehouse, including how to set up the intelligence areas.

Oracle Embedded Data Warehouse Install Guide:
This guide describes how to install Embedded Data Warehouse, including how to create database links and create the end user layer (EUL).

**Oracle Financial Accounting Hub Implementation Guide:**
This guide provides detailed implementation information that leverages the features of Oracle Subledger Accounting to generate accounting.

**Oracle Financial Services Reference Guide:**
This guide provides reference material for Oracle Financial Services applications in Release 12, such as Oracle Transfer Pricing, and includes technical details about application use as well as general concepts, equations, and calculations.

**Oracle Financial Services Implementation Guide:**
This guide describes how to set up Oracle Financial Services applications in Release 12.

**Oracle Financial Services Reporting Administration Guide:**
This guide describes the reporting architecture of Oracle Financial Services applications in Release 12, and provides information on how to view these reports.

**Oracle Financials and Oracle Procurement Functional Upgrade Guide: Release 11i to Release 12:**
This guide describes the functional impacts of upgrading Oracle Financials and Oracle Procurement products from Release 11i to Release 12. This guide supplements the Oracle E-Business Suite Upgrade Guide: Release 12.0 and 12.1 to 12.2.

**Oracle Financials Concepts Guide:**
This guide describes the fundamental concepts of Oracle Financials. The guide is intended to introduce readers to the concepts used in the applications, and help them compare their real world business, organization, and processes to those used in the applications.

**Oracle Financials Country-Specific Installation Supplement:**
This guide provides general country information, such as responsibilities and report security groups, as well as any post-install steps required by some countries.

**Oracle Financials for the Americas User Guide:**
This guide describes functionality developed to meet specific business practices in countries belonging to the Americas region. Consult this user guide along with your financial product user guides to effectively use Oracle Financials in your country.

**Oracle Financials for Asia/Pacific User Guide:**
This guide describes functionality developed to meet specific business practices in countries belonging to the Asia/Pacific region. Consult this user guide along with your financial product user guides to effectively use Oracle Financials in your country.

**Oracle Financials for Europe User Guide:**
This guide describes functionality developed to meet specific business practices in countries belonging to the European region. Consult this user guide along with your financial product user guides to effectively use Oracle Financials in your country.

**Oracle Financials for India User's Guide:**
This guide provides information on how to use Oracle Financials for India. Use this guide to learn how to create and maintain setup related to India taxes, defaulting and calculation of taxes on transactions. This guide also includes information about accounting and reporting of taxes related to India.

**Oracle Financials for India Implementation Guide:**
This guide provides information on how to implement Oracle Financials for India. Use this guide to understand the implementation steps required for application use, including how to set up taxes, tax defaulting hierarchies, set up different tax regimes, organization and transactions.

**Oracle Financials Glossary:**
The glossary includes definitions of common terms that are shared by all Oracle Financials products. In some cases, there may be different definitions of the same term for different Financials products. If you are unsure of the meaning of a term you see in an Oracle Financials guide, please refer to the glossary for clarification. You can find the glossary in the online help or in the Oracle Financials Implementation Guide.

**Oracle Financials Implementation Guide:**
This guide provides information on how to implement the Oracle Financials E-Business Suite. It guides you through setting up your organizations, including legal entities, and their accounting, using the Accounting Setup Manager. It covers intercompany accounting and sequencing of accounting entries, and it provides examples.

**Oracle Financials RXi Reports Administration Tool User Guide:**
This guide describes how to use the RXi reports administration tool to design the content and layout of RXi reports. RXi reports let you order, edit, and present report information to better meet your company's reporting needs.

**Oracle General Ledger Implementation Guide:**
This guide provides information on how to implement Oracle General Ledger. Use this guide to understand the implementation steps required for application use, including how to set up Accounting Flexfields, Accounts, and Calendars.

**Oracle General Ledger Reference Guide**
This guide provides detailed information about setting up General Ledger Profile Options and Applications Desktop Integrator (ADI) Profile Options.

**Oracle General Ledger User's Guide:**
This guide provides information on how to use Oracle General Ledger. Use this guide to learn how to create and maintain ledgers, ledger currencies, budgets, and journal entries. This guide also includes information about running financial reports.
Oracle Incentive Compensation Implementation Guide:

This guide provides Compensation Administrators with guidance during implementation of Oracle Incentive Compensation. The procedures are presented in the recommended order that they should be performed for successful implementation. Appendixes are included that describe system profiles, lookups, and other useful information.

Oracle Incentive Compensation User Guide:

This guide helps Compensation Managers, Compensation Analysts, and Plan administrators to manage Oracle Incentive Compensation on a day-to-day basis. Learn how to create and manage rules hierarchies, create compensation plans, collect transactions, calculate and pay commission, and use Sales Credit Allocation.

Oracle Internet Expenses Implementation and Administration Guide:

This book explains in detail how to configure Oracle Internet Expenses and describes its integration with other applications in the E-Business Suite, such as Oracle Payables and Oracle Projects. Use this guide to understand the implementation steps required for application use, including how to set up policy and rate schedules, credit card policies, audit automation, and the expenses spreadsheet. This guide also includes detailed information about the client extensions that you can use to extend Oracle Internet Expenses functionality.

Oracle iAssets User Guide

This guide provides information on how to implement and use Oracle iAssets. Use this guide to understand the implementation steps required for application use, including setting up Oracle iAssets rules and related product setup steps. It explains how to define approval rules to facilitate the approval process. It also includes information on using the Oracle iAssets user interface to search for assets, create self-service transfer requests and view notifications.

Oracle iProcurement Implementation and Administration Guide:

This manual describes how to set up and administer Oracle iProcurement. Oracle iProcurement enables employees to requisition items through a self-service, Web interface.

Oracle iReceivables Implementation Guide:

This guide provides information on how to implement Oracle iReceivables. Use this guide to understand the implementation steps required for application use, including how to set up and configure iReceivables, and how to set up the Credit Memo Request workflow. There is also a chapter that provides an overview of major features available in iReceivables.

Oracle iSupplier Portal User Guide:

This guide contains information on how to use Oracle iSupplier Portal to enable secure transactions between buyers and suppliers using the Internet. Using Oracle iSupplier Portal, suppliers can monitor and respond to events in the procure-to-pay cycle.
Oracle iSupplier Portal Implementation Guide:
This guide contains information on how to implement Oracle iSupplier Portal and enable secure transactions between buyers and suppliers using the Internet.

Oracle Loans User Guide:
This guide describes how to set up and use Oracle Loans. It includes information on how to create, approve, fund, amortize, bill, and service extended repayment plan and direct loans.

Oracle Partner Management Implementation and Administration Guide:
This guide helps Vendor administrators to set up and maintain relationships and programs in the Partner Management application. The main areas include setting up the partner and channel manager dashboards, partner setup, partner programs and enrollment, opportunity and referral management, deal registration, special pricing management, and partner fund management.

Oracle Partner Management Vendor User Guide:
This guide assists vendor users in using Partner Management on a daily basis. This includes interaction with the partner and channel manager dashboards, working with partners and partner programs, managing opportunities and referrals, registering deals, and working with special pricing and partner funds.

Oracle Payables User's Guide:
This guide describes how to use Oracle Payables to create invoices and make payments. In addition, it describes how to enter and manage suppliers, import invoices using the Payables open interface, manage purchase order and receipt matching, apply holds to invoices, and validate invoices. It contains information on managing expense reporting, procurement cards, and credit cards. This guide also explains the accounting for Payables transactions.

Oracle Payables Implementation Guide:
This guide provides you with information on how to implement Oracle Payables. Use this guide to understand the implementation steps required for how to set up suppliers, payments, accounting, and tax.

Oracle Payables Reference Guide:
This guide provides you with detailed information about the Oracle Payables open interfaces, such as the Invoice open interface, which lets you import invoices. It also includes reference information on purchase order matching and purging purchasing information.

Oracle Payments Implementation Guide:
This guide describes how Oracle Payments, as the central payment engine for the Oracle E-Business Suite, processes transactions, such as invoice payments from Oracle Payables, bank account transfers from Oracle Cash Management, and settlements against credit cards and bank accounts from Oracle Receivables. This guide also describes how Oracle Payments is integrated with financial institutions and payment
systems for receipt and payment processing, known as funds capture and funds
disbursement, respectively. Additionally, the guide explains to the implementer how to
plan the implementation of Oracle Payments, how to configure it, set it up, test
transactions, and how use it with external payment systems.

**Oracle Payments User's Guide:**

This guide describes how Oracle Payments, as the central payment engine for the
Oracle E-Business Suite, processes transactions, such as invoice payments from Oracle
Payables, bank account transfers from Oracle Cash Management, and settlements
against credit cards and bank accounts from Oracle Receivables. This guide also
describes to the Payment Administrator how to monitor the funds capture and funds
disbursement processes, as well as how to remedy any errors that may arise.

**Oracle Procurement Buyer's Guide to Punchout and Transparent Punchout:**

This guide contains necessary information for customers implementing remote catalog
content on a supplier's Web site or on Oracle Exchange.

**Oracle Procurement Contracts Online Help:**

This guide is provided as online help only from the Oracle Procurement Contracts
application and includes information about creating and managing your contract terms
library.

**Oracle Procurement Contracts Implementation and Administration Guide:**

This guide describes how to set up and administer Oracle Procurement Contracts.
Oracle Procurement Contracts enables employees to author and maintain complex
contracts through a self–service, Web interface.

**Oracle Public Sector Financials User Guide:**

This guide describes how to set up and administer Oracle Public Sector Advanced
Features. It describes Encumbrance Reconciliation Reports, GASB 34/35 Asset
Accounting, and Funds Available Enhancements.

**Oracle Purchasing User's Guide:**

This guide describes how to create and approve purchasing documents, including
requisitions, different types of purchase orders, quotations, RFQs, and receipts. This
guide also describes how to manage your supply base through agreements, sourcing
rules, and approved supplier lists. In addition, this guide explains how you can
automatically create purchasing documents based on business rules through integration
with Oracle Workflow technology, which automates many of the key procurement
processes.

**Oracle Receivables User Guide:**

This guide provides you with information on how to use Oracle Receivables. Use this
guide to learn how to create and maintain transactions and bills receivable, enter and
apply receipts, enter customer information, and manage revenue. This guide also
includes information about accounting in Receivables. Use the Standard Navigation
Paths appendix to find out how to access each Receivables window.
Oracle Receivables Implementation Guide:
This guide provides you with information on how to implement Oracle Receivables. Use this guide to understand the implementation steps required for application use, including how to set up customers, transactions, receipts, accounting, tax, and collections. This guide also includes a comprehensive list of profile options that you can set to customize application behavior.

Oracle Receivables Reference Guide:
This guide provides you with detailed information about all public application programming interfaces (APIs) that you can use to extend Oracle Receivables functionality. This guide also describes the Oracle Receivables open interfaces, such as AutoLockbox which lets you create and apply receipts and AutoInvoice which you can use to import and validate transactions from other systems. Archiving and purging Receivables data is also discussed in this guide.

Oracle Sourcing Implementation and Administration Guide:
This guide contains information on how to implement Oracle Sourcing to enable participants from multiple organizations to exchange information, conduct bid and auction processes, and create and implement buying agreements. This allows professional buyers, business experts, and suppliers to participate in a more agile and accurate sourcing process.

Oracle Subledger Accounting Implementation Guide:
This guide provides setup information for Oracle Subledger Accounting features, including the Accounting Methods Builder. You can use the Accounting Methods Builder to create and modify the setup for subledger journal lines and application accounting definitions for Oracle subledger applications. This guide also discusses the reports available in Oracle Subledger Accounting and describes how to inquire on subledger journal entries.

Oracle Supplier Scheduling User's Guide:
This guide describes how you can use Oracle Supplier Scheduling to calculate and maintain planning and shipping schedules and communicate them to your suppliers.

Oracle iProcurement Implementation and Administration Guide:
This manual describes how to set up and administer Oracle iProcurement. Oracle iProcurement enables employees to requisition items through a self–service, Web interface.

Oracle Procurement Contracts Implementation and Administration Guide:
This manual describes how to set up and administer Oracle Procurement Contracts. Oracle Procurement Contracts enables employees to author and maintain complex contracts through a self–service, Web interface.

Oracle Trading Community Architecture User Guide:
This guide describes the Oracle Trading Community Architecture (TCA) and how to use features from the Trading Community Manager responsibility to create, update,
enrich, and cleanse the data in the TCA Registry. It also describes how to use Resource Manager to define and manage resources.

**Oracle Trading Community Architecture Administration Guide:**

This guide describes how to administer and implement Oracle Trading Community Architecture (TCA). You set up, control, and manage functionality that affects data in the TCA Registry. It also describes how to set up and use Resource Manager to manage resources.

**Oracle Trading Community Architecture Reference Guide:**

This guide contains seeded relationship types, seeded Data Quality Management data, D&B data elements, Bulk Import interface table fields and validations, and a comprehensive glossary. This guide supplements the documentation for Oracle Trading Community Architecture and all products in the Oracle Customer Data Management family.

**Oracle Trading Community Architecture Technical Implementation Guide:**

This guide explains how to use the public Oracle Trading Community Architecture application programming interfaces (APIs) and develop callouts based on Oracle Workflow Business Events System (BES). For each API, this guide provides a description of the API, the PL/SQL procedure, and the Java method, as well as a table of the parameter descriptions and validations. For each BES callout, this guide provides the name of the logical entity, its description, and the ID parameter name. Also included are setup instructions and sample code.

**Oracle U.S. Federal Financials User's Guide:**

This guide describes the common concepts for an integrated financial management solution for federal agencies to comply with the requirements of the U.S. Federal government. It describes the product architecture and provides information on Budget Execution, Prompt Payment, Treasury payments, Third party payments, Interagency transactions, Receivables management, Federal reports, CCR Integration, and Year End Closing.

**Oracle U.S. Federal Financials Implementation Guide:**

This guide describes the common concepts for an integrated financial management solution for federal agencies. It includes a consolidated setup checklist by page and provides detailed information on how to set up, maintain, and troubleshoot the Federal Financial application for the following functional areas: Sub Ledger Accounting, Budget Execution, Prompt Payment, Treasury payments, Third party payments, Interagency transactions, Receivables management, Federal reports, CCR Integration, and Year End Closing.

**Oracle Projects Documentation Set**

**Oracle Projects Implementation Guide:**

Use this guide to implement Oracle Projects. This guide also includes appendixes covering function security, menus and responsibilities, and profile options.
Oracle Project Costing User Guide:
Use this guide to learn detailed information about Oracle Project Costing. Oracle Project Costing provides the tools for processing project expenditures, including calculating their cost to each project and determining the General Ledger accounts to which the costs are posted.

Oracle Project Billing User Guide:
This guide shows you how to use Oracle Project Billing to define revenue and invoicing rules for your projects, generate revenue, create invoices, and integrate with other Oracle Applications to process revenue and invoices, process client invoicing, and measure the profitability of your contract projects.

Oracle Project Management User Guide:
This guide shows you how to use Oracle Project Management to manage projects through their lifecycles - from planning, through execution, to completion.

Oracle Project Portfolio Analysis User Guide:
This guide contains the information you need to understand and use Oracle Project Portfolio Analysis. It includes information about project portfolios, planning cycles, and metrics for ranking and selecting projects for a project portfolio.

Oracle Project Resource Management User Guide:
This guide provides you with information on how to use Oracle Project Resource Management. It includes information about staffing, scheduling, and reporting on project resources.

Oracle Grants Accounting Documentation
Oracle Grants Accounting User Guide:
This guide provides you with information about how to implement and use Oracle Grants Accounting. Use this guide to understand the implementation steps required for application use, including defining award types, award templates, allowed cost schedules, and burden set up. This guide also explains how to use Oracle Grants Accounting to track grants and funded projects from inception to final reporting.

Oracle Property Manager Documentation
Oracle Property Manager User Guide:
Use this guide to learn how to use Oracle Property Manager to create and administer properties, space assignments, and lease agreements.

Oracle Property Manager Implementation Guide:
Use this guide to learn how to implement Oracle Property Manager and perform basic setup steps such as setting system options and creating lookup codes, contacts, milestones, grouping rules, term templates, and a location hierarchy. This guide also describes the setup steps that you must complete in other Oracle applications before you can use Oracle Property Manager.
Integration Repository

The Oracle Integration Repository is a compilation of information about the service endpoints exposed by the Oracle E-Business Suite of applications. It provides a complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets users easily discover and deploy the appropriate business service interface for integration with any system, application, or business partner.

The Oracle Integration Repository is shipped as part of the E-Business Suite. As your instance is patched, the repository is automatically updated with content appropriate for the precise revisions of interfaces in your environment.

You can navigate to the Oracle Integration Repository through Oracle E-Business Suite Integrated SOA Gateway.

Do Not Use Database Tools to Modify Oracle E-Business Suite Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle E-Business Suite data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and maintain information in an Oracle database. But if you use Oracle tools such as SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle E-Business Suite tables are interrelated, any change you make using an Oracle E-Business Suite form can update many tables at once. But when you modify Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you may change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle E-Business Suite.

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite automatically checks that your changes are valid. Oracle E-Business Suite also keeps track of who changes information. If you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.
India Local Inventory

This chapter covers the following topics:

- Miscellaneous Transactions Overview
- Inventory & WIP Transactions Overview
- Organization Information
- Managing India Local Inventory
- RG - I Register Entry
- RG 23 Register Entry
- Apply Time Extension
- Master Organization RG Consolidation
- View Register Balance
- View Item Definition
- Outside Processing Transaction
- Processing Inter Organization Transfer Transactions
- Reports

**Miscellaneous Transactions Overview**

You can use the Miscellaneous Transactions to register effect of Inventory movements on Excise Registers. You can record Inventory Issues and Receipts to and from production using Miscellaneous Issue/Receipt (RG Update) and the respective Excise Inventory Registers are updated with these transactions.

**Inventory & WIP Transactions Overview**

Oracle Financials for India supports certain transactions to track movement of Excise Goods. Whenever there is a Transaction using Excise goods is created from the
following features supported by Base Application, then Oracle Financials for India updates Excise Quantity Registers - RG 1 in case of finished goods, RG 23 A for raw materials and RG 23 C Part 1 for capital goods. Following is a list of such transactions and their impact on Excise Registers:

<table>
<thead>
<tr>
<th>Transaction Type</th>
<th>RMIN</th>
<th>CCIN</th>
<th>FGIN</th>
<th>CGIN</th>
<th>OTIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Miscellaneous Receipt RG Update</td>
<td>RG 23A Part 1</td>
<td>RG 1</td>
<td>RG 1</td>
<td>RG 23C Part 1</td>
<td>NA</td>
</tr>
<tr>
<td>Miscellaneous Issue RG Update</td>
<td>RG 23A Part 1</td>
<td>First RG 23A Part 1, then RG 1</td>
<td>RG 1</td>
<td>RG 23C Part 1</td>
<td>NA</td>
</tr>
<tr>
<td>Cycle Count Adjustment.</td>
<td>RG 23A Part 1</td>
<td>RG 23A Part 1</td>
<td>RG 1</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Physical Inventory Adjustment.</td>
<td>RG 23A Part 1</td>
<td>RG 23A Part 1</td>
<td>RG 1</td>
<td>RG 23C Part 1</td>
<td>NA</td>
</tr>
<tr>
<td>Move Order Issue</td>
<td>RG 23A Part 1</td>
<td>RG 1</td>
<td>RG 1</td>
<td>RG 23 C Part 1</td>
<td>NA</td>
</tr>
<tr>
<td>WIP Component Return.</td>
<td>RG 23A Part 1</td>
<td>RG 1</td>
<td>RG 1</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>WIP Assembly Completion.</td>
<td>RG 23A Part 1</td>
<td>RG 1</td>
<td>RG 1</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>WIP Assembly Return.</td>
<td>RG 23A Part 1</td>
<td>RG 1</td>
<td>RG 1</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>WIP Negative Component Issue</td>
<td>RG 23A Part 1</td>
<td>RG 1</td>
<td>RG 1</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>WIP Negative Component Return.</td>
<td>RG 23A Part 1</td>
<td>RG 1</td>
<td>RG 1</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>WIP Scrap Transaction.</td>
<td>RG 23A Part 1</td>
<td>RG 1</td>
<td>RG 1</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Transaction Type</td>
<td>RMIN</td>
<td>CCIN</td>
<td>FGIN</td>
<td>CGIN</td>
<td>OTIN</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------</td>
<td>------</td>
<td>------</td>
<td>------</td>
<td>------</td>
</tr>
<tr>
<td>Staging transfer of a sales order</td>
<td>RG 23A Part 1</td>
<td>RG 1</td>
<td>RG 1</td>
<td>NA</td>
<td>NA</td>
</tr>
</tbody>
</table>

**Organization Information**

**Defining VAT Journal Sources and Categories**

Journal Sources need to be defined to transfer VAT Related Accounting entries to General Ledger.

VAT GL Entries created from PO-Receiving Transactions, Source would be 'Purchasing' and Category would be 'Receiving India'.

Value Added Taxes on Transaction

This section provides details on the implication of Value Added Taxes on transactions.

**VAT Defaulting & Calculation**

VAT Taxes default on following documents

- Purchase Requisitions
- Internal Requisitions
- Request for Quotations
- Quotations
- Purchase Orders
- PO Releases
- PO Receipts
- ISO Receipts
- RMA Receipts

Current Tax defaulting and calculation capabilities of Oracle Financials for India Tax Engine can handle these requirements. Tax defaulting and calculation happens based on Tax Setups. Appropriate setup of Tax Codes, Tax Categories with Precedence and Item Categories will ensure appropriate Tax defaulting and Calculation.
Added Tax Recovery Process

VAT Taxes applicable to a Purchase Transactions can be recovered to set-off the VAT Liability arising from the Sale of Goods arising in the course of intra-state trade. This section provides details of the VAT Recovery process.

The new VAT recovery enhancement supports recovery of taxes at various intervals and with variable recovery amount over each installment. With this enhancement, you can also default the first installment terms and details of other subsequent installments. For detailed information, please refer to Define Claim Terms in the Oracle Financials for India Implementation Guide.

Claim VAT - During Receipt creation

VAT Tax Amounts included in the Purchase transaction can be recovered on Receipt of VAT Invoice from the Supplier. This document can be received either with the Receipt of Material or at a later stage. If the document is received along with the material then, the user has an option to enter the VAT Invoice details by opening the Claim Details window through the Receipts India Local window.

To open the Claim Details window while creating the Receipt, click on Claim VAT on the Receipt India Local screen.

- You should have frozen the Tax lines and amounts before you open the Claim Details screen.

If you have any Tax modifications pending, click 'No'. On clicking 'Yes' Claim Details will open.

The field wise description of the form is given below for ready reference.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipt Header Block</td>
<td>In this block you would see the List of Receipts that meet your query criteria. In case you have opened this Form from Receipts India Local Screen, only the current Receipt would appear in this block. In this block you can view Total of VAT Recoverable Amount. Of which how much is recovered, the VAT Invoice details would appear in this Block</td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Claim Status</td>
<td>VAT Claim status would be displayed here. Following would be the distinct statuses:</td>
</tr>
<tr>
<td></td>
<td>1. <strong>Not Claimed</strong>: This value would appear if none of the Receipt lines are processed</td>
</tr>
<tr>
<td></td>
<td>2. <strong>Full Claimed</strong>: This status would appear if VAT on all the lines are claimed.</td>
</tr>
<tr>
<td></td>
<td>3. <strong>Partial Claimed</strong>: This status would appear when only some of the lines are claimed.</td>
</tr>
<tr>
<td></td>
<td>4. <strong>Non Claimable</strong>: This status would appear when all the lines are not eligible for claim and all of them are marked as not claimable.</td>
</tr>
<tr>
<td>Receipt Number</td>
<td>Receipt Number is displayed here</td>
</tr>
<tr>
<td>Recoverable Amount</td>
<td>This field reflects the Total of Recoverable VAT Tax amounts applicable to the Receipt. <strong>Important</strong>: All Tax Types Assigned to the VAT Regime would be considered as VAT Taxes.</td>
</tr>
<tr>
<td>Recovered Amount</td>
<td>This field displays the Total of VAT Amount Recovered so far. In the following cases Recovered Amount would not be equal to the Recoverable Amount:</td>
</tr>
<tr>
<td></td>
<td>1. When you have processed claim for any of the Receipt Lines.</td>
</tr>
<tr>
<td></td>
<td>2. When only some of the Receipt lines are Recovered</td>
</tr>
<tr>
<td></td>
<td>3. Based on the claim terms only a part of the VAT Amount is recovered</td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Invoice No.</td>
<td>This field would display the VAT Invoice Number. In the following scenarios, no value would be displayed in this field: 1. You have not specified VAT Invoice Number for any of the fields 2. More than one VAT Invoice Number has been specified for the Invoice Lines.</td>
</tr>
<tr>
<td>Invoice Date</td>
<td>VAT Invoice Date is displayed here. The date would be displayed only when the VAT Invoice Number is displayed.</td>
</tr>
<tr>
<td>Party</td>
<td>If the VAT Invoice is received from a Supplier who is different from the PO supplier, you would enter the Party on the Receipt Lines. Such Party would be shown in this field. However, if this value is not distinct for all lines, the field would not display any value. Such Party would be shown in this field. However, if this value is not distinct for all lines, the field would not display any value.</td>
</tr>
<tr>
<td>Party Site</td>
<td>The Site corresponding to the VAT Supplier Site would be displayed here. If this value is not distinct for all lines, the field would not display any value.</td>
</tr>
<tr>
<td>Total Lines</td>
<td>Displays Number of Receipt lines.</td>
</tr>
<tr>
<td>Lines W/O VAT Details</td>
<td>Displays lines without VAT Invoice Details</td>
</tr>
<tr>
<td>Query Lines Block</td>
<td>Use this block to query for specific Receipt Lines.</td>
</tr>
<tr>
<td>Item Class</td>
<td>Select a Item Class from the LOV only when you would like to view and process lines of a specific Item Class</td>
</tr>
<tr>
<td>Item Name</td>
<td>Select a Item Name from the LOV only when you would like to view and process lines of a specific item.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Lines W/O VAT Details</td>
<td>Check this box only when you would like to view lines that do not have VAT Invoice Number and Date.</td>
</tr>
<tr>
<td>Claim Status</td>
<td>Select a specific Claim Status from the LOV. All lines with the matching status would be selected.</td>
</tr>
<tr>
<td>Query Lines</td>
<td>Click this button to Query all Lines with values matching those entered in this block.</td>
</tr>
<tr>
<td>Populate Defaults Block</td>
<td>Specify values here that should be defaulted on all Receipt Lines that are being queried.</td>
</tr>
<tr>
<td>Processing Action</td>
<td>Select a processing action that should be stamped on all lines that are queried. You can select from the following options:</td>
</tr>
<tr>
<td></td>
<td>1. Claim: This implies that the lines will be claimed in the next claim process.</td>
</tr>
<tr>
<td></td>
<td>2. Not Claimable: This status indicates that the lines will not be eligible for claim.</td>
</tr>
<tr>
<td></td>
<td>3. Pending: By marking lines as pending, you are indicating that these lines would remain in pending status and would be separated from the claim process.</td>
</tr>
<tr>
<td>Invoice No.</td>
<td>Specify a value that should be stamped on to the Invoice Number field of all selected lines.</td>
</tr>
<tr>
<td>Invoice Date</td>
<td>Specify a value that should be stamped on to the Invoice Date field of all selected lines.</td>
</tr>
<tr>
<td>Party</td>
<td>This field displays the PO Vendor Name. If the Vendor providing the VAT Invoice is different from the PO Vendor then, select appropriate value here.</td>
</tr>
<tr>
<td>Party Site</td>
<td>This field displays the PO Vendor Site. If the Vendor Site providing the VAT Invoice is different from the PO Vendor/Site then, select appropriate value here.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Populate Defaults</td>
<td>Click this button to populate all the selected lines with the values entered in this block</td>
</tr>
<tr>
<td>Receipt Lines</td>
<td>All Receipt Lines with matching query criteria would be displayed here</td>
</tr>
<tr>
<td>Item Name</td>
<td>Item Name is displayed here.</td>
</tr>
<tr>
<td>Item Class</td>
<td>Item Class as assigned for the combination of VAT Regime and Item would be displayed here</td>
</tr>
<tr>
<td>Claim Status</td>
<td>Claim Status of the Line would be displayed here. If the status is not populated using Populate Defaults block, user needs to specify the status for each line. Following are the details of each claim status:</td>
</tr>
<tr>
<td></td>
<td>1. Not Claimed: This implies that the line is eligible for claim process. But is not yet claimed.</td>
</tr>
<tr>
<td></td>
<td>2. Not Claimable: This status indicates that the line is not eligible for claim.</td>
</tr>
<tr>
<td></td>
<td>3. Partial Claimed: Implies that the line is partially claimed.</td>
</tr>
<tr>
<td></td>
<td>4. Full Claimed: Indicates that the line has been completed processed.</td>
</tr>
<tr>
<td>Processing Action</td>
<td>In this field, select from one of the following processing action.</td>
</tr>
<tr>
<td></td>
<td>1. Claim: This would imply that the lines would be claimed in the next claim process.</td>
</tr>
<tr>
<td></td>
<td>2. Not Claimable: This status would indicate that the lines would not be eligible for claim.</td>
</tr>
<tr>
<td></td>
<td>3. Pending: By marking lines as pending, you are indicating that these lines would remain in pending status and would be separated from the claim process.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Claim Term</td>
<td>Displays the default Claim Term. User has an option to change this until the line has been processed for Claim.</td>
</tr>
<tr>
<td>Invoice No.</td>
<td>Specify The VAT Invoice Number here.</td>
</tr>
<tr>
<td>Invoice Date</td>
<td>Specify a Invoice Date here.</td>
</tr>
<tr>
<td>Party</td>
<td>This field displays the PO Vendor Name. If the Vendor providing the VAT Invoice is different from the PO Vendor then, select appropriate value here.</td>
</tr>
<tr>
<td>Party Site</td>
<td>This field displays the PO Vendor Site. If the Vendor Site providing the VAT Invoice is different from the PO Vendor/Site then, select appropriate value here.</td>
</tr>
<tr>
<td>Recoverable Amount</td>
<td>This field reflects the Total of Recoverable VAT Tax Amounts applicable to the Receipt Line. <strong>Important:</strong> All Tax Types Assigned to the VAT Regime would be considered as VAT Taxes.</td>
</tr>
<tr>
<td>Recovered Amount</td>
<td>This field displays the Total of VAT Amount Recovered so far. In the following cases Recovered Amount would not be equal to the Recoverable Amount: 1. When you have processed claim for any of the Receipt Lines. 2. When only some of the Receipt lines are recovered 3. Based on the claim terms only a part of the VAT Amount is recovered</td>
</tr>
<tr>
<td>Net Quantity</td>
<td>This value displays Receipt Quantity net of Returned and Correction Quantity.</td>
</tr>
<tr>
<td>Receive Qty.</td>
<td>Quantity received is shown here. This is before correction and returned quantity.</td>
</tr>
<tr>
<td>Correct Rcv. Quantity</td>
<td>Correct of Receive Quantity is displayed here.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RTV Quantity</td>
<td>Quantity returned to Supplier is displayed here</td>
</tr>
<tr>
<td>Correct RTV Qty.</td>
<td>This field displays Correction to quantity returned to Vendor</td>
</tr>
<tr>
<td>[ ]</td>
<td>Enter line-specific additional detail and Save.</td>
</tr>
<tr>
<td>Tax Details Tab</td>
<td>This tab displays Tax Amount details.</td>
</tr>
<tr>
<td></td>
<td>Only taxes of the Type assigned to the Regime Registration are displayed here</td>
</tr>
<tr>
<td>Tax Type</td>
<td>Tax Type is displayed here.</td>
</tr>
<tr>
<td>Tax Name</td>
<td>Tax Name is displayed here</td>
</tr>
<tr>
<td>Recoverable Amount</td>
<td>Amount of Tax that can be recovered is displayed here</td>
</tr>
<tr>
<td>Recoverable Amount</td>
<td>This field displays the Tax Amount that is already recovered</td>
</tr>
<tr>
<td>Installment Details Tab</td>
<td>This tab displays the Installment Details.</td>
</tr>
<tr>
<td>Installment No.</td>
<td>Displays Sequence Number; Starting with 1 and incremented by 1 for each record</td>
</tr>
<tr>
<td>Scheduled Date</td>
<td>Displays the Date on which the record would be available for VAT Recovery</td>
</tr>
<tr>
<td>Installment Amount</td>
<td>Displays the Equal Installment Amount that would be eligible for recovery as on the scheduled date</td>
</tr>
<tr>
<td>Status</td>
<td>Displays the Claim Status of the line. If the installment is claimed then, the Status would be 'Claimed'. If the installment is not yet claimed, the Status would be set to 'Not Claimed'</td>
</tr>
</tbody>
</table>

**Claim VAT After Creating Receipt**

If the VAT Invoice details are not entered while creating the Receipt, the option is to enter these details by accessing the Claim VAT screen through the Menu Option. The
Options available would be the same as those when the form is Opened through the Receipts localized screen. However, here the user has an option to query for Multiple Receipts based on the options in the query-find screen.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regime</td>
<td>The value in this field would be &quot;Value Added Tax&quot;</td>
</tr>
<tr>
<td>Organization</td>
<td>Displays the current Organization from the profile</td>
</tr>
<tr>
<td>Location</td>
<td>Select the Location from the LOV</td>
</tr>
<tr>
<td>Receipt Type</td>
<td>Select from the following Values</td>
</tr>
<tr>
<td></td>
<td>PO: Purchase Receipt</td>
</tr>
<tr>
<td></td>
<td>RMA: Customer Receipt</td>
</tr>
<tr>
<td></td>
<td>ISO: Internal Receipt</td>
</tr>
<tr>
<td>Party</td>
<td>Select a Supplier Name here</td>
</tr>
<tr>
<td>Receipt From Date</td>
<td>Specify a date here. This would restrict the Receipts to those created after this Date</td>
</tr>
<tr>
<td>Receipt to Date</td>
<td>Specify a Date here. This would restrict the Receipts to those created before this Date</td>
</tr>
<tr>
<td>Claim Status</td>
<td>Select a Claim Status from the LOV</td>
</tr>
<tr>
<td></td>
<td>Following are the details of each claim status</td>
</tr>
<tr>
<td></td>
<td>1. Not Claimed: This implies that the line is eligible for Claim Process, but is not yet claimed.</td>
</tr>
<tr>
<td></td>
<td>2. Not Claimable: This status would indicate that the line is not be eligible for Claim.</td>
</tr>
<tr>
<td></td>
<td>3. Partial Claimed: Implies that the line is partially claimed.</td>
</tr>
<tr>
<td></td>
<td>3. Full Claimed: Indicates that the line has been completed processed.</td>
</tr>
<tr>
<td>Item Class</td>
<td>Select an Item Class from the LOV. Only those Receipt Lines with this Item Class specified here would be fetched</td>
</tr>
</tbody>
</table>
### VAT Manual Entry

Manual Entry Transactions for VAT may be used for passing Adjustment entries (both VAT Repository / Accounting) for VAT Recovery / VAT Liability transactions done in the P2F and O2C Cycles. VAT Recovery / VAT Liability, VAT Payment transactions can also be created directly using this window.

This functionality is provided as a means for handling exceptional scenarios in your business process that necessitate capturing of such transactions outside the normal transaction cycles.

On saving the transaction system will generate a transaction number. If the 'Generate Invoice Number' flag is checked, system will generate the VAT Invoice number as well. System also generates appropriate accounting entries / VAT repository entries for the transactions.

You will use the following screen to do manual entries related to Service Tax.

**Navigation:** India Local Purchasing > VAT/Service Tax > Transactions > Manual Entry

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipt Number</td>
<td>Specify a specific Receipt Number here. Only lines related to the Receipt would be returned</td>
</tr>
</tbody>
</table>

### Field Description

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header Section</td>
<td>All the Transaction details are captured in the Header Section.</td>
</tr>
<tr>
<td>Regimes</td>
<td>Select VAT Regime</td>
</tr>
<tr>
<td>Organization Type</td>
<td>Select Inventory Organization for VAT</td>
</tr>
<tr>
<td>Organization Name</td>
<td>Select Organization from LOV. LOV contains all Organizations where Oracle Financials for India is installed.</td>
</tr>
<tr>
<td>Transaction Number</td>
<td>An Auto generated Number for each manual transaction successfully performed.</td>
</tr>
<tr>
<td>Location Name</td>
<td>Organization Location is displayed here.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transaction Type</td>
<td>Select Transaction type. LOV contains:</td>
</tr>
<tr>
<td></td>
<td>1. Recovery</td>
</tr>
<tr>
<td></td>
<td>2. Adjustment Recovery</td>
</tr>
<tr>
<td></td>
<td>3. Liability</td>
</tr>
<tr>
<td></td>
<td>4. Adjustment Liability</td>
</tr>
<tr>
<td></td>
<td>5. Payment</td>
</tr>
<tr>
<td>Transaction Date</td>
<td>Select Transaction Date. Transaction Date has to be more than the last Settlement Date and less than the Current System Date.</td>
</tr>
<tr>
<td>Party Type</td>
<td>Select Party Type. LOV contains:</td>
</tr>
<tr>
<td></td>
<td>1. Vendor</td>
</tr>
<tr>
<td></td>
<td>2. Customer</td>
</tr>
<tr>
<td></td>
<td>3. Tax Authority</td>
</tr>
<tr>
<td></td>
<td>You should select Vendor based on the Transaction Type. For e.g. if the Transaction Type is Recovery, you will fill in Vendor details in the 'Party Details' section and similarly if the Transaction Type is liability, you will fill in Customer details in the 'Party Details' section. In case you are capturing VAT payment through this screen then you should select Tax Authority in 'Party Details'.</td>
</tr>
<tr>
<td>Party Name</td>
<td>Select Party Name</td>
</tr>
<tr>
<td>Party Site</td>
<td>Select Party Site.</td>
</tr>
<tr>
<td>Invoice Number</td>
<td>Number of Invoice issued by the party.</td>
</tr>
<tr>
<td>Invoice Date</td>
<td>Date of Invoice issued by the party.</td>
</tr>
<tr>
<td>Item Class</td>
<td>You can select Item Class here.</td>
</tr>
<tr>
<td>Item Name</td>
<td>You can select the Item here</td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Tax Details block</td>
<td>In this block you will enter Tax information related to the transaction.</td>
</tr>
<tr>
<td>Parent Tax Type</td>
<td>This field will display the Parent Tax Type that has been setup for a Child Tax in the Regime setup.</td>
</tr>
<tr>
<td>Assessable Value</td>
<td>Enter Assessable Value for the transaction. Assessable Value for Child Tax will default as Value of Parent Tax.</td>
</tr>
<tr>
<td>Rate (%)</td>
<td>Enter Rate of Tax.</td>
</tr>
<tr>
<td>Tax Amount</td>
<td>Calculated Amount based on Assessable Value and Rate of Tax.</td>
</tr>
<tr>
<td>Adjustment Account</td>
<td>Select Adjustment Account where the amount needs to be adjusted.</td>
</tr>
<tr>
<td>Remarks</td>
<td>Enter Remarks, if any.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Enter line-specific additional detail and Save.</td>
</tr>
</tbody>
</table>

Payment of VAT can also be captured through the Manual Entry Screen. On saving the transaction system will generate a Transaction Number.

**Note:** You can view the GL drilldown accounting entries using the Show transactions button on the Tools menu of the Manual Entry form.
Value Added Tax Accounting

This section provides an overview on the Tax Accounting process. Following figure depicts the Accounting required for VAT Taxes. Tax Accounting happens along with base transaction accounting. This varies when the Tax is deferred and can be recovered or the liability arises only on happening of a particular Accounting event in the future. For example, VAT Recovery is on Receipt of Supplier VAT Invoice. So is the Accounting. In such cases, the actual Recovery happens on claiming VAT through after Receiving Supplier Invoice and Liability accounting happens on generating the VAT Invoice for Customs.

Once the transaction has passed through the Recovery and Liability event, the next phase would be settlement. The total of recovered amount (net of transferred amounts) is what remains to set-off against the Tax Liability under the Regime. The Net Liability is settled by making a payment to the Tax Authority.

This process is applicable to all taxes in Procure to Pay (P2P) and Order to Cash (O2C) Cycles.

Accounting Entries

Accounting for VAT Taxes would be done in two phases. The first would be on the Purchasing and the second would be on Sale event. On initial Purchase and Sale event, the VAT Tax would be Debited/Credited to an Interim Account. This Debit/Credit to Interim Account would be reversed on to Recovery/Liability accounts on Recovery/Liability event.

VAT Repository

All transactions that lead to VAT Recovery or Liability or adjustment to the same would update the VAT Repository. You can use this repository for meeting the reporting requirements specific to the state.

Following events update the VAT Repository:
1. Claim VAT
2. Process VAT Installments
3. Return to Vendor after VAT Claim
4. VAT Invoice Generation based on
   - Shipment
   - AR Transaction Completion
5. Manual Entry following transaction types
   - Recovery
• Recovery Adjustments
• Liability
• Liability Adjustment

6. Settlement

Managing India Local Inventory

This section elaborates on the effect of Transactions that can be handled through Oracle Financials for India Inventory.

Transactions

The Miscellaneous transaction form has been customized to accommodate the RG Register entries through a separate transaction type.

In Oracle Financials for India, navigate to Transactions > Miscellaneous Transaction.

Additional types of 'Miscellaneous Issue (RG update)' and 'Miscellaneous Receipt (RG update)' are introduced under Oracle Financials for India. However, there is No change in the Transaction Lines window.

The only difference between Miscellaneous Issue/Receipt (RG Update) and Miscellaneous Issue/Receipt is that the respective Excise Inventory Registers are updated when the input material is issued from stores to the production or finished goods / input material is received back into stores from production.

RG - I Register Entry

This is a view / entry form that can be used to view/enter the Manual RG-I Transaction. RG - I Register is the daily stock account for all excisable products. It displays on query all the transactions that have an entry in the RG-I Register. Each Inventory Organization will be considered, as an Excise Unit and the user need to specify the Organization Name and Location both for querying & for making manual entries into the register. Querying can be done based on certain fields on the Entry Block and also Transaction Details block.

In Oracle Financials for India, navigate to Transactions > RG Registers > RG1 Register Entry.

The field wise description of RG-I Register and its feature are given here for your ready reference. The following fields are to be entered by the user for manual Entry. Based on your requirement, specify any one of the following fields to View/Enter a Manual Entry in the Register.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating Unit</td>
<td>(Required)</td>
<td>EDIT</td>
<td>Use needs to select the Operating Unit from the LOV.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HELP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PICK</td>
<td></td>
</tr>
<tr>
<td>Organization</td>
<td>(Required)</td>
<td>EDIT</td>
<td>The user needs to specify the Inventory Organization name from LOV for which the Manual Excise Entry is going to be accounted. The user needs to specify a Inventory Organization for which he wants to view the RG-I Register balance and information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HELP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PICK</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>(Required)</td>
<td>EDIT</td>
<td>The user needs to specify the Location of an Inventory Organization from LOV for which Manual Excise Entry is going to be accounted. The user needs to specify a Location of an Inventory Organization for which he wants to view the RG-I Register balance and information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HELP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PICK</td>
<td></td>
</tr>
<tr>
<td>Serial No</td>
<td></td>
<td></td>
<td>It is system generated serial number, which is generated automatically after entering a transaction.</td>
</tr>
<tr>
<td>Transaction Date</td>
<td>(Required)</td>
<td></td>
<td>The Transaction Date will be entered here, If the user wants to view the RG-I Register for a particular day then he has to specify the Transaction Date.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transaction Type</td>
<td>(Required)</td>
<td>EDIT</td>
<td>The Transaction Types are Receipts, Issue, Inter-Org-Receipt, Inter-Org-Issue, Receipts Adjustment, Issue Adjustment, Production Receipts, Production Issue and Customer Return. By picking one the type, the user can view/enter a RG-1 entries for that type.</td>
</tr>
<tr>
<td>Item</td>
<td>(Required)</td>
<td>EDIT</td>
<td>The user needs to specify the Item for which the receipts or issue entry is going to be passed.</td>
</tr>
<tr>
<td>Customer/Vendor Name Location</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>Details such as Name as per Vendor Site will be shown for Receipt Transactions. For Manual Entry these fields are optional. If item is sold directly similar details of Customer will be shown.</td>
</tr>
<tr>
<td>Customer/Vendor site</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>Details such as Vendor Site, will be shown for Receipt Transactions. For Manual Entry these fields are optional. If item is sold directly similar details of Customer Site will be shown.</td>
</tr>
<tr>
<td>Transaction Detail Block</td>
<td>(Required/Displayed)</td>
<td>EDIT</td>
<td>This Block will have the Transaction details with respect to Reference Number, Packed Quantity, Loose quantity, UOM and Registers RG23A or RG23C or PLA which has been used for Issue. These can be entered by the User while entering Manual RG-1 Entry. Please note for a Transaction Type 'Issue', the Excise Invoice Number will be displayed in the Reference No field.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Additional Detail Block</td>
<td>Detail</td>
<td></td>
<td>This Block will have the Transaction details depending upon the Transaction Type Issue, Inter-Org-Issue, Issue Adjustment, and Customer Return.</td>
</tr>
<tr>
<td>Excise Rate / Excise</td>
<td></td>
<td></td>
<td>These fields will be enabled/disabled depending upon the Issue Type in the Additional Details block.</td>
</tr>
<tr>
<td>Amount in the Additional</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Details Block</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Excise Amount Block</td>
<td></td>
<td></td>
<td>This will be enabled only for Issue related transactions while entering a Manual Entry. Excise Basic, Additional, Others, Excise Cess, CVD Cess amount paid on delivery of goods will be displayed here.</td>
</tr>
<tr>
<td>Account</td>
<td></td>
<td></td>
<td>This will be enabled only for issue related transactions to enter the account code.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>User need to take enough care to ensure that proper GL Account is selected for the transaction, as selection of improper GL accounts will have far reaching consequences for account reconciliation.</td>
</tr>
<tr>
<td>Additional Information</td>
<td>(Optional)</td>
<td></td>
<td>The user can enter the Purpose &amp; remarks regarding a Manual RG-I entry.</td>
</tr>
<tr>
<td>Block</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** You can view the GL drilldown accounting entries using the Show transactions button on the Tools menu of the Manual Entry form.
RG 23 Register Entry

RG 23A Register

Adjustments/Manual entries in the CENVAT on inputs can be done in this register. All excisable goods of item type RMIN and RMEX, and credits availed on inputs will be accounted in this register.

Important: This feature can also be used to upload the opening balances for a newly created Organization.

RG 23C Register

Adjustments/Manual entries in the CENVAT on Capital Goods can be done in this register. All excisable goods with item type CGIN and CGEX, and credits availed on capital goods will be accounted in this Register.

This RG23 Manual Entry form can be used for both view/enter RG 23A & C Part I & II entries.

Navigate to this screen from Oracle Financials for India responsibility Registers > RG23 Register Entry.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>Required</td>
<td>EDIT</td>
<td>The user need to specify the Inventory Organization name from LOV in which RG23 Register entries are going to be accounted. The user needs to specify an Inventory Organization for which he wants to view the RG-23A &amp; C Register balance and information.</td>
</tr>
<tr>
<td>Location</td>
<td>Required</td>
<td>EDIT</td>
<td>The user needs to specify the Location of an Inventory Organization from LOV in which the RG23 entries are going to be accounted. The user needs to specify a Location of an Inventory Organization for which he wants to view the RG-23A &amp; C Register balance and information.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Serial No</td>
<td></td>
<td></td>
<td>It is system generated Serial Number after entering a transaction.</td>
</tr>
<tr>
<td>Transaction Date</td>
<td>Required</td>
<td></td>
<td>The Transaction Date will be entered here and If the user wants to view the RG-23A &amp; C Register for a particular day then he has to specify the Transaction Date.</td>
</tr>
<tr>
<td>Transaction Type</td>
<td>Required</td>
<td>EDIT</td>
<td>HELP PICK</td>
</tr>
<tr>
<td>Issue Type</td>
<td>Optional</td>
<td>PICK</td>
<td></td>
</tr>
<tr>
<td>Generate Excise Invoice</td>
<td>Excise</td>
<td>Optional</td>
<td>Enter</td>
</tr>
<tr>
<td>Item</td>
<td>Required</td>
<td>EDIT</td>
<td>HELP PICK</td>
</tr>
<tr>
<td>Customer/Vendor Name</td>
<td>Optional</td>
<td>Enter</td>
<td></td>
</tr>
<tr>
<td>Customer/Vendor Location</td>
<td>Optional</td>
<td>Enter</td>
<td></td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------</td>
<td>----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transaction</td>
<td>Block</td>
<td>Detail</td>
<td>This lock will have transaction details like Reference Number, Packed Quantity, Loose Quantity, UOM and Registers RG23A or RG23C or PLA, specific to the transaction.</td>
</tr>
<tr>
<td>Additional</td>
<td>Block</td>
<td>Details</td>
<td>Union Budget 2000-2001 allows instant credit on capital goods on receipt to the tune of 50% and the procedure of taking credit, only on installation, is dispensed with. These tables/fields are maintained only for future requirements. You can still use these fields to capture information &amp; the same would not have an impact of RG23 Reports.</td>
</tr>
<tr>
<td>Verification Date</td>
<td>(Optional)</td>
<td></td>
<td>This field is relevant in RG 23C for Capital Goods purchase. Enter the verification date of the Capital Item.</td>
</tr>
<tr>
<td>Installation Date</td>
<td>Optional</td>
<td></td>
<td>This field is relevant in RG 23C for Capital Goods purchase. Enter the Installation date of the Capital Item.</td>
</tr>
<tr>
<td>Commission Date</td>
<td>Optional</td>
<td></td>
<td>This field is relevant in RG 23C for Capital Goods purchase. Enter the Commission date of the Capital Item.</td>
</tr>
<tr>
<td>Brand Name</td>
<td>Optional</td>
<td></td>
<td>This field is relevant in RG 23C for Capital Goods purchase. Enter the Brand name of the Capital Item.</td>
</tr>
<tr>
<td>Identification Number</td>
<td>Optional</td>
<td></td>
<td>Enter Identification Number of the Capital Item.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------</td>
<td>--------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Excise Amount Block</td>
<td>Displayed</td>
<td>None</td>
<td>Shows the amount of CENVAT credit taken on inputs</td>
</tr>
<tr>
<td>Basic/Additional/Others</td>
<td>Displayed</td>
<td>EDIT PICK</td>
<td>Amount of MODVAT credit taken on account of Basic, Additional and other Excise Duty on the items purchased &amp; received. This field will display the amount of CENVAT credit utilized for the dispatch of final products.</td>
</tr>
<tr>
<td>Additional CVD</td>
<td></td>
<td></td>
<td>Enter Additional CVD amount in this column.</td>
</tr>
<tr>
<td>Excise Cess, CVD</td>
<td>Displayed</td>
<td>EDIT PICK</td>
<td>Amount of Cess credit taken on account of Basic and CVD Duty on the items purchased &amp; received. This field will display the amount of CENVAT credit utilized for the dispatch of final products.</td>
</tr>
<tr>
<td>Account</td>
<td>Required</td>
<td>EDIT PICK</td>
<td>Enter the Account code to which the credit taken on the inputs will be debited in the General Ledger and the same account will be credited when dispatches sent out.</td>
</tr>
<tr>
<td>Place of Installation</td>
<td>Optional</td>
<td></td>
<td>Enter the location where the Capital Item is installed.</td>
</tr>
<tr>
<td>Identification Mark</td>
<td>Optional</td>
<td></td>
<td>Enter a relevant Identification mark of a capital item.</td>
</tr>
<tr>
<td>[]</td>
<td>Optional</td>
<td>EDIT</td>
<td>Enter line-specific additional detail and Save.</td>
</tr>
<tr>
<td>Remarks Block</td>
<td></td>
<td></td>
<td>You can enter relevant remarks for RG23 Part-I &amp; II register for reference and correspondence</td>
</tr>
</tbody>
</table>
**Apply Time Extension**

Apply Time Extensions screen can be invoked to apply for additional time. In the case of OSP from Inventory or Sales Returns Transactions if the Vendor wants some more time means, he can invoke the time extensions screen & find the appropriate information by entering the transaction type or the start & end date limits or by entering both. He can apply for the time extension, he need. Then the due date is automatically defaulted. It can either be applied or rejected by the appropriate authority. In the case of rejection, the due date is cleared.

This screen can also be used for recording the additional time granted by the Excise Authorities to Receive/Return goods under Rule 173 H and 173 L of the Central Excise Rules.

As per the changes announced in Union Budget 2000-2001, there is no need to debit duty while clearing goods for sub contracting operations under Rule 57 F (4). The requirement for taking time extensions to bring the goods sent under 57 F (4) Challan also stands withdrawn.

As per the current provisions of the Law, duty need to be debited only if the goods sent for sub contracting operations are not received back within 180 days. Later if the goods are received back, the duty debited can be availed. This requirement can be mapped through Manual RG 23 Entries.

Though the requirement for recording the time extensions granted by the Excise authorities does not exist, the form is maintained in the current release by considering similar future requirements.

Navigation to India Localization > Transaction > Apply time Extension.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trans Name</td>
<td>(Required)</td>
<td>ENTER</td>
<td>The user needs to pick up either OSP Transaction or Sales return.</td>
</tr>
<tr>
<td>Vendor/Customer Name</td>
<td>(Required)</td>
<td>EDIT HELP PICK</td>
<td>The user need to enter valid Customer/Vendor Name.</td>
</tr>
<tr>
<td>User Ref. No.</td>
<td>(Optional)</td>
<td>EDIT HELP PICK</td>
<td>Reference No. can be entered here. The user need to enter valid Customer/Vendor Name.</td>
</tr>
</tbody>
</table>

After querying the OSP or Sales Transaction, the user can enter extended time limit for a
transaction and create a record then the due date gets extended by using the below mentioned form.

Navigation to India Localization > Transaction > Apply time Extension.

Trans Name, Vendor Name, User Ref No., Trans Date, Original Due Date Extended Due date is displayed as per referenced transaction.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sl. No.</td>
<td>(Required)</td>
<td></td>
<td>Sl. No. is a system generated Serial No.</td>
</tr>
<tr>
<td>Ext Days</td>
<td>(Required)</td>
<td></td>
<td>You can enter Number of Days for Extension.</td>
</tr>
<tr>
<td>Status</td>
<td>(Required)</td>
<td>PICK</td>
<td>Select Status from drop list. The Options available are Applied, Approved and Rejected. Initially it will be applied. It can be changed to Approved or Rejected.</td>
</tr>
<tr>
<td>Due Date</td>
<td>(Displayed)</td>
<td></td>
<td>Display only field giving the Due Date after applying the Time Extension.</td>
</tr>
</tbody>
</table>

**Master Organization RG Consolidation**

If Multiple Organizations are defined within the same Excise Registered premises, user can opt to identify One Organization & Location Combination as "Master Organization" and all other Organizations needs to be treated as Child Organizations and should have the reference of the master Organization based on ECC code. In such type of setup, the Master Organization will be the Organization at which all excise registers should be generated.

The master child relationship among the Organization and location are used only to generate consolidated excise registers at Master Organization level. You need to submit 'India Master Org RG' request set in order to get Excise Registers consolidated at Master Organization.

**Steps for running the Master Organization RG Consolidation:**

- Ensure that proper setup is done to establish the relationship between the Master and Child Organizations. Please note that the Master Organization flag should be ticked in the Organization-Location record of the Master Organization.

- Organization Location defined, as Master Organization should be a Dummy
Organization only used for Excise Reporting. No transactions should be done in the Master Organization Location directly.

- Master Organization Consolidation request set could be run at periodic intervals depending on the reporting requirements.

**Master Org RG Entries Request Set**

Navigate to Inventory > Reports > All > Request Set > Master Org RG Entries to run the request set. This request set consists of 4 requests, one each for consolidation RG23 A, C, PLA and RG1 Registers. Parameters for each of the requests are same:

- Organization (Required) PICK HELP
  Name of the Master Organization is to be given in this parameter.

- Location (Required) PICK HELP
  Name of the Master Organization Location is to be given in this parameter

After completion of the Request Set, the consolidated RG Entries and balances shall be available at the Master Organization Location. This request set is only a program to copy and consolidate the Child Organization records. Normal RG reports shall have to be used for viewing and printing the RG reports for the Master Organization. The entries for individual Child Organizations shall still be available and if required reports could be obtained for Child Organizations as well.

**View Register Balance**

This section gives us details of the various Register balances.

The user can view the Excise Registers RG23A Part-II, RG23C Part-II and PLA balances through this form.

Transactions RG Registers View Register Balance

After specifying the Operating Unit, Inventory Organization Name, Location and currency the user will get Excise Register balances in the Balances Block.

- RG23A Part-II balance represents the balance available on Account of credit availed on Inputs.
- RG23 A CESS Amount represents the balance available on Account of credit availed on Inputs.
- RG23C Part-II balance represents the balance available on account of credits availed on capital goods.
- RG23 C CESS Amount represents the balance available on Account of credit availed on capital goods.
- PLA Register represents the balance available in PLA Register.
PLA CESS represents the cess balance available in PLA Register.

**View Item Definition**

This view form has been designed to find the relevant Tax Information for an Item. Item definition provides the Localization information for an item with respect to Tax applicability for an Inventory Organization Location.

By invoking the screen India Local Find Item Information we can find the Tax Information relating to Localization. Items - Item Definition.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization Scope</td>
<td>(Required)</td>
<td>EDIT HELP</td>
<td>User can select Organization scope which to enter Items definition. The Quick pick for Organization scope are Single or Single with Master or All Organizations.</td>
</tr>
<tr>
<td>Organization</td>
<td>(Optionally Required)</td>
<td>EDIT HELP PICK</td>
<td>When the user has Single or Single with Master Organization Scope then he need to pickup the Inventory Organization from the LOV.</td>
</tr>
<tr>
<td>Item/Description</td>
<td>(Required)</td>
<td>EDIT HELP</td>
<td>Select the item from LOV for which you want to view the Item definition.</td>
</tr>
<tr>
<td>Localization Info</td>
<td></td>
<td></td>
<td>India Local Item Information form is invoked by opening the Localization Info Button and the information are defaulted from the Master Item regarding the Excise Flag, Modvat Flag, Item Class, Item Folio and Item Tariff.</td>
</tr>
</tbody>
</table>

The Standard Applications Item Information form can be invoked by clicking the Open button in this form and view the item categories, attributes and Revision details.

**Outside Processing Transaction**

Outside Processing (OSP) may happen in two circumstances:

1. Where processing is done without any additional material being input by the OSP
Vendor

2. Where processing is done with additional use of materials

The case where additional material are used by the Vendor, the transaction is not being covered under Excise Rule 57(F)

Under Rule 57(F) of Excise, material may be sent outside the factory for processing on payment of specified percentage (presently 10%) of the value of the goods, which can be reversed provided the goods comeback within the specified (180) number of days. No additional material is permitted to be added by the vendor to ensure that the value addition relates to labor only.

The above provisions of Excise pertaining to debiting (10% of the material cost as) duty and reversing the same once the OSP material is received back in total held goods only upto 31-March-2000. W.E.F 01-April-2000, there is no need to keep a manual track on overdue issues i.e those pending for more than 180 days. The duty on such issues has to be calculated manually and debited to the duty paying register through RG 23 Manual Entry Screen.

Basic Business Needs

The India Local OPM outside functionality satisfies the following requirements of Tracking Goods sent for Outside Processing:

- Track Issue of Process Material
- Track Receipt of Process Material
- Select Payment Register at the time of Issue and Receipt

Major Features

Maintenance of details of 57F(4).

User is provided with facility to maintain the details of 57F(4) and select Payment Registers at the time of Issue and Receipt of Process Material.

Prerequisites:

- A Production batch should be created giving all the issue and receivable items and WIP warehouse should be defined as on OSP warehouse in the Warehouse Attributes Form.
- A Purchase Order for conversion charges should be attached to the above production batch in the Purchasing Module.
- The credit entries can be passed only after receiving the last consignment of material even if the material is received in batches (staggered delivery). In India Local OPM this can happen only when the OSP batch is closed.
**Outside Processing Transaction**

By using India Local OPM features, issue and receipt of goods for subcontracting can be tracked based on parameters setup in the Additional Organization Information, duty will be debited at the time of removal of goods and the same can be credited on receipt of the goods. If there is no need to pay on removal of goods for subcontracting, user needs to take care to setup ZERO in the OSP percentage field of Additional Organization Information. User needs to keep a manual track for the receipt of goods and if the goods are not received back in 180 days, duty needs to be worked out manually and amount should be debited in paying duty registers through RG23 Manual Entry Screen.

**Prerequisites:**

- All Items sent for Outside Processing must exist in Item Master.
- OPS Relation is properly defined.
- All issues for Outside Processing takes place from OPM Inventory and receiving happens into OPM Inventory.
- Excise records will get generated if the item being issued for outside processing has the attribute of Excise Flag 'YES'.

In Oracle Financials for India additional setups are required.

- In Organization Parameters under Taxation Parameters alternative region enter Outside Processing Return Days and Outside Processing Excise Percentage you want to default in 57F (4) Challan.
- While defining OSP Item the Excise and Cenvat flags should be set to YES.

In India Local Oracle Process Manufacturing OSP transactions are handled through production batches. When a WIP warehouse in a production batch is a warehouse marked as OSP Warehouse in Localization the date will be populated into OSP tables. A Purchase Order has to be created for the processing charges and should be received in OPM so that it can be passed to AP for Payment of these processing charges. As these processing charges are treated as one of the ingredients, cost rollup will consider all the costs correctly.

**Under Localization following additional steps or processes are involved:**

- As soon as a production batch is released i.e. production batch having OSP marked warehouse as WIP warehouse the relevant details are populated in localization OSP table.
- Go to OSP Transactions Screen. You are required to verify the details populated and attach a purchase order raised for the processing charges. There you have to give the values for the items so that the excise duty payable will be calculated basing on
the value and the percentage specified in the organization additional information form. You have to select a register for payment of this duty. At this point there are no RG registers hit.

- When the batch is certified RG Registers are hit with the excise payable and quantities depending upon the batch actual consumption of ingredients.
- When the actual quantities of product are given, RG registers will hit for the quantities. At this point reversal of excise credit will not take place.
- When the batch is closed, you can go to the OSP transactions –OSP receipts form and select a register and post the excise receivable amount to RG register.

OSP Issue

Navigate to India OPM Process Execution > Production Mgmt > OSP Transactions.

Sub-letting, job-work or Out Side Processing is a common business requirement. Basic information regarding the OSP transaction is captured using this screen. Vendor Name, Form number is very vital. Issue batch number is used as reference. Only WIP warehouse can be an OSP warehouse.

**Issue Ref No**: It can be selected from a lookup. Lookup consists of all the batch numbers of production batches released and where the WIP warehouse is marked as OSP warehouse.

**Date**: The date on which the above OSP issue is made.

**Type**: Enter whether it is an OSP Issue or OSP Receipt.

**PO Number**: It can be selected from a lookup. Lookup consists of all the purchase order numbers where at least one line item is on inventory item or expense item for OSP labor charges.

Select Payment Registers

Navigate to India OPM Process Execution > Production > OSP Transactions > (B) OSP Lines > (B) Select Payment Registers.

This screen will show the balances available in all the three Registers – RG 23 A Part II, RG 23 C Part II and PLA.

You can enter the Excise amount to be debited will be entered here with break up. Having done the entry, the register selection can be made through the radio button displayed against each of the above three registers.

OSP Receipt

Navigate to India OPM Process Execution > Production Mgmt > OSP Transactions > (B) OSP Lines.
All the fields are display only fields. These fields are populated based on the ref no (Batch No) entered on the previous screen.

If the batch status is closed Select Register will be enabled. You must select a register to credit the excise amount. On selection of Excise Register 'Post RGII Entry' push button will be enabled. On clicking this push button excise register RG II entry will be made. If the receivable excise amount is null , you need not select any register.

The following accounting entries are passed in the localization at the time of claiming the receivable excise amount.

Dr. CENVAT RM/CG Excise duty
Cr. Excise Paid Excise duty

**Item No:** Displays the Item Number.

**UOM:** Displays the Unit of Measure of the item. This is the primary unit of measure of the item.

**Unit Price:** Displayed unit rate of each item.

**Plan Qty:** The total expected quantity will be displayed.

**Received In due date:** The total quantity received with in the due date will be displayed here. Due date will be calculated taking batch certify date as the start date and considering the no of days mentioned OSP Return days field mentioned in the organization additional information screen.

**Received after due date:** The total quantity that is received after the due date.

**Total qty:** The total quantity received before and after the due date. Transaction Details push button will take you to the screen where individual receipt quantities along with date of receipt will be displayed.

**Payable Excise**

The payable excise amount will be calculated and displayed. The excise amount payable will depend upon the value of batch ingredients and OSP excise percentage mentioned in the Organization Additional Information Form.

**Receivable Excise**

Displayed field. The receivable excise amount will be calculated based on the payable excise, expected quantity of the batch output and actual quantity received before due date. If total quantity is received before the due date then receivable excise amount will be equal to the payable excise. Other wise it will be proportionately calculated.

**Processing Inter Organization Transfer Transactions**

Oracle Financials for India Inter Organization Transfer helps in transfer of material between Inventory Units. Transfer of materials can be either from manufacturing to trading unit or vice versa. Existing form of Inventory Transfer of Oracle Base Inventory has been added with two new buttons at the bottom of the screen to meet the Indian
Tax Requirements. Similar to the Internal Sales Order Cycle, the user needs to define the Receiving Organization as the Internal Customer in the Sending Organization. Item Category and Tax Category needs to be defined for the Item to be shipped from the Sending Organization to the Receiving Organization. This needs to be defined and attached in the Internal Customers set up. Tax defaulting hierarchy in the Inter Organization Transfer is similar to Oracle Financials for India process of Tax Defaulting for Sales Order.

Navigate to India Local Inventory > Transactions > IL Inter Organization Transfer. This opens the Base Inventory form of Inter Organization Transfer. Before making a shipment ensure that all Oracle Base Inventory setup is completed.

Click Transaction Lines to view the base detailed transaction form. Match and Taxes button enable Inter Organization Transfer specific to Indian requirements.

Based on the defaulting logic defined and setups for the item transacted, the Tax Category will be defaulted. You can view the tax lines by clicking Taxes in the form. You can modify the taxes like add new tax lines, delete defaulted tax lines and alter precedence of existing tax lines.

**Note:** While defining the Shipping Networks for the Organizations ensure that Inter Organization Transfer Charges Type is set to None. If the same is set to any other type, India Local tax engine neither considers that in the valuation of the Inventory nor in the tax lines.

Close the taxes form after saving your changes to get back to the transaction details form. Save the transfer transaction to update and confirm the transaction and restrict further modifications. Saving the inventory transfer record also generates the Excise and VAT Invoice Numbers when the item has Excise and VAT Taxes. The Invoice numbers generated on saving the transaction are shown in a separate form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Number</td>
<td>Line Number of the item being transacted.</td>
</tr>
<tr>
<td>Exc. Inv. No.</td>
<td>Excise Invoice Number generated for the Transaction if the item is excisable and transaction has Excise Type of Taxes.</td>
</tr>
<tr>
<td>Vat Inv. No.</td>
<td>VAT Invoice Number generated for the Transaction if the item is defined in the VAT Item Classification and transaction has VAT Type of Taxes.</td>
</tr>
<tr>
<td>Item</td>
<td>Gives the description of the Item being shipped.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Quantity</td>
<td>Displays the Quantity being shipped for the Item against the transaction.</td>
</tr>
<tr>
<td>From Org</td>
<td>Displays the name of the Organization from where the goods have been shipped for this transaction.</td>
</tr>
<tr>
<td>To Org</td>
<td>Displays the name of the To Organization, where the goods have been shipped for this transaction.</td>
</tr>
<tr>
<td>From Subinv.</td>
<td>Displays the Sub Inventory of the Shipping Organization from where the goods have been shipped for this transaction.</td>
</tr>
<tr>
<td>To Subinv.</td>
<td>Displays the Sub Inventory of the Receiving Organization to which the goods have been shipped for this transaction.</td>
</tr>
</tbody>
</table>

The register updates for the various type of Inter Organization Transfer from Excise perspective are:

<table>
<thead>
<tr>
<th>Shipping Organization Item Attribute</th>
<th>Registers to be Updated In Shipping Organization</th>
<th>Receiving Organization Item Attribute</th>
<th>Registers to be Updated In Receiving Organization</th>
</tr>
</thead>
<tbody>
<tr>
<td>RMIN</td>
<td>RG23 A Part 1</td>
<td>RMIN</td>
<td>RG23 A Part 1</td>
</tr>
<tr>
<td>RMIN</td>
<td>RG23 A Part 1</td>
<td>FGIN</td>
<td>RG 1</td>
</tr>
<tr>
<td>RMIN</td>
<td>RG23 A Part 1</td>
<td>CGIN</td>
<td>RG23 C Part 1</td>
</tr>
<tr>
<td>RMIN</td>
<td>RG23 A Part 1</td>
<td>CCIN</td>
<td>RG23 A Part 1</td>
</tr>
<tr>
<td>FGIN</td>
<td>RG 1</td>
<td>RMIN</td>
<td>RG23 A Part 1</td>
</tr>
<tr>
<td>FGIN</td>
<td>RG 1</td>
<td>FGIN</td>
<td>RG 1</td>
</tr>
<tr>
<td>FGIN</td>
<td>RG 1</td>
<td>CGIN</td>
<td>RG23 C Part 1</td>
</tr>
</tbody>
</table>
To view register entries navigate to Tools > View Registers after saving the transfer record.

In case of Direct Organization transfer you need not record the receipt of material as the quantities in the Receiving Organization gets updated automatically on shipment. Excise and VAT claims for the same is performed by the system online without any user intervention. The costing for the item also gets updated based on the nature of the tax lines in the Tax Category. You can view register entries of the receiving organization by querying the transfer document from the Receiving Organization responsibility.

Assessable price for the Transaction is picked up from the Customer Additional Information form for Excise and VAT Taxes. If the same is not defined, it takes the value from the Item Cost for the item being shipped.

In case of In Transit Inventory Organization Transfer, you must receive goods as normal receipt and follow the same process of claiming CENVAT and VAT tax credit. In the Receipts, the transaction can be captured through the Shipment Number or through various filters available in the query form.

The default Document Sequence followed for Excise Invoice Number Generation is that of the Domestic Series. The same sequence is followed for the Direct and In Transit Inter Organization Transfers. VAT Invoice Number generation is based on the Default

<table>
<thead>
<tr>
<th>Shipping Organization Item Attribute</th>
<th>Registers to be Updated In Shipping Organization</th>
<th>Receiving Organization Item Attribute</th>
<th>Registers to be Updated In Receiving Organization</th>
</tr>
</thead>
<tbody>
<tr>
<td>FGIN</td>
<td>RG 1</td>
<td>CCIN</td>
<td>RG23 A Part 1</td>
</tr>
<tr>
<td>CGIN</td>
<td>RG23 C Part 1</td>
<td>RMIN</td>
<td>RG23 A Part 1</td>
</tr>
<tr>
<td>CGIN</td>
<td>RG23 C Part 1</td>
<td>FGIN</td>
<td>RG 1</td>
</tr>
<tr>
<td>CGIN</td>
<td>RG23 C Part 1</td>
<td>CGIN</td>
<td>RG23 C Part 1</td>
</tr>
<tr>
<td>CGIN</td>
<td>RG23 C Part 1</td>
<td>CCIN</td>
<td>RG23 A Part 1</td>
</tr>
<tr>
<td>CCIN</td>
<td>RG23 A Part 1</td>
<td>RMIN</td>
<td>RG23 A Part 1</td>
</tr>
<tr>
<td>CCIN</td>
<td>RG23 A Part 1</td>
<td>FGIN</td>
<td>RG 1</td>
</tr>
<tr>
<td>CCIN</td>
<td>RG23 A Part 1</td>
<td>CGIN</td>
<td>RG23 C Part 1</td>
</tr>
<tr>
<td>CCIN</td>
<td>RG23 A Part 1</td>
<td>CCIN</td>
<td>RG23 A Part 1</td>
</tr>
</tbody>
</table>
Document Type set up done against the Regime Registration Number of the Organization. The same sequence is followed for the Direct and In Transit Inter Organization Transfers.

The India Local tax engine generates Accounting Entries only for the items related to Localization Taxes. Oracle Base Inventory will generate the accounting entries for the basic value of Inventory transferred and for variances if any in case of Standard Costing in Receiving Organization.

**Inter Organization Transfer of Capital Goods**

When Capital Goods are being transferred in the same year of purchase, the Accrued Excise Credit on Capital Goods needs to be claimed in the Sending Organization. This claim will be done by the system automatically and the accounting entry for the same will also be generated on matching the line quantity with the original receipt.

You can match the shipment quantity against a specific Receipt to claim the balance accrued excise credit. The system will prompt you to match the shipment with its receipt when you save the record without matching. This option of selecting the receipt from which the claim is to be made is optional and can be ignored when the Capital Goods are more than a year old or hundred percent excise credit has already been availed.

Once the claim for the Capital Goods is carried out, the goods can be sent as normal duty paid goods by charging the relevant rate of Excise Duty. Transfer of Capital Goods is available only for In Transit Inter Organization Transfer.

Similar to CENVAT Claim, you can claim the VAT accrued credit.

Click Match on the detail form to match against the relevant Receipt. You must ensure that the shipment is being matched to the correct receipt. The Match form contains all capital receipts that contain Excise or VAT type of taxes attached to it. You have the flexibility to apply the shipment quantity against multiple receipts. The system ensures that the sum of all quantities applied in the match form equals the shipment quantity. The claimed percentage is also shown in the CENVAT Receipt Details form to facilitate identification of the receipt.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipt Number</td>
<td>Displays various receipts numbers of the capital goods item being shipped by the Sending Organization.</td>
</tr>
<tr>
<td>Receipt Quantity</td>
<td>Displays the number of quantities received against the particular receipt.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Available Quantity</td>
<td>Quantity available for application. (Receipt Quantity – Sum of all Quantity Applied)</td>
</tr>
<tr>
<td>Excise Claimed Percentage</td>
<td>Displays the percentage of excise duty claimed against the receipt for CENVAT purpose. (Amount Claimed / Total Excise to be claimed)</td>
</tr>
<tr>
<td>VAT Claimed Percentage</td>
<td>Displays the percentage of VAT claimed against the receipt. (VAT Amount Claimed / Total VAT to be claimed)</td>
</tr>
<tr>
<td>Quantity to Apply</td>
<td>Quantities to be shipped for the Inter Organization Transfer needs to be entered in this column against which receipt the transaction is to be carried out.</td>
</tr>
</tbody>
</table>

Apart from claiming the accrued CENVAT and VAT claims by matching the shipment to a Receipt, rest of the process is same in the Sending Organization and in the Receiving Organization. Closing the CENVAT Receipt Details form reduces the pending quantity available against the receipt.

**Note:** Matching the receipt quantity also restricts modification of taxes in the tax screen. Thus all activities with respect to taxes such as addition or modification should be completed before matching the receipt quantities.

When line values are modified after completion of match activity, the system reverts the quantities that were already matched against the Receipts. You will need to re-match the shipped quantities in order to claim the balance accrued credit.

**Inter Organization Transfer for Trading Organization**

When material is transferred from a Trading Organization, the user has to match the shipment against a receipt in order to update the Localization Excise Registers. Unlike Manufacturing Organization where RG 1 is updated, RG23D register gets updated in case of a Trading Organization.

The Match receipts functionality allows you to satisfy all requirements related to a Trading Organization or location registered under the Central Excise Rules to pass on Excise Credit to the Customers. The Excise Duty tracked while receiving the goods in a Trading Organization can be allowed as CENVAT credit for the Customers. Thus,
before confirming the shipment, you must allocate the excise duty involved during receipt of the excisable goods. While sending goods from the Trading Organization, you are required to track the exact amount of Duty paid by the Original Manufacturer for passing down the credit under CENVAT procedures. Clicking Match will let you match the required receipt against the shipment.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer name</td>
<td>Name of the Internal Customer will be displayed here.</td>
</tr>
<tr>
<td>Customer Number</td>
<td>Customer Number will be displayed here.</td>
</tr>
<tr>
<td>Quantity Invoiced</td>
<td>Shipped quantity will be displayed here.</td>
</tr>
<tr>
<td>Matched Quantity</td>
<td>Before matching, this field will be blank and after matching this field shows the matched quantity.</td>
</tr>
<tr>
<td>Item</td>
<td>Item code of the material shipped will be displayed here.</td>
</tr>
<tr>
<td>UOM</td>
<td>UOM of an item will be displayed here.</td>
</tr>
<tr>
<td>Transaction Type</td>
<td>Transaction type like Receipts and Return will be displayed here.</td>
</tr>
<tr>
<td>Supplier Invoice No</td>
<td>Supplier Invoice Number for a particular receipt will be displayed here.</td>
</tr>
<tr>
<td>Quantity in Receipt UOM</td>
<td>UOM of the item in the Receipt line will be displayed here.</td>
</tr>
<tr>
<td>Received</td>
<td>Quantity received in a particular Receipt will be displayed here.</td>
</tr>
<tr>
<td>Available</td>
<td>Available Quantity in a particular Receipt will be displayed here.</td>
</tr>
<tr>
<td>Apply</td>
<td>This represents the proposed match quantity. This will be filled by the system for a Release Quantity if the User selected Automatic Matching. The User can also enter number of quantity manually for matching.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Quantity in Issue - UOM</td>
<td>UOM of the item in the Issue line will be displayed here.</td>
</tr>
<tr>
<td>Available</td>
<td>Available Quantity in a particular Issue will be displayed here, this is equivalent to Available receipt quantity.</td>
</tr>
<tr>
<td>Apply</td>
<td>This represents the match quantity.</td>
</tr>
<tr>
<td>Receipt Number</td>
<td>Receipt Number will be displayed here.</td>
</tr>
<tr>
<td>Receipt Date</td>
<td>Receipt Date will be displayed here.</td>
</tr>
<tr>
<td>Duty Per Unit</td>
<td>Excise Duty per unit as per receipt line will be displayed here.</td>
</tr>
<tr>
<td>SH Cess</td>
<td>Cess per unit as per receipt line will be displayed here.</td>
</tr>
</tbody>
</table>

Closing the RG23D Register Entries India Local (match claim) form reduces the pending quantity available against the receipt.

**Note:** Matching the receipt quantity also restricts modification of taxes in the tax screen. Thus all activities with respect to taxes such as addition or modification should be completed before matching the receipt quantities. When line values are modified after completion of match activity, the system reverts the quantities that were already matched against the Receipts. You will need to re-match the shipped quantities in order to claim the balance accrued credit.

**View Inter Organization Transactions**

View Interorg Excise / VAT Details facilitates to view the Inter Organization Transactions. This form is only a view form and no modifications can be made to the form. Navigate to India Local Inventory > Transactions > View Interorg Excise / VAT Details.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find Excise/VAT Details</td>
<td>Select the Name of the Organization form where the Inter Organization Transfer has taken place.</td>
</tr>
<tr>
<td>From Organization</td>
<td>Select the name of the Organization to where the goods are shipped at the time of transacting the Inter Organization Transfer.</td>
</tr>
<tr>
<td>To Organization</td>
<td>Starting from this date the Inter Organization Transactions will be part of the Query criteria.</td>
</tr>
<tr>
<td>From Date</td>
<td>End date of the Query Criteria for the Inter Organization records to be displayed.</td>
</tr>
<tr>
<td>To Date</td>
<td></td>
</tr>
<tr>
<td>Excise Invoice No</td>
<td>Excise Invoice Number for the Inter Organization Transfer being generated at the time of transaction creation. Based on this query criteria the record(s) will be displayed. If a particular Excise Invoice Number is given then the same is displayed.</td>
</tr>
<tr>
<td>VAT Invoice No</td>
<td>VAT Invoice Number for the Inter Organization Transfer being generated at the time of transaction creation. Based on this the query criteria the record(s) will be displayed. If a particular VAT Invoice Number is given then the same is displayed.</td>
</tr>
</tbody>
</table>

**Note:** You can view the GL drilldown accounting entries using the Show transactions button on the Tools menu of the Excise/VAT Details form.

### Reports

This section provides overview and detailed description of these reports:
- Tax List Report
- Excise Duty Claim for RMA Report
India-Tax List Report

This Report gives you the List of Tax Category for an Item Class and its associated Tax Code & Tax type. The user can view and review this report before defining a New Tax Category.

Report Submission

Use the Request Transaction Reports form and enter India-Tax List Report in the Name field to submit the report.

Report Parameters:

Tax Category Name: PICK HELP (optional)
Oracle Financials for India accepts Tax Category name as an optional parameter. If you do not give any value to this field, system will print all the Tax Category names defined in the system till date.

Item Class ID: PICK HELP (optional)
Oracle Financials for India accepts an optional Item Class also.

Tax Name: PICK HELP
Oracle Financials for India accepts Tax Name as an optional parameter. If you do not give any value to this field, system will print all the Tax Names defined in the system till date.

Category Start Date: (Optional)
Oracle Financials for India accepts Category Start Date as an optional parameter. This is to produce the report to your choice. Transactions with Tax Categories defined, on or after the date will be selected for reporting.

Category End Date: (Optional)
Oracle Financials for India accepts Category End Date as an optional parameter. This is to produce the report to your choice. Transactions with Tax Categories defined on or before the date will be selected for reporting. Blank End date means, no check is made on end dates.

Tax name Start Date: (Optional)
Oracle Financials for India accepts Tax Name Start Date as an optional parameter. This is to produce the report to your choice. Transactions with Tax Name defined, on or after the date will be selected for reporting.

Tax name End Date: (Optional)
Oracle Financials for India accepts Tax Name End Date as an optional parameter. This is to produce the report to your choice. Transactions with Tax Name defined on or before the date will be selected for reporting. Blank End date means, no check is made on end dates.

Report Headings
Report Headings provide you with general information about the contents of the report. Oracle lists information on Various Tax Categories and Tax Names defined in the system.

Column Headings:
- Tax Category
- Item Class Code
- Category effective date from
- Category effective date to
- Tax Name
- Amount
- UOM
- Rate
- Adhoc Flag
- Tax Name effective date from

**India - Excise Duty Claim for RMA Report**

This Report gives you the Amount that can be claimed from Excise Authorities on the Excise amount of a RMA Receipts.

**Report Submission**

Use the Submit Requests (India Local INV module) form and enter **India- Excise Duty Claim For RMA Receipts** in the Name field to submit the report.

**Report Parameters**

Customer Name: PICK (Optional)

The User wants to see the RMA Receipt from Particular Customer and the Excise Claimable amount, then he can specify the Customer Name here.

Customer Number

Customer Number of the above Customer will be defaulted here.

RMA No

The User can enter specific RMA Number

Start Date (Required)

End Date: (Required)

Report Headings

Report Headings provide you with general information about the contents of the report. Oracle lists Company Name based on User parameter input.
<table>
<thead>
<tr>
<th>Column Headings</th>
</tr>
</thead>
<tbody>
<tr>
<td>RMA No</td>
</tr>
<tr>
<td>RMA Line</td>
</tr>
<tr>
<td>RMA Date</td>
</tr>
<tr>
<td>RMA Type</td>
</tr>
<tr>
<td>Sub Inventory</td>
</tr>
<tr>
<td>The Delivered Sub Inventory for the Return material.</td>
</tr>
<tr>
<td>Customer Name</td>
</tr>
<tr>
<td>Customer Number</td>
</tr>
<tr>
<td>Ex.Invoice Number</td>
</tr>
<tr>
<td>Original Excise Invoice Number in which the goods where sent</td>
</tr>
<tr>
<td>Ex.Invoice Date</td>
</tr>
<tr>
<td>Original Excise Invoice Date in which the goods where sent</td>
</tr>
<tr>
<td>Excise Due Amount</td>
</tr>
<tr>
<td>Excise duty amount that can be claimed from the Excise Department on account of an return.</td>
</tr>
</tbody>
</table>
This chapter covers the following topics:

- Defining Tax Overview
- Outside Processing Transactions
- Receiving Corrections
- Mass Tax Update
- Transactions Handled
- Encumbrance Accounting
- Setting Up India Local Purchasing
- Managing Purchasing Transactions
- Receiving Corrections
- Using India - Mass Tax Update
- Receipts (Localized)
- India Localization Receipt Details
- Inquiry
- Retroactive Pricing
- Reports

Defining Tax Overview

Businesses in India must pay to the Supplier Taxes related to Central, State, and City Tax Authorities on most of the goods and services that they purchase. Tax Handling helps you to manage taxes for Purchase Orders, Requisitions, Request for Quotations, Quotations, Releases and Receipts.

The Tax Handling functionality lets you satisfy all your Tax requirements related to Purchasing. You can:
• Define Taxes of Excise, Customs, Sales Tax, Value Added Tax, Central Sales Tax and other Type of Taxes

• Define Item Category lists and attach them to the Suppliers and Supplier Sites to enable Tax defaulting.

• Define Tax Categories with Item Classes for last level of Tax defaulting.

• Define precedence for calculation of Taxes to handle Tax-on-Tax Type of calculations including cumulative and compounded Tax calculations.

• Define Adhoc Taxes. The Taxes that do not directly depend on the transaction value can be defined as Adhoc Tax and appropriate value can be assigned during the transaction

• Calculate Taxes in multiple currencies

• Define Tax Recoverable information and the same will be used for Inventory Valuation.

• Track other costs incidental to the Purchase transaction. The same will be used for valuation of the Item.

• Define Third Party Taxes. Separate Invoices are generated for Third Party Taxes.

• Default Taxes on to documents that are created based on other documents.

• Define Tax Registration details of the Supplier, which can be used for Statutory Reports.

• Carry forward taxes defaulted and added to a Purchase Order to Receipts.

• Carry forward taxes defaulted and added to a RMA to Receipts.

• Carry forward taxes defaulted and added to a Internal Sales Order to Receipts.

• Control modification of taxes defaulted on Purchase Receipts

• Claim CENVAT during Receipt. Else, can claim it manually after Receipt.

• Allow corrections to quantities.

• Create Return to Vendor Transactions with respective Tax Implications.

• Receive unordered material.

Oracle Financials for India now supports GL drilldown which enables finding the original transaction in GL from the drilldown UI. This feature also aids viewing
accounting entries from the source transaction. For detailed information, refer to Define Tax Codes in the Oracle Financials for India Implementation Manual.

**Quote Analysis at the Landed Cost**

The quotations are analyzed based on the non-recoverable localization taxes for the calculation of Per Landed Unit Cost. This will not consider the CENVAT able Taxes and VAT Taxes.

**Excise Defaulting for PO**

While creating the Purchase Order, Excise information defined will be defaulted. If the Purchase Order is created from a Quotation, then the taxes defined for the Quotation will be considered. Tax defaulting will be proportional to the quantity specified at the PO level.

**Taxes at Time of Receipt**

When the material is received against a Purchase Order, the taxes defined at the PO level will default. Defaulting will be proportional to the quantity received. Since the taxes specified on the Invoice are actually applicable, user will be able to modify the Taxes as per the Invoice. Localization provides the functionality to Modify the Taxes at the time of Receipt. You can effectively use this functionality, when there are changes in Tax Rates due to change in the statute/budget etc. In case of any change in Taxes from the PO, the user needs to take care to update the Taxes Immediately while performing the Receipt. Tax changes will not be allowed once the user comes out from the Receipt screen.

**Receipt of Unordered Material and Applicable Taxes**

For Unordered Receipts, users will not be able to attach or specify the Taxes applicable while creating Receipt. As a result the Tax Amount will not be calculated or defaulted (as the item price and currency is not known). Taxes defined at the time of purchasing will be applicable here. Tax can be attached or modified to Unordered Receipt in Receipt (Localized) window after matching to PO, this can be achieved based on “Allow tax change on Receipts flag” set in Additional information. If you set Allow Tax change on Receipts to Y, accounting and RG is updated when Receipt localized form is closed. If Allow Tax change on Receipts is set to N, then RG and accounting will be passed when matched to purchase order.

**CENVAT Records and Registers**

You have an option to generate consolidated CENVAT Report or to continue with RG 23 Registers. Option has been provided to the user either to avail CENVAT credit immediately on Receipt of the goods or to defer taking credit for a later time. In the case of Capital Goods, provision to avail partial credit at the time of receipt and balance later
Payments to Vendors Other Than PO Vendor

Provision to pay to the Vendor other than the PO Vendor is provided. This will be required for paying the services offered by other Vendors related to that PO. An approved Invoice for the Non-PO Vendor will be created on running an India Concurrent for Third Party Invoices program. This functionality of Oracle Financials for India can be effectively used for expenses like freight, insurance etc. where payment in normal case will be done directly to such agencies.

PO/Receipt Matching

You have an option to specify whether the Invoice need to be matched to a Receipt or to a Purchase Order. If the user opts for 'match to PO', at the time of matching, the Localization Taxes attached to PO will be taken into consideration and Taxes will be apportioned based on the quantity matched. In this case taxes will be calculated based on the taxes defined in the Purchase Order.

If the user opts for Receipt Matching, system will work out the Taxes based on the Taxes available for the particular Receipt and based on the matched quantity, Taxes will be apportioned.

In India, as the occurrence of variance in the Taxes defined in PO with actual receipt being very frequent, it is suggested to opt for Receipt Matching, so that the taxes in AP will be in sync with the taxes at the time of Receipt.

Automatic Creation of Invoices Based On Receipts

Pay on Receipt functionality in Oracle E-Business Suite will also consider Taxes Payable to the PO Vendor for the payment of Receipts entered. Localization supports Pay on Receipts based on Receipt Number as well as Packing Slip Number. If the user opts for Packing Slip Number, he need to take care to enter the Packing Slip Number at the time of creating a Receipt. Pay on Receipt program takes into account the RTV Transactions against the Receipt.

Purchase Returns

While performing Return to Vendor transaction, system can take care of the reversal of CENVAT Credit that needs to be done before removal of goods. Based on the user-defined parameters, the proportionate amount of CENVAT Credit availed will get reversed in Excise Records*. The user can generate the Excise Invoice Number that needs to be issued for such removals**. Provision for defining user definable prefixes for the Excise document that is generated for RTV transactions is also provided.

System will put a hold to RTV transaction for a CENVAT able Item on which credit was not availed. In such cases, user needs to take credit and process RTV transaction from Return to Vendor India Form. This check has been built for ensuring that payment of
duty does not happen if credit is not availed.

* The Excise Register updated on RTV transaction depends on Register preferences. The credit in PLA will be updated when the PLA Preference is set to '1'.

** Excise Invoice Number will be generated only when you select process action as "Generate"

** CENVAT on Additional Customs Duty (CVD) Paid**

Provision to allow users to claim CENVAT for the Additional Customs Duty paid, if applicable. While availing the CENVAT it will be restricted to the percentage specified for availing CENVAT at the tax level. Also, the appropriate Excise registers will be updated.

**Non - CENVAT Customs Duty**

For the taxes where CENVAT cannot be claimed or the percentage of Customs Duty for which the CENVAT is not available, acquisition cost of the item will be increased to that effect.

**CENVAT Accounting on CVD**

The process of claiming CENVAT is similar to that of the Excise Duty CENVAT. The accounts set for the BOE Account will be used in this case.

**Currency Change for Customs Duty**

Since, the Customs Duty is to be paid in the Functional Currency (INR), you are allowed to change the applicable Currency at the transaction level. However, the provision to change Currency will depend upon the parameters set while Defining the Tax in the India Local Tax Definition option.

**Customs Duty Payment Before Receiving Material**

Since, the Customs Duty is always paid in advance. i.e. the amount is paid before the material is received in stores, there is a facility where the duty could be paid before receiving the material. For this purpose, an on Account (prepayment) payment can be made in the name of Customs Authorities. Bill of Entry (BOE) as given by Customs Authorities is then entered in the system. BOE is settled against the prepayment.

**Bill of Entry (BOE) on Receipt**

Provision to apply the BOE to the Receipt is required. Only the fully paid Bill of Entries will be considered for application at the time of Receipt. This will identify the BOE used for any particular Receipt. The Bill of Entry can only be applied against the Customs Duty type of Taxes i.e. Basic and Additional Customs Duty.
Applying Bill of Entries (BOE) to PO Receipts

During Receipts, the BOE amount applied to the line will be considered as the applicable Customs Duty Amount, instead of the Amount specified at the Receipt Level.

Reversal of Taxes on Purchase Returns

In the event of Purchase Returns, all the taxes applicable to the item will be reversed and for Average Costing Organization the new Average Cost of the Item will re-calculated.

Mass Tax Updates

Mass Tax Update is a batch program to recalculate taxes applicable on the Open Documents. You can use this program to process Open Documents of the selected Document Type. The program uses the localization 3-way defaulting mechanism to derive the Revised Taxes that are applicable to a document. Optionally, you can map the Tax Categories (through request parameters) to replace the existing tax lines with those defined in the New Tax Category. As you process, a record of all documents considered for processing will be maintained.

Bulk Claim CENVAT After Receipts

You can process the Receipt lines to be claimed in claim CENVAT screen line by Line. This option can be used to process each line independently. Else, you can use the option of Bulk Claim CENVAT on Receipts. You can enter values related to Excise Invoice Number and Date on each of the lines and then check 'Check All' and press the 'Claim' Button to process all the selected records simultaneously, through one concurrent request.

Receipt of Goods from Third Party Excise Vendor

Where goods are received from a third party Vendor and an Excise Invoice is issued, then you can update the Excise Vendor name in the 'Claim CENVAT on Receipts' screen. The Name and Registration details of this Vendor will be considered for updating Excise Registers.

Outside Processing Transactions

The Outside Processing Feature of Oracle Financials for India provides the functionality of tracking the goods sent to a Sub-Contractor for processing. This feature provides you with reports that you can use to review the status of each Challan and track each issue. You need to keep a manual track on overdue issues i.e., those pending for more than 180 days. The duty on overdue issues has to be calculated manually and debited to the
duty paying register through RG 23 Manual entry screen.

The Outside Processing functionality lets you satisfy all your needs on Tracking of goods sent for outside processing. You can:

- Create OSP Challan based on the OSP Purchase Order, approve the same
- Create Manual OSP Challans in case of staggered material dispatches.
- Track Receipt of Processed Material
- Authorize issues and Receipts
- Generate reports to maintain private records of useful information

By using the Localization features, goods that need to be sent for Sub-contracting can be tracked through a Challan. Based on the parameters set up in the Additional Organization Information, duty will be debited at the time of removal of goods and the same can be credited on receipt of the goods. Hence there is no need to pay duty on removal of goods for Sub-contracting, user need to take care to set up zero in the OSP percentage field of Additional Organization Information Different reports are being provided by Localization to track the dispatch and receipt of goods sent under OSP transactions. User needs to keep a manual track for the receipt of goods by monitoring OSP reports and if the goods are not received back within 180 days, duty needs to be worked out manually and the amount should be debited in the duty paying register through RG 23 Manual Entry screen.

**Prerequisites:**

- All items sent for outside processing must exist in Organization items and outside processing item attribute is enabled.
- OSP relation is properly defined.
- All issues for outside processing take place from inventory and receiving happens into Inventory.
- Excise records will get generated if the item being issued for outside processing has the attribute of Excise flag - set to 'Yes'.
- Standard Oracle E-Business Suite supports Outside Processing Operations in Oracle WIP. In Oracle Financials for India - user will be able to monitor the movement of goods to the Sub-contractor.
- In Oracle WIP when material is moved to queue of OSP Operation, an approved Requisition is created in interface tables. Then we run Requisition Import to populate the Requisition in PO Module. Using this requisition we auto create PO and approve the PO. When we receive material it is directly updated in WIP Operations.
Under Localization following additional steps or processes are involved:

- Go to 57F4 Dispatch approval Screen. You are required to verify the details populated, update the actual Items and quantities being dispatched and approve 57F4 Form for Dispatch. This will generate Form (Challan) Number.

- 57F4 Forms are created on the basis of BOM components defined for the Item being sub contracted. In case the issue of material to the sub contractor is in a staggered manner (items or quantities), Enter Manual 57F4 Form can be used for the subsequent material dispatches. Each dispatch in the Manual 57F4 generates a separate Challan Number.

- Receive the Items against the PO, 57F4 receipt quantity will get updated.

- On final Receipt of Material go to 57F4 Receipt Approval window and Approve the Receipt.

- If an OSP item is returned, a fresh 57F4 will be generated and then steps 1 to 4 should be followed.

Under Localization following additional setups are required.

- In Organization parameters under Taxation Parameters alternative region enter Outside Processing Return Days and Outside Processing Excise Percentage you want to default in 57F4 Challan.

- While defining OSP Item the Excise and CENVAT flag should be set to YES.

**Populating 57F4 details on moving material for Outside Processing**

In Oracle WIP when material is moved to queue of OSP operation, an approved requisition is created in interface tables. Then we run Requisition Import to populate the Requisition in PO Module. Using this Requisition we auto create PO and approve the PO. When we Receive Material it is directly updated in WIP Operations.

Under Localization following additional steps or processes are involved:

- As soon as a PO of OSP type is approved the relevant details are populated in 57F4 table.

- Go to 57F4 Dispatch Approval Screen. You are required to verify the details populated, update the actual Items and quantities being dispatched and approve 57F4 Form for Dispatch. This will generate Form (Challan) Number.

- 57F4 Forms are created on the basis of BOM Components defined for the Item being Sub Contracted. In case the issue of material to the Sub-contractor is in a staggered manner (items or quantities), the Manual 57F4 Form can be used for the subsequent Material dispatches. Each dispatch in the Manual 57F4 generates a separate Challan.
Number.

• Receive the items against the PO, 57F4 receipt quantity will get updated.

• On final Receipt of Material to 57F4 Receipt Approval window and approve the Receipt.

• If an OSP item is returned, a fresh 57F4 will be generated and then steps 2 to 4 should be followed.

**Support for User-defined Limit Days**

Users will be able to define applicable validity period in number of days for each type of Excise Transaction. These days will be checked while providing Excise treatment. Outside Processing Material is required to be received in 180 days. Otherwise differential duty, based on actual duty on goods not received, has to be paid.

**Approve 57F4 Dispatch**

Using this Form the user can find out the 57F4 dispatch Forms for a PO or a Vendor and the same can be Approved.

Form Approved in this Form is the Primary Form for a particular OSP PO. System creates the 57F4 form comprising all the WIP Components required for the specific WIP Operation attached to OSP PO in the Outside Processing Details. If the WIP Operation is the First Operation, only the Components are to be dispatched to the Sub Contractor. If the WIP Operation is the second or higher, the intermediate assembly of earlier operations along with the Components required for the current operation need to be dispatched to the Sub Contractor. Hence an additional item line with the PO OSP Item description is created in the 57F4 forms for such OSP Purchase Orders. The PO OSP Item Description could be provided in such a way to identify with the Intermediate Assembly. This is a specific workaround to meet the India specific OSP Excise requirement.

It is not mandatory to dispatch all the components or their full quantities in the Primary Form itself. If the dispatches are done in a staggered manner, the first batch could be dispatched through the Primary form. Subsequent dispatches could be done through the Manual 57F4 Forms.

Transactions Outside Processing Approve 57F4 dispatch Find. The field wise description of the screen is given in the table below for your ready reference.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO Number (Optional)</td>
<td>EDIT PICK</td>
<td>HELP</td>
<td>Select PO Number from LOV to find and review or approve Dispatch / Receipt.</td>
</tr>
<tr>
<td>Vendor Name (Optional)</td>
<td>EDIT PICK</td>
<td>HELP</td>
<td>Select Vendor Name from LOV to find and review or approve Dispatches/Receipts for that Vendor.</td>
</tr>
<tr>
<td>Form Date (Optional)</td>
<td>EDIT PICK</td>
<td>HELP</td>
<td>Select Form Date from LOV to find and review or approve Dispatch / Receipt.</td>
</tr>
</tbody>
</table>

**Transactions Outside Processing Approve 57F4 Dispatch**

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization Name, Location</td>
<td>(Display only)</td>
<td>HELP</td>
<td>These fields will show the Organization and its Location in the selected PO.</td>
</tr>
<tr>
<td>Form Number</td>
<td>(Generated)</td>
<td>HELP</td>
<td>This will get generated automatically on approval of Dispatch.</td>
</tr>
<tr>
<td>Form Date</td>
<td>(Display only)</td>
<td></td>
<td>This will be the date on which PO was approved and the relevant data was populated.</td>
</tr>
<tr>
<td>Supplier Name</td>
<td>(Display only)</td>
<td></td>
<td>This field will display the Supplier Name as per the corresponding PO.</td>
</tr>
<tr>
<td>Dispatch Date</td>
<td>(Required)</td>
<td>EDIT PIC</td>
<td>You can enter future date as dispatch date and time. Limit of days will be calculated from this date according to the transaction.</td>
</tr>
<tr>
<td>Maximum permitted days</td>
<td>(Display only)</td>
<td></td>
<td>This field will have default value from Organization parameters.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Receive upto</td>
<td>(Display only)</td>
<td></td>
<td>This field will show the Date by which you need to receive the material back from Vendor.</td>
</tr>
<tr>
<td>Dispatch Register</td>
<td>(Required)</td>
<td>EDIT</td>
<td>HELP Select Register in which you want to debit the CENVAT Credit Reversal. PICK is available which will show the Register Name and current balance available.</td>
</tr>
<tr>
<td>Entry Number</td>
<td>(Display only)</td>
<td></td>
<td>On approval of dispatch entry is made in the selected Register and Entry Number is generated.</td>
</tr>
<tr>
<td>Receipt Register</td>
<td>(Display only)</td>
<td>PICK</td>
<td>This will always be RG 23 A Part II, as per the legal requirement.</td>
</tr>
<tr>
<td>Entry Number</td>
<td>(Display only)</td>
<td></td>
<td>On approval of Receipt entry is made in RG 23 A Part II and Entry Number is generated.</td>
</tr>
<tr>
<td>In Lines</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assembly</td>
<td>(Display only)</td>
<td></td>
<td>This will show the assembly as per WIP Work Order.</td>
</tr>
<tr>
<td>Description</td>
<td>(Display only)</td>
<td></td>
<td>Description of Assembly will be defaulted as defined in Item Definition</td>
</tr>
<tr>
<td>Job Name</td>
<td>(Display only)</td>
<td></td>
<td>Pick the Job Name from LOV</td>
</tr>
<tr>
<td>Item, Description</td>
<td>(Display only)</td>
<td></td>
<td>These fields will show Item Code and Description</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------</td>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td></td>
<td></td>
<td>Unit of Measure for the Item being dispatched. Primary UOM of the Item shall be defaulted. However other UOM's could be used if UOM conversion is defined for the Item. The quantity and rate details shall be automatically recalculated based on the UOM conversions defined.</td>
</tr>
<tr>
<td>Identification</td>
<td>(Display only)</td>
<td></td>
<td>Enter Identification Mark if any. There is no validation for this field.</td>
</tr>
<tr>
<td>Tariff Code</td>
<td>(Display only)</td>
<td></td>
<td>Tariff Code will be defaulted from Item Definition. User can change the same. There is no validation for this field.</td>
</tr>
<tr>
<td>Dispatch Quantity</td>
<td></td>
<td></td>
<td>This is the Quantity as per Purchase Order. This could be modified based on the Actual Quantity being dispatched in the current form.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------</td>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Item Rate</td>
<td>(Display only)</td>
<td>Value is defaulted in this field in the following order:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. List Price from Price list attached combination of Item, Vendor, Vendor Site and UOM Code.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. List Price from Price List attached for the combination of Item, Vendor (Null Site) and UOM Code.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. List Price for Item, Organization combination in Item Definition</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Item Cost for Organization, Item</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>This can be updated as per the valuation for excise per unit of OSP item.</td>
<td></td>
</tr>
<tr>
<td>Dispatch value</td>
<td>(Display only)</td>
<td>Dispatch value = Dispatch Quantity * Item Rate</td>
<td></td>
</tr>
<tr>
<td>Excise Rate</td>
<td>(Display only)</td>
<td>Excise rate will be defaulted from Organization Parameters. You can change if required as per legal provisions. This is percentage rate on Dispatch value and not a per unit rate.</td>
<td></td>
</tr>
<tr>
<td>Dispatch Excise</td>
<td>(Display only)</td>
<td>Dispatch Excise Amount = Dispatch value * Excise Rate</td>
<td></td>
</tr>
<tr>
<td>Amount</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Processing Nature</td>
<td>(Display only)</td>
<td>This will default from Operation Description of OSP operation from the related job. This can be edited if required.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** You can view the GL Drilldown Accounting lines by clicking the Show Transaction button on the Tools menu in Approve 57F4 Dispatch
Enter Manual 57F4

This form can be used to create a Manual 57F4 for sending material for Outside Processing and view the 57F4 Forms. Manual Forms can be created based on an OSP PO or just on the basis of Supplier Information filled in the Query window.

**Note:** You can view the GL Drilldown Accounting lines by clicking the Show Transaction button on the Tools menu in Enter Manual 57F4 form.

Report Submission

If the Manual 57F4 Form is being created based on a OSP PO, the system checks for the dispatched quantity in the Primary Form. An entry is allowed in the Manual 57F4 Form only if the full quantity is not dispatched through the Primary Form. System does not allow to dispatch any additional material against the PO in excess of the materials required for the WIP Job linked to the OSP PO Item line. Use the Submit Requests (INV & PO Modules) Form and enter OSP Pending Receipts Report in the Name field to submit the report.

If the Manual 57F4 form being is created based on the Supplier, there is no linkage to the WIP Job and hence the update to the Form is entirely Manual. The system shall not default any Job related data while creating the Form entries - neither it updates the 'Return Quantity' value as there is no linkage to any PO in this case. The form updates have to be done manually based on manual controls of issue and receipt.

Transactions Outside Processing - Enter Manual 57F4

<table>
<thead>
<tr>
<th>Field description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO Number</td>
<td>(Required/optional)</td>
<td>EDIT HELP PICK</td>
<td>Select PO Number from LOV if a PO has been raised for this OSP transaction, otherwise leave blank.</td>
</tr>
<tr>
<td>Vendor Name</td>
<td>Optional</td>
<td>EDIT HELP PICK</td>
<td>Select Vendor Name from LOV for whom the 57F4 is going to be created.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Site</td>
<td>Optional</td>
<td>EDIT HELP PICK</td>
<td>Select Vendor Site for the above Vendor from LOV relevant for a 57F4 transaction.</td>
</tr>
</tbody>
</table>

Click Open and enter values into the 57F4 - India Local Form based on the details below.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>(Required/Defaulted)</td>
<td>ENTER</td>
<td>The user needs to enter the Inventory Organization name here. If the Manual 57F4 referred through a Purchase Order, then the PO Organization will be defaulted here.</td>
</tr>
<tr>
<td>Location</td>
<td>(Required)</td>
<td>ENTER</td>
<td>The users need to enter the Location of the above Inventory Organization where this Manual 57F4 is to be raised.</td>
</tr>
<tr>
<td>Form Number</td>
<td>(Display Only)</td>
<td></td>
<td>System generated Form Number will be displayed after completion and approval of a transaction.</td>
</tr>
<tr>
<td>Form Date</td>
<td>(Display Only)</td>
<td>ENTER</td>
<td>By default this will be Current Date.</td>
</tr>
<tr>
<td>Supplier Name</td>
<td>(Required/Defaulted)</td>
<td>ENTER</td>
<td>If the Manual 57F4 referred through a Purchase Order, then the PO Supplier Name will be defaulted here otherwise the user need to enter the Supplier Name.</td>
</tr>
<tr>
<td>Dispatch Date</td>
<td>(Display only)</td>
<td></td>
<td>By default Current Date and Time will be displayed here.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Supplier Name</td>
<td>(Required/Defaulted)</td>
<td>ENTER</td>
<td>If the Manual 57F4 referred through a Purchase Order, then the PO Supplier Name will be defaulted here otherwise the user need to enter the Supplier Name.</td>
</tr>
<tr>
<td>Max Days Permitted</td>
<td>(Display only)</td>
<td></td>
<td>This field will have default value from Organization Parameters.</td>
</tr>
<tr>
<td>Receive upto</td>
<td>(Display only)</td>
<td></td>
<td>This will be the cutoff date for Receiving back the OSP materials from the delivery date from the Vendor.</td>
</tr>
<tr>
<td>Registers Block</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dispatch Register</td>
<td>(Required)</td>
<td>ENTER</td>
<td>The users need to select the Excise Register to be used for this OSP transaction from the LOV.</td>
</tr>
<tr>
<td>Entry Number</td>
<td>(Display only)</td>
<td></td>
<td>On approval of dispatch entry in the selected register and Entry Number is generated and displayed here.</td>
</tr>
<tr>
<td>Receipt Register</td>
<td>(Display only)</td>
<td></td>
<td>This will always be RG23 A Part II as per the legal requirement.</td>
</tr>
<tr>
<td>Entry Number</td>
<td>(Display only)</td>
<td></td>
<td>On approval of Receipt Entry is made in RG 23 A Part-II and Entry Number is generated.</td>
</tr>
<tr>
<td>Line level</td>
<td>(Display / Required)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Job Name</td>
<td>ENTER</td>
<td></td>
<td>Job Name associated in the PO will be defaulted here if the user enter Manual 57F4 with PO reference otherwise the user need to select the respective Job Name from the LOV.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assembly</td>
<td>(Display only)</td>
<td></td>
<td>Assembly for the above Job Name will be displayed here.</td>
</tr>
<tr>
<td>Description</td>
<td>(Display only)</td>
<td></td>
<td>Description for the above Job Name will be displayed here.</td>
</tr>
<tr>
<td>Item</td>
<td>(Required)</td>
<td>ENTER</td>
<td>The user needs to select the Inventory Item from the LOV.</td>
</tr>
<tr>
<td>Description</td>
<td>(Display only)</td>
<td></td>
<td>Description of the above Inventory will display here.</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>(Display only in PO linked Manual Forms)</td>
<td></td>
<td>Unit of Measure for the Item being dispatched. Primary UOM of the Item shall be defaulted. However other UOMs could be used if UOM conversion is defined for the Item.</td>
</tr>
<tr>
<td>Identification</td>
<td>(Display only)</td>
<td></td>
<td>Enter Identification Mark if any. There is no validation for this field.</td>
</tr>
<tr>
<td>Tariff Code</td>
<td>(Display only)</td>
<td></td>
<td>Tariff Code will be defaulted from Item Definition. User can change the same. There is no validation for this field.</td>
</tr>
<tr>
<td>Dispatch Quantity</td>
<td>(Required/Display only)</td>
<td></td>
<td>This is the Quantity as per Purchase Order or the user can enter the Dispatch Quantity.</td>
</tr>
<tr>
<td>Item Rate</td>
<td>(Display only)</td>
<td></td>
<td>List Price in Item Definition will be defaulted in this field. This can be updated as per the valuation for Excise Per Unit of OSP Item.</td>
</tr>
<tr>
<td>Dispatch value</td>
<td>(Display only)</td>
<td></td>
<td>Dispatch value = Dispatch Quantity * Item Rate</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------</td>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Excise Rate</td>
<td>(Display only)</td>
<td></td>
<td>Excise Rate will be defaulted from Organization Parameters. This is percentage rate on Dispatch value and not a per unit rate.</td>
</tr>
<tr>
<td>Dispatch Excise Amount</td>
<td>(Display only)</td>
<td></td>
<td>Dispatch Excise Amount = Dispatch value * Excise Rate</td>
</tr>
<tr>
<td>Processing Nature</td>
<td>(Display only)</td>
<td></td>
<td>This will default from Operation Description of OSP Operation from the related job and this can be edited if required. The user can enter the relevant processing details here if the Manual 57F4 is created without PO reference. After entering data press the Approve dispatch button, then the transaction will be saved and approved.</td>
</tr>
</tbody>
</table>

**Approval 57F4 Receipts**

Through this form the user can find out the 57F4 Receipt and approve them. An automatic update feature is provided for the 'Return Quantity' field on Receipt of the materials against the PO. The 'Return Quantity' field is updated on Receipt in the following sequence:

- Primary Form
- Manual Form
- RTV Form (in case of RTV re-receipt)

Such automatic update of the Receipt Quantities is provided only for the Forms linked to Purchase Orders. This is not available for Manual Forms created without any linkage to Purchase Order.

Transactions - Outside Processing - Approve 57F4 Receipts

The field wise description of the form is given below for ready reference.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return Quantity</td>
<td></td>
<td></td>
<td>This will be Quantity Received till date. On Receipt of the Material from OSP Vendor this Quantity will get updated.</td>
</tr>
<tr>
<td>Return value</td>
<td>(Display only)</td>
<td></td>
<td>Return value = Return Quantity * Item Rate</td>
</tr>
<tr>
<td>Return Excise Amount</td>
<td>(Display only)</td>
<td>Return Excise Amount = Return value * Excise Rate.</td>
<td></td>
</tr>
</tbody>
</table>

**Important:** It is advisable to have single distribution line for return of material under 57F4 in order to update the 57F4 forms in an Inventory Location.

**Using India - Control over Printing of OSP Challans**

This section gives brief overview of 57F4 Challan Printing and Control

**Overview**

This feature enables you to control printing of 57F4 Challans. It would restrict repeated prints of a Challans. Control over printing of Duplicates would be controlled and Duplicate Challans would be marked as such.

In cases where the print could not be generated due to Printer errors, authorized users can generate an original print.

**Using India - Control over Printing of OSP Challans**

Records in 'Approve 57F4 Dispatch' window would be populated on Approval of a PO with Line 'Type' as Outside Processing. The user would check the accuracy of the Records and Approve the Dispatch and not the Form Number. On approval a record would be populated in 'Print Control 57F4 window, the 'Original' in this Form would be set to 'Yes' and the value in the 'Duplicate' field would be set to 'No'.

After approval, the user would navigate to India Local Purchasing Reports Run, to run the 'India - Outside Processing Challan' report. The 'Form Numbers From' and 'Form Numbers To' fields would display only the unprinted Challans i.e., challans with either
the ‘Original’ or ‘Duplicate’ status set to ‘Yes’ (in the ‘View 57F4 Challan’ window). On 
Printing the Challan, the value in the ‘Original’ field would be set to ‘No’. At this stage, 
both ‘Original’ and ‘Duplicate’ fields can be updated.

The Access to ‘View 57F4 Challans’ window would be restricted to authorized users. 
These users can query for the Forms, and change either ‘Original’ or ‘Duplicate’. The 
value in either one of these fields can be set to ‘Yes’. On changing value in one of these 
fields the other field would be disabled. This change would list the Form for Printing 
one more. The Challan Report that have 'Duplicate' as 'Yes' would be marked as 
'Duplicate'.

On printing the Challan the values in both ‘Original’ and ‘Duplicate’ fields would be set 
to set to ‘No’.

Print Control 57F4

Organization Name
The User can select from the Organizations. The LOV for all other fields would be based 
on value selected in this field. This would be a mandatory field.

Location
The User can select from the Locations defined for the Organization. The LOV for all 
other fields would be based on value selected in this field. This would be a mandatory 
field.

Fin Year
The LOV for this field would list the Fin Year (Localization) defined for the select 
Organization and Location. This would be a mandatory field.

Vendor Name
The LOV for this parameter would display the Suppliers with OSP transactions.

PO Number
The LOV for this field would display the Purchase Orders with OSP Items created for 
the selected Organization, Location, and Financial Year. This would be restricted based 
on the value selected in the Vendor Name field.

Form Number
The LOV for this field would display the Form Numbers created for the selected 
Organization, Location, and Financial Year. This would be restricted to Unapproved 
57F4 Receipts.

This would be restricted based on the value selected in the Vendor Name field.

Print Control 57F4 Form

PO Number
This field would display the Purchase Order Number based on which the Form Number has been generated.

Form Number
This field would display the 57F4 Form Number.

Vendor Name
This field would display the Supplier Name for which the Form has been generated.

Original
The Check box would be enabled when the 57F4 is dispatched. Once the Challan is printed the check would be removed. However, the user can check this to Print a 'Original' Challan. This field cannot be checked if the 'Duplicate' field is checked.

Duplicate
The Check box can be enabled only on user intervention. Once the Challan is printed the check would be removed. However, the user can check this to Print a 'Duplicate' Challan. This field cannot be checked if the 'Original' field is checked.

Reports
System generates following Reports for Oracle Financials for India Outside Processing Transaction.

- OSP Pending Dispatch Report: Lists Unapproved 57F4 dispatches made in an Organization, location, for a given period of time and a given Vendor. The output is listed Work Order Number wise.

- OSP Pending Receipt Report: Lists Unapproved 57F4 Receipts in an Organization, location, for a given period of time and a given Vendor. The output is listed Work Order Number wise.

- OSP Stock Register: This Report is an extract of all 57F4 transactions in an Inventory Organization, Location for a given period of time and the format of the Report is as specified by the Central Excise Act.

- Outside Processing Challan: This report gives you the 57F4 Forms used. The output is listed Challan Number wise.

Receiving Corrections
Oracle Financials for India product supports Receiving Corrections feature provided by Base Receiving. Oracle Financials for India automates adjustment to Taxes and corresponding Accounting and Register Entries on corrections to Receiving Transactions using Receiving Corrections feature.

Oracle Financials for India supports Corrections to following transactions.
• Receiving
• Delivery
• Return to Receiving and
• Return to Vendor Transaction

Oracle Financials for India adjusts following entries on correcting any of the transactions, specified above:
• Adjust Receiving Entries (created for India Local Taxes)
• Create Cost Adjustments (for non-recoverable taxes)
• Create CENVAT Adjustment Entries (to adjust the accounting Impact of the CENVAT Entries created on Claim CENVAT)
• Adjust CENVAT Quantity and Duty Registers

The above list varies depending on the stage of transaction at which it is corrected.

Mass Tax Update

Mass Tax Update is a batch program that enables you to recalculate taxes applicable to the Open Documents. You can use this program to process open documents of the selected Document Type. The program uses the localization 3-way defaulting mechanism to derive the revised taxes that are applicable to a Document. Optionally, you can map the Tax Categories (through request parameters) to replace the existing tax lines with those defined in the New Tax Category. As you process, a record of all documents records considered for processing will be maintained.

Mass Tax Changes functionality enables you to address all your needs related to changes in Tax applicability and Tax Rates. Using this functionality, you can:
• Recalculate taxes whenever there is a change in the Tax Rates and Tax applicability
• Process Documents selectively
• Process only a particular Type of Documents
• Recalculate taxes for partially processed documents, optionally.
• Map Tax Categories. This selects documents wherever tax category is applicable and replaces it with the new Tax Category.
• Manually added taxes can be overridden.
Recalculating Taxes
Whenever there is change in Tax Rates or Tax applicability that applies to a particular type of documents or documents related to a particular Supplier, you can define the New Taxes, Tax Categories and attach them to a Item Category List. On running the program the system will follow the localization defaulting logic to check the revised tax applicability. The Taxes will be defaulted and recalculated accordingly. Optionally, you can map Tax Categories (in the request parameters) to replace the existing Taxes with the Taxes in the new Category.

The Mass Tax Recalculation feature can be used to apply Additional CVD to existing open transactions.

Maintaining History of Processed Records
After every run of the program, the system administrator can query for the records that are processed and check the old Tax Category and the new Tax Category, error codes for the records that are left unprocessed.

Transactions Handled
Oracle Financials for India is designed to handle tax defaulting and calculation for the transactions entered by the user in Requisitions, RFQ, Quotations, Purchase Orders, PO Releases and Receipts. Apart from the transactions created manually, when a transaction is created based on any other document, Taxes are also copied from the Source Document. This section lists such Documents, Source Documents and the events.

Requisitions
• Default Localization Taxes on creating Requisitions, manually from Requisitions (Localized) window.

• Creation of RFQ from Requisitions (Localized) using Auto Create window.

• Creation of Standard Purchase Order from Requisitions (Localized) using Auto Create window.

• Creation of Standard Purchase Order from Requisitions Using Auto Create window. Taxes will be defaulted on the SPO, though no taxes are attached to Requisition. This will work only when the 'Tax Override' flag is enabled for the Supplier Site.

• Creation of Planned Purchase Order from Requisitions (Localized) using Auto Create window.

• Creation of Blanket Release from Requisitions (Localized) using Auto Create window for Blanket Purchase Agreement.
• Localization Tax defaulting on Requisition import.

RFQ

Default Localization Taxes on creating RFQ from RFQ (Localized) window.*

* Taxes will defaulted only from item class, 3 level tax defaulting is not supported for RFQ.

Quotations

• Default Localization Taxes on creating Quotations, manually from Quotations (Localized) Window

• Creation of Quotation from RFQ (Localized)

• Creation of Standard Purchase Order from Quotations (Localized) using Copy Document (Tools Copy Document)

• Creation of Planned Purchase Order from Quotations (Localized) using Copy Document (Tools Copy Document)

• Creation of Blanket Purchase Agreement from Quotations (Localized) using Copy Document (Tools Copy Document)

Quote Analysis

• Default Localization Taxes on Quote Analysis created from Standard Quotations (Localized)

• Calculate Per Landed Cost on Quote Analysis created from Standard Quotations (Localized)

Standard Purchase Order

• Default Localization Taxes on creating Standard Purchase Order, manually from the Purchase Order (localized) Window

• Creation of Standard Purchase Order from Existing PO using Copy Document

• Creation of Standard Purchase Order based on Catalog Quotation using Catalog (function)

• Creation of SPO from Requisition using Auto Create Window

Planned Purchase Order

• Default Localization Taxes on creating Planned Purchase Order, manually from the Purchase Order (localized) Window.

• Creation of Planned Purchase Order from Existing PO using Copy Document
• Creation of Planned Purchase Order based On Quotation using MRP Workbench, when Approved Supplier List (ASL) is attached to Quotation

**Blanket Purchase Agreement**

• Default Localization Taxes on creating Blanket Purchase Agreement, manually from the Purchase Order (localized) Window

• Creation of Blanket Purchase Agreement from Existing PO using Copy Document

• Creation of Blanket Purchase Agreement from Existing Quotation using Copy Document

**Blanket Release**

• Default Localization Taxes (from Blanket Purchase Agreement) on creating Release, manually from the Release (Localize screen) Window.

• Creation of Blanket Release Based On Blanket Agreement using MRP Workbench, when Approved Supplier List (ASL) is attached to Quotation.

• Creation of Blanket Release FROM Existing Blanket Purchase Agreement using Auto Create against a Requisition.

**Receipts**

• Default Localization Taxes on Receipt, when created from a Standard PO, Blanket Release, Planned Release from, Receipt (Localized) Window.

**Receipts (RMA/ISO)**

• Default Localization Taxes on Receipt (RMA) Created from Sales Order (Localized)

• Default Localization Taxes on Receipt (ISO) Created from Fulfilled Orders (Localized)

**Returns**

• Default Localization Taxes (of Excise Type) on Returns created from Return to Vendor - India window

**Unordered Receipts**

• Default Localization Taxes on Unordered Receipts when matched to a Purchase Order with Localization Taxes.

**Claim CENVAT on Receipt**

Defaulting of Excise Type of Taxes (included in the Receipt) to Claim CENVAT on Receipts screen. This happens only when:

• The CENVAT is not claimed on Receipt.
• Excise tax should be set as 100% CENVAT recoverable.

• EXCISE and MODVAT Flags for the Item are set to 'YES'.

Encumbrance Accounting

India Local taxes are stored separately in India Local tables; this data is not visible to the Base application processes. Hence base application encumbrance processes were not considering India Local taxes while doing the Funds checking or generating encumbrance accounting. Now India Local taxes will be considered in encumbrance accounting as the India Local tax amounts are interfaced into the base application encumbrance processes in a streamlined fashion without any change in the user process flows.

Encumbrance accounting is available for the following events in the P2P cycle:

• Requisitions (External and Internal)
  • Creation of Requisition encumbrance

• Purchase Orders
  • Creation of PO Encumbrance
  • Relieving of Requisition encumbrance (if PO is sourced from a requisition)

• Receipts (if PO line has 'Accrue on Receipt' flag checked)
  • Relieving of PO / Internal Requisition encumbrance
  • PO / Internal Requisition Encumbrance relieving adjustments on Receipt corrections
  • PO Encumbrance relieving adjustments on Returns

• Invoice Validation
  • Creation of Invoice Encumbrance
  • Relieving of PO encumbrance (if PO line has 'Accrue on Receipt' flag unchecked – Period End Accrual)

• Invoice Accounting
  • Relieving of Invoice encumbrance

Funds Available = Budget amount – Encumbrance (till date) – Actual utilization (till date).
Transaction processing is allowed only on the basis of the Funds check control level set up i.e. Absolute (No overspending allowed), Advisory (Raises warning on overspending) or None (Allows overspending).

**Requisition / Purchase Order Funds Checking, Reserve / Approval / Modification**

Requisition / Purchase Order Encumbrance actions such as Funds checking, Reserve, Approval, Modifications and Control actions will include the attached IL Non-Recoverable (NR) taxes also.

Currently no tax modification is allowed if the Requisition / Purchase Order is in 'Approved' or 'Approved and Reserved' status. This restriction will now be extended to the status of 'Reserved' also under the Encumbrance support to ensure that the reserved amount is equal to the non-recoverable taxes attached to the Requisition / Purchase Order line.

India Local taxes are currently attached at the Requisition line / Purchase Order Shipment level only. Encumbrance is calculated and accounted based on the Requisition / Purchase Order Distribution level. Hence the non-recoverable taxes will be apportioned to the distributions, if multiple distributions exist for the line, and the encumbrance amount is calculated. Such apportioning is done through:

- Non-Recoverable Tax amount will be summed up at the line level
- Non-Recoverable Tax amount at the line level will be apportioned to various distribution lines based on the distribution line quantity, whether the value basis for the line is quantity or amount
- Distribution level Non-Recoverable tax amounts will be rounded to 2 decimals and rounding difference if any between the distribution level tax amounts and line level tax amount, will be adjusted against the last distribution line.

**Receiving / Corrections / Returns for Inventory items**

Purchase Order / Internal Requisition encumbrances are reversed on the Inventory items' Receipt Deliver event. Non-recoverable tax amounts of Purchase Order / Internal Requisition distribution that is being received / corrected / returned will be included in the Encumbrance accounting actions of the respective event.

**Note:** Deliveries to Process Manufacturing Organizations do not generate Encumbrance reversal entries since Oracle Process Manufacturing Costing and Sub ledger accounting does not support Encumbrance currently. Hence there will be no support for India Local taxes for Inventory item deliveries to Process Manufacturing Organizations.
Receiving /Corrections /Returns for Expense items with 'At Receipt' accrual method

Purchase Order / Internal Requisition encumbrances are reversed on the Expense Delivery event. Similar to the Inventory destination deliveries, non-recoverable tax amounts of Purchase Order / Internal Requisition distribution that is being received / corrected / returned will be included in the Encumbrance accounting actions of the respective event.

Receiving /Corrections /Returns for Expense items with 'Period End' accrual method

Oracle Financials for India does not support 'Period End' accrual method, as it is not compatible with India Tax Regimes. Hence Oracle Financials for India support is not being provided for this feature.

Invoicing Encumbrance actions

In the Procure to Pay cycle, encumbrance accounting impact is only applicable for PO matched invoices for Expense items with 'Period End' Accrual method. As Oracle Financials for India does not support this accrual method, Oracle Financials for India support is not extended for encumbrance accounting in such an event.

Invoice level encumbrance accounting on invoice validation / invoice accounting will automatically consider the India Local tax distributions as these are created as Invoice distributions.

Encumbrance Reporting

'PO Encumbrance Details' report shall be including the IL non-recoverable tax amounts also with the respective transaction amounts.

Migration / Upgrade Script

If any customer has been using the Encumbrance feature (without the IL support) and then adopts the IL encumbrance support solution, there shall be discrepancies in encumbrance accounting in the following scenarios:

• Purchase Requisition lines with non-recoverable taxes – Reserved before IL encumbrance solution application and Unreserved after IL solution application

• Purchase Requisition lines with non-recoverable taxes – Approved before IL encumbrance solution application and related PO created after IL solution application

• Internal Requisition lines with non-recoverable taxes – Reserved before IL encumbrance solution application and Unreserved after IL solution application
• Internal Requisition lines with non-recoverable taxes – Approved before IL encumbrance solution application and ISO receipt created after IL solution application

• Purchase Order lines with non-recoverable taxes - Reserved before IL encumbrance solution application and Unreserved after IL solution application

• Purchase Order lines with non-recoverable taxes - Approved before IL encumbrance solution application and Receipt created after IL solution application

Documents reserved or approved before IL encumbrance solution application will not have India Local tax amounts in the Encumbrance accounting entries. Hence post-migration to the new solution, it will be ensured that the Encumbrance reversal entries generated for the migrated documents do not include the tax amounts so that there is no discrepancy in the resulting encumbrance accounting.

Setting Up India Local Purchasing

This section describes the setup procedures for India Localization Purchasing. You should have completed the Organization, Inventory and Tax Setups before you start setting up Oracle Financials for India Purchasing.

To set up India Local Purchasing, you must:
1. Define Supplier Additional Information, page 2-29
2. Set up Profile Options, page 2-33
3. Run India Receiving Transaction Processor
4. Run India RG Period Balances Calculation
5. Round off Excise Amount
6. Run India RG Rounding Process

Defining Supplier Additional Information

You need to setup Supplier Additional Information before you start using Oracle Financials for India for Purchase Module. This lets you record the Tax Registration Information, Item Category List and Assessable Price List. This information setup for the Supplier and Supplier Sites will be the basis for Tax defaulting and calculation. The Tax Registration Information will be used for Reporting.

As a part of set up, you need to create separate records for each Supplier with Null Location, where in you need to set the IT/TDS related information pertaining to the Supplier as IT/TDS calculations are not based on Supplier Sites.
You can setup the Supplier Additional Information for a Supplier NULL Site. The information defined in this record will default to transactions created for all Sites. However, if you create this setup for Supplier Sites, then the Information defined there will be the basis for Tax defaulting and calculation.

In the Excise block, you record all Excise related information of the Supplier Site like Range, Division, Commissionerate, ECC Number, Supplier Type and Document Type as these values are used for printing different Excise related reports pertaining to the supplier related transactions.

If the Supplier Site is a Sales Tax registered Site located within the Site, he should give only his LST Number and the CST field should be left as null. Likewise if the Supplier is a Sales Tax Registered Site located outside the State LST field should be null and only his CST details should be recorded. If the Supplier is not registered under the Sales Tax Rules, the user should leave the CST and LST Number fields as Null.

**Important:** Excise zone needs to be filled in order to generate Excise Related reports.

**Prerequisites**

Before you enter the Supplier Additional Information Details, you must:

- Define Organizations
- Define Locations
- Define Organization Additional Information
- Define Taxes
- Define Tax Categories
- Define Items
- Define Item Categories
- Define Supplier, Supplier Sites
- Define Assessable Price Lists

**Navigation:**

India Local Purchasing > India Localization > Suppliers > Supplier Additional Info

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating Unit</td>
<td>You have to select Operating Unit from the LOV.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Vendor Name/Site</td>
<td>You can select the Vendor Name from LOV for whom the Additional Information Regarding Tax are to be defined, the Vendor Number will be defaulted and relevant Vendor Site will be selected from LOV.</td>
</tr>
<tr>
<td>Excise Block</td>
<td></td>
</tr>
<tr>
<td>Excise Range</td>
<td>Use this field to enter Excise Range under which this Supplier's Site falls. This would be printed on all the documents that are required under Excise Act.</td>
</tr>
<tr>
<td>Excise Division</td>
<td>Use this field to enter Excise Division under which this Supplier's Site falls. This would be printed on all the documents that are required under Excise Act.</td>
</tr>
<tr>
<td>Excise Registration Number</td>
<td>Use this field to enter Excise Registration Number of this Supplier’s Site. This would be printed on all the documents that are required under Excise Act.</td>
</tr>
<tr>
<td>Excise Zone</td>
<td>Use this field to review and enter Excise Zone under which this Supplier's Site falls. This would be printed on all the documents that are required under Excise Act.</td>
</tr>
<tr>
<td>Excise Region</td>
<td>Use this field to review and enter Excise Region under which this Supplier's Site falls. This would be printed on all the documents that are required under Excise Act.</td>
</tr>
<tr>
<td>Excise Circle</td>
<td>Use this field to review and enter Excise Circle under which this Supplier's Site falls. This would be printed on all the documents that are required under Excise Act.</td>
</tr>
<tr>
<td>Excise Commissionerate</td>
<td>Use this field to review and enter Excise Range under which this Supplier's Site falls. This would be printed on all the documents that are required under Excise Act.</td>
</tr>
<tr>
<td>Excise EC Code</td>
<td>Use this field to review and enter Excise EC Code of this Supplier’s Site. This would be printed on all the documents that are required under Excise Act.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Document type</strong></td>
<td>You need to specify the Document, which will be supplied by the Supplier/Site. User can specify any duty document name like Invoice, Delivery Challan, Excise Invoice, Excise Challan, Dealer Invoice, Bill of Entry etc. in this field. This information is used for printing CENVAT reports that need to be submitted to the Central Excise Authorities.</td>
</tr>
<tr>
<td><strong>Vendor type</strong></td>
<td>You need to pick the Vendor Type from the pick list. The options available are Manufacturer, Depot, First Stage Dealer, Second Stage Dealer and Importer. This information is used for printing the CENVAT reports that need to be submitted to the Central Excise Authorities.</td>
</tr>
<tr>
<td><strong>Sales Tax Block</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Sales Tax - Central ST Reg. No.</strong></td>
<td>Use this field to review and enter Central Sales Tax Registration Number of this Supplier's Site. This field should be null for those Supplier Sites, which are not registered under Sales Tax Act and for those registered Supplier Sites falling within the state.</td>
</tr>
<tr>
<td><strong>Sales Tax - State ST Reg. No.</strong></td>
<td>Use this field to review and enter State Sales Tax Registration Number of this Supplier's Site. This field should be null for those Supplier Sites, which are not registered under Sales Tax Act and for those registered Supplier Sites falling outside the state.</td>
</tr>
<tr>
<td><strong>Item Category List</strong></td>
<td>The user can enter the Item Category list then for all the items appearing in this list. The taxes lines will be defaulted as per the Tax Category attached to this Item. This is an optional field and if the user decides to enter the tax lines for a Vendor manually, it can be left blank.</td>
</tr>
<tr>
<td><strong>Assessable Value</strong></td>
<td>In case of Excisable products, assessable value on which Excise Duty is calculated is not the basic Sales Price. Then the user need to specify whether Assessable Value for a particular Item have to be considered or not in the price list column of Vendor Information - India Form. Only the Excise Duty will be calculated on Assessable Value and the other Taxes will be actual Invoice Value.</td>
</tr>
<tr>
<td><strong>Invoice Approval block</strong></td>
<td></td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create pre-approved TDS Invoice and Credit Memo</td>
<td>You have to enable this check box at Supplier Site level if you require the Credit Memo and Invoices generated for TDS transactions to be pre-approved. You would also have an option to enter this value at the Supplier Null Site Level. In such a case, the TDS Invoices &amp; Credit Memos created from any of the Sites would be pre-approved. Unless, the setup for a specific Site does not have this check enabled.</td>
</tr>
<tr>
<td>VAT Tax Block</td>
<td>VAT Tax Block</td>
</tr>
<tr>
<td>Reg No</td>
<td>Specify the VAT Registration Number applicable to the Supplier Site</td>
</tr>
<tr>
<td>Assessable Value</td>
<td>You can select from the list of Price Lists. The price specified in the list here would replace the Line Amount while calculating VAT Taxes</td>
</tr>
<tr>
<td>Standalone AP Invoice Block</td>
<td>Standalone AP Invoice Block</td>
</tr>
<tr>
<td>Tax Category</td>
<td>Select this to assign tax categories directly to a supplier site for defaulting of taxes to standalone invoices. This field is enabled only at the supplier site level.</td>
</tr>
<tr>
<td>Service Tax Block</td>
<td>Service Tax Block</td>
</tr>
<tr>
<td>Reg No</td>
<td>Specify the Service Tax Registration Number applicable to the Supplier Site</td>
</tr>
</tbody>
</table>

### Setting Up Profile Options

To use Oracle Financials for India Purchasing, you need to ensure that the Profile Options mentioned below are set up accordingly in the Personal Profiles of Purchasing. These settings are mandatory for using the features of Oracle Financials for India.

- Display the Auto-created Documents in PO: NO
- Display the Auto-created Quotation in PO: NO
- Processing Mode in RCV: Immediate/Online

### India Receiving Transaction Processor

To process pending records, India Receiving Transaction Processor can be submitted
manually or can be scheduled. This will handle following transactions:

- Corrections
- Deliver
- Return to Receiving
- Receiving
- Return to Supplier.

This concurrent program can process in batches when 'RCV: Processing Mode ' profile option is set to 'BATCH'.

This concurrent program can also be scheduled for a particular Inventory Organization, when P_CALLED_FROM is set to JAINPORE in concurrent program definition.

Navigate to India Local Purchasing > Reports > Run > India Receiving Transaction Processor.

India - Concurrent request for defaulting taxes in PO when linked with Quotation

A Purchase Order can be created based on a Quotation using Sourcing rules. In such cases, taxes assigned to a Quotation should be carried to PO. The program 'India - Concurrent request for defaulting Taxes in PO when linked with Quotation' defaults taxes from Quotation to PO.

You can schedule this program so that taxes default on all eligible PO's.

Navigation: India Local Purchasing - Reports - Run - India - Concurrent request for defaulting taxes in PO when linked with Quotation

**India - RG Period Balances Calculation**

This program calculates balances for the CENVAT Taxes. These balances are maintained on a monthly basis. These balances are used in the India - RG 23 Register Reports. *If the balance for the previous month is not calculated before running India - RG 23 Register Report, then India - RG 23 Register Report ends with an error.*

Navigate to India Local Purchasing > Reports > Run > India > RG Period Balances Calculation.

**Parameters**

Register Type: The register Type can either be ‘A’ for Input register and ‘C’ for Capital Goods.

Consolidate Till: This should be last date of the unprocessed month. Any other date will end this program with an error.
Rounding Excise Amounts

This feature is to comply with the rounding of Total Excise Duty on an Excise Invoice. This feature ensures that the Total of Excise Duty in an Excise Invoice is rounded to the nearest rupee.

Prerequisite Setup

You should specify '2' as the Rounding Precision for the Excise Tax that you are defining. For Complete information on Setting up Taxes refer to 'Setting Up Tax Information' section of Oracle Financials for India Implementation Manual.

Specify the Excise Rounding Account for the Organization through the 'Organization Additional Information' screen. For Complete information on Setting up Organization Tax Information refer to 'Defining Organization Additional Information' section of Oracle Financials for India User Reference Manual.

Tax on the Purchase Order and the Receipt is rounded to '2' decimal places.

On CENVAT Claim, the Accounting Entries and the Register updates are made upto two decimal places.

India - RG Rounding Process

This concurrent program creates Rounding Adjustment Entries for the Excise Invoices falling between specified dates.

You should schedule 'India - RG Rounding Process' by specifying the Organization and the Excise Invoice Date Range.

This program creates accounting entries to:

- Dr/Cr CENVAT RM/CG Account
- Cr/Dr Excise Rounding Account

The CENVAT Account will be debited when the Excise Amount on the Invoice is rounded up. The CENVAT account (RM or CG) picked up will be based on the type of Items purchased.

In cases where the Excise Invoice consists of both Raw Material and Capital Goods Purchased, then the rounding amount will be passed to the Register Type specified in the 'India - RG Rounding Process' concurrent request.

Navigate to India Local Purchasing > Reports > Run > India > RG Rounding Process.

Parameters

Organization: Select an Inventory Organization that has been setup for Oracle Financials for India.

Transaction Type: Select the Transaction Type from the LOV for which you wish to process rounding entries.
Register Type: Select either 'A' or 'C'. 'A' Implies 'Inputs' and 'C' implies 'Capital Goods'. This applies only to Excise Invoices including both Inputs and Capital Goods. In such cases, rounding adjustment amount will be passed to the Register you select here.

From Excise Invoice Date: Specify a Date here. The program will show only those Excise Invoices with dates after this date.

To Excise Invoice Date: Specify a date here. The program will show only those Excise Invoices till this date.

In case of CGIN Items, the CENVAT claimed in any year will be rounded to the nearest rupee. In the year subsequent to the year of purchase (and first claim), rounding entry will be created for the total amount and will be passed as and when the Concurrent request is submitted.

### Managing Purchasing Transactions

This section elaborates on the transactions for which you can default and calculate the Localization taxes. This is possible only when you create the transactions navigating through the localization windows.

Purchase Requisition is the one from where the business cycle for all Purchases begins and it is always better to consider all Indian business aspect and tax requirement from the Requisition level itself. The tax and incidental expenses information captured here flows to other documents created based on the Requisition.

To default and calculate localization taxes you have to create a Requisition navigating through Requisitions (Localized) window. India Local Requisition is a view form and the data in this window is populated based on the transaction details entered in Base Applications form and the Tax Setups.

### Creating Requisitions

In India Local Purchasing Responsibility, navigate to the India Local Requisitions window from Requisitions > Requisitions (Localized).

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header Block Number</td>
<td>(Display only)</td>
<td></td>
<td>The Requisition Number is a system-generated number will be displayed after enter and save a Requisition.</td>
</tr>
<tr>
<td>Operating Unit</td>
<td>HELP, EDIT, PICK</td>
<td></td>
<td>You have to select the Operating Unit from the LOV.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Type</td>
<td>(Display only)</td>
<td></td>
<td>The Type selected in the Standard Apps form will be defaulted.</td>
</tr>
<tr>
<td>Preparer</td>
<td>(Display only)</td>
<td></td>
<td>The Preparer’s Name will be displayed here.</td>
</tr>
<tr>
<td>Description</td>
<td>(Display only)</td>
<td></td>
<td>Description of a Requisition will be displayed here.</td>
</tr>
<tr>
<td>Status</td>
<td>(Display only)</td>
<td></td>
<td>The status of the Requisition will be displayed here. (Quick field are Incomplete, In-Process and Approved)</td>
</tr>
<tr>
<td>Total</td>
<td>(Display only)</td>
<td></td>
<td>The Total value of the Requisition including Tax Amount will be displayed here and this field will get updated whenever any change made in the tax calculation.</td>
</tr>
<tr>
<td>Line No</td>
<td>(Display only)</td>
<td></td>
<td>Line Number of a Requisition will be displayed here.</td>
</tr>
<tr>
<td>Item</td>
<td>(Displayed)</td>
<td></td>
<td>The Item selected in the Std Apps Requisition form for this line will be displayed here.</td>
</tr>
<tr>
<td>Description</td>
<td>(Displayed)</td>
<td></td>
<td>The Item Description will be displayed here.</td>
</tr>
<tr>
<td>UOM</td>
<td>(Displayed)</td>
<td></td>
<td>UOM of the entered Item will be displayed.</td>
</tr>
<tr>
<td>Qty</td>
<td>(Display only)</td>
<td></td>
<td>Requisition Quantity will be displayed here.</td>
</tr>
<tr>
<td>Price</td>
<td>(Display only)</td>
<td></td>
<td>Price at which requisition is raised for an Item will be displayed here.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------</td>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Amount</td>
<td>(Display only)</td>
<td></td>
<td>Represents the Material Cost excluding Tax will be displayed here.</td>
</tr>
<tr>
<td>Tax Amount</td>
<td>(Display only)</td>
<td></td>
<td>Tax Amount for an item in a line are defaulted from India Local Tax Details form and this field will get updated whenever any change made in the tax calculation.</td>
</tr>
<tr>
<td>Total Line Amount</td>
<td>(Display only)</td>
<td></td>
<td>Represents the Total Line Amount for a line.</td>
</tr>
<tr>
<td>Footer Block</td>
<td></td>
<td></td>
<td>The information relating to Inventory Module like Destination type, Requester, Organization, Location, Sub-inventory are defaulted from Standard Applications Requisition form.</td>
</tr>
</tbody>
</table>

The information regarding Supplier like Source, Supplier Name, Site, Contact, Phone are defaulted from Standard Applications, Requisition Form.


Click Taxes in the India Local Requisition to open the tax details.

The Tax Lines will default based on the Tax Category attached to the Item Class applicable to the Item or based on the Item Category list attached to the Supplier/Supplier Site. You can add Tax lines manually.

Precedence of taxes will decide the basis for calculating the Tax Amount. You can specify the precedence in the Precedence fields.

**Important:** It is advised that you verify the tax lines and Approve the Requisition; otherwise you cannot change the tax line after Approval of Requisition.

For Excise/CVD related taxes on which credit can be claimed under CENVAT scheme, you need to ensure that appropriate credit percentage is defined in the Tax Definition and the CENVAT credit is considered for deriving the Item Cost while performing a Receipt.
The Vendor Name for a Tax in the Tax Details window will be the same as specified in the header line of a requisition or the Vendor Name specified in the Tax Definition. But, for the Tax lines with Taxes that have Update Vendor Flag enabled, you can Add/Change the Vendor Name in the Tax Details window.

While creating a requisition you can enable the RFQ Required Flag depending upon the type of requisition being entered.

**RFQ (Localized)**

You can create a RFQ from India Local RFQ window. This will enable defaulting and calculation of Localization Taxes. The defaulting is based on the Three-way defaulting logic followed for Oracle Financials for India i.e., based on Supplier, Supplier Site or Item Class. You can alternatively create a RFQ from the Requisitions. The localization taxes flow to RFQs, if such Requisition is created from Requisitions (Localized) window. For the Quotations created from India Local RFQ, taxes flow to the same.

Click Open in the India Local RFQ window to create RFQs in the Standard Applications RFQ window. This will take you to the India Local RFQ window; the information entered in the Standard Applications window would be defaulted here along with the India Local Taxes.

**Creating RFQs**

In India Local Purchasing Responsibility, navigate to the India Local RFQ window from RFQ and Quotation - RFQs (Localized).

Functionality of RFQ's India Localization is similar to Requisition India Localization. You need to follow the regular functionality of Standard Applications while entering data in the Standard Applications RFQ window.

Click Taxes to open the Tax Form to enter the Tax details in the same manner as mentioned in the Requisition form. In India Local Tax Details window the tax lines are defaulted based on the Tax Category attached to the Item Class applicable to the Item or based on the Item Category list attached to the Supplier/Supplier Site. You would also have an Option to Add Tax Lines Manually.

**Quotations (Localized)**

You can create a Quotation by navigating through India Local Quotations window. This would enable defaulting and calculation of Localization Taxes. The defaulting would be based on the Three-way defaulting logic followed for Oracle Financials for India i.e., based on Supplier, Supplier Site or Item Class. You can alternatively create a Quotation from an RFQ. The Localization Taxes would flow to Quotation, if such RFQ is created from RFQ (Localized) window. For the Purchase Orders created from India Local Quotations, taxes would flow to the same.

You can navigate to Standard Applications Quotations Entry window by clicking on the Open button of India Local Quotations. On closing this form after entering and saving
the details, the same would flow to India Local Quotations. The Tax Amounts in this form would default from the India Local Tax Details window.

India Local Quotations is a view form and the data in this window is defaulted from the Standard Applications Quotations and India Local Tax Details.

Creating Quotations
In India Local Purchasing Responsibility, navigate to RFQ’s and Quotations > Quotations (Localized).

Functionality of the India Local Quotations window is similar to India Local RFQ and you need to follow the regular functionality of Standard Applications while entering data in the Standard Applications Quotations form.

Purchase Orders (Localized)
India Local Purchase Orders is designed to meet the requirements related to Tax defaulting and calculation for a purchase transaction. The Purchase Order can be created manually or automatically, based on an existing Purchase Order or based on a Quotation or a Requisition.

Taxes on a Purchase Order are either created:
• Based on the Tax Category attached to the Item, in the Item Category List attached to the Supplier
• Based on the Tax Category attached to the Item, in the Item Category List attached to the Supplier Site
• Based on the Item Class attached to the Item, which, in turn, is attached to a Tax Category
• Tax Lines added manually
• Tax attached to the Requisition, Quotation that is used to auto-create Purchase Order.

In all the cases, you can modify the tax lines.

India Local Purchase Orders is a view form, displays the details entered in the Purchase Orders Standard Applications window, which in turn, is opened navigating through India Local Purchase Orders window. The Tax details in this form are based on the India Local Tax Details.

Creating Purchase Orders
In India Local Purchasing Responsibility, navigate to Purchase Orders > Purchase Orders (Localized).
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header Block</td>
<td></td>
<td></td>
<td>You have to select Operating Unit from the LOV.</td>
</tr>
<tr>
<td>Operating Unit</td>
<td>EDIT</td>
<td>PICK</td>
<td>You have to select Operating Unit from the LOV.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HELP</td>
<td>You have to select Operating Unit from the LOV.</td>
</tr>
<tr>
<td>PO Rev.</td>
<td>(Display only)</td>
<td></td>
<td>The PO Number allotted in the Standard Apps form will be displayed here.</td>
</tr>
<tr>
<td>Type</td>
<td>(Display only)</td>
<td></td>
<td>The PO Type selected in the Standard Apps Form will be displayed here.</td>
</tr>
<tr>
<td>Currency</td>
<td>(Display only)</td>
<td></td>
<td>PO Currency will be displayed here.</td>
</tr>
<tr>
<td>Supplier/Site</td>
<td>(Display only)</td>
<td></td>
<td>Defaulted from Standard Apps PO Forms.</td>
</tr>
<tr>
<td>Ship To / Bill To</td>
<td>(Display only)</td>
<td></td>
<td>Defaulted Ship To / Bill To Inventory Organization Location from Standard Apps PO Forms will be displayed.</td>
</tr>
<tr>
<td>Buyer</td>
<td>(Display only)</td>
<td></td>
<td>Buyer Name will be displayed from Standard Apps PO Forms.</td>
</tr>
<tr>
<td>Status</td>
<td>(Display only)</td>
<td></td>
<td>The Status of the PO will be displayed here.</td>
</tr>
<tr>
<td>Description</td>
<td>(Display only)</td>
<td></td>
<td>Description of the PO is displayed here from Standard Apps PO Forms.</td>
</tr>
<tr>
<td>Amount</td>
<td>(Display only)</td>
<td></td>
<td>Defaulted the PO Material Cost from Standard Apps PO Forms.</td>
</tr>
<tr>
<td>Tax Amount</td>
<td>(Display only)</td>
<td></td>
<td>The Total Tax Amount for the PO will be displayed here.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Total</td>
<td>(Display only)</td>
<td></td>
<td>The Total PO Value will be displayed here.</td>
</tr>
<tr>
<td>Line Block</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line No</td>
<td>(Display only)</td>
<td></td>
<td>Auto generated Line Number will be displayed here.</td>
</tr>
<tr>
<td>Shipment No</td>
<td>(Display only)</td>
<td></td>
<td>Auto generated Shipment Number will be displayed here.</td>
</tr>
<tr>
<td>Item / Description</td>
<td>(Display only)</td>
<td></td>
<td>The Item selected in the Std Apps PO form for this line and its Description will be displayed here.</td>
</tr>
<tr>
<td>UOM/Qty</td>
<td>(Display only)</td>
<td></td>
<td>UOM and Qty entered for an Item will be displayed.</td>
</tr>
<tr>
<td>Price</td>
<td>(Display only)</td>
<td></td>
<td>Price for the Item in a line will be displayed here from Std Apps PO Form.</td>
</tr>
<tr>
<td>Ship To Organization</td>
<td>(Display only)</td>
<td></td>
<td>Displayed from Standard Apps PO Forms.</td>
</tr>
<tr>
<td>Bill To Location</td>
<td>(Display only)</td>
<td></td>
<td>Displayed from Standard Apps PO Forms respective the Operating Unit.</td>
</tr>
<tr>
<td>Need-By date</td>
<td>(Display only)</td>
<td></td>
<td>Defaulted from Standard Apps PO Forms.</td>
</tr>
<tr>
<td>Line Amount</td>
<td>(Display only)</td>
<td></td>
<td>Represents the material cost excluding tax and defaulted from Std Apps PO Form.</td>
</tr>
<tr>
<td>Tax Amount</td>
<td>(Display only)</td>
<td></td>
<td>Tax Amount for a Item in a line are defaulted here. India Local Tax Details Form and this field will get updated whenever any change made in the Tax Calculation.</td>
</tr>
</tbody>
</table>
The following is the Tax form for the above Purchase Order India Localization and which shows all the taxes related to that PO and the user can add or delete a tax lines depending upon his requirement. Through Apply Button the user can save the tax lines.

Navigate to Purchase Orders > India Local Purchase Order > Taxes

- Taxes can be defaulted based on the Three-way defaulting logic used by Oracle Financials for India.
- You can modify the defaulted Taxes.
- Taxes can be modified only before approving the Purchase Order.
- If you need to change the taxes on approval of the Purchase Order, the solution suggested is to create a purchase order revision by modifying the PO lines and then change the Taxes.

**PO Releases (Localized)**

This feature is designed to take care Taxes for a PO Release against Blanket Agreement and Contract Agreement. Standard Applications PO Releases Form will be invoked through Open button and after filling up the inventory details for a Blanket or Contract Agreement save and close the Standard Application Form.

**Creating PO Releases**

In India Local Purchasing Responsibility, navigate to Purchase Orders > Releases (Localized).

The user can move to the Tax Form and verify whether the tax lines are defaulted as per the tax specified in the Blanket or Contract Agreement.

- Whenever you change the quantity in Releases (Base Apps screen), the user needs to navigate to Releases (Localized) screen and should click Apply in India Local Tax Details so that the taxes are
PLA Manual Entry

PLA Manual Entry is a View / Entry form that can be used to View/Enter the Manual PLA transaction. It displays on query all the transactions that have an entry in the PLA Register. Each Inventory Organization is considered as Excise Unit. Thus, you need to specify the Organization Name and Location both for querying & for making manual entries into the Register. Querying can be done based on certain fields on the Entry Block and also Transaction Details block.

India Local Purchasing > Registers > PLA Manual Entry

Use the details given here to create a manual entry in PLA Register. The screen's field wise description and its feature are described below for ready reference.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating Unit</td>
<td>(Required)</td>
<td>EDIT</td>
<td>You have to select Operating Unit from the LOV.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HELP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PICK</td>
<td></td>
</tr>
<tr>
<td>Organization</td>
<td>(Required)</td>
<td>EDIT</td>
<td>You need to specify the Inventory Organization Name to which PLA Register entries are to be updated. Where you would like to use this window to view the existing PLA Entries, specify an Inventory Organization for which you would like to view the PLA Register balance and information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HELP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PICK</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>(Required)</td>
<td>EDIT</td>
<td>You need to specify the Location for the Organization you have chosen. The display of existing entries or creation of a new entry would be for the chosen Organization and Location.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HELP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PICK</td>
<td></td>
</tr>
<tr>
<td>Serial No</td>
<td>(Required)</td>
<td></td>
<td>It is system generated Serial Number after entering a transaction.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------</td>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transaction Date</td>
<td></td>
<td></td>
<td>The Transaction Date should be entered here. If you would like to view existing PLA Register entries for a particular day then you can specify the Transaction Date.</td>
</tr>
<tr>
<td>Transaction Type</td>
<td></td>
<td></td>
<td>The transaction types of either Receipt, Issue should be chosen here.</td>
</tr>
<tr>
<td>Item</td>
<td></td>
<td></td>
<td>You need to specify Item for which the Receipts/Issue entry is going to be passed.</td>
</tr>
<tr>
<td>Customer/Vendor Name</td>
<td></td>
<td></td>
<td>Enter Customer/Vendor Name should be entered here and the manual entry is being made in PLA Register.</td>
</tr>
<tr>
<td>Customer/Vendor Location</td>
<td></td>
<td></td>
<td>Enter Customer / Vendor Location should be entered here.</td>
</tr>
<tr>
<td>Transaction Detail Block</td>
<td></td>
<td></td>
<td>This block has Transaction details with respect to Reference Number, Invoice No, and Invoice Date.</td>
</tr>
<tr>
<td>Excise Amount</td>
<td></td>
<td></td>
<td>Excise utilization details should be entered here.</td>
</tr>
<tr>
<td>Excise Cess</td>
<td></td>
<td></td>
<td>Enter Excise Cess Amount in this column.</td>
</tr>
<tr>
<td>CVD Cess</td>
<td></td>
<td></td>
<td>Enter CVD Cess Amount in this column.</td>
</tr>
<tr>
<td>Account</td>
<td></td>
<td></td>
<td>You need to enter the Account Code to which the Excise Amount on Receipt transaction has to be credited. This account would be debited with the Excise Amount on Issue transaction.</td>
</tr>
</tbody>
</table>
### Receiving Corrections

- On correcting a base Receiving Transaction, Oracle Financials for India creates accounting and Register Entries to adjust taxes assigned to the Receipt.

- To correct a Receiving Transaction, navigate to the Receiving Corrections screen and query for the Receipt. The lines fetched will depend on the status of the Transaction. In case you have received, delivered and Returned to Vendor then you would have three lines here.

- You will have to Correct the Deliver transaction before correcting the Receiving Transaction. Similarly the Return to receiving has to be corrected before correcting Return to Vendor.

- You have to select the line to be corrected and enter the correction quantity. On saving this transaction, system would create a record in the base Receiving Table. On doing this 'India - Receiving Transaction Processor for Corrections' concurrent request would be submitted by Oracle Financials for India. This request will create adjustment Accounting, Costing and Excise Register Entries.

- The program will not create CENVAT adjustments to Receipts on which CENVAT is claimed in the previous months.

- In cases where AP Invoice is created before making a Correction entry, the Invoice has to be adjusted by creating a corresponding Debit Memo. On matching this Debit Memo to the Receipt, Oracle Financials for India concurrent program 'To Insert Tax Distributions' would be submitted to fetch Tax Amounts from the Receipts, in proportion to the Quantity matched.

### Using India - Mass Tax Update

In Oracle Financials for India, the Mass Tax update program is designed to handle
impacts of Tax Rate revisions and Tax applicability changes for the following documents:

- Internal Requisitions
- Purchase Requisitions
- Request for Quotations
- Quotations
- Standard Purchase Orders
- Planned Purchase Orders
- Blanket Purchase Agreements
- Blanket Releases
- Sales Orders
- Contract Purchase Orders

On running this concurrent, taxes will be recalculated for all selected OPEN documents.

**Prerequisite Setups:**

You must list changes in Taxes that will impact the Open transactions. Following Changes/Additions will be made to current Tax Setup:

- Tax Rate Changes / New Tax: Wherever, the Tax Rates have changed or a new Tax has been introduced, a New Tax code has to be defined. A new Tax Category has to be defined with the New Tax Code. For all the Item, Supplier combinations where the new rate is applicable, the Tax Categories in the Item Category list would be changed appropriately.

- Change in Classification: Identify Items with changes in classification. Identify applicable New Tax Category. Replace Assign the new Tax Category to Items on the Item Category list.

**India - Mass Tax Recalculation**

After completing the above setup changes, submit the Mass Tax Changes Concurrent request. To submit the request navigate to India Local Purchasing > Submit: Requests > Mass Tax Updates.

Choose the 'Document Type' (mandatory), From Date, To Date (Mandatory) and any other parameter fields (optionally). On successful completion of the Request, the Taxes
on the Open transactions in the chosen Document Type would be recalculated, where applicable. The Taxes on the Tax Details window will be updated with the Taxes from the revised Tax Categories. The Tax Amount and the Total Amount on the Document header and lines would be recalculated to reflect the latest Tax Amounts. All Tax lines, manually added before the update, will be retained if these lines do not have precedence on any other lines (except the Base Item Line) and neither does any other Tax line have precedence over these lines. All documents with manual tax lines having precedence on other lines, will not be processed and audit tables will be updated accordingly.

Successful completion of the Concurrent Request updates the audit tables with the documents that are affected, the Old Tax Category and the New Tax Category. It will also list the documents that could not be updated and needs manual intervention.

If you do not wish to change the Supplier Additional Information and the Item Category Lists, then the Old Tax Category and the New Tax Category Codes can be chosen in the Parameters window. On running the concurrent request, all lines that have Old Tax Category Codes will be replaced with the new Tax Category Codes.

### India- Mass Tax Recalculation - Request

**Document Type**

The User can select from the List of Document Type. This is a mandatory parameter.

**From Date**

Enter a Date Value in this field. The Transaction lines with the document date created on or after this date would be considered for processing. This is a mandatory parameter.

**To Date**

Enter a Date Value in this field. The Transaction lines with document date created on or before this date would not be considered for process. This is a mandatory parameter.

**Supplier**

The LOV for this parameter would display the Suppliers with transactions. This field is enabled only if Purchase Type of document is chosen in the Document Type field.

**Supplier Site**

The User can choose Supplier Site ID from the LOV. The LOV is restricted to the value chosen in the Supplier field.

**Customer**

The LOV for this parameter displays the Customers with transactions. This field is enabled only if Sales Type of document is chosen in the Document Type field.

**Customer Site**

The User can choose Customer Site ID from the LOV. The LOV is restricted to the value
chosen in the Customer field.

**Old Tax Category**

The User can choose Tax Category from the LOV. The Transaction lines with this Tax Category is considered for processing. This Tax Category will be replaced with the value chosen in the 'New Tax Category' parameter and the Taxes will be recalculated accordingly.

**New Tax Category**

The User can choose Tax Category from the LOV. The Tax Category on the Transaction lines chosen for processing will be replaced with the value chosen in this field and the Taxes will be recalculated accordingly.

**Document No.**

Enter a Transaction Number of the document type of the transaction that you would restrict the processing to.

**Blanket Release No.**

Enter the Release Number to be processed.

**Document Line No.**

Enter the corresponding Document Line Number to be processed.

**Shipment No.**

Enter the corresponding Shipment Line Number to be processed.

**Override Manual Taxes**

On selecting 'Yes' in this field you would be restricting the processing to documents that do not have Manual Tax Lines. Else, all selected documents would be processed and any Manual Lines on these document would be deleted and new tax lines that would be defaulted for the transaction would be restricted to the taxes that are included in the Tax Category.

**Commit Interval**

Enter a Numeric Value here. The program will commit the processed records in groups defined by this Number.

**Process Partial**

Select 'Yes' or 'No'. All OPEN Documents including those Partially Processed, will be considered for update if you selected 'Yes'.

**Update Tax Category**

On completion of Patch application the Tax Category will default on the existing documents. The Tax Categories would be defaulted, based on the existing Localization setup.

Oracle Financials for India is designed to handle tax defaulting and calculation for the
transactions entered by the user through Requisitions, RFQ, Quotations, Purchase Orders, PO Releases, Receipts, Sales Orders and RMA. The Defaulting would be based on the Three-way defaulting logic followed for Oracle Financials for India i.e., based on Supplier/Customer, Supplier Site/Customer Site or Item Class. However, following would be exceptions:

- **Internal Requisitions (Localized)**: in case of Internal Requisitions created from Requisitions (Local) the taxes would be defaulting only from the Item class applicable to the lines.

- **Blanket Releases (Localized)**: Taxes would be flowing from the Blanket Purchase Agreement

- **Internal Sales Order**: Internal Sales Order would be created on importing Internal Requisitions.

### Receipts (Localized)

The Localization Taxes defined in the Purchase Order will be defaulted and the procedure for Accounting / treating different Localization taxes can be handled at the time of Receipt. For this, user need to Open Receipt through Receipt Localized window. By activating the "NEW" button, user will be taken to the Standard Receipt screen where he needs to match the receipt with a Purchase Order.

Navigate to India Local Purchasing - Receiving - Receipts (Localized) and use the India Local Receipts India Localization form to view and create receipts.

You can view receipts by querying any field like Receipt Number, Receipt Date, Shipment Number, Shipment Date, Excise Invoice No, Excise Invoice Date, Supplier Name, Inventory Organization.

1. Click New to create receipts. Enter the Header information for the receipt.

2. In the Transaction Type field, select either Express or Non Express. Selecting Express ensures that a single India Receiving Transaction processor concurrent request is submitted to Process all Receipt lines. The default value in this field is blank, which is equivalent to Non Express.

After the Receipt is created, Receipt details will be auto-queried to Receipt localized window where details of the Excise Documents need to be captured. Excise Invoice Number and Excise Invoice Date is captured in this screen. If you wish to avail CENVAT credit in Auto mode immediately on Receipt, you must check claim CENVAT on Receipt Flag.

**Important:** Whenever credit on Capital Goods is availed, you can claim 50% of Credit at the time of Receipt by specifying 'Yes' in the 'Claim CENVAT on Receipts'. The balance Credit can be availed using 'Claim
CENVAT on Receipt' screen.

If a Receipt has multiple lines and share the same Excise Information, then the user can fill these details at the Header level and click on populate defaults button to default the details to shipment lines. You also have an option to change these details at line level.

If there are Multiple Excise Documents for a Single Receipt, user can incorporate this information in the line level also. The user need to enter the Line information for the shipment line and save the data as per the regular standard Applications functionality.

Through the Tax button the user can view the Tax lines for the Receipt, which is as per the PO terms and the user is empowered to modify the tax lines at the times of Receipts. Only the modified tax lines for which the tax Vendor is other than the PO Vendor in the Receipts will be considered for AP Invoices raised for receipts for the respective tax and Third Party Vendor.

**Important:** The standard applications ‘Receiving Transaction Processor’ needs to be completed before the localization screen reflects the taxes.

On Receipt, all modifications are permitted to the tax lines provided the Receipt Modify Flag in Additional Organization Information screen is enabled. The modifications include:

- Deletion of a tax line
- Addition of a tax line
- Modification of a tax amount
- Modification of the amount computed for any tax line
- Changing the vendor on receipt for tax lines if allowed by tax definition.
- Changing the currency applicable to the particular tax line if allowed by tax definition.

**Important:** These modification of tax lines can be done only before closing of Receipt (Localized) form, once the Receipts (localized) form is closed, the corresponding accounting entries will be passed and the System won’t allow the user to modify the tax lines.

The Total Amount will get updated with the Revised Amounts on saving the screen. However, on change of the Tax Amount the dependent tax amounts would not be re-calculated.

Once the Receipt localization screen is closed, India Receiving transaction processor concurrent program is submitted. This concurrent updates Excise Registers and creates
Accounting Entries. In case of a Trading Organization RG 23D Register Entry and corresponding Accounting Entries are created by this Concurrent Request.

In case of a Manufacturing Organization, updates to Excise Registers and creates Accounting Entries would be based on the Receipt Routing Type and the value entered for Claim CENVAT in the Receipt.

- If Receipt Routing is Standard and Claim CENVAT on Receipts is 'Yes', Excise Quantity and Duty Registers are updated and Accounting Entries are passed. None of the Excise Registers will be updated when Claim CENVAT is Set to 'N'.

- If Receipt Routing is Direct Delivery and Claim CENVAT on Receipts is ‘Yes’, Excise Quantity and Duty Registers are updated and Accounting Entries are passed. If the Claim CENVAT is Set to 'N' then, Receiving and Delivery Accounting Entries will be passed but Excise Registers will not be updated.

You can check for the successful completion of the above concurrent program by navigating through view request.

**Auto Accounting using NEW Button**

A new Receipt can be created without closing Receipt localized form. This can be done using NEW button on India Local Receipts screen. Following message is populated when the user tries to create a new receipt using this path.

Accounting Entries and Excise Register Entries for the Receipt would be generated on accepting the message. You need to ensure that the taxes are updated before creating a new Receipt.

**View Accounting**

An option to view the Accounting Entries for Tax Accounting generated during the receipt is being provided. You can use this option to verify accounting entries are generated for the Receipt properly. Navigate to Tools > View accounting.

In the Transaction Type segment, you can select the transaction like Receive, Deliver, RTV etc. and look for the accounting entries generated.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Type</td>
<td></td>
<td></td>
<td>The user can look for Accounting Entries generated for different account types like CENVAT, Receiving etc.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Account Mode</td>
<td></td>
<td></td>
<td>Accounting can be viewed for logistic transactions like Receipts, Return to Vendor etc. For Receipts Type of transactions, Account mode will be regular and for Return related transactions account mode will be reversal.</td>
</tr>
<tr>
<td>UOM</td>
<td></td>
<td></td>
<td>This field displays the Unit of Measurement in which the transaction was recorded.</td>
</tr>
<tr>
<td>Line number</td>
<td></td>
<td></td>
<td>This field displays the Accounting Transactions lines for which view Accounting Entries are displayed. By using the down/up arrows, user can view the Accounting Entries for different lines in the Receipt.</td>
</tr>
<tr>
<td>Transaction Date</td>
<td></td>
<td></td>
<td>This field displays the date on which Accounting Transaction is recorded.</td>
</tr>
<tr>
<td>Quantity</td>
<td></td>
<td></td>
<td>This field displays the Quantity Received against the transaction</td>
</tr>
</tbody>
</table>

- In the transaction segment, system displays the GL Account, the Debit and Credits against the Accounting line, Transaction Currency, Currency Conversions, Period Name, Created Date and Transaction Date.
- This feature is provided to enable the user to confirm that the receipts are accounted properly. User is provided an option to view the localization tax entries in the "T" Shape accounts form.

**View Registers**

On completion of the Receipt Accounting process, by navigating through the Tools - View Register Menu, the user can check the updates in the CENVAT Registers. In the Receipt Segment, Receipt related information like Transaction Date, Unit of
measurement, Quantity Received, Sub Inventory and Lines Numbers are displayed. This functionality facilitates the user to confirm updation of excise registers on completion of a Receipt transaction and the amount flown into the CENVAT Registers.

In the Register segment, by using the TAB key, user can move to part I, part II, RG 23 D and PLA registers as per the transaction parameters.

* PLA will be updated only for RTV Transactions when preference is set to 1 or when sufficient balances are not available.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register Type</td>
<td></td>
<td></td>
<td>This field displays the Register in which the transactions are recorded. This will be updated based on the values for the Items defined in the Item Class. This can be CENVAT on input (RG 23 A), CENVAT on Capital Goods (RG 23 C) or Dealers CENVAT Register (RG 23 D)</td>
</tr>
<tr>
<td>Serial Number</td>
<td></td>
<td></td>
<td>This field displays the Serial Number in the respective Register under which the transaction was recorded.</td>
</tr>
<tr>
<td>UOM</td>
<td></td>
<td></td>
<td>This displays the Unit of Measurement in which Excise Registers got updated. Always Excise Registers will get updated only in the primary Unit of Measurements and users need to take enough care while defining the conversion factor from primary Unit of Measurement to secondary Unit of Measurement.</td>
</tr>
<tr>
<td>Invoice Number</td>
<td></td>
<td></td>
<td>This field displays the Excise Document Number that was recorded for the transaction</td>
</tr>
<tr>
<td>Invoice Date</td>
<td></td>
<td></td>
<td>This field displays the Duty paying Document Date on which credit was availed.</td>
</tr>
</tbody>
</table>
### Vendor Name

This field displays the Vendor/Customer Name with whom the transaction was performed.

### Apply BOE to Receipts

In all Receipts where tax of type Customs Duty or Additional Customs Duty is defined in the tax lines, the system will not permit saving the record, without applying Bill of Entry (BOE). BOE Button will be enabled only when the receipts tax lines have tax type like Customs Duty, Additional Customs Duty.

Payment towards Customs Duty need to be done through BOE Invoices in AP Module (Invoices- BOE Invoices) At the time of Receipt, Items need to be matched with the payment of Customs Duty paid on the item. This is done by matching the BOE Invoice with the Receipt. Matching is done on Item-to-Item basis. Each Item where Customs type of taxes are attached, Choose ‘Apply BOE’ to indicate against which Bill Of Entry the Duty Amount was paid.

The Customs Duty is paid to Customs Authorities on the Bill of Entry Value before the Receipts of Goods. You can record the BOE details using BOE Invoices feature in India Local Payables. This will automate creation of a AP Invoice for the Customs Authority. BOE created through BOE Invoices can be applied against a Receipt by using the 'Apply BOE' form.

In the Header Block

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customs</td>
<td>(Displayed)</td>
<td></td>
<td>The amount of Customs Duty in the Receipt Tax Line will be defaulted here.</td>
</tr>
<tr>
<td>CVD</td>
<td>(Displayed)</td>
<td></td>
<td>The amount of CVD in the Receipt Tax Line will be defaulted here.</td>
</tr>
<tr>
<td>Total Customs Duty</td>
<td>(Displayed)</td>
<td></td>
<td>Total of Customs Duty and CVD in the Receipt Tax line will be defaulted here</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------</td>
<td>----------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Total Amount Applied</td>
<td>(Displayed)</td>
<td></td>
<td>The Total Amount of Customs Duty will be displayed after entering the line data.</td>
</tr>
</tbody>
</table>

**In the Line Level**

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOE No</td>
<td>(Displayed)</td>
<td></td>
<td>All the BOE No’s raised in AP but not yet applied will be displayed here.</td>
</tr>
<tr>
<td>Import Dept. Sl. No.</td>
<td>(Displayed)</td>
<td></td>
<td>Value entered in the corresponding field of the BOE Payment Screen would appear in this field.</td>
</tr>
<tr>
<td>Customs Authority</td>
<td>(Displayed)</td>
<td></td>
<td>You can view the Customs Authority Name in this field.</td>
</tr>
<tr>
<td>BOE Amount</td>
<td>(Displayed)</td>
<td></td>
<td>BOE Amount will be displayed here.</td>
</tr>
<tr>
<td>Amount written off</td>
<td>(Displayed)</td>
<td></td>
<td>If part of the BOE Amount is already written off through the Written off functionality in Accounts Payable, then the same amount will be displayed here.</td>
</tr>
<tr>
<td>Amount already applied</td>
<td>(Displayed)</td>
<td></td>
<td>If part of the BOE Amount has been applied, then the same will appear here.</td>
</tr>
<tr>
<td>Amount to be applied</td>
<td>(Enterable)</td>
<td></td>
<td>The user can enter the amount to be applied, which can not exceed the Total Customs Amount. The User need to save this screen after entering the above information. Once a BOE is fully applied it won’t be appearing in this form for application.</td>
</tr>
</tbody>
</table>
Unordered Receipt

At the time of Receipt of Items it may not be possible to ascertain the Purchase Order against which an Item is being received. In such case you enter an Unordered Receipt.

In respect of Unordered Receipt, no taxes are defaulted for the receipt since the purchase order against which the receipt is done is unknown.

Unless the Receipt is matched to Purchase Order the Taxes does not default.

While matching Receipt with PO, Oracle Financials for India will provide the taxes from the Purchase Order and these taxes cannot be modified.

The option to claim CENVAT on receiving is not available on the Unordered Receipts screen. It is available while matching Receipt with PO. The Excise Records are updated for Material Receipt in RG23A/C Part I only on matching the Receipt to a Purchase Order.

No Accounting Entries are generated at the time of Receiving. The Accounting Entries are generated at the time of matching with Purchase Order.

You can also access the 'Claim CENVAT on Receipts' screen under Inventory Receiving to generate the Excise Entries and accounting for CENVAT if you do not claim CENVAT Credit while matching Receipt with PO.

After matching the Unordered Receipts, the User has to query the Receipt Number in the Receipt Localization screen and BOE has to be applied for the Receipt if the receipts tax line are having customs type of taxes.

Match Unordered Receipt

The Unordered Receipts needs to be matched to a Purchase Order later. CENVAT credit on Unordered Receipts can be claimed only once the Receipt is matched with a Purchase Order. In the flex field, user needs to select India Receipt as the context value and record the Excise Duty paying document details.

Navigation: Receiving - Match Unordered Receipts

The Excise related information like Excise Invoice, Excise Invoice Date and Claim CENVAT on Receipts would be entered. Receipt Localized window.

* CENVAT Credit cannot be taken for Unordered Receipt on Receipt of the Goods. Credit can be taken only on matching the Unordered Receipts with a Purchase Order. Query the Receipt from Receipt localized window and provide Excise information to claim. The provision for Tax Corrections at the time of Receipt is not available for Unordered Receipts. Hence User need to ensure that the Purchase Order has the actual tax figures.

India Localization Receipt Details

India Local Receipt Details form summarizes taxes, Excise Registers (both quantity and
amount), Accounting, Costing and BOE details of receiving transactions.
1. Navigate to India Local Purchasing > Receiving > Receiving Transactions Summary.
2. Query the transaction to display the Receiving Headers Summary window.
3. Click 'Transactions' to display the Receiving Transaction Summary window.
4. Click View > Zoom to display India Local Receipt Details window.

In the Header Block

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipt Number</td>
<td>Receipt Number that is queried will be displayed here.</td>
</tr>
<tr>
<td>Unit of Measurement</td>
<td>UOM of the Item will be displayed here.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity of the Item received will be displayed here.</td>
</tr>
<tr>
<td>Transaction Type</td>
<td>Transaction Type will be displayed here.</td>
</tr>
<tr>
<td>Tax Amount</td>
<td>Total Tax Amount of the Receipt Tax line will be displayed here.</td>
</tr>
<tr>
<td>Cenvat Amount</td>
<td>Cenvat Amount of the Receipt Tax Line will be displayed here.</td>
</tr>
<tr>
<td>Item Class</td>
<td>Item Class of the Item Received will be displayed here.</td>
</tr>
<tr>
<td>Excise Invoice Number</td>
<td>Excise Invoice Number of the Vendor will be displayed here.</td>
</tr>
<tr>
<td>Excise Invoice Date</td>
<td>Date of the Excise Invoice will be displayed here.</td>
</tr>
<tr>
<td>Processing Status</td>
<td>This field displays process status related to Non-Cenvat Taxes included in the Receipt. This field displays following values: E - Implies error during processing Y - Implies successful completion of the program X - means that taxes are not applicable to the receipt line O - Implies missing setup</td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Cenvat Process Status</td>
<td>This field displays process status related to cenvat taxes included in the receipt. This field displays following values:</td>
</tr>
<tr>
<td></td>
<td>E - Implies error during processing</td>
</tr>
<tr>
<td></td>
<td>Y - Implies successful completion of the program</td>
</tr>
<tr>
<td></td>
<td>X - means that taxes are not applicable to the receipt line</td>
</tr>
<tr>
<td></td>
<td>O - Implies missing setup</td>
</tr>
<tr>
<td></td>
<td>XT - Implies that correction could not be completed due to change in the period of receipt and the correction.</td>
</tr>
<tr>
<td>Process Message</td>
<td>This message displays process message for Non-Cenvat Taxes. The message depends on the value in the Processing status.</td>
</tr>
<tr>
<td>Cenvat Process Message</td>
<td>This message displays process message for Non-Cenvat Taxes. The message depends on the value in CENVAT Process status field.</td>
</tr>
</tbody>
</table>

In the Line Level

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Tab</td>
<td></td>
</tr>
<tr>
<td>Line Number</td>
<td>Serial Number</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the Tax will be displayed here.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of Tax as selected while Defining Tax.</td>
</tr>
<tr>
<td>Rate Type</td>
<td>Rate type will be displayed here.</td>
</tr>
<tr>
<td></td>
<td>It can either be Percentage Adhoc or UOM Depending on the Tax Definition</td>
</tr>
<tr>
<td>Rate</td>
<td>Rate of Tax as defined while Tax Definition.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Precedence / UOM</td>
<td>Precedence used to calculate Taxable Basis. This field would be populated for percentage-based taxes.</td>
</tr>
<tr>
<td></td>
<td>In case of UOM based Taxes, Unit of Measure assigned to the Tax Code will be shown.</td>
</tr>
<tr>
<td>Currency</td>
<td>Tax Currency will be displayed here.</td>
</tr>
<tr>
<td>Amount</td>
<td>Amount of Tax will be displayed here.</td>
</tr>
<tr>
<td>Recovery %</td>
<td>Recovery Percentage as specified while Defining Tax.</td>
</tr>
<tr>
<td>Recoverable</td>
<td>The value in this field would be set to 'Yes' whenever the Tax is Recoverable in the context of the transaction.</td>
</tr>
<tr>
<td></td>
<td>In cases where a Recoverable Tax is not recovered due to certain Item and Organization setup, this field would reflect 'No' irrespective of the value in the 'Recovery %' field.</td>
</tr>
<tr>
<td>Modified Manually</td>
<td>This will be 'Yes' when the Tax Amounts or the Taxes have been modified by the user.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Name of the Vendor will be displayed here.</td>
</tr>
<tr>
<td></td>
<td>In case of the First Party Taxes, the PO Vendor Name would be displayed here.</td>
</tr>
<tr>
<td></td>
<td>In case of Third Party Taxes, the Tax Vendor Name would be displayed here.</td>
</tr>
<tr>
<td>Vendor Site</td>
<td>Vendor Site Name will be displayed here.</td>
</tr>
<tr>
<td></td>
<td>In case of the First Party Taxes, the PO Vendor Site would be displayed here.</td>
</tr>
<tr>
<td></td>
<td>In case of Third Party Taxes, the Tax Vendor Site would be displayed here.</td>
</tr>
<tr>
<td>Organization</td>
<td>Name of the Organization will be displayed here.</td>
</tr>
<tr>
<td>Location</td>
<td></td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Fin Year</td>
<td></td>
</tr>
<tr>
<td>Register</td>
<td>Register type will be either RG23A or RG23C.</td>
</tr>
<tr>
<td>Sl No.</td>
<td>Serial Number of the entry in the Quantity Register will be displayed here.</td>
</tr>
<tr>
<td>Creation Date</td>
<td></td>
</tr>
<tr>
<td>Excise Invoice Number</td>
<td>Excise Invoice Number of the Vendor will be displayed here.</td>
</tr>
<tr>
<td>Excise Invoice Date</td>
<td>Date of the Excise Invoice will be displayed here.</td>
</tr>
<tr>
<td>Transaction UOM</td>
<td>UOM in which the Transaction has been made will be displayed here.</td>
</tr>
<tr>
<td>Primary UOM</td>
<td>Primary UOM assigned to the Organization item will be displayed here.</td>
</tr>
<tr>
<td>Quantity Received</td>
<td>Quantity Received will be displayed here.</td>
</tr>
<tr>
<td>Amount Register Tab</td>
<td></td>
</tr>
<tr>
<td>Organization</td>
<td>Name of the Organization will be displayed here.</td>
</tr>
<tr>
<td>Location</td>
<td>Location of Receipt will be displayed here.</td>
</tr>
<tr>
<td>Fin Year</td>
<td>Financial year in which the receipt was created will be displayed here.</td>
</tr>
<tr>
<td>Register</td>
<td>Register type will be either RG23A or RG23C.</td>
</tr>
<tr>
<td>Sl No.</td>
<td>Serial number of the entry in the amount register will be displayed here.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>Creation date of the CENVAT Register Entry will be displayed here.</td>
</tr>
<tr>
<td>Excise Invoice Number</td>
<td></td>
</tr>
</tbody>
</table>
**Field Description** | **Description**  
--- | ---  
Date of the excise invoice will be displayed here.  
Debit | Amount debited to the register through the transaction will be displayed here.  
Credit | Amount credited to the register through the transaction will be displayed here.  
Accounting Tab  
Transaction Date  
Creation Date | Creation date of the Accounting Entry will be displayed here  
Account | Number of the account in which the effect of the transaction is going will be displayed here.  
Account Type | This field displays the class of accounting entries.  
Period | Accounting period  
Debit | Amount Debited will be displayed here.  
Credit | Amount Credited will be displayed here.  
GL Posting Status | Displays the status of posting to GL  
Sub Ledger | Displays the status of posting to Ja_In_Rev_Journals  
Date of the receipt transaction will be displayed here.  
This field displays the class of accounting entries.  
Organization | Name of the Organization will be displayed here.  
Costing Tab  
Creation Date | Date of the receipt transaction will be displayed here.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>Number of the Account in which the effect of the transaction is going will be displayed here.</td>
</tr>
<tr>
<td>Period</td>
<td>Displays Accounting Period</td>
</tr>
<tr>
<td>Debit</td>
<td>Amount Debited will be displayed here.</td>
</tr>
<tr>
<td>Credit</td>
<td>Amount Credited will be displayed here.</td>
</tr>
<tr>
<td>Organization</td>
<td>Name of the Organization will be displayed here.</td>
</tr>
<tr>
<td>BOE Tab</td>
<td></td>
</tr>
<tr>
<td>Customs Authority</td>
<td></td>
</tr>
<tr>
<td>Site</td>
<td>Site of customs authority will be displayed here.</td>
</tr>
<tr>
<td>Agent Name</td>
<td></td>
</tr>
<tr>
<td>Number of the BOE</td>
<td>Number of the BOE will be displayed here.</td>
</tr>
<tr>
<td>Amount</td>
<td>Amount applied against the BOE will be displayed here.</td>
</tr>
</tbody>
</table>

**Claim CENVAT on Receipts**

If you do not wish to take credit on inputs or capital goods immediately on Receipt, you can claim the credit from the Claim Credit on Receipts window. In the case of capital goods, balance Credit of 50% that can be availed in the Next Financial Year can be claimed through this screen.

While taking Credit on Capital Goods through this windows the Accounting Entries mentioned will get generated.

This form can be used to claim CENVAT Credit on Receipt if the CENVAT Credit is not taken at the time of Receipt because of non-availability of adequate information. Further, for Capital Goods the CENVAT Credit could be taken only after installation and thus this feature of claiming CENVAT at a later stage after the Receipt is provided.

1. Receiving and CENVAT entries are not generated for Receipts with routing as Standard, unless CENVAT Credit is claimed.
2. Ensure that CENVAT is claimed before the Purchasing and Inventory periods are closed.

Navigate to India Local Purchasing > India Localization > Receipts > Claim Modvat on Receipts > Find Receipts India Localization.

This Query Find window provides following checkboxes.

- Last Years claim only
- CGIN only
- 50% Claim only.

This feature would help you in querying eligible Receipts for Claim CENVAT, in a Batch Mode. This feature would be of great use to claim remaining CENVAT on Capital Goods (CGIN Items) purchased during the Previous Year.

Following would be the behavior in each combination of options above:

- **Combination A**: 1+2+3: If the user checks all the fields then, all receipt lines pertaining to purchase of CGIN Items in the previous year would be fetched. Only those CGIN purchases for which 50% of CENVAT has been claimed in the previous year would be fetched.

  **Combination B**: 1: All purchases made in the previous year, for which CENVAT is available for claim would be fetched. This would include both RMIN and CGIN Items.

  Rather this is an exclusion of Receipt lines in the current year (pending CENVAT Claim).

  **Combination C**: 2: All CGIN purchases with CENVAT attached, not claimed completely would be fetched. This would include receipt lines of the current and also the previous year.

  **Combination D**: 3: All CGIN purchases for which first 50% CENVAT has been claimed would be fetched. This would be irrespective of the year.

  **Combination F**: 1+3: All CGIN purchases made in the previous year for which first 50% CENVAT has been claimed in the previous year would be fetched.

  **Combination G**: 2+3: All CGIN purchases for which first 50% CENVAT has been claimed would be fetched. This would be irrespective of the year in which the goods are purchased.

The below mentioned screen will be used to claim CENVAT for the Receipts. These Receipts should have associated tax lines and CENVAT = 'Yes'

Navigate to India Local Purchasing > India Localization > Receipts > Claim Modvat on Receipts > Find Receipts India Localization.

Receipt Number (Displayed)
The Receipt Number for which CENVAT is to be claimed.
Receipt Date (Displayed)
Date on which the receipt has been entered.
Item (Displayed)
The Item for which the Receipt has been entered.
Description (Displayed)
Description of the Item.
Item Class
The Item Class of the Item will be defaulted in this field. By default, this will be CGIN or CGEX as defined in the Item Category flex-field.
Total CENVAT Amount
This field displays the total CENVAT Credit available on the Item
Claimed CENVAT Amount
If partial Credit is availed on the Receipt, this field displays the amount of credit that is already availed.
Claimed CENVAT Percentage
This field displays the Percentage of Credit availed on the item for the Receipt under reference.
CENVAT percentage to be availed
This field displays the percentage of credit which is available for claiming credit
Original Quantity
This field displays the Quantity of Goods received against Receipt under reference
Location
This field displays the Location in which the Receipt under reference was performed
Vendor Changed
You need to check this field whenever, the Vendor Name and Vendor Site has to be changed. This would enable the Vendor Name and Vendor Site field.
Vendor Name (Displayed)
Name of the Vendor from whom the Inventory is received. The PO Vendor would be displayed in this field. However, in case you have received the goods from a different Vendor, then you can update the Vendor Name with the Vendor from whom you have received the goods. To do this, check the ‘Vendor Changed’ Checkbox. Select a new Vendor and Vendor Site.
Vendor Site (Displayed)
Name of the Vendor Site from whom the Inventory is received. The PO Vendor Site
would be displayed in this field. However, in case you have received the goods from a
different Vendor, then you can update the Vendor Name with the Vendor From whom
you have received the goods. To do this, check the 'Vendor Changed' Checkbox. After
you update the Vendor Name you can select the Vendor Site in this field.

Excise Invoice No (Required) ENTER
You have to enter the Excise Invoice Number.
Excise Invoice Date (Required) ENTER
Date of the above Excise Invoice Number.
Claim CENVAT (Required) CHECK BOX
You have to enable this check box to take CENVAT credit on a particular Receipts
Unclaim CENVAT (Required) CHECK BOX
You have to enable this check box to take unclaim CENVAT credit on a particular
Receipts.
Check All
Click this field to select all the Receipt Lines for processing.
Clear All
Click this field to deselect all the Receipts.
Unclaim All
Click this field to Unclaim all the Receipts and load Excise Amount to Item Cost.
Claim
Click this button, process the selected Receipt Lines. A single concurrent would be fired
to process all the selected Lines.
Unclaim
Click this button, process the selected Receipt Lines for Unclaim. A single concurrent
would be fired to process all the selected Lines.

You can select lines one at a time by Clicking on 'Unclaim CENVAT' checkbox on the
line. Else, you can check the 'Unclaim All' checkbox on the header.

All selected lines are processed for Unclaim on clicking on the 'Unclaim' button.

1. Oracle Financials for India supports Receipts corrections with
   IN60106. Entries to adjust taxes would be automated on saving
   Receipt corrections. Hence the 'Modify' facility has been removed
   from Claim CENVAT on Receipts' screen.

2. You cannot claim CENVAT for a receipt if the same combination of
   Excise Invoice Number, Excise Invoice Date has been used for
another Receipt created in the current Organization from the same Vendor Site.

CENVAT Credit on Capital Goods

At the time of taking CENVAT Credit on Capital Goods, the user can define the percentage of CENVAT Credit the user wants to take immediately on Receipt of the Goods. For using this functionality, the user needs to carry out the steps mentioned below.

Following setups are mandatory for availing partial Credit on Capital Goods and to Claim the balance later.

Item should be classified as Excisable, Modvatatable and Item class should be CGIN or CGEX.

After creating the Receipt, Excise Document details need to be provided in Receipt localized window. These values can also be filled in at the Receipts Line level. If "Claim CENVAT on Receipt" is checked, RG 23 C Part II Register Entries would be created for 50% of CENVAT applicable to the Receipt Line. else, if you don't check will defer the claim of CENVAT. In such cases, you need to follow the "Claim CENVAT on Receipts" process (as specified in the previous section of this Chapter).

Remaining 50% of CENVAT Credit arising from the Capital Purchase can be claimed during the following year

• In case of Return of the Capital Goods to Supplier, you can create a Return only after claiming the remaining 50%. This can be claimed in the same Financial Year. Hence, you should ensure that the total CENVAT is claimed before saving an RTV Transaction.

• You can find the CENVAT Credit he can avail by running India CENVAT report. This report is available in India Local Purchasing Responsibility.

• In the Additional Organization. Information Screen, the user need to key in an account to which all pending CENVAT Credit need to be posted and it will be tracked. This account is being identified as "CENVAT Receivable Account"

Unclaim CENVAT

CENVAT can be claimed only on Receipt of documentary evidence indicating the Excise Duty Liability incurred by the Shipping Organization. There would be situations where the Organization might not receive such documentary evidence. In such cases
the Excise Duty amount has to be included the Item Cost and the record should be eliminated from the list of records that have to be processed for CENVAT Claim.

In case the Item is Inventory Item then, such CENVAT Amount should be added to Item Cost if the costing method is 'Average'. The same should be accounted as Purchase Price Variance, where the costing method is STANDARD. If the item is EXPENSE then the CENVAT amount needs to be added to Expense Account.

An option has been provided in the 'Claim CENVAT on Receipts' screen, where the user can identify the Receipt lines that have to be eliminated from the CENVAT Claim processing. Such records would be eliminated from CENVAT Claim processing & excise duty related to such records would be included in the Item Cost.

Navigate to India Purchasing > India Localization > Receipts > Claim CENVAT on Receipts

Through the above find Receipts Form you can find the Receipt for which you will like to unclaim CENVAT. After entering the required fields the “find” button has to be clicked to fetch the existing records for the criteria entered.

In the Claim CENVAT on India Local Receipts screen you can select all lines that you would like to Unclaim and eliminate them from further process of CENVAT Claim.

You can select lines one at a time by Clicking on ‘Unclaim CENVAT’ checkbox on the line. Else, you can check the ‘Unclaim All’ checkbox on the header.

All selected lines are processed for Unclaim on clicking on the ‘Unclaim’ button.

Returns to Vendor

A Return to Vendor transaction has to be created by the user Navigate from Return to Vendor India screen

When you create a return for material that has CENVAT applicability then you need to select Generate from process action LOV. This would ensure appropriate accounting for CENVAT taxes.

A Batch Number will be generated based on which 'India - Return to Vendor' Report can be taken.

Navigate to India Local Purchasing > India Localization > Receipts > Return to Vendor (India) > Return.

After entering the required criteria - Excise Invoice Number, Batch Number and VAT Invoice Number, click Find to fetch the records depending on the criteria entered.

Quantity (Required)
The Quantity to be returned is entered in this field.

UOM (Required)
The Unit of Measure of the Item to be returned.

Return to (Required)
Destination of the Item to be returned whether to receiving or to Supplier

Supplier/Location (Conditionally Required)

Enter Location if the return to is receiving and if it is Supplier field will display name of the Supplier.

Return type to Reason (Optional)

This is available from the Details tab of the Receiving Returns of the base form.

After entering all the required fields save record. After saving the transaction navigate back to Return to Vendor-India to default the details.

Select Process action from the LOV and click on default button to default the action details to shipment lines.

On saving the record, Accounting Entries and Entries in RG23A-Part I & II or RG23C-Part I & II and PLA are created depending on the Item Class and Type of Organization.

In case of Manufacturing Organizations, the Duty Registers selected depends upon the preferences set up done in the Additional Organization Info screen. If PLA is set as the last preference and the item returned is a capital good (CGIN Item) then, balance in RG 23C Part II would be considered first. PLA would be updated only if there no adequate balance in RG 23C Part II. However, balance in RG 23A Part II registers will not be considered.

RG 23D Register would be updated for Trading Organizations.

On completion of RTV transaction, the relevant excise registers will be updated and the print of the duty-paying document can be taken.

**Return to Vendor in the Case of a Trading Item**

Return to Vendor of a Trading will be done in the Standard Application form itself and the respective Issue entries will be passed in the RG23D Register and the same can be viewed through Transaction type Return to Vendor.

**Return to SSI Vendor**

Return to Vendor of a SSI would require a change in the rate of CENVAT Duty. To enter the revised Duty applicable to the Return, you can query an Existing Return transaction using Return to Vendor (India) screen. Here you have an option to specify the Revised Rate / Amount. Only Excise and Education CESS taxes will be displayed.

Navigate to India Local Purchasing > India Localization > Receipts > Return to Vendor (India) > Inquiry.

**Approval Workflow for Purchasing Documents with Localization Tax details**

Oracle Financials for India now enables reporting and display of India taxes in
purchasing approval workflow notifications. India taxes are included in the following:

- Purchase order, requisitions, and releases workflow notifications
- Total amount reported on workflow notifications
- Approval limit in the workflow hierarchy
- Change order workflow

In addition, you can modify the tax amount, precedence, vendor, and vendor site information at the time of approval.

**Inquiry**

**Requisition Summary (Localized)**

Use this View Requisition Summary to review a particular Requisition (Localized) by specifying its Number. All the Requisitions will be viewed if the user does not specify a single Requisition PO Number. By pressing the New Requisition button the user can create a new Requisition also.

**Viewing Requisition Summary**

In Oracle Financials for India, navigate to the India Local Requisitions Summary window from India Local Purchasing > India Localization > Requisitions > Requisition Summary (Localized).

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requisition Number</td>
<td></td>
<td></td>
<td>The user need to specify the Requisition Number which he wants to review through this View Requisition Summary form otherwise all the Requisition will appear in the summary.</td>
</tr>
<tr>
<td>Preparer</td>
<td></td>
<td></td>
<td>The user need to review all the requisition prepared by a person, then by specifying the Name of the Preparer in this column he can get a summarized report on all Requisition raised by that Preparer.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Approval Status</td>
<td></td>
<td></td>
<td>If the user wants view all the Requisitions with a particular Approval Status (the Quick field for Approval Status are Rejected, Require Re-approval, Returned then he can specify that and view the summary report.</td>
</tr>
<tr>
<td>Order Number</td>
<td></td>
<td></td>
<td>The user can view the Requisition summary report for a particular purchase order by specifying the Order Number here.</td>
</tr>
<tr>
<td>Type</td>
<td>(Optional)</td>
<td></td>
<td>By specifying the Requisition type like Purchase or Internal, he can view the reports of all Requisitions raised for a particular Type.</td>
</tr>
<tr>
<td>Requester</td>
<td>(Optional)</td>
<td></td>
<td>By specifying a particular Requester Name, the user can view all the requisitions raised by that Requester.</td>
</tr>
<tr>
<td>Item</td>
<td>(Optional)</td>
<td></td>
<td>By specifying a particular Item, the user can view all the requisitions raised for that Item.</td>
</tr>
<tr>
<td>Supplier</td>
<td>(Optional)</td>
<td></td>
<td>By specifying a particular Supplier Name, the user can view all the requisitions raised for that Supplier.</td>
</tr>
</tbody>
</table>

If the user wants to view all the Requisitions then he need not to specify any of the above field for querying and can blind query through the Find button.

**Note:** The Assessable Value used for tax calculation falling under Excise/VAT regime is retrieved from Assessable Price list based on Item Category.

**Quote Analysis (Localized)**

You can use this feature to analyze your quotations. By navigating through Quote
Analysis (Localized) you can view the Per Landed Unit Cost (for the item) including Localization Taxes.

Through this form the user can view the Quotations (Localized) raised by a specific query or a blind query.

**Viewing Quotations**

In Oracle Financials for India, navigate to India Local Purchasing > India Localization > Quotations > Quote Analysis (Localized).

Click Find without supplying values for any field to view all Local Quotations. You can further sort the results by specifying particular fields in the form like RFQ, Supplier, Quotation and respective quotations can be viewed.

*Note:* Only Non-recoverable portion of the taxes will be considered for calculation of per landed unit cost.

**Purchase Order Summary**

Use this View Purchase Order Summary to view a particular Purchase by specifying its Number and all the Purchase Orders will be viewed if the user does not specify any of the field. The user can do new release for a PO through New Release button and the user can create a new Purchase Order through the New PO button.

**Viewing Purchase Orders**

In Oracle Financials for India, navigate to India Local Purchasing > India Localization > Purchase Orders > PO Summary (Localized).

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchase Order Number</td>
<td>The user need to specify the Purchase Order Number for which he wants to review through this View Purchase Order Summary Form.</td>
</tr>
<tr>
<td>Release Number</td>
<td>The user need to the review all the Purchase Order Released under a Blanket Agreement, then by specifying the Release Number in this column he can get a summarized report on all Purchase Orders raised.</td>
</tr>
<tr>
<td>Supplier</td>
<td>By specifying a particular Supplier, the user can view all Purchase Orders raised for that particular Supplier.</td>
</tr>
</tbody>
</table>
**Field Description** | **Description**
---|---
Ship To-Org | By specifying a particular Ship To Inventory Organization Name, the user can view the entire PO raised for that Inventory Organization.
Bill To | By specifying a particular Bill To Site Name of an Inventory Organization, the user can view all the PO's raised for that Bill to Location.
Type | By specifying the Purchase Order Type like Standard, Blanket Order or Contract Agreement, he can view the report of all Purchase Order raised for a particular Type.
Item | By specifying a particular Item, the user can view all the purchase orders raised for that Item.
Ship To | By specifying a particular Ship To Site Name of an Inventory Organization, the user can view all the PO's raised for that Ship To Location.
Buyer | By specifying a particular Buyer Name, the user can view all the PO raised for that Buyer.

**Important:** On Clicking Open Button in the PO Summary (Localized) window, Purchase Orders, Base Applications window would be opened.

The following column will be displayed in this Summary screen. The field wise description of the form is given below for ready reference.

**Field Description** | **Description**
---|---
PO Number | Purchase Order Number will be displayed
Release Number | The Release Number for the Purchase Order will be displayed.
Line Number of the PO | Line Number of the Purchase Order will be displayed.
Shipment Number of the PO | Shipment Number of the Purchase Order is displayed.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of the PO</td>
<td>Type of the Purchase Order will be displayed in this field.</td>
</tr>
<tr>
<td>Item</td>
<td>Item Code of the Item is displayed.</td>
</tr>
<tr>
<td>Item Description</td>
<td>Item description is displayed</td>
</tr>
<tr>
<td>UOM</td>
<td>Unit of the Measurement is displayed in this field.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity transacted will be displayed in this field.</td>
</tr>
<tr>
<td>Currency</td>
<td>The Currency in which the transaction got recorded will be displayed.</td>
</tr>
<tr>
<td>Price</td>
<td>Transaction Price is displayed in this field.</td>
</tr>
<tr>
<td>Amount</td>
<td>Quantity multiplied by Price will be displayed.</td>
</tr>
<tr>
<td>Tax Amount</td>
<td>Tax Amount will be displayed in this field.</td>
</tr>
<tr>
<td>Line Total</td>
<td>Total of the Line Amount will be displayed in this field.</td>
</tr>
<tr>
<td>Ship To Location</td>
<td>This field displays the Location to which the goods will be shipped.</td>
</tr>
<tr>
<td>Supplier Name</td>
<td>Name of the Supplier will be displayed in this field.</td>
</tr>
<tr>
<td>Supplier site</td>
<td>Supplier Site with which the transactions are to be made will be displayed.</td>
</tr>
<tr>
<td>Authorization Status</td>
<td>This field displays the Authorization Status of the document.</td>
</tr>
<tr>
<td>Need by Date</td>
<td>Need by Date for the item will be displayed in this field.</td>
</tr>
<tr>
<td>Buyer Name</td>
<td>Name of the Buyer will be displayed in this field.</td>
</tr>
</tbody>
</table>

**Retroactive Pricing**

In some industries, it is a common practice for buyers and suppliers to agree on an interim price for a new part while negotiations for a final price are still in progress.
Purchase orders for the new part are placed and payments made based on this interim price. In many cases the final price resulting from the negotiation process takes effect retroactively from an agreed upon date. The effect of this retroactive price change is that existing blanket releases for the item need to be priced again and invoices adjusted for price corrections along with the tax impact.

The Retroactive Pricing function allows price revision events to be propagated from the blanket agreement to the downstream documents relating to that agreement such as releases or standard purchase orders. Such price modifications on purchasing documents have a direct impact on the taxes applicable to the transactions.

The retroactive function lets you recalculate India taxes on downstream transactions.

**Prerequisites**

1. Set the PO: Allow Retroactive Pricing of POs profile options to the following values:

<table>
<thead>
<tr>
<th>Profile Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Releases Only</td>
<td>Processes only releases or standard purchase orders that have not been received nor invoiced</td>
</tr>
<tr>
<td>All Releases</td>
<td>Consider all releases in the appropriate status irrespective of whether they have been received or invoiced</td>
</tr>
</tbody>
</table>

   **Note:** The retroactive pricing is disabled if you set the value to Never.

2. Uncheck Use PO Encumbrance on the Financials Options window, Encumbrance tab.

   Navigation - India Local Purchasing > Oracle Purchasing > Setup > Organizations > Financial Options

**Applying the Retroactive Pricing**

In Oracle Payables, you first change the prices and run the 'Retroactive Price Update of Purchasing Documents' concurrent request to apply the revised prices to the existing purchase orders or releases. Once retroactive prices are applied, the tax amounts based on the item price need to be recalculated.

To recalculate the tax amounts, run the 'India Retroactive Tax Update of Receipts' concurrent request with the parameters described in the following table:
### India Retroactive Tax Update of Receipts Concurrent Request Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Name</td>
<td>Name of the supplier.</td>
</tr>
<tr>
<td>Vendor Site</td>
<td>Vendor sites are displayed according to the vendor selected.</td>
</tr>
<tr>
<td>Agreement Number</td>
<td>The agreement number is displayed according to the vendor and vendor site selected.</td>
</tr>
<tr>
<td>Effective From</td>
<td>Enter an effective date for the retroactive pricing.</td>
</tr>
<tr>
<td>Cenvat Action</td>
<td>Claim or unclaim tax benefits.</td>
</tr>
<tr>
<td>Supplementary Excise Invoice Number</td>
<td>Supplementary Excise Invoice number.</td>
</tr>
<tr>
<td>Supplementary Excise Invoice Date</td>
<td>Supplementary Excise Invoice date.</td>
</tr>
<tr>
<td>VAT Action</td>
<td>Claim or unclaim VAT.</td>
</tr>
<tr>
<td>Supplementary VAT Invoice Number</td>
<td>Supplementary VAT Invoice Number.</td>
</tr>
<tr>
<td>Supplementary VAT Invoice Date</td>
<td>Supplementary VAT Invoice Date.</td>
</tr>
<tr>
<td>Process Taxes for Downward Revision</td>
<td>Select Y or N to process taxes for downward revision or not.</td>
</tr>
</tbody>
</table>

The India Retroactive Tax Update of Receipts concurrent request will do the following:

- Update receipt tax amounts in accordance with the price update.
- Create accounting entries for the tax amount changes due to the price update.
- Update the recovery register (Cenvat or VAT claim) automatically if the Cenvat or VAT action is set to Claim and the Supplementary Invoice number is specified. In case of excise goods, the Rg23 Part II A register is updated for raw materials and the Rg23 Part II C register is updated for capital goods with the tax amount with a distinct serial number. If the revision results in price increase, then you avail the additional credit.
- Cenvat or VAT unclaim is done automatically if the Cenvat or VAT action is set to
UnClaim. If it is downward revision of price, then it results in debit entry in the respective registers.

**Note:** Skip this process if the price changes in BPA or GPA that does not have any related document like POs, release, and receipts

The retroactive price change is not applicable in the following cases:

1. The tax amount is calculated based on Assessable values such as Excise or VAT.
2. The tax is a UOM based tax.
3. The tax type is Adhoc.
4. The tax is third party type.

**Reports**

This section provides overview and detailed descriptions of these reports:

- India - Purchase Register Report
- India Receiving Accounts
- India - Purchases Report - This report lists Purchases made Outside state, unregistered dealer or within state. Report can be submitted using Parameter, "Report For". Based on the selection report is generated.
- PLA Register Report
- RG 23A Part-I Report
- RG 23A Part-II Report
- RG Part-I Report
- RG 23C Part-II Report
- India - CENVAT Monthly Return - Inputs
- India - CENVAT Monthly Return - Capital Goods
- India - CENVAT Monthly Return - Abstract
- OSP Pending Dispatch Report
- OSP Pending Receipt Report
• OSP Stock Register
• Outside Processing Challan

India - Purchase Register Report

This report provides details of all purchases made for a vendor or for all the vendors for a given period. This report is based on the AP Invoices created for the purchases.

Report Submission:

Use the Submit Requests (India Local AP & PO Module Only) form and enter India - Purchase Register Report in the Name field to submit the report.

Report Parameters:

If you purchase for a specific vendor, then you can enter the name, else purchase for all the vendors will be reported.

If vendor name is specified in the above parameter, then the respective vendor number will be defaulted.

Period of Report (Required)

Enter the period for which you wish to take the Purchase Report for.

Report Headings:

Report headings provide you with general information about the contents of the report. Oracle lists Company Name and Operating unit information based on User parameter input.

Column Headings:

Sl. No.
Serial Number of the Line details will be reported.

Voucher No
Purchase Invoice Voucher Number will be reported

Vendor Name
Name of the Vendor will be reported.

Bill No & Date
Supplier Bill No & Date will be reported

PO Number & Date
Purchase Order Number matched to the Invoice.

Remarks
Remarks appearing in the Purchase Voucher will be reported

Currency
Transaction Currency will be reported.

**Net Amount**
Purchase Invoice Line Amount will be reported.

The following taxes in a purchase invoice will be reported.

**Excise Duty**
Excise Duty amount associated in the transaction.

**Customs Duty**
Custom Duty Amount associated in the transaction.

**LST (Local Sales Tax)**
Sales Tax Amount associated in the transaction.

**Insurance**
Insurance Tax Amount associated in the transaction.

**Freight**
Freight Tax Amount associated in the transaction.

**Octroi**
Octroi Tax Amount associated in the transaction.

**VAT Tax**
Value Added Tax Amount associated in the transaction.

**Service Tax**
Service Tax Amount associated in the transaction.

**Other (Other taxes if any)**
Other Tax Amount associated in the transaction.

**Total Amount**
Total of the Purchase Invoice will be reported.

**India Receiving Accounts**

**Report Submission:**
Use the Submit Requests (*India Local PO Module*) form and enter **India - Receiving Accounts** in the Name field to submit the report.

**Report Parameters:**

**Organization Code (Optional)**
Organization Code, for which you wish to take the Receiving Accounts report for.

**Receipt Number (Optional)**
Receipt Number of the above Organization, you wish to display the transaction details or to display all Receipt Numbers.

**Line Number (Optional)**

This parameter is specific to the above parameter. Line Number of the above receipt, you wish to view the transaction details or all Line Numbers of the above receipt will be displayed.

**Account Type (Optional)**

Account Type, you wish to display transaction details of particular Account Type or to display all Account Types details

**Transaction Type (Optional)**

Select the Transaction for which you want to generate the report type or to display all Transaction Type details.

**From Date (Optional)**

Date to print all the transaction details starting with the entered date.

**To Date (Optional)**

End Date to restrict the transactions till this date.

**Report Headings:**

Report Headings provide you with general information about the contents of the report. Oracle lists organization information based on user parameter input.

**Column Headings:**

**Organization Code**

Code of the Organization will be reported.

**Receipt Number**

Receipt Numbers will be reported.

**Line Number.**

Line Numbers of each transaction will be reported.

**Item Description**

Item details on which transactions has done will be reported.

**Transaction type**

A specific Transaction Type for which the report is printed.

**UOM**

Unit of Measure used in transaction will be reported.

**Quantity**

Quantity received in each transaction will be reported.
Account Type
Account Type used in each transaction will be reported.

Account Mode
Account Mode used in each transaction will be reported.

Account
General Ledger Account to track the accounting entries for a specific account.

Amount (Dr)
Column representing amount debited.

Amount (Cr)
Column representing amount credited.

Currency Code (Dr)
Currency used in transaction will be reported.

Currency Conversion Rate
Currency Conversion Rate used in the transaction will be reported if MRC is used.

Period
Period in a financial year will be reported.

Creation Date
Date on which the transaction was created.

Report Summary:
This section of the report lists the net activity of all accounts according to the transaction type.

Account
General Ledger Account to track the accounting entries for a specific account.

Transaction Type
Transaction Type of particular type will be reported.

Total Amount (Dr)
Total Amount debited for one particular transaction of the account.

Total Amount (Cr)
Total Amount credited for one particular transaction of the account.

Net Activity
Total of amount debited and amount credited for a particular account.

Total Net Activity for All Accounts
Total of amount debited and amount credited for all accounts.

**Report Order:**

Report is printed in the order of Receipt Number, Line Number, and Transaction Type for the selected Organization.

**India - Purchases Report**

Use India Purchases Report to generate transaction details for Purchases made Outside the State, Within the State and Unregistered Dealers.

**Report Submission:**

Use the Submit Requests (India Local PO Module) form and enter India - Purchases Report in the Name field to submit the report.

**Report Parameters:**

**Report For (Required, Default)**

Single Report can generate transactions carried Outside the State, Within the State, and Unregistered Dealers based on this parameter.

**Organization (Required)**

Select the Organization for which you wish to print the report.

**Location (Optional)**

Select the location for which you wish to print the report.

**Supplier**

Select the supplier if you wish to generate the report for a specific supplier.

**Supplier Site**

Select the Supplier if you wish to generate the report for a specific Supplier Site.

**Start Date**

Date Range to specify from which date these transactions needs to be picked.

**End Date**

Date Range to specify till which date these transactions needs to be picked.

**Report Headings:**

Provide you with general information about the contents of the report. Oracle lists organization information based on user parameter input.

**Columns Headings:**

**Name of Vendor**

Name of Vendor from whom the purchase was made.

**Sales Tax Registration No. of Vendor**
Sales Tax Registration No. of Vendor as entered in vendor entry form.

**Invoice Number**
Invoice Number of the purchase.

**Invoice Date**
Invoice Date of the Purchase.

**Invoice Amount**
Gross Amount as entered in Invoice.

**Sales / VAT Tax Rate**
Sales Tax Rate for the particular Invoice Line.

**Sales / VAT tax Amount**
Total Sales Tax Amount for the ST rate for the Invoice.

**Report Totals**
Invoice Total & Sales Tax total for the chosen period.

**Report Summary:**
This section of the report lists the summary (Tax summary) of Rate wise total for Sales Tax.

**Total for Tax Type @ rate %**
Total for the Sales Tax Rate for the chosen period.

**Tax Total**
Total Tax for the chosen period.

**Report Order:**
Report is printed in the order of Vendor Name, Invoice Date, and Tax Rate for the selected Organization.

**India PLA Register Report**
This report gives you complete details of Personal Ledger Account as per prescribed format specified by Central Excise Act. Format and columns of this report is same as specified by the Central Excise Act.

Use the Request Transaction Reports form and enter *India PLA Register Report* in the Name field to submit the report.

**Organization (Required)**
Enter a Organization, you wish to take the PLA Report for.

**Location (Required)**
Enter a Location, you wish to take the PLA Report for.
Transaction From/To Date (Required)

Oracle Financials for India allows the user to print selectively the transactions from a given date onwards.

Report Headings:

Report headings provide you with general information about the contents of the report. Oracle lists information as given in the report format of PLA Register.

Column Headings:

Sl. No.
Serial Number of the Register maintained in the order of transactions.

Date
Transactions Date.

Document No
Localization prints TR6 Challan Number.

Document Date
Localization prints TR6 Challan Number.

Basic Excise Duty
Localization prints cr_other_ed for Excise Duty.

Special Excise Duty
Localization prints cr_other_ed.

Additional Excise Duty
Localization prints cr_additional_ed.

Invoice No.
Localization prints dr_invoice_id.

Invoice Date
Localization prints dr_invoice_date.

Debit Excise Duty Amount
Derived as dr_basic_ed + dr_additional_ed + dr_other_ed.

Balance
Derived as cr_basic_ed + cr_additional_ed + cr_other_ed - dr_basic_ed - dr_additional_ed - dr_other_ed.

Central Excise Reports

All these Reports related Central Excise Act will be available in India Local INV, PO, AP, OE, & AR Modules in the respective report requests.
India RG 23A Part-I Report

This report gives you the Stock Account of 'Inputs' for use in or in relation to the manufacture of 'Final Products' and complete Quantitative Details as per format specified by Central Excise Act for an Inventory Organization and its Location. Format and columns of this report is as same as specified by the Central Excise Act.

Report Submission:

Use the Request Transaction Reports form and enter India RG 23A Part I Report in the Name field to submit the report.

Report Parameters:

Organization (Optional)
Enter the organization, you wish to take the RG Report for.

Location (Optional)
Enter a location, you wish to take the RG Report for.

Transaction From / To Date (Required, Default)
If the user wants to take report for a specific period, then he has to specify the period.

Report Headings:

Report headings provide you with general information about the contents of the report. Oracle lists information as given in the report format of RG Registers.

Column Headings:

Sl. No.
Serial Number of the Register for the Organization and Location, selected.

Date
Date of the Transaction seen in the Register.

Description of Inputs received.
Item Description for the Transaction will be seen in the Register.

Quantity Received
Quantity Received for the Transaction will be seen in the Register.

Bill of Entry No. & Date
Fields Receipt Number and Receipt Date are concatenated and printed.

Name & address of manufacturer
PO Vendor’s Name and Address.

Range and Division
Taken from the master data for the particular vendor.
Issued for use in - Chit no. and date
Blank.

Issued for use in - quantity

Issues for Clearance - AR-1 / GP-1 No. & Date

Issues for Clearance - Quantity
Sales Invoice quantity.

Otherwise - Document Id and Date

Otherwise - Quantity

Balance Quantity
Derived as sum (Received quantity - Goods issue quantity - sales invoice quantity - other document quantity).

Officer's Initials
Blank

Remarks

India RG 23A Part-II Report
This report provides you with the information that would be required to meet the Duty Register requirements specified under the CENVAT Credit Rules 2004.

This report can be submitted both for Raw Material and Capital Goods. You can also generate the report for a given date range.

Report Submission:
Use the Request Transaction Reports form and enter India RG 23A Part II Report in the Name field to submit the report.

Report Parameters:

Organization (Required, Default)
Enter the organization, you wish to take the RG Report for.

Location (Required, Default)
Enter a location, you wish to take the RG Report for.

Register Type (Required, Default)
Select the Register Type here. Select ‘A’ for Raw Material and ‘C’ for Capital Goods

Transaction From Date (Required, Default)
Enter the begin date for the report.

Transaction To Date (Required, Default)
Enter the end date for the report.
Report Headings:
Report headings provide you with general information about the contents of the report. Oracle lists information as given in the report format of RG Registers

Column Headings:
Sl. No.
Serial Number is dynamically generated when the reported is submitted.
Date
Date of the Transaction seen in the Register.
Opening Balance
Opening balance for Excise Duty Amount.
Opening Balance Edu. Excise
Opening balance for Education Cess Duty Amount.
Opening Balance Edu. CVD
Opening balance for CVD Education Cess.
ECC Code No of the Supplier
This field displays the ECC Number of the Supplier Site from where the inputs are received.
Range & Division
Duty Credited - Additional Duty
Total Credit Available -
Derived as opening balance + cr_basic_ed + cr_additional_ed + cr_other_ed .
Debit - Document No. & Date
Debit - (Basic + Additional)
Officer's Initials
Blank.
Receipt Number
This field displays the corresponding Receipt Number.
Closing Balance
Opening Balance + (cr_basic_ed + cr_additional_ed) - (dr_basic_ed + dr_additional_ed) + (cr_other_ed - dr_other_ed).

Important: It is necessary that to run 'India - RG Period Balances Calculation' program with the last day of the month preceding the report dates. This program should be scheduled once for every month
with the last of the month. If this is not done, the report would end with an error.

**India RG 23C Part-I Report**

This report gives you the Stock Account of ‘Capital Goods’ to be used in the manufacture of ‘Final Products’ and complete Quantitative Details as per format specified by Central Excise Act for an Inventory Organization and its Location. Format and columns of this report is same as specified by the Central Excise Act.

**Report Submission:**

Use the Request Transaction Reports form and enter **India RG23C Part I Report** in the Name field to submit the report.

**Report Parameters:**

**Organization (Optional)**

Enter the organization, you wish to take the RG Report for.

**Location (Optional)**

Enter a location, you wish to take the RG Report for.

**Transaction From/To Date (Required)**

If the user wants to take report for a specific period then he has to specify the time periods.

**Report Headings:**

Report headings provide you with general information about the contents of the report. Oracle lists information as given in the report format of RG Registers.

**Sl. No.**

Serial Number of the Register for the Organization and Location, selected.

**Date of Receipt**

Date on which the Capital Goods were received is reported.

**Description of Capital goods received.**

Description of the Capital Goods received is reported.

**Quantity received**

Quantity of the goods of the Goods Received against the transaction is reported.

**Range and Division**

The Range and Division of the Organization where the goods have been received.

**Date of Verification**
The date on which the Capital Goods were issued to the production and verified.

**Issued for Installation- Chit no. and date**

Chit Number / Issue slip details through which the Capital Goods are issued along with the date.

**Place of Installation**

Place of Installation where the Capital Goods were installed in the factory premises.

**Date of Installation**

The Date on which the Capital Goods were installed.

**Date of starting of use**

Date on which the Capital Goods are put to use.

**Removal of Capital Foods - Quantity**

**Otherwise - Document ID and Date**

**Otherwise - Quantity**

**Balance Quantity**

Derived as sum (received_quantity - goods_issue_quantity - sales_invoice_quantity - oth_document_quantity).

**Officer's Initials**

Blank.

**Folio and Entry No. in part II**

**Remarks**

Remarks as listed in the RG Registers.

---

**India - CENVAT Monthly Return**

This report in accordance with the format specified under Rule 7 (5) of CENVAT Credit Rules 2002. This report along with 'India - CENVAT Monthly Abstract' report gives you complete information as required under the rule.

This report can be submitted either for CENVAT credits availed on purchase of Raw Material or on Capital Goods.

**Report Submission:**

Use the Request Transaction Reports form and enter **India - CENVAT Monthly Return** in the Name field to submit the report.

**Report Parameters:**

**Organization (Required, Required)**

Oracle Financials for India displays the Default Organization (default). Enter the
organization, you wish to take the RG Report for.

**Location (Required, Default)**

Oracle Financials for India displays the Default Location (default). Enter a location, you wish to take the RG Report for.

**Register Type (Required, Default)**

Select Register Type to print the report for Raw Materials or Capital Goods.

**Transaction From Date (Required, Default)**

Enter the begin date for the report.

**Transaction To Date (Required, Default)**

Enter the end date for the report.

**Report Details:**

**Sl. No.**

Serial Number of the credit taken. This will start with Sl. No. 1 at the beginning of the financial year and jump by one for each transaction.

**Type of Document**

System will default the Type of document that has been attached to the concerned Supplier Site. The type of the document is a new field attached to the Additional Supplier Information screen. For each Supplier Site, it is Required that the user needs to enter this information. The standard Document Type that is being widely used in the industry are Invoice, Delivery Challan, Bill of Entry, and Excise Challan.

**Number and Date of the Document**

This field displays the Identification Number of the Supplier document and date on which CENVAT credit has been taken on the Capital Goods.

**Name of the Supplier**

This field displays the name of the Supplier from whom the Capital Goods on which CENVAT was claimed was received.

**Type of Supplier**

An additional field is provided in the Supplier Additional Information screen to capture the type of the Supplier. Standard Supplier Types used in the industry are Manufacturer, Dealer, and Importer.

**ECC Number of the Supplier**

This field displays the ECC Number of the Supplier Site from where the inputs are received.

**Date on which Input/Capital Goods Received**

This field displays the Date of Receipt of Goods / Input.

**Details of Credit taken**
These fields display the amount of CENVAT credit taken against the transaction.

**Description**
This field displays the description of the goods received.

**Sub heading**
This field displays the Tariff heading of the Goods received.

**Quantity**
This field displays the Quantity of the goods received.

*Important:* The value is derived by back working from the taxes. Because the taxes are rounded off, this back working might lead to a marginal difference.

---

**India - CENVAT Monthly Abstract**

This report forms the second part of the CENVAT Monthly Return Report in the format specified under Rule 7 (5) of CENVAT Credit Rules 2002. This report along with 'India - CENVAT Monthly Return' Report gives you complete information as required under the rule.

**Report Submission:**
Use the Request Transaction Reports form and enter **India - CENVAT Monthly Return - Capital Goods** in the Name field to submit the report.

**Report Parameters:**

**Organization**
Enter the organization, if you wish to take the India - CENVAT Monthly Return - Capital Goods report.

**Location**
Enter the location, if you wish to take the India - CENVAT Monthly Return - Capital Goods / Inputs report.

**Transaction From/To Date**
Enter the range of the dates, if you wish to take the India - CENVAT Monthly Return - Inputs report.

**Material Type**
Select from the LOV whether you need to run the abstract for Inputs or Capital Goods.

**Column Headings:**

**Opening Balance**
This field shows the Opening Balances based on the report parameter.
Credit taken during the month
This field takes into consideration the Total Amount of Credit availed during the period specified in the report parameter.
This field takes into consideration the total amount utilized for payment/debit of duty that is being adjusted to CENVAT credit on inputs/capital goods based on the report parameter.

Closing Balance
This field shows the total of unutilized amount of Credit availed as on a particular date for Inputs/Capital Goods based on the report parameter.

India RG-I Report
This report gives you the Daily Stock Account for Finished Goods, Scrap, Intermediate Products, and By-products as per format specified by Central Excise Act. Report is same as specified by the Central Excise Act.

Report Submission:
Use the Request Transaction Reports form and enter India RG-I Report in the Name field to submit the report.

Report Parameters:
Organization (Required, Default)
Oracle Financials for India displays the Default Organization (default). Enter the organization, you wish to take the RG Report for.

Location (Required, Default)
Oracle Financials for India displays the Default Location (default). Enter a location, you wish to take the RG Report for.

Transaction From/To Date
Oracle Financials for India allows the user to print selectively the transactions from a given date onwards.

Show All Items Stock (Default)
Gives flexibility for the user to print all Items transacted during the period or in stock.

Report Headings:
Report headings provide you with general information about the contents of the report. Oracle lists information as given in the report format of RG Registers.

Column Headings:

Date
Transaction date.

Opening Balance
Derived as sum (balance packed + balance loose).

**Quantity Manufactured**

Will be populated when Finished Good is received.

**Total**

Derived as Opening Balance + Manufactured Qty.

**Removal from factory - on payment of duty - Home Use**

**Removal from factory - on payment of duty - For export under claim**

**Removal from factory - without duty - For export under bond**

**Removal from factory - without duty - To other factories**

**For Other Purpose - Purpose**

**For Other Purpose - Quantity**

**Duty Rate**

Excise Duty Rate.

**Duty Amount**

Excise Duty Amount.

**Balance Quantity- In Finishing Room**


**Balance Quantity- In Bonded Store**

Closing Balance available in bonded store.

**Signature of the Assessee / his agent**

Blank

**Report Order:**

Report is printed in the order of Transaction Date applicable for that location and for that organization.

**India OSP Pending Dispatch Report**

**Report Submission:**

Use the Submit Requests (INV & PO Modules) form and enter **India OSP Pending Dispatch Report** in the Name field to submit the report.

**Organization (Required)**

Enter the organization for which you wish to take the Unapproved OSP Dispatches Report for.
Location (Optional)
Enter the location for which you wish to take the Unapproved OSP dispatches Report for.

Vendor Name (Skip for all)
Oracle Financials for India prints the 57F3 forms for this Vendor only, if you enter a value for this parameter.
Oracle Financials for India prints all the OSP items Unapproved starting with the date you enter for this parameter.

From Date (Optional)
Oracle Financials for India prints all the OSP items Unapproved starting with the Date you enter for this parameter.

To Date (Optional)
Oracle Financials for India prints all the OSP items Unapproved up to the Date you enter for this parameter.

Report Headings:
Report Headings provide you with general information about the contents of the report. Oracle Financials for India prints Organization related information, Report date and Sheet number on all pages, along with report heading on all pages.

Column Headings:
Vendor Name
Name of Vendor to whom the item was sent for further processing.

Work Order Number
Work Order Number of WIP Operation.

Nature of Work
Nature of OSP work to be performed on OSP Item.

57F3 Form Date
Date on which 57F3 form was created.

Item
Name of Item sent out for further processing.

Item description
Description of Item sent out for further processing.

Dispatch Quantity
Quantity of items sent out for further processing.

Excise Duty
Estimated Excise Duty (based on Assessable Value of Item) to be paid for OSP item.

**Total**

Excise Duty Totals for Vendor, Location, and Organization.

**Report Order:**

Report is printed in the order of Vendor Name, Due Date, Form Number, and Item description.

---

**India OSP Pending Receipt Report**

This report gives you the unapproved 57F4 Receipts in the organization, Location, for a given period of time and a given vendor. The output is listed Work Order Number wise

**Report Submission:**

Use the Submit Requests (INV & PO Modules) form and enter India OSP Pending Receipts Report in the Name field to submit the report.

**Report Parameters:**

**Organization (Required)**

Enter the organization for which you wish to take the Unapproved OSP Receipts Report for.

**Location (Optional)**

Enter the location for which you wish to take the Unapproved OSP Receipts Report for.

**Vendor Name (Skip for all)**

Oracle Financials for India prints the 57F3 Forms for this Vendor only, if you enter a value for this parameter.

**From Date**

Oracle Financials for India prints all the OSP items Unapproved starting with the Date you enter for this parameter.

**To Date**

Oracle Financials for India prints all the OSP items Unapproved upto the date you enter for this parameter.

**Report Headings:**

Provides you with general information about the contents of the report. Oracle Financials for India prints Organization related Information, Report Date, and Sheet Number on all pages, along with report heading on all pages.

**Column Headings:**

**Vendor Name**

Name of the Vendor to whom the item was sent for further processing.
57F3 Form Number
57F3 Form Number on which the Items were sent.

Form Date
Date of 57F3 Form.

Item Description
Description of Items sent out for further processing.

Despatch Quantity
Quantity of Items sent out for further processing.

Return Quantity
Quantity of Items returned till date.

Pending Quantity
Pending Quantity of Items not yet returned till date.

Duty Amount
Amount of Duty paid on Items sent out.

Due Date
Due Date calculated as (From date + Expected duration of Processing/Manufacturing.).

Vendor Total Duty Amount
Vendor wise Total Duty Amount.

Location Total Duty
Location wise Total Duty Amount.

Organization Duty Total
Report’s Total Duty Amount for the Organization Chosen.

Report Order:
Report is printed in the order of Vendor Name, Due Date, Form Number, and Item Description.

India OSP Stock Register

This report is an extract of all 57F4 transactions in an Inventory Organization and Location for a given period of time and the format of the report is as specified by the Central Excise Act.

Report Submission:
Use the Submit Requests (INV and PO Modules) form and enter India OSP Stock Register in the Name field to submit the report.

Report Parameters:
**Organization (Required)**
Enter the organization for which you wish to take the 57F4 Register Report for.

**Location (Optional)**
Enter the location for which you wish to take the 57F4 Register Report for.

**From Date (Optional)**
Oracle Financials for India prints all entries in the register starting with the date you enter for this parameter.

**To Date (Optional)**
Oracle Financials for India prints all entries in the register up to the date you enter for this parameter.

**Report Headings:**
Report headings provide you with general information about the contents of the report. Oracle lists Organization Information based on user input.

**Column Headings:**
- **Description of Goods**
  Description of OSP Item.
- **Tariff Classification**
  Excise Item Tariff Classification.
- **Dispatch Quantity**
  Quantity of Item dispatched.
- **Identification marks, if any**
  Identification marks of OSP item, if any.
- **Premises/Factory to which removed**
  Premises/Factory to which OSP items were sent.
- **Challan No./Challan date**
  Date and Number of 57F4 Challan.
- **Nature of Processing required**
  Nature of Processing required for the OSP Item.
- **Rate and Amount of Credit Reversal**
  Rate and Amount of Excise Duty paid on removal of OSP items.
- **Reg. Name, Sl. No., & Date of Dr./Initials of Mfr./Supplier**
  Reg. Name, Sl No. and Date of Debit entry in the Excise Register.
- **Receipt Date / Clearance Date from Processor**
Date of Receipt of Items in the factory.

**Received Quantity/Unit of Measure**
Quantity of Items Received till date.

**Pending Quantity**
Pending quantity of OSP item.

**RG23A Sl. No, Credit Date and Re-credit Amount taken**
Sl. No. , Date and Amount of Re-credit taken on Receipt of items.

**Report Order:**
Report is printed in the order of date of issue for the selected organization.

**India Outside Processing Challan**
This report gives you the challan required under rule 4 (5) of The Central Excise Rules. The output is listed Challan number wise.

Use OSP Form Report to print Challan for material sent for outside processing. The report, is divided into three parts. Data for PART I is populated by the system, during printing, while PART II and PART III data are to be manually filled up as and when required.

**Report Submission:**
Use the Submit Requests (INV & PO Modules) form and enter India Outside Processing Challan in the Name field to submit the report.

**Report Parameters:**

**Organization Name (Required)**
Oracle Financials for India displays the 57F4 Forms for the organization you enter for this parameter.

**Location (Required)**
Oracle Financials for India displays the 57F4 Forms for the location you enter for this parameter.

**Fin Year (Required)**
Oracle Financials for India displays the 57F4 Forms for the financial year you enter for this parameter.

**Issue Date From (Optional)**
Oracle Financials for India prints all the 57F4 Forms starting from the date you enter for this parameter.

**Issue Date to (Optional)**
Oracle Financials for India prints all the 57F4 Forms up to the date you enter for this
parameter.

**Form Nos. From (Optional)**
Oracle Financials for India prints all the 57F4 Forms starting with the number you enter for this parameter.

**Form Nos. To (Optional)**
Oracle Financials for India prints all the 57F4 Forms up to the number you enter for this parameter.

**Vendor (Optional)**
Oracle Financials for India prints the 57F4 Forms for this vendor only, if you enter a value for this parameter.

**Place (Optional)**
Oracle Financials for India prints this name in Place field of 57F4 Forms.

**Name of the Signee (Optional)**
Oracle Financials for India prints this name in Signature of Manufacturer/Authorized Signatory field of 57F4 Forms.

**Report Headings**
Report headings provide you with general information about the contents of the report. Oracle Financials for India prints OSP Challan Number, Vendor Name, and Sheet Number of Certificate on all pages, along with Report Heading.

**Column Headings**

**Description**
Description of Item being dispatched for outside processing.

**Identification marks and No. if any**
Identification marks and No. if any for the item.

**Tariff Classification**
Tariff Classification of the item.

**Quantity**
Quantity and Unit of Measure of item being dispatched.

**Unit assessable value**
Assessable Value of item.

**Excise Duty Reversal Rate**
Excise Duty Reversal Rate applicable to item.

**Excise duty reversal amount**
Excise Duty Reversal Amount that can be claimed for the item.
Nature of Processing / Manufacturing
Nature of Processing / Manufacturing to be done on the item outside the factory.

Serial Number of Debit Entry in PLA and Date
Serial Number of Debit Entry in PLA and Date for Excise Amount Payment for the Form.

Factory/Place of Processing/manufacturing
Factory/Place where the items are being sent for further Processing / Manufacturing.

Date and Time of Issue
Date and Time of Issue of Items for outside processing.

Expected Duration of Processing/Manufacturing
Expected Duration of Processing/Manufacturing.

Report Order:
Report is printed in the order of 57F4 Challan Forms.
India Local Payables

This chapter covers the following topics:

- eTDS Returns
- Bill of Entry (BOE)
- Capture Personal Ledger Account (PLA) Payment
- Tracking of Sales Tax Forms Issues
- Third Party Taxes - Additions to Fixed Assets
- Defining TCS Authority
- Managing TDS Transactions
- Service Type Review
- Supporting Service Tax for Advance Receipts Payment
- Supporting Uptake of Point of Taxation for Service Tax
- BOE Invoices
- PLA Invoices/Payment
- Using Sales Tax Declaration Forms - Issue Tracking
- India - FA Mass Additions
- Define Invoice Tolerance Limits
- View / Resubmit / Delete Error Tax Lines
- Importing Taxes to Payables and Receivables
- Reports
- Account Payables Standalone Invoice
eTDS Returns

This feature is in accordance with the requirements of Income Tax Act. The Act mandates reporting of non-salary deductions through eTDS Returns. These certificates replace the existing Return in the Form 26.

Basic Business Needs

The feature enables generation of eTDS Certificates considering the following information:

- TDS deducted on Prepayment Invoices
- TDS deducted on Standard Invoices
- Payments against Invoices generated for TDS Authorities
- Data Generated for Form 16A Certificates

This feature considers TDS Calculations in following situations:

- Invoice Validation.
- Application of Prepayment Invoice to the Standard Invoice
- Unapply of Prepayment Invoice to the Standard Invoice
- Invoice Payments
- Invoice Cancellation
- TDS Deductions under Lower Rates
- Users can generate eTDS returns flat file by using the concurrent program 'India - Program to Generate eTDS Quarterly Certificates'.

Bill of Entry (BOE)

Customs Duty Liability arises on import of material. Customs Duty has to be paid in advance i.e., before the material is received in stores. The clearance of goods imported would be possible only after submission of the Bill of Entry in the specified format. This document details the goods imported in the consignment and the amount of Customs Duty liability for each commodity included in the consignment. Bill of Entry in Oracle Financials for India helps you manage the documentation process and account for the liability arising from the transaction.

Bill of Entry helps you manage the import process. Using BOE you can perform the
following tasks:

- Capture the vital information required for the creation of the Bill of Entry in the format specified by the Bill of Entry (forms) regulation.
- Record the Total Customs Duty liability arising from the transaction.
- Create an AP Invoice for the total Customs Duty liability arising from the transaction.
- Maintain account for the Customs Duty Liability.
- Control receiving transactions until the Customs Type of taxes arising from the transaction are matched to the corresponding Bill of Entry.
- Enables write-off of the disputed amount and amount that could not be applied fully to the transaction.

**Bill of Entry (BOE)**

You must use this feature to capture the information required for the Bill of Entry report to be submitted to the Customs Authority.

While creating a Bill of Entry, you can now enter the Additional CVD percentage. This percentage is applied on the Total of all preceding taxes.

**Calculation of Customs Duty**

This feature helps you in calculation of the Customs Duty, Additional Duty and Surcharge based on the Assessable price entered for the transaction.

**Creation of AP Invoice**

An Approved AP Invoice would be automatically created for the Customs Authority with the Total Customs Duty liability arising from the transaction.

**Control over Receipt Transactions**

For the goods receipts that are created through India Local Receipts screen, which have Customs Duty of Tax, attached to it, a control would be placed, where you cannot quit the form until an appropriate BOE is attached to the receipt line. This would set-off the Customs liability arising from the transaction.

**BOE Amount Write-Off**

You have a facility to write-off the Un-applied BOE amount in a BOE Invoice which no longer to be applied against any Receipts. If the Customs Duty paid need to be written
off for any reasons, you can make use of this functionality. For example, the Customs Duty is paid through a BOE Invoice and during transit of goods from the port to the Organization; the duty paid goods were lost in transit. In such cases, the duty paid on such goods cannot be applied to the inventory receipt transaction and the duty paid need to be Written Off.

Reports

Payables generates the following reports applicable to India:

**BOE Written off Report** - Lists Bill of Entry (BOE) records written-off during the selected period.

Supporting Bill of Entry Enhancements

The Bill of Entry functionality has been enhanced. Bill of Entry is a legal document in a predefined format that must be submitted to Customs Authority by the importer or the authorized agent. Bill of Entry contains information about goods imported to India, value, and other relevant details required for assessment of Customs duty.

Whenever Government of India introduces a new type of customs duty or bring changes to the tax calculation logic (like change of basis), changes are reflected in the Financials for India application.

The Bill of Entry feature has been enhanced such that it is closely integrated with the Procurement to Receipt Flow. Bill of Entry window has been modified to:

- Capture additional information
- Match Purchase Order, Release, and ASBN document
- Change default Tax Category for a line
- Cancel bill of entry
- Show Tax type-wise breakup
- New window is added to show bill of entry Receipts that have been applied
- New window is added to show bill of entry Tax Level Accounting and Write off
- Reporting Impact

Customs Regime

All the generic setups related to bill of entry are done in the regime registration as Customs Regime. In Customs Regime, tax types are associated at inventory organization level, accounting information is setup along with other attributes.

Attributes
In the Customs Regime, Organization is assigned at the inventory organization level. For assigning tax types for bill of entry type of taxes, a new regime called the Customs Regime is seeded and cannot be changed. Currently, Others tab is enabled for Customs Regime.

Tax Types

Tax types are associated in the customs regime like other regimes. A few new tax types are also included for this. You can specify the list of tax types that are supported.

Any Other BOE Tax Types

Any Other BOE Tax Type behavior is the same as other customs tax types. If recoverable percentage is defined at the tax code level the same is updating the RG 23 Part II A or C based on the item classification and if the same is not defined then item cost is updated as it is a recoverable tax. The accounting treatment and claim differ if Claim 100% in the year of purchase for capital goods is setup for the specific customs tax type. The same option is available for all the five hard coded Any Other BOE Tax Types.

Accounting

The account names to be used for each tax type are Paid, Payable, and Write off Account.

The write off account can be same for each tax type or different for each tax type. Based on the setup, the accounting entries will be passed accordingly. In the LOV, you should be able to see only these tax account names for Customs Regime.

For recoverable import type of taxes, the recovery account will be picked up from the existing Organization Additional Information window only.

Changes to Bill of Entry Window

The bill of entry window is also available in India Local Purchasing responsibility besides the India Local Payables.

For meeting various requirements of capturing additional information in bill of entry, matching of a bill of entry to a purchase order, Release or ASBN, capturing Custom Notified Currency details, showing the total amounts against each Tax type, are all modified.

This ensures that all required information for generation of bill of entry template as per Customs Authority format can be captured.

Changes to Bill of Entry Window

As the fields are numerous, the Bill of Entry window is organized into four tabs, Import Details, Currency, Shipment and Others.

Freight is used for deriving the assessable value. In case of FOB imports the freight has to be paid by the supplier to a different one. In such case, you can add the freight as a tax line in the purchase order or receipts and give the supplier name and site.

When receipt is created, AP invoice is created on the supplier give for the freight tax.
line. Payables invoice is created on submission of the India Concurrent for Third Party Invoices concurrent process.

Assessable Value

Assessable value for basic customs duty is computed by the system. All the tax lines above the Basic Customs duty will be part of the assessable value along with PO item line price provide these tax lines form the precedence for custom taxes. If the taxes or the line price are in different currency the same will be converted into INR based on the currency rate given in the Currency Tab of the BOE Invoice. The assessable value given by the IL for the base PO cannot be used for customs duty computation. Assessable value is used for computation in this case.

In some cases the customs authority may not be satisfied with the assessable value declared by the importer. In such case, the Land Cost is determined by the customs authority and the same has to be used for the computation of the customs duties. For such cases, you use the Assessable Value in the Taxes window. The amount determined by the customs authority is entered in the Assessable Value for the particular tax.

Voiding Bill of Entry Invoice Payment

In case of voiding the payment to tax authority, the accounting entry is passed by the Base AP.

Cancelling Bill of Entry Invoice

In the case of cancelling bill of entry invoices in Payables, the accounting entry is passed by the base Payables itself. The status of bill of entry invoice changes to Cancelled.

DEPB Adjustment against BOE

You can settle the Customs Duty liability using the DEPB Credit. Enter value in DEPB amount for bill of entry not marked as Confirmed.

The accounting entry for the DEPB adjustment is passed in the BOE invoice only. The DEPB amount will not be adjusted against any of the tax types payable but are adjusted from the tax authority liability. Validation DEPB amount cannot be greater than BOE amount.

Third Party Bill of Entry

If a bill of entry is selected as a Third Party Bill of Entry, then define any bill of entry in the system. In this case, the taxes flow from purchase order only and you can make changes on the Receipt Taxes window.

Payables invoice is not generated. In case of Third Party bill of entry, the system does not create a bill of entry.

On the Receipts Localization window, if the Third Party BOE is checked, then Apply BOE is disabled even if the document has import type of taxes. The account entry is similar to that of a normal receipt as it does not have any Customs or other tax type Paid account.

Recoverable taxes update the respective tax registers and the non recoverable taxes update the item cost.
Bill of Entry Invoice Status
For the bill of entry invoices, there are statuses to determine at each and every level of the bill of entry invoice.

The following are the BOE Invoice status:

• Applied
• Available for Receipt Application
• Cancelled
• Closed
• Confirmed
• Not Yet Assessed

Once the bill of entry invoice status is Cancelled, you cannot update any information and also all the amounts become zero.

Bill of entry must not be updated for all the mandatory fields once the status is changed to Confirmed.

Bill of Entry Receipts
A view window, Receipts Applied, shows the receipt application details for bill of entry. You can drilldown to look into the details of the Receipt.

Changes to Receipt Application
Once the bill of entry is applied to the receipt, the Customs and other type of taxes are modified during the bill of entry creation replaces the defaulted PO taxes on the receipt.

You cannot modify the Customs Type of Taxes on the Receipt once the bill of entry is applied to the receipt. It is applicable to Header Level or Line Level matching of bill of entry’s to receipt.

Clicking the Apply BOE option on the Receipts Localization window, you can see the Open and Available bill of entries applicable for that purchase order. While applying BOE to Receipt, the BOE application at both Receipt header level and Receipt Line level are supported.

The default purchase order taxes on the receipt are replaced by the taxes from the bill of entry once it is applied. Taxes from bill of entry (includes non-bill of entry tax types) are copied on the receipt and you cannot modify or delete any taxes that are used in the computation of the bill of entry taxes. Once the taxes are copied from the bill of entry to receipt, you cannot add any custom type of taxes on the receipt. Once the BOE is applied to the receipt, you cannot modify Customs Type of taxes on the receipt or taxes that have customs taxes as precedence.

When taxes are copied from the bill of entry to the Receipt, only the amount is shown and the precedence's are not shown in the receipt taxes window. Only bill of entry with
status Available and Applied are considered for application. Once the receipt line is applied, the bill of entry applied flag of the receipt line is updated to Y and when you click the Apply BOE, then error message displays that this line is already applied to bill of entry.

**Receipt Application at Header Level**

While supporting bill of entry application at the header level, a checkbox is provided at the Receipt header level, select it to enable Receipt application at the header level. Once the check box is selected, you select bill of entry from the list of values to apply at receipt. If the bill of entry does not meet all the receipt items, then you apply one bill of entry to all lines of the receipt or to few lines only. Selecting bill of entry for receipt performs validations like receipt items must be present in the bill of entries.

The quantity available for application for at least one item should be greater than or equal to the receipt item. The based bill of entry attached to purchase order used for Receipt creation is only shown in the list of value for POs. The bill of entry unapplied amounts must be greater than Receipt Amount at the item level.

**Bill of Entry Receipts Correction**

Corrections are allowed for only negative quantity on the bill of entry receipt. At the time of correction, the amount for each tax type is prorated based on the quantity and is added to the Remaining Amount for the bill of entry and is deducted from the Applied Amount.

The quantity corrected should also be updated in the available BOE Quantity. If delivery has taken place for the receipt, then the accounting entries should also be adjusted accordingly. Here the behavior should be same as in the Other Tax Types. The receipts taxes should not be updated with the corrected quantity tax amounts. The behavior should be in sync with other tax type, so we will not make any changes here. In case of recoverable taxes which have updated the registers RG23 Part II A/c should also be updated accordingly. The non recoverable taxes should be reduced from the item cost. Correction is not supported for the positive quantity.

**Bill of Entry Write off**

Bill of Entry accounting is done at tax code level. This has an impact on the Write off functionality. You can only write off bill of entry taxes. The Write off Account code defaults from the Customs regime. In the Customs Regime, you have an option of giving different write off accounts for different tax types or same account code for all tax types. Based on this the accounting entry will be passed. The write off can be for positive and negative amount. The negative write off cannot be more than Rupee 1. Negative write off is adjusted against the write off amount.

Once a Receipt is applied to a bill of entry, the AP Invoice raised at time of marking the bill of entry as Confirmed is not allowed to be modified or cancelled.

**Migration**

Supports all open bill of entries at the time of upgrade. The accounting entries are passed to bill of entry invoices as journal entries in the General Ledger as the existing
bill of entries are accounted for all tax types together. The accounting entries are passed through a concurrent process. This concurrent process is submitted after doing Customs Regime setup. If the Customs Regime setup is not available, then an error displays.

For open bill of entries, create tax codes for each tax used in the bill of entry and attach these tax codes in tax category and then specify the tax category ID against the bill of entry ID in the flat file. Only unapplied and unwritten amounts to tax codes are migrated.

**Reporting Impact**

A new report, India - BOE Details Report, is added. The report is described in the Reports topic.

The following reports are updated to accommodate the bill of entry functionality:

**Bill of Entry Write Off report**

The report includes account code. The account shown in this report retrieves each bill of entry write off transaction. The data in this report is grouped by inventory organization, location, and then is sorted by bill of entry number. The tax codes for each bill of entry is shown in the report if there is any write off amount associated with that particular tax code.

**RG23D report**

In case of customers who trade in the imported goods, they can match the receipts at the time of shipment. A new column is added to display the bill of entry numbers that are used against the shipment for the receipt being matched. This column shows all the bill of entry numbers.

**Max Tax Update report**

This report processes the unassessed bill of entries only.

### Capture Personal Ledger Account (PLA) Payment

The Excise liability arising from the removal transactions needs to be settled within 5 days from the end of the Month / Period. The Duty can be discharged on debiting a current account, referred to as Personal Ledger Account (PLA). PLA credit is taken by depositing money in the banks on T.R.6 Challan. Capture PLA feature helps you capturing the information required for the PLA Report to be submitted to the Excise Authorities. This feature helps you in raising Invoice to capture and maintain account for the liability arising from the transaction.

### Basic Business Needs

The Capture PLA Payments feature in Payables helps you manage the Excise Duty liability settlement process. Using this feature, you can:

Capture the information required to update the PLA Register
Account for the liability arising from the transaction

Control on updation of PLA Register

**Important:** An AP Invoice would be generated on saving the Capture PLA Payment transaction.

**Major Features**

Major features of PLA are mentioned below

**PLA Payment**

The net Excise Duty liability arising during the Month / Period has to be settled by a payment made through TR 6 Challan. The PLA Register would be hit when the payment is actually made to the Excise Authority and the user acknowledges this payment from the 'PLA Invoices' Screen. The Capture PLA Payment feature captures the information required for the updation of the PLA Register.

**Creation of AP Invoice**

An AP Invoice with status 'Validated' would be automatically created for the Total Amount on the Capture PLA Payment lines. This would take care of accounting the liability arising from the transaction.

**Acknowledging PLA Payment**

The PLA Register would be updated only when the PLA Payment is acknowledged. The Acknowledgment is allowed only when the AP Invoice created for this transaction is fully paid.

**Tracking of Sales Tax Forms Issues**

**Overview**

The reduced rates of Sales Tax are applicable based on issue of declaration forms to the Supplier. These forms would be as specified in the applicable Sales Tax Regime. For this you will have to keep track of the transactions that would qualify for concessional rate of Sales Tax. Further, you will have to keep track of details of Forms Issued and the Invoices included in each of the Forms.

**Basic Business Needs**

Sales Tax Issue tracking helps you manage the issue of Issue of declaration forms in
order to avail concessional rate for Sales Tax. Using this feature you can perform the following tasks:

- Setup Declaration Form names that have to be issued to avail the concessional rate of Sales Tax.

- Assigning Form Names to appropriate Tax Codes while defining these Taxes.

- Keep track of Purchase Invoices against which Sales Tax Declaration forms have to be issued to the Supplier.

- Facilitate recording details of Forms Issued and the Invoices included in issue of form.

- Provides with a facility to query Issued Forms and view Form details and the Invoices included in these Forms.

**Third Party Taxes - Additions to Fixed Assets**

**Overview**

Taxes and charges that are incurred on a transaction but are not paid to the Supplier of Goods are defined as Third Party Taxes in Oracle Financials for India. Third Party Taxes applicable to a transaction would depend on the Shipment terms. The terms used commonly are Ex-works and FOB. In cases where the terms of Shipment is Ex-works, the Seller delivers the goods at his premises. All costs incurred after this stage has to be borne by the Buyer. In case of Inland purchases, the cost components would be Freight, Insurance, Octroi and Entry Tax. In case of Imports the Third Party Taxes would be Freight, Insurance, Landing Charges, Inland Freight, Installation Charges and would also involve Basic Customs Duty, CVD and Customs Clearance Charges. On such transactions there is a good possibility of having multiple Third Party Vendors and Tax Authorities. Also, the amount paid would be consolidated by Third Party Vendor and Vendor Site.

Of these Tax Types, except for the Countervailing Duty, all others are Non-Recoverable Taxes. These have to be added to the Item Cost. In case of the Raw Material Purchases, the Average Cost has to be updated and in case of Capital Goods, the amount should be added to the Asset Cost.

Oracle Financials for India automates transfer of Third Party Taxes to Fixed Assets.

This feature automates transfer of following taxes/expenses to Fixed Asset Cost:

**Third Party Taxes:** Costs that are not billed to the PO Supplier but are incurred in the course of the transaction.

**Non-Recoverable Customs Duty:** Customs Duties that are paid to the Customs Authorities through Bill of Entry (BOE).
Defining TCS Authority

TCS Authority needs to be defined for settlement of TCS Taxes and payments. You can identify a TCS authority by assigning the Supplier Type as India TCS Authority. To classify a supplier as a TCS Authority, access Supplier window from India Local Payable > Supply Base > Suppliers.

Managing TDS Transactions

This Section elaborates on the effect of TDS setup on Actions applied to an Invoice. You can see the impact on the Supplier Liability, Accounting and generation of TDS Certificates.

Invoices with TDS Codes

When you create an AP Invoice, the TDS gets calculated based on the TDS Threshold Setup done.

India Distributions Global Descriptive Flexfield

Usage of earlier Invoice Distributions Descriptive Flexfield has been discontinued and the same functionality has been implemented through India Distributions Global Descriptive Flexfield.

The users should ensure that at least one segment of this India Distributions Global Descriptive Flexfield is marked as 'Enabled'. The users should not make any of the segments as 'Required'.

Following are the details of the Global Descriptive Flexfield:
Application: Regional Localizations
Title: JG_AP_INVOICE_DISTRIBUTIONS
Context Field Values:
Code: JA.IN.APXINWK.B.DISTRIBUTIONS
Name: Invoice Distributions
Description: Asia/Pacific Invoice Distributions Information
Apart from the above, there are no changes from a user perspective in the TDS functionality due to migration of the Descriptive Flexfield to Global Descriptive Flexfield.

Supporting Descriptive Flexfield

This document describes support for descriptive flexfields. Descriptive Flexfields help
you capture additional data while processing a transaction that is often used in customizing the reports.

Use the Descriptive Flexfield Segments window to define Oracle Financials for India descriptive flexfield structure.

Use the Descriptive Flexfield Segments window to define descriptive flexfield structures, and the descriptive information and validation information for each segment in a structure.

Prerequisites

Before you can use the TDS feature on Invoices, you should have completed the mandatory setup defined in the Setup Documentation.

1. TDS On AP Invoices and Prepayments

The TDS calculation and creation of the TDS related Invoices would take effect, during the Validation of an AP Invoice, with either TDS Code attached in Invoice Distributions or with a TDS Tax Name attached in the TDS Thresholds Setup.

2. On Validation of a Standard Invoice or a Prepayment Invoice

When you validate a Standard Invoice or a Prepayment, the Supplier would be debited to the extent of Tax Deducted by means of a Credit Memo, while the Balance of Tax Authority would be increased by means of a Standard Invoice.

Thus, balance due to the Supplier would be net of the Credit Memo created on Validation. You should take adequate care to consider such Credit Memos while making the Payment to the Supplier.

3. On Application of Prepayment Invoice to Standard Invoice

When you apply a Prepayment to a Standard Invoice, both are subject to Tax Deduction, Invoices would be created for the reversal of the TDS deducted on the Prepayment. This is done by creating:

- Standard Invoice for the Supplier
- Credit Memo for the Tax Authority

You need to ensure that Prepayment with multiple distributions, each having a different TDS Section applicable, should not be applied to a Standard Invoice. To deal with such cases, you have to create a Separate Prepayment Invoice for each of such Payments.
4. Amount considered for reversal on Prepayment Application

The following are

- On applying a Prepayment to a ‘Validated’ Standard Invoice, considering both have TDS, the TDS calculated on Standard Invoice is reversed.

- When the Standard Invoice has multiple lines each with a different TDS Codes and it is partially applied to a prepayment then, the lines considered for TDS reversed will be on a FIFO basis.

- Where some of the lines have to be reversed, you have to ensure that the Prepayment is applied only after you have reversed the lines that you wish to reverse.

- Reversed lines, Reversal lines and Prepayment lines are not considered for TDS Calculation.

5. On Un-Applying Prepayment Invoice applied to a Standard Invoice

When you un-apply a Prepayment to Standard Invoice, both of these subject to Tax Deduction, Invoices would be created to reverse the effect of the Invoices created on application of the prepayment. Standard Invoice would be created for the TDS Authority and a Credit Memo would be created for a Supplier.

6. On Canceling Standard Invoice

On canceling a Standard Invoice for which Tax has been deducted, the Invoice created for the Tax Authority would be canceled and a Standard Invoice to the extent of the Tax Deducted an Standard Invoice would be created for the Supplier.

However, there would not be any effect on these Invoices if the Invoice for the Tax Authority is already paid.

You have an option to cancel the Supplier Invoice while you are voiding the Payment for the Invoice. In such cases, Invoices to Tax Authority would also be cancelled. However, it is necessary that the Tax Authority Invoice is not yet paid.

TDS Invoice Payments

Navigation: India Local Payables - India Localization - Others - India TDS Challan

In this screen, the user can capture the information of TDS payment details. This screen would list all Payments made to TDS Authorities where the Challan information has not been entered. The user would then be able to enter the attribute information for these payments.

The user will create an AP Invoice in the base application for payments to be made to
the TDS Authorities. After creating the AP Invoice, the user will query this Invoice in the India Local TDS Payments screen and update the Additional Information here. Find TDS Parameters field wise description.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Authority</td>
<td>EDIT, PICK</td>
<td>User needs to select the Tax Authority Name from the LOV.</td>
<td></td>
</tr>
<tr>
<td>Tax Authority Site</td>
<td>EDIT, PICK</td>
<td>User needs to select the Tax Authority Site Name from the LOV</td>
<td></td>
</tr>
<tr>
<td>From Date</td>
<td>EDIT, PICK</td>
<td>Enter the date range</td>
<td></td>
</tr>
<tr>
<td>To Date</td>
<td>EDIT, PICK</td>
<td>Enter the date range</td>
<td></td>
</tr>
<tr>
<td>Clear</td>
<td>BUTTON</td>
<td>Pressing this button will clear the screen.</td>
<td></td>
</tr>
<tr>
<td>New</td>
<td>BUTTON</td>
<td>Pressing this button will take the user to the next screen wherein the user can select different TDS Invoice payments and enter the Challan Number details.</td>
<td></td>
</tr>
<tr>
<td>Find</td>
<td>BUTTON</td>
<td>Pressing this Button, system will find all the TDS Challan Details, which are created earlier.</td>
<td></td>
</tr>
</tbody>
</table>

Field wise details of TDS Challan Details Screen

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Authority</td>
<td>EDIT, PICK</td>
<td>User needs to select the Tax Authority Name from the LOV.</td>
<td></td>
</tr>
<tr>
<td>Tax Authority Site</td>
<td>EDIT, PICK</td>
<td>User needs to select the Tax Authority Site Name from the LOV</td>
<td></td>
</tr>
<tr>
<td>Check Number</td>
<td>DISPLAY</td>
<td>System will query the existing data.</td>
<td></td>
</tr>
<tr>
<td>Check Date</td>
<td>DISPLAY</td>
<td>System will query the existing data.</td>
<td></td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------</td>
<td>--------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Currency Code</td>
<td>DISPLAY</td>
<td></td>
<td>System will query the existing data.</td>
</tr>
<tr>
<td>Amount</td>
<td>DISPLAY</td>
<td></td>
<td>System will query the existing data.</td>
</tr>
<tr>
<td>Check Deposit Date</td>
<td>EDIT</td>
<td></td>
<td>The Date on which the Check has been deposited into government treasury needs to be entered for TDS Payments being made &amp; printed on the TDS Certificates / Returns.</td>
</tr>
<tr>
<td>Challan Number</td>
<td>EDIT</td>
<td></td>
<td>User should enter the value of Challan issued by the Income Tax Department that has to be submitted along with the remittances of TDS Amounts. This information is used in TDS Certificates issued to the Vendor and at time of Tax Returns.</td>
</tr>
<tr>
<td>Bank Name</td>
<td>EDIT, PICK</td>
<td></td>
<td>Enter the value of Bank in which, the TDS payment / Challan is deposited.</td>
</tr>
</tbody>
</table>

**TDS Certificate Generation**

You can generate TDS Certificate to be issued as per the Income Tax Act. Based on the TDS Section and Tax Authority, you should first generate the TDS Certificate. One TDS Certificate can be issued for all the TDS deductions for a Vendor based on the transaction range or individual TDS Certificates can be generated for each TDS Deduction.

Navigational path: India Local Payables - India Localization - Others - Generate TDS Certificates

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAN Number</td>
<td>(Required)</td>
<td></td>
<td>The user should pick the value from the LOV.</td>
</tr>
<tr>
<td>Operating Unit</td>
<td></td>
<td></td>
<td>Select the appropriate value from the LOV.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Certificate</td>
<td>(Required)</td>
<td>EDIT</td>
<td>You need to specify the period the period for which he wants to generate the TDS Certificate.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HELP</td>
<td>These dates will be compared against the Invoice Dates of the Invoices generated for TDS Authority.</td>
</tr>
<tr>
<td>Period</td>
<td></td>
<td>PICK</td>
<td></td>
</tr>
<tr>
<td>Section</td>
<td>(Required)</td>
<td>ENTER</td>
<td>You need to specify the TDS Section for which he wants to generate the TDS Certificate.</td>
</tr>
<tr>
<td>Tax Authority</td>
<td>(Optional)</td>
<td>ENTER</td>
<td>You can specify a particular Tax Authority Name for whom he wants to generate the TDS Certificate.</td>
</tr>
<tr>
<td>Vendor Name</td>
<td>(Required)</td>
<td>ENTER</td>
<td>You need to specify a particular Vendor Name for whom he wants to generate the TDS Certificate.</td>
</tr>
</tbody>
</table>

- It is a pre-requisite to run the 'Generate TDS Certificates' to view the data in 'India - TDS Prescribed Rates Report' and 'India - TDS Lower Rates Report'.

- TDS Certificates would be generated only for those Invoices where TDS deducted has been remitted to the Tax Authority. Payments to the Tax Authorities can be done either by paying the TDS Invoices (generated on validation of Supplier Invoice) or by applying a Prepayment Invoice to the TDS Invoice.

**Generating eTDS Returns**

You can generate eTDS Returns using 'India - Program to Generate eTDS Certificates' Concurrent program. Prior to that you should completed validating Supplier Invoices and made payments to Invoices generated for TDS Authorities.

The concurrent program should be run for a Particular TAN Number for a given Financial Year.

As the output would be flat file, the users would be provided with an option to generate the file with separators and Headers. The file can be generated in this format by checking 'Generate Headers' parameter of the Concurrent request. Using this file
user can check the records and the appropriate values. On finding that the data is correct, you can choose select the file with same parameters, without headers. The file would be saved at the path specified in the 'utl_file_dir' parameter of the Database.

To generate eTDS Returns, navigate to 'India - Program to Generate eTDS Certificates' as follow:

India Local Payables - View Requests (M) - Submit New Requests.

This request facilitates

- Specifying Query Criteria
- Entering Information that would be included in the Report.
- Generating the Return in a readable format for the user to decipher and verify the information
- Specifying the File Name

The user should specify following information in the following parameters

1. **TAN Number:** User should select the value from the LOV. The User should select the TAN Number value for which, the return is to be generated.

2. **Financial Year:** User has to select the Financial Year value for which, the returns have to be generated.

3. **Organization:** Select the value of Organization for which, the returns have to be generated.

4. **Tax Authority:** Select the Income Tax Authority for which the TDS Invoices have been generated and paid.

5. **Tax Authority Site:** Select the Vendor Site code of the Income Tax Authority.

6. **Deductor Name:** Enter the Name of the Deductor.

7. **Deductor State:** Select the appropriate value for the State from the LOV.

8. **Address Changed Since Last Return?** : Select the value 'Yes/No' from the LOV.

9. **Deductor Status:** Select the appropriate value from LOV.

10. **Person Responsible for Deduction:** Enter the Name of the Person Responsible.

11. **Designation of Person Responsible:** Enter the Designation of Person Responsible for deduction.

12. **Challan Start Date:** Enter the From date range.
13. Challan End Date: Enter the To Date Range

14. File Path: Select the Default value from the LOV. This value will be selected based on the util_file_dir parameter value of the database.

15. File Name: Enter the Name of the flat file name and the eTDS returns flat file will be generated with this name.

16. Generate Headers: Select the values 'Yes/No' from the LOV.

17. If the value 'Yes' is selected, then system will generate a flat file including Headers (columns).

18. If the value 'No' is selected, system will generate a flat file which can be validated against the file validation utility of NSDL.

**Tax Deducted at Source Repository and Architecture Changes**

This document explains changes made to Tax Deducted at Source (TDS) architecture and support for Direct Tax Code.

The following modifications have been made to TDS repository and architecture:

- Define Section Code Mapping
- Populate repository table in the new TDS architecture
- Generate eTDS flat file in the new TDS architecture
- Migrate old transactions into new TDS repository
- Generate eTDS flat file for old transactions in the new TDS architecture

**Defining Section Code Mapping**

A new window, Code Mapping, is added for mapping old section code to revised tax deducted at source section code to use in eTDS file.

- Attach the mapping definition at the regime level is used only by the TDS regime.
- Map old section code to the new tax deducted at source section code which to use in eTDS file.
- Define date range for each mapping. At any time point, a section code is unique to each section mapping.

**Enhancement to India TDS Challan**

The Indian Tax Deducted at Source Challan window has been enhanced to maintain TDS payment information and challan information in the new TDS repository table.
Whenever challan information is updated the TDS repository is updated.

**Modifying India Tax Category Definition**

A new column, EFFECTIVE_TDS_RATE is added to the jai_cmn_tax_ctgs_all table to store effective rate for tax deducted at source tax categories.

**Defining Tax Category**

A new field, tax_category_id, is added to the JAI_AP_TDS_INVPAYMENTS table. The tax deducted at source transaction table uses tax category details.

**Modifying TDS packages**

A new package, jai_ap_tds_pop_rpst_pkg, is added to maintain the tax deducted at source repository table.

**Populating TDS Repository**

The tax deducted at source repository is populated whenever the following events take place:

- An invoice for TDS vendor is validated
- Threshold transition to first cumulative slab or surcharge slab occurs.
- An invoice for TDS vendor is cancelled.
- Payment Details are created or updated for a TDS Invoice.

**New eTDS**

The eTDS (electronic Tax Deducted at Source) is added and performs the following:

- eTDS extracts data base on TDS repository.
- The new TDS invoice is created based on tax category.

**Migration Script for eTDS**

The script migrates existing transactions from the old TDS to support new eTDS and the data is extracted into the TDS repository.

---

**Uptake of File Validation Utility for Tax Deducted at Source and Tax Collected at Source**

This topic explains changes made to Tax Deducted at Source (TDS) architecture and support for Direct Tax Code. NSDL (National Securities Depository Limited) has released a new file validation utility for quarterly filing of tax deducted at source (TDS) and tax collected at source (TCS). If the filing is done after 16-Oct-2012, then India Localization customers must use the same file validation utility. The changes released are for both salaries and non-salaries.

The new File Validation Utility 3.6 has tracking of payments to software vendors, new Tax Deducted at Source sections, and new items for Tax Collected at Source.
Importing a Challan file

Importing a Challan file is now mandatory for the assessee to upload the flat file along with the challan file downloaded from the NSDL site. This challan file is in encrypted format and NSDL performs validations on this file.

Addition of two new TDS sections

In Federal Budget 2012, two Tax Deducted at Source (TDS) sections are added in Income Tax Act for widening the TDS net and to cover areas that are not being taxed now. These two new sections are basically for the foreign transactions-related items.

The two new sections are:

• Section 194 LC - Income by way of interest from Indian company

• Section 194 LB - TDS on interest payable on infrastructure debt fund to a non-resident or a foreign company.

These two sections are part of the 27Q.

Addition of two new items for TCS

Two new items have been added to the list of items on which Tax Collected at Source (TCS) are collected as per section 206 (C) of Income Tax Act 1961.

These two new items are:

• J – Sale of minerals

• K -- Cash sales of cash of Bullion and Jewelry.

They are also added for generation of 27EQ.

Flagging of Payments made to Software Vendors

Payments made to software vendors fall under Section 194 (c) and these payments are tracked separately and reported in Form 26Q. It is similar to how transporter payments are recorded and submitted. Use TDS Vendor Classification to classify a supplier as transporter.

Service Type Review

Service Type Review lets you capture the Service Type for those transactions where it was either not captured during the transactions or could not be captured for some reason. We recommend you to carry out this review before carrying out settlement. You also have an option of querying existing records to view and change he captured Service Type for any existing Transaction.

Navigate to India Local Payables > India TCS/VAT/Service Tax > Period End > Service Tax Repository Review.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>PICK</td>
<td></td>
<td>The source from which the Repository entry has been carried out and would give LOV values of Payables, Receivables, Manual and Distribution.</td>
</tr>
<tr>
<td>Organization</td>
<td></td>
<td></td>
<td>This lists the Inventory Organizations for which you need to find the transactions.</td>
</tr>
<tr>
<td>Location</td>
<td></td>
<td></td>
<td>Lists Locations based on the Organization selected.</td>
</tr>
<tr>
<td>Transaction Dates:</td>
<td></td>
<td></td>
<td>This is to enter a date range from which the repository records needs to be displayed.</td>
</tr>
<tr>
<td>From</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transaction Dates: To</td>
<td></td>
<td></td>
<td>This is to enter a date range to which the repository records needs to be displayed.</td>
</tr>
<tr>
<td>Include Settled</td>
<td>Optional</td>
<td>Checkbox</td>
<td>Checking this will enable query of already settled transactions.</td>
</tr>
<tr>
<td>Transactions</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Query Read Only</td>
<td>Optional</td>
<td>Checkbox</td>
<td>Checking this will enable query in read only mode i.e. view mode.</td>
</tr>
</tbody>
</table>
This search lists all the Service Tax Repository Transactions for the given find criteria. You have an option of Defaulting Service Type from setup. Alternatively, use a Service Type specified in this search results. The Service Type can then be defaulted only to those records where Service Type is null.

**Note:** Settlement cannot be carried out till you ensure that the Service Tax balance is transferred from Operating Unit to Inventory Organizations. Also, you need to ensure that all the transactions are classified by the right Service Type.

Service Type Review also lets you view accounting entries made against Service Tax. Navigate to India Local Payables > India TCS/VAT/Service Tax > Period End > Service Tax Repository Review. Click View Accounting to view the accounting entries for a particular Service Tax repository entry.

**Note:** You can view the GL drilldown accounting entries using the Show transactions button on the Tools menu of the Service Tax Repository Review form.

### Supporting Service Tax for Advance Receipts Payment

Oracle Financials for India Service Tax functionality earlier did not account the service tax liability when payment was received in advance. In the Federal Budget of 2011-12, Government of India introduced Point of Taxation Rules, which significantly changed the service tax regulations. This change impacted taxable events for accounting service tax liability. The Point of Taxation Rules changed prevailing cash based system of service tax accounting to accrual based accounting. Central Board of Excise and Customs decided that the prevailing provisions of accounting service tax will continue for payments received in advance.

This enhancement works with E-Business Suite Release 12.2 and includes the support for Advance Receipts for Service Tax in Receivables. This enhancement generates accounting and updates repository for Advance Receipt of service tax in Receivables. It does not generate Service Tax invoice.

You can define Service tax invoice number format in Document Sequencing window.
Service tax invoice number generation is the gapless numbers starting from the first day of every financial year.

For Order import and Project Invoice import to Receivables, invoice number is generated by India tax import concurrent programs. For Manual Receivables transactions, it is generated at the Complete event.

1. **Step 1. Transaction is created using one of the following ways:**
   - Sales Order Import
   - Project Billing Import
   - Oracle Financials for India Interface Import
   - Manually Create Transaction

For Sales Order import, concurrent process, India - Local Concurrent for processing order lines to AR, generates accounting and service tax invoice number.

For Project Billing import, concurrent process, India - Import Projects Taxes to Receivables, generates accounting and service tax invoice number.

For import taxes from external system, concurrent process India - AR Tax and Freight Defaultation, generates accounting and service tax invoice number.

For manual create Transaction, complete button will do it.

1. **Step 2. India - Service Taxes Processing**
   - For cash basis, the India - Service Taxes Processing program, generates liability account from interim account, and updates repository with service invoice number.
   - For accrual basis, the India - Service Taxes Processing program, updates repository with service invoice number.

**Enhancement to Document Sequencing Setup window for Service Tax**

The Document Sequencing window has been updated as follows:

**Enhancement to Document Sequencing Setup window for Service Tax**

The Document Sequencing window has been updated as follows:

- The VAT menu is removed.
- Regime code now includes Service Tax regime
- Registration Number includes Service Tax Registration Number set in regime registrations
• For Service tax, Document Type is Order, Invoice and Default.

Enhancement to Regime Registration window for Service Tax
Includes new registration names, AR Receipt Class, Batch Source Credit Memo, Batch Source Debit Memo.
Registration Value: For service tax, you can change the receipt class at regime and organization level. If the receipt class had been used for Service tax, and it had been replaced at the organization level, then it can only be used to query existing data in the Receipt window and open the Tax window to from the Receipt window to view Oracle Financials for India Tax.

Change to Enter Transactions India Localization Window
The field No has been renamed to Num. Service Invoice Number field is added in the lines region.
Service invoice number displays in the reference column for a standard receivables transaction window based on the JAI: Include Tax Invoice Number in AR Transactions – Reference profile value.

Service Tax Invoice Number Generation for Receivables Transaction
Service tax invoice number generation depends on the Document Sequencing Setup window definition starting from the first day of every financial year.
Generate Service Invoice Number:
Service tax invoice number is generated for completed Receivables transaction. The Interface Tax Lines India window includes a new column, Service Tax Invoice Number.

Enhancement to India Localization Cash Receipts Window for Service Tax
Save the receipts before opening Cash Receipts window for service tax. Once you confirm taxes on the Cash Receipts window, the advanced receipts cannot be modified.
• Cash Receipts window is opened when the receipt class is defined in Service Tax region for Advance Receipts. If the receipt has taxes, then India Localization Cash Receipts window can be opened for query even though it is not defined in regime for advanced receipt.
• Tax category fields select values that are for service tax only when the receipt class is defined in service tax regime for Advance Receipts.
• Added a Service type field. You cannot enable the service type field if the receipt class is defined in the Tax Collected at Source Regime.
• On the TCS Regime window, the Number field is renamed to Document number and added a Document Type.

Modifying India - Service Tax processing

The India - Service Tax processing process has been modified to update repository when the service tax accounting is generated on Advance Receipt. A new column for service tax invoice number is added in the repository table.

Modified Profile Option name

The profile, JAI: Include Excise and VAT Invoice Number in AR Transactions – Reference, has been modified to JAI: Include Tax Invoice Number in AR Transactions – Reference. You can set up this profile at the Site, Application and Responsibility levels. The default value is No.

Impact on Service Tax Report

Support for Reverse Charge Mechanism – Service Tax

This topic describes the support for reverse charge pertaining to service tax. In the fiscal budget of India, the federal government issued Notification Number 15/2012 Service Tax dated 17-Mar-2012, which notifies that some portion of the service tax liability must be paid by the service provider and the other portion of the service tax liability is paid by the service receiver. On 20th of June, Notification Number 30/2012, the federal government had issued another notification suppressing the Notification Number 15/2012 – Service Tax dated 17-Mar-2012 wide.

A guidance paper on Service tax was released by the Finance Ministry mentioning the effective date of the changes for reverse charge as July 1, 2012. To enable accounting of reverse charge pertaining to service tax in the Oracle Financials for India, the following changes have been made:

Tax Definition India Localization

To classify the tax for reverse charge, a new check box, Reverse Charge is added in the Flags region of the Tax Definition India Localization window.

• Reverse Charge option is enabled for the following tax types:
  • Service Tax
  • Service Tax – Education Cess
  • Service SH Education Cess

• When Reserve Charge is enabled, the Inclusive Tax will not be available.
India - Service Tax Processing

Service Tax India Processing concurrent process is modified to support the taxes that are flagged as Reverse Charge.

- Receivables Side: Taxes flagged as Reverse Charge are not considered for processing when submitted for determining the liability

- Payables side: The taxes flagged as Reverse Charge are not considered at the time of processing on payables side for determining the recover amount and updating the repository. During the month in which the service provider is paid, all those transactions are considered. Supplier invoice payment can be made in full or partial. In the case of partial payments, the transactions are considered and taxes are computed in proportion to the amount paid. The date of payment is the transaction date for updating the repository and GL Interface is also populated with the same date for gl_date.

Service Tax Payment Details

After making the payment to the tax authority, payment is captured in the India localization. When the Reverse Charge is selected for payments line, accounting entries are inserted in GL Interface table with the GL date for claiming credit of the service tax paid in the previous month and also updates the repository. Alternatively, when the Service tax processing concurrent process the accounting entries are passed to the GL Interface table and the repository is updated.

Service Tax Repository Review Window

After the Reverse Charge functionality, Payables shows the following details for each Payables invoice:

1. Accrual basis credit for the tax paid by the service provider

2. Liability line for the amount paid to service tax authority

3. Credit of the tax availed on the tax paid to service tax authority

The credit is availed at the time of accounting for the service tax paid by the service provider shows as normal line.

For the service tax paid to the tax authority in the month when payment is made to the supplier is shown as the transaction completed for that month. If the service receiver makes multiple payments to the service provider for the same invoice, then all the liability entries are shown as well.

Credit Entries for the service tax availed on the payment made to the tax authority is shown. If there are multiple payments to the tax authority in different months, then they are displayed. If there are multiple lines for the same month, then all are compiled into one line. The Reverse Charge is represented as Reverse Charge – Liability and Reverse Charge – Recovery. In case of other transactions these columns are left blank.

There is no impact on the Receivables side.
Regime Registration

Regime Registration window is modified to support the Reverse Charge functionality. A new value Reverse Charge is seeded for the Account Name LOV.

The value is set at the Regime level and users can change the same at the Inventory Organization level. Now with the uptake of the Reverse Charge functionality, Interim Liability Account should be defined.

India – Add Tax Value to Sales Order Reports

The India – Add Value to Sales Order concurrent process has been modified to not consider the taxes that are flagged as Reverse Tax. Reverse tax is paid by the service receiver so it does not have an impact on the credit limit of the customer.

- Taxes Window
  The Taxes window shows the India Localization Taxes as well as the Reverse Charge flagged taxes. The total on the taxes considers these taxes.

- Others Window
  There should not be any impact on the receiving or delivery side with respect to accounting or costing update. The packages should not consider the taxes which are flagged with "Reverse Charge".

Debit Memos / Credit Memos

There is an impact on the Debit and Credit memos for Payables and Receivables due to reverse charge for service tax.

For Receivables

Reverse charge does not affect the accounting side as it is tax. It is applicable only on supplementary invoices like Debit memos that result in billing to customers. For example,

- Debit Memos
  Debit Memo is similar to invoice where we ask the customer to pay more which may arise due to increase in rate or any other reason. The treatment for Debit memo should be same as that of the Invoice in AR that is it should also include the Reverse Charge Tax but should not be accounted to receivables or update the service tax repository.

- Credit Memos
  Credit Memos are issued by supplier for mostly for the deficiency in service or price. It is an accounting adjustment and as such it does not have any tax implications which respect to reverse charge. On AR credit memos we should not have any reverse charge taxes on it.

For Payables
Reverse charge taxes also has impact on the Payables Debit and Credit Memos.

- **Debit Memos**
  
  Debit Memos are issued by customer to supplier on account of deficiency of service or over billing or some other account related. Since there is no concept of service being provided by the service receiver and it is mainly on account of accounting adjustment reverse charge is not applicable.

- **Credit Memos**
  
  Credit Memo is issued by supplier or service provider for increase in rate or quantity so on, Suppliers Debit Memo which is equivalent to supplementary invoice and that has all the taxes. In this case it will also have the reverse charge taxes.

  Credit Memo should be handed to support the Reverse charge taxes and the treatment for this document will be same as that of the Payables Invoice.

**Accounting in the Payables flow**

Reverse Charge accounting happens only during Invoice accounting and there is no impact at the time of PO Match, Receipt Match or ERS Invoice creation.

When the Payables invoice is accounted and the document has Reverse Charges classified tax codes, then the accounting entry is created for interim liability and for reducing the balance of the supplier liability for equivalent portion of service tax to be paid directly to the service tax authority.

At the time of defaulting of taxes on the standalone Payables invoice, the following accounting entry is generated:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit/Credit</th>
<th>Debit/Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplier Liability A/C</td>
<td>DRr</td>
<td></td>
</tr>
<tr>
<td>Service Tax Interim Liability A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax Education cess Interim Liability A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax SH Education Cess Interim Liability A/C</td>
<td></td>
<td>Cr</td>
</tr>
</tbody>
</table>

Credit on the reverse charge on service tax is available on the subsequent month of payment of supplier invoice.

During the month when the supplier payment is made, at the time of submission of
India – Service Tax Processing concurrent program, the related reverse charge lines are considered and the liability is updated to the repository.

The accounting entry passed at the time of updating the repository is:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit/Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Tax Interim Liability A/C</td>
<td>Dr</td>
</tr>
<tr>
<td>Service Tax Education cess Interim Liability A/C</td>
<td>Dr</td>
</tr>
<tr>
<td>Service Tax SH Education Cess Interim Liability A/C</td>
<td>Dr</td>
</tr>
<tr>
<td>Service Tax Liability A/C</td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax Education cess Liability A/C</td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax SH Education Cess Liability A/C</td>
<td>Cr</td>
</tr>
</tbody>
</table>

At the time of settlement these liability entries are considered and tax authority invoice is created along with other liability entries. The payment for the tax authority invoice is like a normal settlement invoice.

After the payment of the tax authority invoice, navigate to the India Localization, click the process payment button in Settlement Payment Details and this generates the recovery entries for the service tax reverse charge taxes with the system date. The accounting generated is:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit/Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Tax Recovery A/C</td>
<td>Dr</td>
</tr>
<tr>
<td>Service Tax Education cess Recovery A/C</td>
<td>Dr</td>
</tr>
<tr>
<td>Account</td>
<td>Debit/Credit</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Service Tax SH Education Cess Recovery A/C</td>
<td>Dr</td>
</tr>
<tr>
<td>Service Tax Reverse Charge A/C</td>
<td></td>
</tr>
<tr>
<td>Service Tax Education cess Reverse Charge A/C</td>
<td></td>
</tr>
<tr>
<td>Service Tax SH Education Cess Reverse Charge A/C</td>
<td></td>
</tr>
</tbody>
</table>

On submission of the Service Tax Credit Register there are two lines for the invoice that have reverse charge, one for the credit availed at the time of accounting under POT basis and second line for the credit availed on payment of tax authority invoice.

There are no service taxes accounting impact on the receivables on the service provider side, when the settlement is done for the service tax transactions. The only difference is that for these transactions data is retrieved from Payables instead of Receivables. For these transactions the source will be Payables.

**Impact on Financials for India Reports**

**India Service Tax Pending Liability Report**

This Report shows data for the transactions where reverse charge tax is there on the transactions and for which the service provider payment is not shown. If the payment is made partially to the service provider, the interim liability is prorated and shown accordingly for the balance payable. Once the payment is fully made, the lines do not appear in the report.

**India Service Tax Credit Register Report**

In this report the recovery entry is shown only when the payment flag is checked. If the Payment flag is not checked, then data is not displayed. If multiple payments are made to the tax authority, then that many number of lines display in this report.

List of other report which may have impact are:

1. India - Create Variances for Payables Tax line
2. India - Concurrent for 3rd Party Invoices
3. India - Service Tax Pending Recovery Report

India - Program to Generate eTDS Quarterly Certificates 26Q – must not consider the amount being paid to the service tax authority as the law as tax has to be recovered on
the amount debited or credited to the supplier. In this case, the service tax authority is paid for the reverse charge. This is applicable for all the TDS reports.

**Supporting Uptake of Point of Taxation for Service Tax**

Point of Taxation has been introduced by the Federal Government of India through the budget of 2011-12. Initially, the law was made applicable from April 1, 2011, NT # 18/2011- Service Tax. There were a lot of ambiguities in the notification like the accrual basis is applicable on Order to Cash flows and in Procure to Pay cycle credit needs to be considered on payment basis as Cenvat Credit Rules 2004 was not amended. Also, the transitional provisions were ambiguous.

To remove all the ambiguities, the Federal Government of India has released further notifications on March 31, 2011.

- NT # 25/2011 - Service Tax is issued to remove the ambiguity on the transitional provisions. You can use cash basis or accrual basis till June 30, 2011 and it is mandatory to switch to Point of Rules form July 1, 2011 on accrual basis both in case the of Procure to Pay and Order to Cash flows.

- NT # 13/2011 Central Excise is issued to remove the ambiguity on the recovery of service tax credit in Procure to Pay cycle under Cenvat credit rules of 2004. You can use service tax credit at the time of invoice entry but the same needs to be reversed if you fail to make the payment within three months. If the payments are made to the supplier after reversal, then Cenvat credit is available on those invoices to the extent of amount paid.

**Setting Up Point of Taxation**

In the Others tab of the Service Tax Regime Registration window, a new field Effective date for Service Tax Point of Taxation is added. This date is the date from which the Point of Taxation is applicable. It is applicable to all the organizations defined for Service Tax Regime.

Before setting up, ensure that the liability accounts and recovery accounts in the Service Tax Regime are setup properly. Otherwise, the accounting becomes incorrect.

The reversal period must be defined in the Others tab and is applicable to all the inventory organizations. The reversal Period can be defined as days or months based on the interpretation of the law. Currently it says at three months.

**Note:** Once the setup is done, you cannot change the date and from this date accrual basis is applicable for service type of taxes in Procure to Pay and Order to Cash flows.

**Accounting and Repository update based on GL date**

With this enhancement, repository is updated based on the GL date for both Procure to
Pay and Order to Cash flows.

**Accounting Entries**

**Order to Cash Flows**

Effective from July 1, 2011 the following accounting entry is generated for Manual Receivables Invoice, Debit Notes, Invoices imported through Order Entry (Sales Orders and Bill only workflow):

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debtors A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Revenue A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax Liability A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax Edu Cess Liability A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax SH Edu Cess Liability A/C</td>
<td></td>
<td>Cr</td>
</tr>
</tbody>
</table>

Accounting entry for Cancellation of AR invoice and Debit Note

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax Liability A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax Edu Cess Liability A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax SH Edu Cess Liability A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Debtors A/C</td>
<td></td>
<td>Cr</td>
</tr>
</tbody>
</table>

Effective Date for Service Tax Point of Taxation is compared with the GL date and this is the date on which the repository will be updated on submission of the India - Service Tax Processing concurrent process.
Note: If there are transactions created before July 1, 2011, then service tax repository is updated based on payment basis.

Procure to Purchase Flows

In the case of Procure to Purchase flows, credit is eligible on the creation of AP (Accounts Payables) invoice. The AP invoice is created as Standalone AP invoice, based on Purchase Order Match or Receipt Match.

The Accounting entry for service tax credit is created at the time of Final or Final Post. GL Date of the transaction is considered for the creation of service tax credit entry and for repository update.

Repository is updated when India – Service Tax Processing concurrent process is submitted. Interim recovery account is a suspense account that is debited at the time of base transaction creation and the entry gets written off at the time of Final or Final Post where the Cenvat credit on service tax is availed.

Following are the accounting entry at the time of Final or Final Post of Standalone AP invoice:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Tax Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Education Cess Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax SH Edu Cess Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax Interim Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax Edu Cess Interim Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax SH Edu Cess Interim Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
</tbody>
</table>

If the AP invoice is cancelled in the same period, recovery accounts will be reversed and if the cancellation is happening in the subsequent periods, liability account will be reversed. Accounting entry for cancellation will be generated on the same date AP creates.
<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Tax Interim Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax Edu Cess Interim Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax SH Edu Cess Interim Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Education Cess Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax SH Edu Cess Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
</tbody>
</table>

Following accounting entry is generated, if cancellation happens in different period:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Tax Interim Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax Edu Cess Interim Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax SH Edu Cess Interim Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Education Cess Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax SH Edu Cess Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
</tbody>
</table>

**Note:** If you cancel the AP invoice in the prior period which is open,
then the accounting is created in that period only. You must submit the India – Service Tax Processing concurrent process for that date to update the repository.

In case of Debit or Credit Memos created though AP Invoice workbench, Service Tax Liability account will be updated.

Following accounting entry is created in GL Interface for Debit or Credit Memos:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Education Cess Interim Liability A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax SH Edu Cess Interim Liability A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax Liability A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax Edu Cess Liability A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax SH Edu Cess Liability A/C</td>
<td></td>
<td>Cr</td>
</tr>
</tbody>
</table>

Following accounting entry is created in GL Interface for Debit or Credit Memos in case of cancellation:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Tax Liability A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax Educ Cess Liability A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax SH Edu Cess Liability A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax Interim Liability A/C</td>
<td></td>
<td>Cr</td>
</tr>
</tbody>
</table>
Following accounting entry is created in case of standalone AP Invoice with partial recovery of service tax:

This is the accounting entry for AP invoice

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Education Cess</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Interim Liability A/C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Tax SH Educ Cess</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Interim Liability A/C</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Following accounting entry is created at the time of Final Or Final Post of Standalone
AP Invoice with partial recovery of service tax:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Tax Recovery Account (to the extent of Recoverable) A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Education Cess Recovery (to the extent Service Tax Edu Cess Recoverable) A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax SH Edu Cess Recovery (to the extent Service Tax SH Edu Cess Recoverable) A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax Interim Recovery (to the extent Recoverable) A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax Edu Cess Interim Recovery (to the extent Service Tax Edu Cess Recoverable) A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax SH Edu Cess Interim Recovery (to the extent Service Tax SH Edu Cess Recoverable) A/C</td>
<td></td>
<td>Cr</td>
</tr>
</tbody>
</table>

Purchase Order Matched Invoices

This accounting entry is passed at the time of accounting in GL interface for:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Tax Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Education Cess Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
</tbody>
</table>
### Account Debit or Credit Debit or Credit

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Tax SH Edu Cess Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax Interim Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax Edu Cess Interim Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax SHE Edu Cess Interim Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Inventory Receiving A/C</td>
<td></td>
<td>Cr</td>
</tr>
</tbody>
</table>

### Receipt Matched Invoices

Following accounting entry is created by IL in GL Interface at the time of receiving:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Tax Interim Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax Edu Cess Interim Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax SHE Edu Cess Interim Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Inventory Receiving A/C</td>
<td></td>
<td>Cr</td>
</tr>
</tbody>
</table>

Following is the accounting entry is created at the time of accounting of AP invoice:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Tax Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax SHE Edu Cess Interim Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
</tbody>
</table>
Account Debit or Credit | Debit or Credit
---|---
Service Tax Interim Recovery A/C | Dr
Service Tax Interim Recovery A/C | Cr
Service Tax Edu Cess Interim Recovery A/C | Cr
Service Tax SH Edu Cess Interim Recovery A/C | Cr

In case of transactions that are created prior to the specified Effective date for Service Tax Point of Taxation, you can take credit on payment basis. Repository is updated based on running the India – Service Tax Processing concurrent process.

**Accounting for Inclusive Service Tax**

This topic explains the accounting for inclusive service tax.

Accounting set up is set at N for Account Inclusive Tax in TDS Year.

If the value is set as N, then accounting entries are not generated for inclusive service tax. In case of Standard Invoice, Debit and Credit Memos are created using India Localization Support for Standalone Payables invoice. Documents created through Payables invoice workbench, miscellaneous lines with positive amount, and negative amount for service taxes are inserted for the same account.

Repository for the above transactions will be updated based on the GL date on submission of India Service Tax Processing concurrent process.

Accounting set up is Set Y for Account Inclusive Tax in Tax Deducted at Source Year details. If you select Yes, then accounting entries are generated for inclusive service tax. In case of Standard Invoice, Debit and Credit Memos are created using India Localization Support for Standalone AP invoice at the time of Final or Final Post in the GL interface directly.

This is the accounting entry at the time of accounting in GL interface in case of the above documents:

Account Debit or Credit | Debit or Credit
---|---
Service Tax Recovery A/C | Dr
### Accounting entries for Receipt Matched Invoices

At the time of receiving – entry generated by base for amount including service tax:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receiving Inventory A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>AP Accrual A/C</td>
<td></td>
<td>Cr</td>
</tr>
</tbody>
</table>

Separate account for inclusive tax (to the extent of Inclusive Tax):

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>AP Accrual A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Receiving Inventory A/C</td>
<td></td>
<td>Cr</td>
</tr>
</tbody>
</table>

Accounting entry at time of delivery – passed by IL (there is no change in this entry):
Accounting entry at the time of Invoice Match to receipt:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Tax Interim Recovery A/C</td>
<td>Dr</td>
</tr>
<tr>
<td>Service Tax Edu Cess Interim Recovery A/C</td>
<td>Dr</td>
</tr>
<tr>
<td>Service Tax SHE Cess Interim Recovery A/C</td>
<td>Dr</td>
</tr>
<tr>
<td>Supplier Liability A/C</td>
<td>Cr</td>
</tr>
</tbody>
</table>

| Supplier Liability A/C                               | DCr             |
| AP Accrual A/C                                       | Dr              |

Accounting entry at the time of Final or Final Post:
<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Tax Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Education Cess Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax SH Edu Cess Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax Interim Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax Educ Cess Interim Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax SH Edu Cess Interim Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
</tbody>
</table>

The above accounting entry is passed for Purchase Order matched invoices at the time of invoice accounting.

**Reversal Process**

A new menu is provided for the reversal of the Payable invoices which are not paid based on the reversal period defined in the Other Tab of the Service Tax Regime.

Based on the query criteria, the window lists invoices that are not yet paid or partially paid. You can select all the invoices or specific invoices for reversal.

Date of Reversal is computed by the system based on the setup in the Service Tax Regime and you can change it.

Batch number is provided for each reversal and you can query transactions using the batch number.

After you click Reversal, the reversal entries for the Tax to be Adjusted are inserted into the GL Interface table. Accounting is based on the Date of Reversal for that particular invoice. If the invoice is partially paid, then the tax reversal is done to the extent of the open invoice amount and the tax on it.

Repository for the Reversal Transactions is updated once the India – Service Tax Processing concurrent process is submitted.

**Note:** Once the payment is made to the supplier, Credit is used on the invoices that are reversed. Credit for such transactions is available on cash basis. Credit can be taken on the date when payment is made to
the supplier. Credit on such transactions is updated in the repository when the India Service Tax Processing concurrent process is submitted.

Accounting entry at the time of Reversal At the time of reversal, the following accounting entry is passed to the GL interface table:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit or Credit</th>
<th>Debit or Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Tax Interim Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax Educ Cess Interim Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax SH Edu Cess Interim Recovery A/C</td>
<td>Dr</td>
<td></td>
</tr>
<tr>
<td>Service Tax Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Education Cess Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
<tr>
<td>Service Tax SH Edu Cess Recovery A/C</td>
<td></td>
<td>Cr</td>
</tr>
</tbody>
</table>

**Impact on Reports**

All the reports in the service tax are based on the GL date with the application of this patch that is the date parameters in the report now refers to the GL dates of the transactions.

Service Tax Credit Register Report

Service Tax Credit Register report shows all the transactions that have updated the repository.

Two new parameters are added to show data based on organization and location. Transactions are distinguished as cash basis or credit basis with a C or A ID against the transaction.

Following transactions are shown in the report:

- Credit taken in accrual basis
- Credit taken in cash basis for the transactions created during the transition period
- If cancellation happens in the same month, then the cancellation of Standalone
Payables invoice displays

- Manual Recovery transactions
- Manual Adjustment Recovery transactions
- Service Tax Distribution In transactions
- Reversed transactions for which payment is not made and on which credit it taken, reversed after the stipulated period as negative line.
- Reversal Transactions for which credit is availed again after payment being made.

**Service Tax Pending Recovery Report**

This report is based on the GL date and it shows all the transactions that have not updated the repository for using credit and also on transactions on which credit can be availed.

Following transactions are shown in the report:

- All Payables invoices for which payment is not made or partly made
- All Payables transactions that are created post effective date setup where accounting is not completed.
- Reversed transactions for which payment is not made and on which credit is taken, reversed after the stipulated period as a positive line.
- Reversal Transactions for which credit is availed again after payment being made.

**Service Tax Report**

Service Tax report shows all the transactions that have updated the repository.

Two new parameters are added to show data based on organization and location. Transactions are distinguished as cash basis or credit basis with a C or A ID against the transaction.

Following transactions are shown in the report:

- Cash basis for the transition transactions where payment has been received
- Accrual basis for all the transactions after the effective date
- Manual Liability Transactions
- Manual adjustment Liability entries
- AP Debit / Credit Memos
• AP invoices where cancellation has taken place in different period.

• Service Tax Liability distribution transactions

**Service Tax Pending Liability Report**

This report is based on the GL date and the report shows all the transactions that have not updated the repository for ascertaining the liability.

Following transactions are shown in the report:

• All Receivables transactions where payments have not been received.

• All Receivables transactions created after effective date where the transaction has not completed.

• Payables Debit and Credit memos are accounted.

• Payables invoices cancelled in subsequent period where Service Tax Processing is not submitted.

**Service Tax Repository Review**

Changes are made in the Service Tax Repository Review window. Two new transaction sources, Payables Reversal and Payables Reversal Claim, are added for identifying and viewing reversal transactions and payment for reversal transactions.

Accounting for service tax is changed from cash basis to accrual basis with effective from July 1, 2011 in the federal budget of 2012 to 2012 under the Point of Taxation rules of 2011. But there are some provisions under the Point of Taxation Rules 2011, where accrual basis is exempted, that is, cash basis is applicable for certain category of service, transactions, and entities.

In the NT # 25/2011 - Service Tax, it is stated that cash basis is applicable for only specific organization rendering set of services.

**Requirements Under NT # 25/2011 - Service Tax**

Individuals or proprietary firms or partnership firms providing taxable services referred to in sub-clauses (p), (q), (s), (t), (u), (za), (zzzzm) of clause (105) of section 65 of the Finance Act, 1994, shall be the date on which payment is received or made, as the case may be.

**Setting Up**

To enable accounting and recovery of service tax on cash basis for the specified organizations the same is provided through setups in the Service Tax Regime.

Two new lookup are added, after setting up these lookups and organization is assigned, then the cash basis is applicable for the selected organization.

**Lookups**

Organization Classification – Select if the organization is individual, proprietary firm,
or partnership firm.

Services Rendered – Select the service being rendered by the organization which are services provided under sub-clauses (p), (q), (s), (t), (u), (za), (zzz zm) of clause (105) of section 65 of the Finance Act, 1994.

The accounting entries are generated on cash basis, that is, similar to the pre-Point of Taxation and service tax repository is updated on submission of India Service Tax Processing concurrent.

Note: At the regime level, define the new look up as Organization and Others for both the lookup and change to respective values at Inventory Organization level. If these two values are different at the organization level, then for the organization cash basis is applicable.

BOE Invoices

Generating BOE Invoices

You can create the BOE Invoices for all the import purchases and the liability will be recognized to the Customs Authority and any Advance Payment can be made before the actual receipts of material.

To enter BOE Invoices, navigate to the India Local Bill Of Entry window.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header Information</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating Unit</td>
<td>(Required)</td>
<td></td>
<td>Enter or select operating unit.</td>
</tr>
<tr>
<td>BOE Status</td>
<td>(Display Only)</td>
<td></td>
<td>Displays the BOE status.</td>
</tr>
<tr>
<td>Inventory Organization</td>
<td>(Required)</td>
<td>EDIT</td>
<td>HELP select the Inventory Organization where this import is going to be</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PICK</td>
<td>accounted.</td>
</tr>
<tr>
<td>Location</td>
<td>(Required)</td>
<td>EDIT</td>
<td>HELP Location for that Inventory Organization is to be picked from LOV</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PICK</td>
<td>where this import is going to be accounted.</td>
</tr>
<tr>
<td>Inventory Organization</td>
<td>(Required)</td>
<td></td>
<td>Enter or select the inventory organization.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Supplier Name</td>
<td>(Required)</td>
<td></td>
<td>Enter or select the supplier name.</td>
</tr>
<tr>
<td>Supplier Site</td>
<td>(Required)</td>
<td></td>
<td>Enter or select the site for the supplier.</td>
</tr>
<tr>
<td>BOE Number</td>
<td>(Display only)</td>
<td></td>
<td>Select from the LOV depending upon the BOE for which the Invoice is to be generated.</td>
</tr>
<tr>
<td>BOE Date</td>
<td>(Mandatory)</td>
<td></td>
<td>Enter the BOE date as specified in the BOE Document.</td>
</tr>
<tr>
<td>Import Dept Sl.No</td>
<td>(Optional)</td>
<td></td>
<td>Enter the Serial Number allotted by the Import Dept.</td>
</tr>
<tr>
<td>Import Dept Sl.Date</td>
<td>(Optional)</td>
<td></td>
<td>Enter the date allotted by the Import Dept.</td>
</tr>
</tbody>
</table>

**Import Detail Tab**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customs Authority</td>
<td>(Required)</td>
<td>HELP PICK</td>
<td>Select the respective Vendor Name or Customs Authority Supplier.</td>
</tr>
<tr>
<td>Authority Site</td>
<td>(Required)</td>
<td>EDIT PICK</td>
<td>HELP Defaulted Site for a respective Vendor or Customs Authority Supplier.</td>
</tr>
<tr>
<td>BOE Type</td>
<td>(Required)</td>
<td>EDIT PICK</td>
<td>HELP Select the value depending upon the nature of transaction.</td>
</tr>
<tr>
<td>Nature of Trans</td>
<td>(Optional)</td>
<td></td>
<td>Define the nature of transaction.</td>
</tr>
<tr>
<td>Agent Code</td>
<td>(Optional)</td>
<td>EDIT PICK</td>
<td>HELP Enter the Agent Code who is dealing this particular Import Shipment.</td>
</tr>
<tr>
<td>Port Code/Type</td>
<td>(Optional)</td>
<td></td>
<td>Select the Port Code or Type like Sea, Air, and Land.</td>
</tr>
<tr>
<td>BOE Without Reference</td>
<td>(Optional)</td>
<td></td>
<td>In case of BOE’s without Item References, there should be a validation that only one line can be entered</td>
</tr>
<tr>
<td>Field Name</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BOE Item</td>
<td>(Optional)</td>
<td></td>
<td>You can use this option to create an Item Independent BOE. You can define a BOE for a Dummy Item and this can be used to match the Customs liability on any Item.</td>
</tr>
<tr>
<td>Independent Flag</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accounts Region</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BOE Amount</td>
<td>(Defaulted)</td>
<td></td>
<td>Defaulted from the BOE Details.</td>
</tr>
<tr>
<td>Applied Amount</td>
<td>(Defaulted)</td>
<td></td>
<td>Defaulted from the BOE details.</td>
</tr>
<tr>
<td>Write Off Amount</td>
<td>(Defaulted)</td>
<td></td>
<td>Defaulted from the BOE details.</td>
</tr>
<tr>
<td>Remaining Amount</td>
<td>(Defaulted)</td>
<td></td>
<td>This is calculated by the system.</td>
</tr>
<tr>
<td>DEPB Amount</td>
<td>(Optional)</td>
<td></td>
<td>Enter the DEBP amount.</td>
</tr>
<tr>
<td>[ ]</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>Enter line-specific additional detail and Save.</td>
</tr>
<tr>
<td>Currency Tab</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Currency Code</td>
<td>(Optional)</td>
<td></td>
<td>Enter the currency code.</td>
</tr>
<tr>
<td>Currency Date</td>
<td>(Optional)</td>
<td></td>
<td>Enter the date for the currency code.</td>
</tr>
<tr>
<td>Currency Rate Type</td>
<td>(Optional)</td>
<td></td>
<td>Enter the currency rate type.</td>
</tr>
<tr>
<td>Currency Rate</td>
<td>(Optional)</td>
<td></td>
<td>Enter the currency rate.</td>
</tr>
<tr>
<td>Shipment Information Tab</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Country of Origin and Code</td>
<td>(Optional)</td>
<td></td>
<td>Enter the country of origin.</td>
</tr>
<tr>
<td>Country of Consignment and Code</td>
<td>(Optional)</td>
<td></td>
<td>Enter the country where the consignment is going to.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------</td>
<td>-------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Port of Shipment</td>
<td>(Optional)</td>
<td>Enter</td>
<td>Enter the port where the shipment originated.</td>
</tr>
<tr>
<td>Vessel Name</td>
<td>(Optional)</td>
<td>Enter</td>
<td>Enter the name of the vessel containing the shipment.</td>
</tr>
<tr>
<td>Bill of Lading Number</td>
<td>(Optional)</td>
<td>Entee</td>
<td>Entee the bill of lading number.</td>
</tr>
<tr>
<td>Bill of Lading Date</td>
<td>(Optional)</td>
<td>Enter</td>
<td>Enter the bill of lading date.</td>
</tr>
<tr>
<td>Gross Weight</td>
<td>(Optional)</td>
<td>Enter</td>
<td>Enter the gross weight of the shipment.</td>
</tr>
<tr>
<td>Number of Packages</td>
<td>(Optional)</td>
<td>Enter</td>
<td>Enter number of package being shipped.</td>
</tr>
<tr>
<td><strong>Others Tab</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>License Num</td>
<td></td>
<td>Enter</td>
<td>Enter the License number.</td>
</tr>
<tr>
<td>Rotation Date</td>
<td></td>
<td>Enter</td>
<td>Enter the rotation date.</td>
</tr>
<tr>
<td>Rotation Num</td>
<td></td>
<td>Enter</td>
<td>Enter the number for the rotation.</td>
</tr>
<tr>
<td>IGM Date</td>
<td></td>
<td>Enter</td>
<td>Enter the IGM date.</td>
</tr>
<tr>
<td>IGM Num</td>
<td></td>
<td>Enter</td>
<td>Enter the number associated with the IGM.</td>
</tr>
<tr>
<td>MAWB Date</td>
<td></td>
<td>Enter</td>
<td>Enter the MAWB date.</td>
</tr>
<tr>
<td>MAWB Num</td>
<td></td>
<td>Enter</td>
<td>Enter the number associated with MAWB.</td>
</tr>
<tr>
<td>HAWB Date</td>
<td></td>
<td>Enter</td>
<td>Enter the HAWB date.</td>
</tr>
<tr>
<td>HAWB Num</td>
<td></td>
<td>Enter</td>
<td>Enter the number associated with HAWB.</td>
</tr>
</tbody>
</table>
### Field Name Description

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green Channel</td>
<td>Channel</td>
<td></td>
<td>Specify if it is eligible for Green Channel customs clearance.</td>
</tr>
<tr>
<td>Rotation No/date</td>
<td>(Optional)</td>
<td></td>
<td>Enter the Rotation Number and the Date allotted by the Import Dept.</td>
</tr>
</tbody>
</table>

### Amounts Block

#### BOE Line Details

Field wise description of BOE Line Details is given below

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Selection Region</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Num</td>
<td>(Required)</td>
<td></td>
<td>Enter the number.</td>
</tr>
<tr>
<td>Document Type</td>
<td>(Required)</td>
<td></td>
<td>Enter or select the document type.</td>
</tr>
<tr>
<td>Document Num</td>
<td>(Required)</td>
<td></td>
<td>Enter the document number.</td>
</tr>
<tr>
<td>Description</td>
<td>(Optional)</td>
<td></td>
<td>Enter the description.</td>
</tr>
</tbody>
</table>

#### Tax Category Region

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Category</td>
<td>(Required)</td>
<td></td>
<td>Enter or select the tax category.</td>
</tr>
<tr>
<td>All Lines</td>
<td>(Optional)</td>
<td></td>
<td>Indicate if the Tax Category is applicable to all lines.</td>
</tr>
<tr>
<td>Lines with No Tax Category</td>
<td>(Optional)</td>
<td></td>
<td>Indicate whether it applies to lines with no tax category defined.</td>
</tr>
<tr>
<td>Add lines</td>
<td>(Optional)</td>
<td></td>
<td>Click Add Lines to add detail lines with the information defined.</td>
</tr>
</tbody>
</table>

#### Details Region
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Num</td>
<td>ENTER</td>
<td></td>
<td>The Number of packages will be mentioned here.</td>
</tr>
<tr>
<td>Line Num</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shipment Num</td>
<td>Line</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>(Required)</td>
<td>ENTER</td>
<td>Item Name need to be specified for calculating Customs Duty Item wise.</td>
</tr>
<tr>
<td>Description</td>
<td>(Optional)</td>
<td>ENTER</td>
<td>The Description of the packages can be mentioned here.</td>
</tr>
<tr>
<td>UOM</td>
<td>(Required)</td>
<td>ENTER</td>
<td>UOM of the Item.</td>
</tr>
<tr>
<td>Unit Price</td>
<td>(Required)</td>
<td>ENTER</td>
<td>Enter the unit price of the item.</td>
</tr>
<tr>
<td>Quantity</td>
<td>(Required)</td>
<td>ENTER</td>
<td>The total Quantity imported and for which the Customs Duty is to be paid.</td>
</tr>
<tr>
<td>Applied Quantity</td>
<td>(Defaul ted)</td>
<td></td>
<td>Defaulted from the BOE details.</td>
</tr>
<tr>
<td>Amount</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assessable value</td>
<td>(Required/O ptional)</td>
<td>ENTER</td>
<td>The total Assessable Value of the goods on which the duty will be calculated.</td>
</tr>
<tr>
<td>Tax Category</td>
<td>(Optional)</td>
<td></td>
<td>Indicates the tax category selected.</td>
</tr>
<tr>
<td>Tax Amount</td>
<td>(Optional)</td>
<td>ENTER</td>
<td>Enter the tax amount.</td>
</tr>
<tr>
<td>Customs Code</td>
<td>Tariff</td>
<td>ENTER</td>
<td>Customs Tariff Number under which the duty will be assessed.</td>
</tr>
<tr>
<td>Customs Heading</td>
<td>Tariff</td>
<td>ENTER</td>
<td>Custom tariff heading under which the duty is assessed.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marks &amp; Number</td>
<td>(Optional)</td>
<td>ENTER</td>
<td>Enter the marks and number value.</td>
</tr>
<tr>
<td>Serial Number</td>
<td>(Optional)</td>
<td>ENTER</td>
<td>Enter the Serial Number of the Item packed with the Description of the packages.</td>
</tr>
</tbody>
</table>

### Rounding

The following fields are included in the Rounding window:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Taxes</td>
<td>(Required)</td>
<td></td>
<td>Enter the tax code.</td>
</tr>
<tr>
<td>Amount</td>
<td>(Optional)</td>
<td></td>
<td>Enter the amount.</td>
</tr>
<tr>
<td>Rounding Amount</td>
<td>(Optional)</td>
<td></td>
<td>Enter the rounding amount for each tax code.</td>
</tr>
<tr>
<td>Total Amount</td>
<td>(Optional)</td>
<td></td>
<td>Displays the total amount.</td>
</tr>
</tbody>
</table>

### Receipts Applied

The following fields are included in the Receipts Applied window:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipt Number</td>
<td>(Required)</td>
<td></td>
<td>Enter the receipt number to apply to.</td>
</tr>
<tr>
<td>Receipt Date</td>
<td>(Optional)</td>
<td></td>
<td>Enter the receipt date.</td>
</tr>
<tr>
<td>Shipment Number</td>
<td>(Optional)</td>
<td></td>
<td>Enter the shipment number.</td>
</tr>
<tr>
<td>Shipment Date</td>
<td>(Optional)</td>
<td></td>
<td>Enter the shipment Date.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------</td>
<td>-----------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Amount to Write off</td>
<td>(Displayed/Req</td>
<td></td>
<td>The User has to enter the Write Off Amount, which no longer</td>
</tr>
<tr>
<td></td>
<td>uired)</td>
<td></td>
<td>required. By default the Balance remaining in a BOE Invoice</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>will be displayed here but the User can override and change</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>the Amount.</td>
</tr>
<tr>
<td>Write off date</td>
<td>(Required)</td>
<td></td>
<td>The User has to enter the Date on which he is Writing Off a</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>BOE Invoice.</td>
</tr>
<tr>
<td>Write off Reason</td>
<td>(Optional)</td>
<td></td>
<td>The User has to enter the reason for the Write Off in this</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>optional field.</td>
</tr>
</tbody>
</table>

Once the User saves this window the entered amount is written from BOE Invoice and the Written Off column in the Amount Block of the BOE Invoice window is updated.

Note: You can view the GL Drilldown Accounting entries by clicking Show Transactions on the Tools Menu in Bill of Entry India Localization form.

PLA Invoices/Payment

Navigation, India Local Payable > India Localization > Invoice Entry > PLA Invoices
Field wise details for the PLA Invoice / Payment is given below

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment_Id</td>
<td>(Defaulted)</td>
<td></td>
<td>This is the system generated Payment_Id after entering data and save this form.</td>
</tr>
<tr>
<td>TR6 Challan No/Date</td>
<td>(Required)</td>
<td>ENTER</td>
<td>The user can enter TR6 Challan Number and Date through which the PLA Payment will be made.</td>
</tr>
<tr>
<td>Inventory Organization</td>
<td>(Required)</td>
<td>EDIT HELP PICK</td>
<td>The user defined Inventory Organization need to be picked up here from LOV.</td>
</tr>
<tr>
<td>Location</td>
<td>(Required)</td>
<td>EDIT HELP PICK</td>
<td>Location for that Inventory Organization is to be picked up from LOV.</td>
</tr>
<tr>
<td>Acknowledgment Block</td>
<td></td>
<td></td>
<td>The Acknowledgment Flag will be enabled after the PLA Payment is made and the user can update the Acknowledgment Date. Only after Acknowledgment is received and the Acknowledgment Flag is enabled the PLA Register will be updated.</td>
</tr>
<tr>
<td>PLA Amount</td>
<td>(Displayed)</td>
<td></td>
<td>This is the displayed total line amount of Excise Duty proposed to pay.</td>
</tr>
<tr>
<td>Authority</td>
<td>(Required)</td>
<td>EDIT HELP PICK</td>
<td>Select the respective Vendor Name or Commissioner of Excise from the LOV.</td>
</tr>
<tr>
<td>Site</td>
<td>(Required)</td>
<td>EDIT HELP PICK</td>
<td>Select the Site for the above selected Vendor from the LOV.</td>
</tr>
<tr>
<td>PLA Details Block</td>
<td>(Required)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Item Tariff</td>
<td>ENTER</td>
<td></td>
<td>Enter Item Tariff under which this PLA payment will be made.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Sub Heading</td>
<td></td>
<td></td>
<td>This is defaulted field as per the Item Tariff.</td>
</tr>
<tr>
<td>Basic Amount/Additional Amount/Other Excise</td>
<td>(Required) ENTER</td>
<td></td>
<td>The user has to specify how he wants to pay in Basic, Additional, and Other Excise Duty through this TR6 Challan.</td>
</tr>
</tbody>
</table>

**Note:** You can view the GL Drilldown Accounting lines by clicking Shows Transactions on the Tools menu in PLA Register manual entry India Localization form

On saving the transaction, a PLA Invoice will be automatically generated, validated and ready for payment. This Invoice Number has a prefix of 'PLA'. The payment for this Invoice may be made through regular Oracle Payables functionality.

Only after entering the Acknowledgment Date, PLA Register balance will be updated.

- Acknowledgment for a PLA Payment is not received and Flag is not enabled, then there will be difference between GL Balance and PLA Register till such time of receipt of Acknowledgment. The Acknowledgment Flag needs to be enabled by Opening the PLA Invoice screen itself.

### Using Sales Tax Declaration Forms - Issue Tracking

#### Overview

Purchases made by Registered Dealers, from Registered Dealer would be eligible for Concessional Rate of Sales Tax. This would require identification of transactions that are eligible for such rates. Also, the Declaration Form to be issued in order to avail such rate has to be tracked.

You can issue Sales Tax declaration forms for each of the transactions. Oracle Financials for India provides you with a feature to define Form Names, Define Taxes with Declaration Forms attached, Tracking Invoices for which these Forms have to be issued, Record details of Forms issued and query and view the Form details.

#### Prerequisites
Before creating the Transactions with Concessional Rates of Sales Tax, following setup needs to be done:

- Define Form Names
- Define Taxes with Form Names attached
- Define Supplier Additional Information
- Define Tax Categories with this Tax Code
- Define Item Categories with this Tax Categories

Before recording details of Concessional Forms to be issued to Supplier, following needs to be done:

- Complete Purchase Orders/Receipts with Sales Taxes with Form Names attached
- Create Invoices for these PO’s / Receipts
- Ensure that Invoice Distributions are created to account for Localization Taxes.
- Validated the Invoice.
- Submit 'India - ST Forms Issue Processing'

**Recording details of Sales Tax Declaration Forms**

To record details of Sales Tax Declaration forms, navigate to 'Define Sales Tax Form Details' window as follows

India Local Payables - India Localization - Suppliers - Issue ST Forms

In 'Find ST Form Details' screen, enter the Supplier Name, Supplier Site and Form Type in order to query for Invoices against which Forms are not yet issued. You can enter other query criteria to find specific invoices.

Details you enter in each of the fields would form criteria for the records fetched.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type Action Description</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue/Receipt</td>
<td>(Display only)</td>
<td></td>
<td>This field gets populated as Issue / Receipt based upon the Application chosen.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Issue in case of Payables and Receipt in case of Receivables.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Party Name</td>
<td></td>
<td></td>
<td>Party Name as defined in the ST form related data. Compared against the Party Name as available in the Invoices to which Sales Tax Forms is applicable.</td>
</tr>
<tr>
<td>Party Site</td>
<td></td>
<td></td>
<td>Party Site as available in the Invoices to which Sales Tax Forms is applicable.</td>
</tr>
<tr>
<td>Form Type</td>
<td></td>
<td></td>
<td>Form Type's which are applicable to the Sales Tax attached to the Invoices</td>
</tr>
<tr>
<td>Invoice from Date</td>
<td></td>
<td></td>
<td>Invoices having Invoice Date starting from this date onwards would form a part of the query criteria for matching. Viewing matched records. Should be a valid date in 'DD-MON-YYYY' format</td>
</tr>
<tr>
<td>Invoice To Date</td>
<td></td>
<td></td>
<td>Invoices having Invoice Date till this date would form a part of the query criteria for matching. Viewing matched records Should be a valid date in 'DD-MON-YYYY' format</td>
</tr>
<tr>
<td>Fin Year</td>
<td></td>
<td></td>
<td>Financial Year as applicable to the ST Form related data.</td>
</tr>
<tr>
<td>Form Number</td>
<td></td>
<td></td>
<td>Form Numbers that are issued to the Supplier, Supplier Site and Form Type.</td>
</tr>
<tr>
<td>Issue/Receipt Date</td>
<td></td>
<td></td>
<td>Enter a Date, which might match with the Issued Form’s Transaction Date.</td>
</tr>
<tr>
<td>View Forms Button</td>
<td></td>
<td></td>
<td>Button, which upon being clicked invokes the 'View Sales Tax form Details' Screen</td>
</tr>
</tbody>
</table>
On clicking the 'Issue/Receive Forms' button, the system fetches the Invoices to be matched. This information would be displayed in 'Define Sales Tax Forms Details' screen.

This screen has Header and Detail Sections

**Header Section**

This section allows you to record Form details such as Financial Year, Form Number, Form Amount, Form Date and Transaction Date. These details can be entered for a combination of Supplier Name, Supplier Site, Form Type and Operating Unit.

The Supplier Name, Supplier Site and Form Type are populated as the context information from the Query Find Screen.

It's mandatory to enter Financial Year, Form Number, Form Date and Transaction date fields before proceeding to the detail section to select Invoices.

You may choose to key in the Form Amount and proceed to the detail section for selecting Invoices to match the Form Amount. Else, you can leave the form amount to be automatically populated upon save, based on the sum of all Invoice level Form Amounts.

**Match All**

On checking Match All field, the system automates matching based on the header form amount.

The Match all Checkbox is unchecked, by default.

Un-checking the checkbox causes the detailed Invoice level form amount to be set to zero.

**Queried Amount**

Queried Form Amount fields display the total Form Amount that can be matched across all unmatched Invoices.

This is a display only field and cannot be modified.
Detail Section

This section displays unmatched Invoices in Issue Tab Page. The records would be grouped based on the combination of Invoice and Purchase Order.

The sum of all invoices level Form Amounts entered is displayed at the bottom in the Total Form Amount display field.

- It is mandatory that the sum of detail level Invoice Form Amounts match with header Form Amount. This is applicable only when you enter the Form Amount.
- In case of Invoices with negative tax target amounts the form amount entered should exactly be equal to that of the Tax target amount.

On saving the entered details, the Header Block is refreshed and the Form details are set to blank. Also, the Detail block is refreshed and only unmatched and partially matched records are fetched. The cursor returns to the header.

Issued Forms can be viewed through the 'View Sales Tax Form Detail' Screen. This is invoked by clicking on the 'View Forms' option in 'Finds ST Form Detail' window.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define Sales Tax Form Header Block (Matching Header)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Party Name</td>
<td>(Display only)</td>
<td></td>
<td>Context Information carried over from Query Find Screen</td>
</tr>
<tr>
<td>Party Site</td>
<td>(Display only)</td>
<td></td>
<td>Context Information carried over from Query Find Screen</td>
</tr>
<tr>
<td>Form Type</td>
<td>(Display only)</td>
<td></td>
<td>Context Information carried over from Query Find Screen</td>
</tr>
<tr>
<td>Fin Year</td>
<td>Required</td>
<td></td>
<td>User defined Financial Year Value to be selected from list of values as defined in the Tax Year Setup</td>
</tr>
<tr>
<td>Form Number</td>
<td>Required</td>
<td></td>
<td>Sales Tax Form Number to be defined by the user. This needs to be unique for Form Type and Fin year combination</td>
</tr>
</tbody>
</table>

3-60 Oracle Financials for India User's Guide
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form Amount</td>
<td>Required</td>
<td></td>
<td>The form Amount needs to exactly match with the sum of all Invoice level detailed form amounts.</td>
</tr>
<tr>
<td>Form Date</td>
<td>Required</td>
<td></td>
<td>Should be a valid date in 'DD-MON-YYYY' format</td>
</tr>
<tr>
<td>Transaction Date</td>
<td>Required</td>
<td></td>
<td>Should be a valid date in 'DD-MON-YYYY' format</td>
</tr>
<tr>
<td>Match All</td>
<td>Default Value 'N'</td>
<td></td>
<td>Requires a valid value for Fin Year, Form Number, Form Amount, Form Date and Transaction Date when checked. Matches the entire Invoice level records based on the form amount value. When unchecked, sets all detail level Invoice form amount to 0.</td>
</tr>
<tr>
<td>Queried Form Amount</td>
<td>(Display only)</td>
<td></td>
<td>Displays Total Form Amount that can be matched across all unmatched Invoices. This amount would be Sum of Matched Amounts reduced from Sum of Tax Target Amounts.</td>
</tr>
</tbody>
</table>

Sales Tax Form Detail Block (Matching Detail) - Issue Side

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoice Number</td>
<td>(Display only)</td>
<td>To be filled</td>
<td></td>
</tr>
<tr>
<td>Invoice date</td>
<td>(Display only)</td>
<td>To be filled</td>
<td></td>
</tr>
<tr>
<td>Po/Requisition Num</td>
<td>(Display only)</td>
<td>To be filled</td>
<td></td>
</tr>
<tr>
<td>Document Type</td>
<td>(Display only)</td>
<td>To be filled</td>
<td></td>
</tr>
<tr>
<td>Tax Target Amt</td>
<td>(Display only)</td>
<td>To be filled</td>
<td></td>
</tr>
<tr>
<td>Matched Amt</td>
<td>(Display only)</td>
<td>To be filled</td>
<td></td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form Amount</td>
<td></td>
<td></td>
<td>In case of + ve invoices sum of invoice level form amount and Matched amount cannot be greater than Tax target amount.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>In case of - ve invoices the form amount needs to be exactly same as that of tax target amount.</td>
</tr>
<tr>
<td>Total Form Amount</td>
<td>(Display only)</td>
<td></td>
<td>Sum of all invoice level Form amounts.</td>
</tr>
</tbody>
</table>

### Viewing Issued Forms

You can view the Sales Tax Forms Issued by clicking on the 'View Forms' button on the 'Find ST Forms Details' window. This would open 'View Sales Tax Form Details' window.

You will have to enter Supplier, Supplier Site and Form Type Details before you query for the Issued Forms.

This window has three sections Header, Details and Sub-Details.

### Header Section

The section shows Supplier Name, Supplier Site and Form Type. These details are populated as the context information from the Query Find Screen.

### Sales Tax Form Details

This section displays Form details based on the query criteria specified in the Query Find screen.

### Sales Tax Form Sub-Details

This section displays all matched Invoices grouped by combination of Invoice Number and Purchase Order.

For each Invoice the Tax Target amount verses the Matched Amount is displayed based on the above grouping.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Sales Tax</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Form Header Block</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Party Name</td>
<td>(Display only)</td>
<td></td>
<td>Context Information carried over from Query Find Screen</td>
</tr>
<tr>
<td>Party Site</td>
<td>(Display only)</td>
<td></td>
<td>Context Information carried over from Query Find Screen</td>
</tr>
<tr>
<td>Form Type</td>
<td>(Display only)</td>
<td></td>
<td>Context Information carried over from Query Find Screen</td>
</tr>
<tr>
<td>View Sales Tax</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Form Detail Block</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fin Year</td>
<td>(Display only)</td>
<td></td>
<td>Fin Year as created from the match detail screen.</td>
</tr>
<tr>
<td>Form Number</td>
<td>(Display only)</td>
<td></td>
<td>Form Number as created from the match detail screen.</td>
</tr>
<tr>
<td>Form Date</td>
<td>(Display only)</td>
<td></td>
<td>Form Date as created from the match detail screen.</td>
</tr>
<tr>
<td>Transaction Date</td>
<td>(Display only)</td>
<td></td>
<td>Transaction Date as created from the match detail screen.</td>
</tr>
<tr>
<td>Form Amount</td>
<td>(Display only)</td>
<td></td>
<td>Form Amount as created from the match detail screen.</td>
</tr>
<tr>
<td>View Sales Tax</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Form Sub Detail Block - Issue Block</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Invoice Number</td>
<td>(Display only)</td>
<td></td>
<td>This is the Transaction Number</td>
</tr>
<tr>
<td>PO / Requisition Amount</td>
<td>(Display only)</td>
<td></td>
<td>This field displays the Purchase Order Number</td>
</tr>
<tr>
<td>Document Type</td>
<td>(Display only)</td>
<td></td>
<td>This field displays the Document Type.</td>
</tr>
<tr>
<td>Tax Target Amt</td>
<td>(Display only)</td>
<td></td>
<td>This field displays Tax target amount.</td>
</tr>
</tbody>
</table>
Generating Records for Sales Tax Issue Tracking

Invoice Details required for issuing Sales Tax Forms would be generated by submitting 'India - ST Forms Issue Processing' concurrent program.

This concurrent program is available in India Local Payables Responsibility. This request would check for all Invoices that have Sales Tax with concessional Form applicability. Only validated Invoices would be considered for processing. The Invoice would be considered for Processing only if it was not processed earlier. Processed Invoices would be considered conditionally based on the changes to the document.

You can submit this request from India Local Payables Submit Requests 'India - ST Forms Issue Processing'.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Matched Amount</td>
<td>(Display only)</td>
<td></td>
<td>This field displays Matched Amount</td>
</tr>
<tr>
<td>Operating Unit</td>
<td>(Display only)</td>
<td></td>
<td>Value determined from the Profile values</td>
</tr>
<tr>
<td>Process for All Operating Units?</td>
<td></td>
<td></td>
<td>If you select 'Yes' in this field, then, the program would process Invoices corresponding to all Operating Units defined in the system. Else, only those related to the Operating Unit determined from Profile would be processed.</td>
</tr>
<tr>
<td>From Date</td>
<td>Mandatory</td>
<td></td>
<td>Low Value of Invoice Date to filter the Invoices.</td>
</tr>
<tr>
<td>To Date</td>
<td>Mandatory</td>
<td></td>
<td>High Value of Invoice Date to filter the Invoices.</td>
</tr>
<tr>
<td>Supplier</td>
<td></td>
<td></td>
<td>If you would like to process records for a specific Supplier then, select a Supplier Name in this field.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Supplier Site</td>
<td></td>
<td></td>
<td>This will be used to filter the data related to given Supplier Site, otherwise all Supplier Site's related data is processed.</td>
</tr>
<tr>
<td>Re Process not issued invoices</td>
<td></td>
<td></td>
<td>This would consider all Invoices in the selected date range for processing. Also, those Invoices that have been processed earlier would be re-processed. Hence, all revised actions and status on Invoices would be considered for re-processing. Invoices for which Forms are already issued would be left unprocessed.</td>
</tr>
<tr>
<td>Enable Trace</td>
<td></td>
<td></td>
<td>On selecting 'Yes' in this field, a Raw Trace File would be generated for this request. It is a pre-requisite to have 'Enable Trace' checked for 'India - ST Forms Issue Processing' Concurrent Program.</td>
</tr>
</tbody>
</table>

**India - FA Mass Additions**

After creation of Receipts, user should submit request for creation of Payables Invoices for the Third Party taxes that are included in the receipts. Meanwhile, user would create the Payables Invoices for the PO Vendor (Base Invoice). These Invoices would be either created manually or automated by submitting 'Pay on Receipt Auto Invoice' program for the receipt.

Once a Receipt matched AP Invoice is validated, approved and accounted, they would qualify for FA Mass Additions. User can schedule Mass Additions Create program to carry these lines to Fixed Assets. This program would only process base Invoices. As soon as this program completes successfully, 'India - Mass Additions Creation' program would be submitted automatically. This request would scan for all Third Party Taxes and Customs Duties applicable to the purchase. In cases where the Receipt includes any such Tax, this program would create one line per Receipt Tax line in Fixed Assets Mass Additions.

The user can view these requests in 'Prepare Mass Additions window. These lines will
carry the Invoice and PO Numbers of the First Party Invoice. The user can either create New Assets or Add these lines to an existing Asset or Merge them to another line.

'India - Mass Additions Creation' program can also be submitted explicitly. This can be used in exceptional scenarios where the third party tax lines are not transferred to FA. This request can be invoked from 'India Local Payables View Submit Requests - India Mass Additions Create'.

Define Invoice Tolerance Limits

Overview

As per Indian Central Excise Act and Income Tax Act, the Excise duty and TDS amount will be rounded off to the nearest Rupee and in effect the AP Invoices, the Header Amount and the Distribution Amount will have minor difference. Base Applications Invoices feature places an hold on Invoices that have difference between Header Amount and Distribution Amount.

Invoice Tolerance feature provided by Oracle Financials for India allows you to setup the Tolerance Percentages and Amounts. Wherever a hold is placed on Invoices due to difference in Distributions Total and the Invoice Header, then, the system would check for the tolerance limits setup for Organization. If the difference Amount falls within the specified limit, then this inserts an Additional Invoice Distribution line for the Difference Amount and the Invoice is Approved. This line would have the line type as 'Miscellaneous' and the charge Account would be as specified in the Invoice Tolerance Setup for the Organization.

In cases where you are Re-Approving the Invoices, the system would check for the existence of an Distribution line for Rounding Amount. If one exists, then the amount of this line would be updated with the revised difference.

Field Description

Operating Unit
User can select the Operating Unit value from the LOV.

Enable Percent Tolerance Flag
You need to enable this Flag if you want to allow Percentage based Tolerance limits. This Percentage would be applied on the Header Amount. On activating this flag, you will have to specify the Upper Percentage Value and Lower Percentage Value.

Enable Amount Tolerance Flag
You need to enable this Flag if you want to allow Amount based Tolerance Limits. On activating this flag, you will have to specify the Upper and Lower Value.
Important: Where you have specified both Percentage and Amount Tolerances then both will be applied on the Invoice and the Minimum of the two is considered as the Tolerance Limit.

Tolerance Charge account _ Id

You need to specify the GL Account to which the Rounding amount should be debited/credited.

View / Resubmit / Delete Error Tax Lines

Overview

The concurrent 'To insert tax distributions for pay on receipt' for processing of tax Lines for ERS Invoices created based on Purchase Receipts runs in batch mode. Whenever, some of the tax lines remain unprocessed due to some error, the error message is captured by localization. This feature provides with an option to view these error records and corresponding messages and mark them eligible for Reprocess. You would also have an option to delete these records.

To view the error records, navigate to India Local Payables - India Localization - Other - India - Resubmit Taxes for Pay on Receipt.

The form shows Invoice Number, Number of distribution Lines, Invoice Date, Error Date, Invoice Amount, Vendor Name, Vendor Site Code and Error Message for all Tax Lines (grouped by Invoice Number) that have ended in an error during 'India - To Insert Taxes For Pay On Receipt' program.

The user can check the records for resubmission either one or all at a time. If you would like to resubmit only one record then, you have to check the Re-Submit checkbox on the line. In you wish to resubmit all records, and then check the 'Re-Submit All' checkbox.

For Resubmission of the Error Invoices

- Check 'Re-Submit' for the Invoices that need to be resubmitted. Alternatively, Re-Submit All can be checked to resubmit all error Invoices.

- Click on 'Submit' button.

- Submit the concurrent 'India - To Insert Taxes For Pay On Receipt' for these Invoices to get processed.

For Deletion of the Error Invoices

Check 'Delete' for the Invoices that need to be deleted.

Click on Submit button.
The form would merely make the Invoices eligible for reprocessing. You have to explicitly run the concurrent 'India - To Insert Taxes For Pay On Receipt' for these Invoices to get processed.

**Importing Taxes to Payables and Receivables**

This topic describes support for importing taxes to Payables and Receivables. After data is imported into Receivables or Payables table, you can run the new India – Interface Tax Import to AP and India - Interface Tax Import to AR concurrent processes to import taxes into Receivables and Payables along with the standard their transaction. For all imported tax, you cannot modify or delete the tax.

New Interface Data Mapping window is added for imported data mapping to Oracle E-Business Suite setups. When you import tax data from external system into E-Business Suite, the importing data must comply with EBS definition. Taxable event must be specified in the mapping window based on Operating Unit, you can determine if the imported data could be recalculated by OFI or not by this setup.

If there are no mapping setup or source data is incorrect, an error displays and the import process stops. Right information is imported as Receivables transactions with Completed status or Payables invoice with Need Validation status. Incorrect information is stored in the Interface table and you can correct the data manually and import it again submitting the India – Import OFI Interface Tax concurrent process.

**Receivables**

Before running the import OFI tax, perform the following:

- Define external application’s tax code mapping to E-Business Suite’s Oracle Financials for India tax code in the Interface Date Mapping window.

- Import transaction data to AR interface table, you define particular column in RA_INTERFACE_LINES_ALL with specific value and the same value is populated in the Oracle Financials for India Interface table.

- Upload OFI interface table along with base interface table when updating data from the external system.

- Run Auto Invoice concurrent process.

- Submit the India - Interface Import Tax to AR process after the import is complete.

**Import Taxes to OFI Taxes Interface Table**

Imported application is Receivables. Ensure that Taxable Event is External or Standard. If the value is External, then add credit accounting of external system’s tax generating and add Excise and VAT invoice number to interface. If the value is Standard, then taxes are recalculated in E-Business Suite along with accounting, invoice number.
Update and Confirm OFI Taxes

You can import data in Oracle Financials for India Taxes Interface window for both External or Standard taxable events. Run the, India – Interface Import Tax to AR, concurrent process to import Financials for India taxes into receivables transaction. If the process errors, then view the error log, correct the data in the OFI Taxes Interface table. Rerun the India – Interface Import Tax to AR concurrent process until the process completes successfully.

Create accounting

Confirm the imported OFI Taxes in EBS

Accounting:

When Taxable Event is External, all of interface exclusive tax accounting is copied to Receivables parent transaction’s distribution. when Taxable Event is Standard, taxes are recalculated, accounting is generated for Exclusive taxes in Receivables parent transaction’s distribution and for accounting is generated for Inclusive taxes in General Ledger.

Payables

Before running the import OFI tax, perform the following:

- Define external system’s tax code mapping to E-Business Suite application’s OFI tax code in the Interface Date Mapping window.
- Import invoice data to Payables interface table. Upload OFI interface table along with base interface table when updating data from the external system.
- Run concurrent process, Payables Open Interface Import, to import Payables invoice from the interface table.
- Submit the India - Interface Import Tax to AR process after the import is complete.

Import Taxes to OFI Taxes Interface Table

Imported module is Payables. Ensure that Taxable Event is External or Standard. If the value is External, then add debit accounting of external system’s tax generating and add Excise and VAT invoice number to interface. If the value is Standard, then taxes are recalculated in E-Business Suite along with accounting, invoice number.

Update and Confirm OFI Taxes

You can import data in Oracle Financials for India Taxes Interface window for both External or Standard taxable events. External or Standard taxable events. Run the, India – Interface Import Tax to AR, concurrent process to import Financials for India taxes into receivables transaction. If the process errors, then view the error log, correct the data in the OFI Taxes Interface table. Rerun the India – Interface Import Tax to AR concurrent process until the process completes successfully.

Create accounting
Confirm the imported OFI Taxes in EBS.

**Accounting:**

When Taxable Event is External, all of interface exclusive tax accounting is copied to Payables invoice distribution line type of Miscellaneous. When Taxable Event is Standard, taxes are recalculated, accounting is generated for Exclusive and Inclusive taxes in invoice distribution and for Miscellaneous line type.

**Defining Interface Tax Lines India**

A new window, Interface Tax Lines India, is created for previewing interface tax lines in the India Local Receivables responsibility, under the Transactions menu. The interface data that are not imported into Receivables or Payables successfully due to validation errors also display here.

**Field Reference**

- **Operating Unit** – Select or enter the operating unit. This field is mandatory.
- **Organization** – Enter or select an organization.
- **Location** – Enter or select a location.
- **Import module** – Select either Payables or Receivables.
- **Error Exists** - This is View only field.
- **Batch Source Name** – Enter the name of the batch source.
- **Taxable Event** – Select the value as External or Standard. If you do not enter this field, then the system defaults value form tax code mapping window.
- **Taxable Basis** – This field is mandatory only for Standard event. The value is Line Amount or Assessable Value. If this is being used with Payables as the Import Module, then select Line Amount as the value. Excise and VAT import are not supported.
- **Transaction Number** - If Receivables is used as the Import module, then tax data is inserted into the transaction number. If Payables is used as the Import module, then tax data is inserted into the transaction number.
- **Transaction Line** – Enter the transaction line.
- **Transaction ID** – Enter the transaction ID to distinguish the record.
- **Exclusive Tax Amount** – Enter the value for exclusive tax amount.
- **Inclusive Tax Amount** – Enter the value for inclusive tax amount.
• VAT Invoice Number – Displays the VAT invoice Number if available for External event.

• Excise Invoice Number – Displays the Excise invoice Number if available for External event.

• Reference – Displays the document numbers that are generated in the import from modules or external system.

• Party Name – Enter the Supplier or Customer name. This field is mandatory.

• Party Site Name – Enter the site for the supplier or customer. This field is mandatory.

• Tax Category – Enter tax category for Standard event.

• Service Type – Enter the service type. If you do not enter a value in this field, then the system gets default value from Supplier Additional information setting. If no values are setup in the Supplier Additional information, then the Tax Import process displays an error.

Defining India - Import OFI Interface Tax

New Concurrent processes, India – Interface Tax Import to AR and India – Interface Tax Import to AP are created to import taxes from interface table to Receivables and Payables.

In Receivables, the Import process is submitted following the AutoInvoice process. In Payables, the Import process is submitted following the Invoice Validation process. When Payables Open Interface Import process completes, run the Invoice Validation concurrent process to validate imported Payables invoices.

Field References

Following are the common parameters for the Receivables and Payables Interface Import Tax process:

• Operation Unit – Enter or select the operating unit.

• Organization – Enter or select the organization associated with the operating unit.

• Location – Enter or select the location for the organization.

• Supplier Name (Payables) or Customer Name (Receivables) – Enter or select the supplier name for Payables and customer name for Receivables.

• Supplier Site (Payables) or Customer Site (Receivables) – Enter or select the supplier site for Payables and customer name for Receivables associated with the Supplier and Customer respectively.
• Transaction Number From – Enter or select the transaction number to start from.

• Transaction Number To – Enter or select the transaction number to end with.

Interface Data Value

Taxable event is External

Validated tax data and tax accounting are imported to tax detail and transaction distribution line. All eligible data is imported into Receivables and Payables transaction table and OFI taxes table without changes. You can modify the incorrect data in the interface table.

Taxable event is Standard

All eligible taxes are recalculated based on tax defaulting rules. You can modify the incorrect data in the interface table.

Defining India - Interface Tax Purge Program

A new concurrent program, India - Interface Tax Purge Program, is added to purge all data in the interface table.

Field Reference

• Import Module – Select the import module, AR or AP.

• Operation Unit – Enter or select the operating unit.

• Organization – Enter or select the organization associated with the operating unit.

• Location – Enter or select the location for the organization.

• Party Name – Enter the Supplier or Customer name. This field is mandatory.

• Party Site Name – Enter the site for the supplier or customer. This field is mandatory.

• Source Invoice Number From – Enter or select the source invoice number to start from.

• Source Invoice Number To – Enter or select the source invoice number to end with

• Line Status – Select the line status, All, Error, or Success.

Reports

This section provides overview and detailed descriptions of the following reports:
• Form 16A Report
• TDS at Prescribed Rate Report
• India Cash/Bank Book Report
• India-Creditors Ledger Report
• India-Creditors Trial Balance Report
• India-Statement of Account for Suppliers
• India - BOE Write Off Report
• India - TDS Related Invoices Report
• India VAT Returns Template
• India - BOE Detail Report

Form 16A Report

Use Form 16A Report to print Form 16A (As per Statutory Format) for sending it to Vendors. 'ORIGINAL' is printed on the Form when printed for the first time and 'DUPLICATE' will be printed for subsequent prints of same Certificate.

If some problem occurs during printing of Certificate for first time (e.g. Printer Paper jam etc.), then navigate to 'View TDS Certificate - India Localization' Form in AP Module and set the 'PRINT FLAG' of corresponding certificate to 'N', then the next Print will print 'ORIGINAL' on the Certificate.

Report Submission

Use the Submit Requests (India Local Payable Module only) form and enter India TDS Certificates in the Name field to submit the report.

Report Parameters

TAN Number (Mandatory)

Select the value from the LOV.

Financial Year (Mandatory)

System will display all the Financial Years from the LOV Based on the transactions will be processed.

Organization (Optional)

Select the value from the LOV. System will use this Organization details for printing the address on the report.

Certificate Nos. From (Optional)
India Localization prints all the Certificates starting with the Number you enter for this parameter.

**Certificate Nos. To (Optional)**

India Localization prints all the Certificates up to the Number you enter for this parameter.

**Certificate From date (Optional)**

India Localization prints all the Certificates starting From the Date you enter for this parameter.

**Certificates To date (Optional)**

India Localization prints all the Certificates up to the Date you enter for this parameter.

**Vendor (Optional)**

India Localization prints the Certificates for this Vendor only, if you enter a value for this parameter.

**Name of the Signee (Optional)**

India Localization prints this Name in Full Name field of Certificates

**Designation (Optional)**

India Localization prints the Designation of the Signee on the report.

**Place (Optional)**

India Localization prints this Name in Place field of Certificates

**Report Headings**

Report Headings provide you with general information about the contents of the report. India Localization prints Certificate Number and Sheet Number of certificate on all pages, along with report heading.

Also on the first page of the Certificate Name & Address of the Company Deducting the Tax, Tax Deduction A/c No. of the Deductor, PAN / GIR No. of the deductor, TDS circle where Annual returns are filed u/s 206, Name & Address of the Person in whose a/c it is credited, PAN / GIR no. of Payee & the period are printed.

Also at the end of each certificate Total amount of tax deducted for the particular vendor (for the period) is printed in Words.

**Column Headings**

**Invoice Date**

Date of Invoice.

**Amount Paid or credited (Rs.)**

Invoice amount.

**Amount of Income tax**
Amount of Tax Deducted at source.

Challan Number and Date

Challan Number and Date on which tax was deposited to Central Govt. A/c.

Name of bank where tax is deposited

Name of bank where tax was deposited.

Report Order

Report is printed in the order of Invoice date for a certificate.

TDS at prescribed rate Report

Use TDS at prescribed rate Report to calculate Tax deducted at source for a company or others for various TDS categories like Rent, Technical / Professional Services, and Payments to Contractors/Subcontractors etc.

Report Submission

Use the Submit Requests (India Local Payable Module Only) form and enter India TDS at prescribed rate Report in the Name field to submit the report.

Report Parameters

Organization TAN Number (Required) PICK
Select the value from the LOV.

FIN Year (Required) PICK
Select the value from the LOV.

Organization (Optional) PICK
Select the value from the LOV.

TDS Payment type (Required) PICK
Enter a TDS Payment type, you wish to take the TDS at prescribed rate Report for.

Supplier Organization Type (Required) PICK
Enter a Supplier Organization type (Company or others), you wish to take the TDS at prescribed rate Report for.

Period of Report (Optional)

Report Headings

Report headings provide you with general information about the contents of the report. Oracle lists Organization information based on User parameter input.

Column Headings

PAN Number of the Company
PAN Number of Company for which TDS has been deducted.
Name of the Company
Name of Company for which TDS has been deducted.

Address of the Company
Address of Company for which TDS has been deducted

Amount Credited or Paid
(Invoice) Amount paid or credited whichever is earlier.

Date on which Amount Credited or Paid whichever is earlier
(Invoice) Date on which Amount paid or credited whichever is earlier.

Amount of Tax Deducted
Amount of Tax Deducted for the Invoice

Date of Deposit
Date on which Tax was deducted for the Invoice.

Date on which Tax was paid to the Credit of the Central Government
Date on which Tax was paid to the credit of the Central Government.

Tax Deduction Certificate Number
TDS Certificate Number which was sent to the Supplier informing him the TDS details.

Date of furnishing of TDS Certificate to Company
Date on which TDS Certificate was sent to the Supplier Company.

Report Totals
Invoice Amount Total and TDS Amount Total for the report.

Report Order
Report is printed in the order of Vendor Name, Certificate Number and Invoice Number for the selected Organization.

India - Cash / Bank Book Report
The Cash/Bank Book can be printed as per user requirement for a range of period.

Report Submission
Use the Submit Requests (India Local Payable & India Local Receivables Module) form and enter India-Cash/Bank Book Report in the Name field to submit the report.

Report Parameters
Bank Name (Required) PICK
Account Number (Required) PICK
Account Number of the Above Bank for which the User wants to take the Bank Book for
a given period.

**Book Type (Required)**

Either 'B' meant for Bank Book or 'C' meant for Cash Book can be selected by the User from the LOV

**Start Date (Required)**

**End Date (Required)**

Report Headings

Report headings provide you with general information about the contents of the report. Oracle lists Company Name based on User parameter input.

Column Headings

**GL Date**

GL Date for the transaction will be reported.

**Voucher No & Date**

Voucher Number and Date will be reported

**Check Number & Date**

Check Number and Check Date will be reported

**Supplier Bill Number and Date**

Supplier Bill No & Date will be reported

**Vendor Name/Customer Name**

In the Case of Payments, the Vendor Name will be reported. In the Case of Receipts, the Customer Name will be reported. For charges in the Bank Book, this field won't be having any details.

**PO Number. & Date**

PO Number for the respective purchase will be reported

**Remarks/Narration**

Remarks / Narration appearing in the Receipts and Payments Vouchers will be reported

**Account Code**

GL Account for the respective Receipts and Payments will be reported

**Description**

Description of the GL Account for the respective Receipts and Payments will be reported.

**Receipts**

Receipts Amount will be reported into this column

**Payments**
Payments Amount will be reported into this column.

**Balance**
Balance Amount in the Cash/Bank will be reported into this column.

**India-Creditors Ledger Report**
Use this Report to get Creditors Sub-Ledger with complete details of Invoices, Debit Memos and Payments.

Use the Submit Requests (India Local Payable modules Only) form and enter India-Creditors Ledger Report in the Name field to submit the report.

**Report Parameters**

**Vendor Name (Optional) PICK**
If the User wants Creditor Ledger for a specific Vendor, then he need to enter Vendor Name here otherwise Sub Ledger for all the Vendors for a given period will be reported.

**Vendor Number (Defaulted) PICK**
Vendor Number of the above Vendor will be defaulted here.

**Vendor Type (Optional)**
If the User wants Creditor Ledger for a specific Vendor Type, then he need to enter Vendor Type in this field otherwise Sub Ledger for all the Vendors for a given period will be reported

**Chart of Accounts**
Enter the chart of accounts details.

**Account Code**
Enter or select the account code.

**Operating Unit**
Enter or select the operating unit to which you have access.

**As of Date**
Enter the date on which the balances want to be computed and shown. It must not be a future date. It must be system date or lesser than system date.

**From Date (Required)**

**To Date (Required)**

**Vendor Site (Optional) PICK**
Report Headings
Report headings provide you with general information about the contents of the report. Oracle lists Company Name based on User parameter input.
Column Headings

GL Date
GL Date for the transaction will be reported.

PO No
PO Number will be reported

Organization Name
Name of the Organization Location where in the transaction taken place will be reported.

Batch Number
Batch Number for the transaction will be reported.

Invoice Type
Invoice Type will be reported

AP Invoice No / Date
AP Invoice Voucher No and Date will be reported

Supplier Bill No / Date
Supplier Bill Number will be reported

Payment voucher No / Date
Payment Voucher / Invoice No and Date will be reported

Check No and Date will be reported

Description
Description appearing in the Invoice or Payment Voucher will be reported

Account Code
GL Account for the respective transaction will be reported

Currency
Transaction currency will be reported

Exchange

Foreign Currency Dr
Debit amount in a foreign currency transaction will be reported.

Foreign Currency Cr
Credit amount in a foreign currency transaction will be reported.

Rupee Equivalent Dr
Rupee equivalent for the Debit amount will be reported.
**Foreign Currency Cr**

Rupee equivalent for the Credit amount will be reported.

**India-Creditors Trial Balance Report**

Use the Submit Requests (India Local AP modules Only) form and enter India-Creditors Trial Balance in the Name field to submit the report.

**Report Parameters**

If the User wants Creditor Trial Balance for a specific vendor, then he need to enter vendor name here otherwise Trial Balance for all the vendors for a given period will be reported.

Vendor Number of the above Vendor will be defaulted here.

**Vendor Type (Optional)**

Vendor Type will be shown in this column.

**Account Code (Optional)**

CL Account code will be printed here.

**As of Date (Required)**

Enter the date on which the balances want to be computed and shown. It must not be a future date. It must be system date or lesser than system date.

**Vendor Name From and To**

Enter the vendor name range for which the report displays the trial balance details.

**Vendor Number From and To**

Enter the vendor number range for which the report displays the trial balance details.

**Vendor Type Lookup Code**

Enter the values of the lookup code.

**Chart of Accounts**

Enter the chart of accounts details.

**Account Code**

Enter or select the account code.

**Operating Unit**

Enter or select the operating unit to which you have access.

**Report Headings**

Report headings provide you with general information about the contents of the report. Oracle lists Company Name based on User parameter input.

**Column Headings**
Sl.No
Serial Number of the Trial Balance will be reported.

Vendor Type
Vendor Type will be reported

Vendor Name
Vendor Name will be reported.

Vendor Code
Vendor Code (Number) will be reported

Currency
The Transaction currency will be reported.

Entered Amount
Closing Balance of a vendor in Foreign currency will be reported.

Rupee Amount
Rupee equivalent of a vendor will be reported

Total : Total Vendor Balances in INR
Total for the Vendor is shown in RS

Order by : Liability Account wise

India-Statement of Account for Suppliers
This statement of account of Creditors shows Invoice wise outstanding to a Vendor

Report Submission
Use the Submit Requests (India Local Payable modules Only) form and enter India-Statement of Accounts for Suppliers in the Name field to submit the report.

Report Parameters
Vendor Name (Optional) PICK
If the User this Report for a specific Vendor, then he need to enter Vendor Name here otherwise Statement of accounts for all the Vendors for a given period will be reported.

AS on Date (Required) PICK
Up to a Specific Date
Aging interval like 30 days or 15 days can be entered by the User

Number of Interval (Optional)

Report Headings
Report headings provide you with general information about the contents of the report.
Oracle lists Company Name based on User parameter input

**Column Headings**

**AP Voucher No**
AP Voucher No will shown here

**Bill no**
Supplier Bill Number

**Bill date**
Supplier Bill No

**Vendor Name**
Vendor Name will be reported.

**Amount**
Amount of the Bill

**Remarks**
Remarks will be shown here

---

**India - BOE Write Off Report**

This Reports gives the Details of Written off Bill of Entry for a given period

**Report Submission**

**Report Parameters**

**BOE Number From (Optional)**

**BOE Number To (Optional)**

BOLE Number will be shown here

**From Date (Required)**
Start Date will be shown here

**To Date (Required)**
End date will be shown here

**Report Headings**

**Column Headings**

The following field will be reported

**Account Code**
Displays Account code.

**Bill no**
Supplier Bill Number

**Bill date**
Vendor Name will be reported.

**Amount**
Outstanding Invoice Amount will be reported.

**Remarks**
Remarks like 'Partly Paid' will appear for Partly paid Invoice.

**India-TDS Related Invoices Report**
This Report provides with the list of All Invoices for which TDS has been calculated. For each such Invoice, all TDS Related Invoices generated for the Invoice are shown.

**Event**
Invoices shown

On Validating a Standard/Prepayment Invoice
Credit Memo generated for the Supplier

On Applying Prepayment Invoice to a Standard Invoice
Invoice generated for the Supplier

On UnApply Prepayment Invoice to a Standard Invoice
Credit Memo generated for the Supplier

On Cancellation of Standard Invoice
Standard Invoice generated for the Supplier

**Report Submission**

**Report Parameters**
Operating Unit defaults from the one specified for the Responsibility

**From Date (Defaulted) PICK**
Enter a Date here. This date is compared against the Invoice Date of the Invoices for which Tax is Deducted at Source.

**To Date (Optional)**
Enter a Date here. This date is compared against the Invoice Date of the Invoices for which Tax is deducted at Source

**Report Headings**
Report headings displays name of the Report and the Period for which this Report is generated.

The Report Details Section has two parts. One that shows the details of the Base Invoice
for which TDS is calculated and the next, which lists out all TDS Invoices, related to the Base Invoice.

**Column Headings**

**Invoice Name**
This field displays the Type of Invoice and the Invoice for which this is generated.

**Invoice Number**
This field displays the Invoice Number

**Invoice Amount**
This field displays the Invoice Amount.

**Invoice Currency**
This field displays the currency applicable to the Invoice

**Vendor Name**
This field displays the Vendor Name.

**Vendor Site**
This field displays the Vendor Name.

**TDS Section**
This field displays the Income Tax Section under which TDS is calculated

**TDS Tax Name**
This field displays the Name of the TDS Tax.

**TDS Tax Rate**
This field displays the Rate.

---

**India - VAT Returns Report**

India – VAT Returns Report provides data related to sales and purchases, which can be used to fill state-specific VAT return forms. Use the Submit Requests / Other Reports form (India Accounts Payable / India Accounts Receivable) and enter India VAT Returns Report in the Name field to submit the report.

**Report Parameters**
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registration Number</td>
<td>Required</td>
<td>PICK</td>
<td>The Registration number for which the report is being generated.</td>
</tr>
<tr>
<td>Organization Number</td>
<td>Optional</td>
<td>PICK</td>
<td>The Inventory organization for which the report is being generated.</td>
</tr>
<tr>
<td>Location</td>
<td>Optional</td>
<td>PICK</td>
<td>The Inventory Location for which the report is being generated. This needs to be left blank if all locations are to be printed. This gets enabled only if the Inventory Organization is selected.</td>
</tr>
<tr>
<td>From Date and To Date</td>
<td>Required</td>
<td></td>
<td>Start Date and End Date for which the report is being run.</td>
</tr>
</tbody>
</table>

**India - BOE Details Report**

A new report, India Localization - BOE Details Report, is added. You can submit this report from the tools menu of the BOE Lines window or through the normal report submission. In this report, you can see the bill of entry lines based on the bill of entry item lines or grouped by customs Tariff Code.

When you submit this report as a request, you must specify the bill of entry Number. All taxes are shown for each line of the bill of entry along with the Assessable Value for the tax if available.

**Report Parameters**

- Organization Name – Select the Inventory Organization to see data for the selected Inventory Organization.

- Location Name – Enter or select the location for the selected inventory organization.
• BOE Number – Select the bill of entry number. If this field is not entered, then the report is generated for all the bill of entry numbers.

• Status – Select the bill of entry status. The following are the BOE Invoice status
  • Applied
  • Available for Receipt Application
  • Cancelled
  • Closed
  • Confirmed
  • Not Yet Assessed

• Group By Customs Tariff Code + UOM – Enter the customs tariff code to group by. You can select Yes or No as the values.

**Account Payables Standalone Invoice**

The standalone AP invoice is an invoice created manually by a user in Oracle Account Payables module that does not matches either to a purchase order or a receipt. The support for standalone AP Invoice functionality allows the India localization users to compute taxes such as service tax on standalone AP invoices. Primarily standalone AP invoices are raised for non-item based expense or service activities.

Value Added Tax (VAT) or Sales Tax (ST) can now be attached to invoices where item information is not critical. You can also add non-recoverable taxes of ‘Any Other’ type to standalone invoices. You can also use the non-recoverable tax type to add other miscellaneous charges to the invoice.

**Computing Taxes on Standalone AP Invoices**

You can compute taxes on standalone AP invoices in the following two ways:

**Defaulting Taxes to Standalone AP Invoices**

You can assign a tax category directly to a supplier site for defaulting of taxes on standalone invoices. You can do this by defining the tax category on the Supplier Tax Information India Localization window, see Defining Supplier Additional Information, page 2-29 for the detailed information.

Tax defaulting to Standalone AP invoices happens only if a tax category is assigned at supplier site used in the invoice and when you have the invoice line in the AP Invoices workbench.
Manual Tax Computation

You can also add a tax category or tax lines manually if these were not attached at the supplier site level. You can also modify the defaulted taxes on this window. To add a tax category or tax lines, perform the following:

1. Navigate to the invoice.
2. Select the Lines tab.
3. Select the invoice line.
4. Select Tools > IL Tax Details from the menu to navigate to the India Localization Taxes window.
5. Select the tax category at the header level, the taxes associated with this category are shown in the tax lines.
6. Alternatively, you can also add each tax line and add precedences accordingly.

Treatment on Specific Invoices

- The Pay on Receipt invoices, Tax Detail India Localization will be shown in a View Only mode
- TDS Invoices - you cannot add any taxes to these invoices.
- Third Party Invoices: you can add taxes to these invoices.
- Project Invoices:

Service Tax Recovery

If a service tax is attached to a standalone invoice line and is recoverable, then such recoverable service tax is created as a separate tax line (miscellaneous type) with the appropriate accounting code combination specified in the service tax recovery setup at the time of saving the invoice.

On validation of the invoice, the recoverable portion of the service tax is populated to the service tax repository.

Till recent, Oracle Financials for India did not allow picking the exchange rate at the time of application of the receipts. It used the Exchange rate available while entering the Invoice. The current enhancement complies with the service tax regulations and the service tax liability on foreign currency transactions is accounted based on the exchange rate applicable on the receipt date. Oracle Financials for India passes an accounting entry to bridge the rate difference between the invoice date rate and the receipt date rate.
The Service Tax interim liability is squared off based on the differential rate and the liability is not counted as part of P&L but deposited to government treasury.

**Reports**

All the following service tax recovery reports include the service tax information on standalone invoices.

- India - Service Tax Credit Register report
- India - Service Tax Pending Recovery report
- India – Service Tax ST3 report
- ERI report
India Local Order Management

This chapter covers the following topics:

- Sales Order India Localized
- Fulfilled Orders India Localized
- Sales Order Returns India Localized
- AR3A Form Receipt Tracking
- Concurrents
- Managing Order Management Transactions
- Reports

Sales Order India Localized

You can create a Sales Order by navigating through the India Local Sales Order window. This enables defaulting and calculation of Localization Taxes. The defaulting is based on the three-way defaulting logic followed for India Localization i.e., based on Customer, Customer Site or Item Class. Alternatively, you can create a Sales Order from Internal Requisitions, using Import Orders feature. The localization taxes will flow to Fulfilled Orders India Localization. For the Deliveries created from India Local Sales Orders, taxes will flow to the same.

The Localization Tax information flows into Shipping Localized screen on completion of the packing, shipping and Inventory and Order Management Interface. This information flows to AR Transactions created based on such deliveries. The same information flows to Transactions after running the Auto Invoice program.

The Sales Order India Localized functionality caters to your tax calculation needs required for a Sales Order Transaction. You can:

- Define Item category lists and attach the same to Customer and Customer Sites. Alternatively, an Item Class can be attached to a Tax Category. This would enable third level of Tax defaulting, which would apply only when the Tax Information
does not default from Customer and Customer Site. This would be the basis for taxes defaulting to Transactions.

- Assign Assessable Prices to Items. This price would be the basis for Excise Duty / VAT Taxes Calculation. The Assessable Price Lists can be attached selectively to Customer Sites.

- Create Sales Orders by navigating through India Local Sales Orders window. This would automate tax defaulting and calculation.

- Modify defaulted tax lines and add to the existing list.

- Get overview information for Sales Order Lines, without localization taxes.

- Create Sales Order for Excise exempted sales e.g., CT2, CT3. Relevant Certificate information can be recorded.

- Create Sales Order for VAT Exempted Sales Order like Vat Exemption Item, Export, Inter State Sale, Sale to Specified parties, Transfer.

- Automate calculation, recording and accounting of CENVAT Recovery (as specified under Rule 6 of The CENVAT Credit Rules 2002) for excise-exempted sale.

- The Sales Order displays Assessable Value, which forms the base for calculation of Excise Duty.

- The Sales Order also displays the VAT Assessable Value, which forms the base for calculation of VAT taxes.

- When running autoinvoice program to import sales orders as invoices:
  - For Shipping Parameters, set the Raise Business Events to Yes.
  - For Global Parameters, set the Raise Business Events to Yes.
  - When setting up transaction types, for order type of Standard Order, set the taxable event to Entering, instead of Invoicing.

**Major Features of Sales Order India Localized**

**Defaulting Taxes to India Local Sales Orders**

You can use Localization taxes while creating a Sales Order in the Order Management. These taxes can be defaulted based on the Tax Defaulting Rules. The automatic Tax Defaulting is based on Item Category assigned to the Customer, Customer Site or based on the Item Class assigned to the Tax Category.

**Tax Base Amount**
You can define precedence logic to calculate Tax Base Amount on which the Tax Rate is applied. The Tax Base Amount can either be the line amount or line amount including other taxes calculated for the transaction.

**Important:** No precedence logic and tax rates are available for adhoc taxes.

**Defaulting Assessable Value to India Local Sales Orders**

You can use an Assessable Value that is different from the Sales Price while creating a Sales Order in the Order Management. This Assessable Price can be defaulted based on the Tax Defaulting Rules. The automatic defaulting is based on Price List assigned to the Customer, Customer Site or null Site.

**Important:** The Assessable Value is a display only field and cannot be edited by user on Sales Order. It is only controlled through Price List setups and Price List attachments.

**Manual Changes to Defaulted Taxes to India Local Sales Orders**

The Taxes defaulted can be changed manually, if required.

- Tax Line can be deleted only when there is no dependent tax line.
- You must Apply and Save after deleting defaulted taxes and before attaching New Taxes.

**Record Excise Exemptions**

You can choose the Exemption Type applicable to the Sales Order by selecting the Excise Exempted check box provided at the line level. This changes the Excise Value of that line to zero.

**Record VAT Exemptions**

You can choose the VAT Exemption Type applicable to the Sales Order. To do this, you need to select VAT Exemption Type, Date and Ref No at Header. This gets defaulted on all lines and changes the VAT value of all lines to zero.

If you require partial VAT Exemption viz., on some lines only, you need to deselect the VAT Exemption flag. You can also have a different type of VAT Exemption at line level.

**CENVAT Recovery against Excise Exemptions**

You can set up CENVAT Recovery % in the Organization Additional Information Screen in CENVAT Recovery % field using India Local Inventory Responsibility which will ensure CENVAT Recovery under Rule 6 of The CENVAT Credit Rules 2002 for the above Excise Exempted Transactions.

**Splitting of Sales Order Lines**
Any splitting lines in the base Sales Order also split lines in India Local Sales Order. The Tax lines are then recalculated based on the revised line quantity.

**Changes in Sales Order Lines**

Changes made to Quantity in Base Sales Orders are automatically reflected in the Sales Order India Localization. Lines deleted from base order also get deleted from India Local Sales Order.

**Cancellation in Sales Order Lines**

A line cancelled in the base Sales Order changes the Quantity in Localization screen to zero.

**Copying of Sales Orders**

A Sales Order created by navigating through India Local Sales Order screen can be copied using the Copy Order feature. This will result in taxes flowing to Localization for the copied Order. While coping Order, if there is any change in the Assessable Price with respect to source Order line, then it results in recalculation of the taxes.

**Important:** Copy Sales Order feature can be used to create a RMA Order. An RMA Order taxes is based on shipping taxes and hence to avoid data inconsistency issues in localization tables, Copying of Sales Order is not possible unless such Order is already shipped & data is available in Localization shipping tables.

Localization does not currently allow copy of RMA Order to standard Order or existing RMA Order to new RMA Order.

**Assessable Price Recalculation**

Excise duties attached to the Order lines can be recalculated whenever there are changes in assessable price of items. This is helpful at the time of Budget/changes in Excise statutes. For further details refer Assessable price recalculation provided under reports.

**Line Level Query in India Local Sales Order**

You can now query for lines in Sales Orders India Localization screen once the Sales Order is queried. This feature would be helpful to find the lines in case where the item name is above 25 characters long or Sales Order has large number of lines.

**Auto Query of India Local Sales Order**

Clicking the Open Button on the India Local Sales Order displays the Base Sales Order Form to create an Order.

When you fill the base Sales Order form and save it, the details of the transaction are auto queried and displayed in the India Local Sales Order form. To view the details, navigate to the India Local Sales Order form. You can also query an existing Order in the Localized Sales Order form.

If you navigated away to multiple forms, Auto query does not work and you must click
refresh to view the localization screen with requisite details.

**Note:** For details on generating VAT invoices for non-shippable items, refer to Generating VAT Invoices in the Oracle Financials for India Implementation Manual.

### Supporting Credit Check in Order Management

Oracle Order Management Credit check functionality lets you validate credit worthiness while processing the Sales order and put a hold if the qualifying criteria for credit check are not met.

Currently, Oracle Financials for India Taxes computed in the Order to Cash cycle are not integrated with Order Management Credit Check capability and tax amounts are not considered when performing credit check.

With this enhancement, Oracle Financials for India integrates with credit check functionality such that tax amounts computed by Oracle Financials for India Taxes are considered while performing the credit check.

The following changes are implemented to support Credit Check in Order Management:

**New Concurrent Process**

A new concurrent process, India - Add Tax Value to Sales Order, is added that gets Oracle Financials for India Exclusive tax total value from the JAI table and inserts it into the Order Entry table by line, except Excise Bond. This concurrent process is submitted when the sales order line is open and the status is not Shipped, Fulfilled, or Cancelled.

**Parameters:**

- Customer - Select or enter the customer.
- Order Type: Select or enter the order type.
- Order Number From and To – Specify the range of order numbers to choose from.

**Note:** The Order Type Excise is not supported.

### Enhancement to Sales Order India Localization

A new menu option, Add Taxes to Sales Order, is added in the Tools menu of the Sales Order and Matching – India Localization windows. When this is selected, the India - Add Tax Value to Sales Order is run to add Oracle Financials for India tax to Order Entry table.

**Updating Adhoc Excise Tax Amount to Sales Order after Matching Receipt**
In Trading Organization, Adhoc Excise tax amount is updated after matching receipt and it displays in the Fulfillment window after shipping is confirmed. If one sales order line matches multiple receipt lines, then Adhoc Excise tax amount is sum of all matched receipt tax amount.

**Impact on Reporting**

Oracle Financials for India Exclusive tax value is inserted in the Order Entry table. The following reports display exclusive taxes in the output:

- Customer Credit Snapshot
- Credit Exposure Report

**Fulfilled Orders India Localized**

**Overview**

You can make changes to localized freight in the Order Management Module. You will also have a facility to add Localization Freight manually at this stage.

This information flows into Shipping Localized screen on completion of the Picking, Shipping and Inventory and Order Management Interface. Taxes entered in Sales Order cannot be changed at this stage. However, you can change or add freight details at this stage. The same information flows to AR Transactions after running the Auto Invoice program.

The Fulfilled Orders India Localized functionality lets you satisfy all your needs related to Freight addition required for a Shipment Transaction. You can:

- Query a Fulfilled Order Transaction using Delivery Name, Order Number, Customer etc to find localization related details.
- Add or change Freight type of Tax at this stage.
- View Tax lines attached to each line of delivery.
- On completion of the 'India - Excise Invoice Generation' you can also view the Excise Invoice Number that has been generated against this delivery.
- Query based on the Excise Invoice Number generated.
- Query based on items. Option to view all Items in the delivery or only Items whose name has been entered in the query.
- View details of the Duty paying Register that has been hit by the delivery transaction.
• Enter AR3A Form Number and Date for Excise Exempted transactions.

Major Features of Fulfilled Orders India Localized

Facility to Add Freight in Fulfilled Orders India localized

You have an option to change or add new freight lines using the Fulfilled Orders Localized screen.

**Important:** All the features mentioned here involving changes to transaction has to be completed before Auto Invoice happens, else the same will not flow to the AR Transaction.

Record AR3A Form Number and Date

You can record AR3A form Number and Date against individual shipment line for Excise-Exempted transactions for the purpose for tracking.

Reports

Receivables generates these reports for India:

India - Debtors Ledger Report - Lists all the transactions with the Customer to arrive at the net liability for the Customer. You can use this report to get Debtors Sub-Ledger.

India - Commercial Invoice for OM Report - This Report gives you the Commercial Invoice with Excise Invoice Number, Excise Details for a Sales Order against each delivery.

India - Forecast Excise Amount in RG Registers - Gives the Forecast for CENVAT and PLA Payments for a given Organization, Location Combination from As of Date to Entered Date.

Sales Order Returns India Localized

Users can create RMA Orders with localized taxes in the Order Management. The taxes would be calculated for the RMA lines, based on the Original Sales Order.

The RMA Order India Localized functionality allows the user to satisfy all requirements related to Tax calculation required for a RMA Transaction. Users can create an RMA Order by giving:

• Reference to the Original Sales Order

• Reference to the Invoice

• Without giving any reference.

• Return Orders without Excise Component.
Reference to the delivery line shipped

**Major Features of Sales Order Returns India Localized**

**Defaulting Taxes to India Local RMA Orders**

You have an option to use Localization taxes while creating a return sale Order in the Order Management. These taxes can either be defaulted based on the Tax Defaulting Rules or can be attached manually. The automatic tax defaulting would be based on the Item Category assigned to the Customer, Customer Site or based on the Item Class assigned to the Tax Category. This is only applicable for the RMA Order created without reference and the reference is filled as 'Legacy'. For a RMA Order created with reference taxes are defaulted based on the original delivery and cannot be changed.

**Auto picking of Delivery Detail ID in India Local RMA Orders**

Whenever a RMA Sales Order is created with reference, Localization taxes would be based on the shipment taxes and hence required entry of Delivery Detail ID. There is no need to search this delivery detail id, which would make the process tedious. On navigating to Localization Screen, the same gets automatically populated if the Sales Order reference is given.

**Returns without Excise**

Whenever a return takes place beyond the stipulated period by Excise Authorities, you are prevented from claiming CENVAT benefit on the returned goods viz., when returns are made beyond 180 days. Under such circumstances, many a times, it is necessary that the Credit Memo that is raised for such return be raised for the base amount without passing on the benefit of Excise Duty. For such kind of transactions, the days within which if return is made, the Excise to be allowed has to be mentioned in the Organization Additional Information in Excise Return Days field. This ensures that when any RMA is made beyond such stipulated period, the Credit Memo raised will be net of Excise.

**RMA without Sales Tax**

Whenever a return takes place beyond the stipulated period by Sales Tax Authorities, you are prevented from claiming the same in your Sales Tax Returns. Under such circumstances, many a times, it is necessary that the Credit Memo that is raised for such return be raised for the base amount without passing on the benefit of Sales Tax. For such kind of transactions, the days within which if RMA is made, the Sales Tax to be allowed has to be mentioned in the Organization Additional Information Sales Tax Return Days field. This ensures that when any RMA is made beyond such stipulated period, the Credit Memo raised will be net of Sales Tax.

**AR3A Form Receipt Tracking**

Material Clearance without payment of duty under AR3A needs to be tracked for receipt of Re-warehousing Certificate. AR3A Receipt Tracking feature of Oracle
Financials for India can be used to meet this requirement. All clearances under Excise Exemptions is recorded and on receipt of the authenticated document; the Receipt Date can be recorded. The data thus collected can be used to monitor the Rewarehousing Certificates that need to be received from Customers at any point of time.

The AR3A Receipt Tracking functionality allows user AR3A forms due from Customers. Users can:

• Track AR3A Forms to be received from the Customers. You can enter the Date on which the Form is received.

• Generate a Report to view the AR3A forms pending from each Customer.

Reports

India - AR3A Status Report lists all exempted sales transactions, while an Acknowledged AR3A form is pending from Customer.

Concurrents

India Local Order Management requires the following concurrent programs to be run:

India - Excise Invoice Generation

This is a mandatory concurrent program, if you are using Excise Type of localization taxes, which generates Excise invoice Number against delivery and also hits Excise registers based on the Delivery ID (optional). You must schedule it to run after Inventory Interface and Order Management Interface and prior to AutoInvoice. This report does not generate any printable output.

• This concurrent needs to be setup as incompatible to itself. If the same is not done and multiple users run it with blank Delivery_id, it would result in skipping Excise Invoice Numbers or alternatively hitting the Excise Register multiple times for the same delivery.

• This concurrent is expected to be scheduled with blank Delivery id, which would pick and process all available deliveries. This is to be run with Delivery_id for specific cases where debug log is required for any problem reporting.

• In case the users run it with delivery_id as a part of the process, then the concurrent needs to be scheduled to run atleast once a day without Delivery_id to ensure that any records skipped get Excise Invoice Numbers for the same day. Not doing this will result in sequencing issues when compared to Excise Invoice Dates.
• The concurrent will process only those deliveries, which are OM interfaced and Inventory Interfaced.

• This concurrent is for generating Excise Invoice Number and Accounting thereof. There is no rdf attached to the same and hence this is not supposed to generate any output.

• This concurrent needs to be run prior to Auto Invoice import if the Excise Invoice Number is required to be seen in Localization AR tables.

India - Excise Duty Recalculation

This is an optional concurrent program that enables you to recalculate Excise Duty attached to Unshipped Orders, if there is a change in the assessable value of items. Excise Duty recalculation is done for those Unshipped Orders that satisfy the input criteria. This report does not generate any printable output. You can use this program to recalculate the Excise Duty and all dependent taxes on Open Sales Orders. The Excise Duty is recalculated to reflect the latest Assessable Prices applicable to the items included in the transaction. Using this feature, you can eliminate manual effort required to update all Open Sales Orders to reflect changes in Assessable Prices.

This concurrent can be invoked through India Local Order Management > Reports, Request > Single Request > India > Excise Duty Recalculation

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Order</td>
<td>Required</td>
<td>PICK</td>
<td>Enter the Sales Order from which you would like to effect Tax Changes</td>
</tr>
<tr>
<td>End Order</td>
<td>Required</td>
<td>PICK</td>
<td>Enter the Sales Order which you would like to take as the last document on which the change has to be effected.</td>
</tr>
<tr>
<td>Order Type</td>
<td>Required</td>
<td>PICK</td>
<td>Choose one of the Order Types from the list</td>
</tr>
</tbody>
</table>
Important: On completion of the request the selected Sales Orders, provided they are open and have an Assessable Price applicable, are updated with the revised Tax Amounts.

India - Service Tax Processing

All Accounting events will be accounted when the Base transaction line is being accounted. The ‘India Service Tax Processing’ Concurrent program processes the recovery Accounting events. This program must be scheduled at regular intervals. At each run, the program would create Accounting and Service Tax Repository entries for all eligible transactions.

This concurrent can be invoked through India Local Receivables > Reports, Request > Single Request > India > Service Tax Processing.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regime</td>
<td>(Required)</td>
<td>PICK</td>
<td>Select the Regime you have defined for Service Tax.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HELP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>EDIT</td>
<td></td>
</tr>
<tr>
<td>Tax Registration</td>
<td>(Required)</td>
<td>PICK</td>
<td>Select the Registration Number here.</td>
</tr>
<tr>
<td>Number</td>
<td></td>
<td>HELP</td>
<td>Organizations are logically grouped by Tax Registration Number. On selecting a Registration Number, all eligible transactions created in the related group of Organizations would be processed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EDIT</td>
<td></td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------</td>
<td>--------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Transaction From Date</td>
<td>(Required)</td>
<td>PICK, HELP,</td>
<td>Specify Transaction From Date here.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EDIT</td>
<td></td>
</tr>
<tr>
<td>Organization Name</td>
<td>(Required)</td>
<td>PICK, HELP,</td>
<td>Specify Inventory Organization here.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EDIT</td>
<td></td>
</tr>
</tbody>
</table>

**India - VAT Invoice Generation**

The India - VAT Invoice Generation / Accounting concurrent program handles generation of VAT Invoice and passes requisite VAT Accounting entries for VAT type of taxes from Order Management. This program captures Value Added Tax localization taxes in Shipments and inserts VAT Invoice Number in India Local Shipment Table and Entries in GL interface. You have to schedule the concurrent to submit the request at suitable intervals.

**Note:** VAT Invoice Number is now supported for non shippable items in both Standalone AR Invoice and Sales Orders, if the Item is classified as VAT Item in Oracle Financials for India and defined as Non Shippable Item in the base inventory. For detailed information, please refer to Generating VAT Invoices in the Oracle financials for India Implementation Manual.

This concurrent can be invoked through India Local Order Management > Reports, Request > Single Request > Select ‘India - VAT Invoice Generation / Accounting’ > Schedule

**Important:** Please make it mandatory to Schedule this concurrent program.

The field wise detail description of the screen and its feature are described below for ready reference.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regime</td>
<td>(Required)</td>
<td>PICK</td>
<td>You will have to pick the Regime here. Currently only 'VAT' (Value Added Tax) is available here.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EDIT</td>
<td></td>
</tr>
<tr>
<td>Tax Registration No.</td>
<td>(Required)</td>
<td>PICK</td>
<td>You will have to pick the Tax Registration Number that has been defined for VAT Regime here. This LOV will display all Registration Numbers defined by you for VAT Regime.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EDIT</td>
<td></td>
</tr>
<tr>
<td>Organization</td>
<td>(Optional)</td>
<td>PICK</td>
<td>You can choose the Organization here if you want to run the program for a specific Organization.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EDIT</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>(Optional)</td>
<td>PICK</td>
<td>This will be enabled only if you select an Organization and you can choose the Location here if you want to run the program for a specific Location.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EDIT</td>
<td></td>
</tr>
<tr>
<td>Delivery From</td>
<td>(Optional)</td>
<td>PICK</td>
<td>This will be enabled only if you select an Organization and Location and you can choose the from Delivery id here if you want to run the program for a specific range of delivery ids.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EDIT</td>
<td></td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------</td>
<td>--------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Delivery To</td>
<td>(Optional)</td>
<td>PICK</td>
<td>This will be enabled only if you select an Organization and Location and you can choose the end Delivery id here if you want to run the program for a specific range of delivery id's.</td>
</tr>
<tr>
<td>Transactions from</td>
<td>(Required)</td>
<td>EDIT</td>
<td>Enter Transaction Date Range here. All transactions having transaction date between this range will be picked up for processing.</td>
</tr>
<tr>
<td>Date</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transactions to Date</td>
<td>(Required)</td>
<td>EDIT</td>
<td>Enter Transaction Date range here. All transactions having transaction date between this range will be picked up for processing.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Action</td>
<td>(Required)</td>
<td>PICK</td>
<td>This is the type of action, which is expected. The program has three options</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EDIT</td>
<td>1) &quot;GENERATE INVOICE NO&quot; which will only generate VAT invoices for the selected Regime,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2) &quot;PROCESS ACCOUNTING&quot; which will make repository entries and pass GL entries for the selected Regime.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3) &quot;PROCESS ALL&quot; which will result in both generation of VAT Invoice and pass GL entries.</td>
</tr>
<tr>
<td>Generate Invoice</td>
<td>Single</td>
<td>PICK</td>
<td>You have an option of running the concurrent with &quot;Yes&quot; for this parameter which will then group delivery ids for each Customer and create a single VAT Invoice for each Customer instead of one VAT Invoice per delivery.</td>
</tr>
<tr>
<td></td>
<td>(Optional)</td>
<td>EDIT</td>
<td></td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default Invoice Date</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>Using this option you can enter a Date for which you want the VAT Invoice Date and Accounting to happen. This is useful mainly for cases where shipment happens as say 11:45 pm on Month end &amp; you are running the concurrent during the next month but want the accounting to happen on a date different from current date. This will however not impact the number series &amp; hence care should be taken to process all pending invoices prior to running the concurrent for the next period.</td>
</tr>
<tr>
<td>Debug Switch</td>
<td>(Required)</td>
<td>PICK</td>
<td>Default value of this parameter is &quot;No&quot; but the same can be changed to &quot;Yes&quot; to see the debug messages when required.</td>
</tr>
</tbody>
</table>

- This program is a mandatory program to be run for generating VAT Invoice Number and generation of Accounting Entries.

- This concurrent will show the following error "Excise Invoice generation program has not been run for various reasons" or "Excise Invoice Generation is not generated yet for this Delivery. Please run the Excise Invoice Number generation Number for delivery: " when you have setup 'Same Invoice No for Excise and VAT Regimes' as 'Y' for this Registration Number and try to run
this program prior to running Excise Invoice generation or if the Excise Invoice Generation has errored out for this delivery.

- This concurrent will show the following error "Document sequencing setup not done at Registration number level" if you try to run the same without defining the Document sequencing for the given Registration Number.

- This concurrent will show the following error "Document Numbers are exhausted. Please set the End Number to a larger value" when the last Number as setup in document sequencing has been reached & hence cannot generate a VAT Invoice Number.

- When VAT Invoice Number generation happens after the AR Invoice is created, localization AR table does not have VAT Invoice Number imported from localized shipping tables. Hence care should be taken to run the VAT Invoice Generation program prior to creation of AR Invoice.

- When this concurrent is run with parameter of 'GENERATE INVOICE NO' Accounting Entries are not passed.

- Running the concurrent after Booking order will result in picking only Non-shippable lines that are fulfilled and if the concurrent is run after shipment it will result in a single number for Shippable & non shippable items.

- RMA for a non-shippable line results in updating of Recovered Account directly, instead of reversing the original entry.

**Advanced Pricing Support**

For detailed information, refer to India Local Advanced Pricing chapter in the Oracle Financials for India User manual.

**Managing Order Management Transactions**

This Section elaborates on the transactions for which you can default and calculate the Localization taxes. This would be possible only when you create the transactions navigating through the localization windows.

**Transactions Sales Order (Localized)**

In Oracle Financials for India, the Sales Orders are designed handle tax impacts on Sales
Orders and Sales Returns.

In order to use India Local taxes, you need to navigate to the open standard application Sales Order screen by navigating through Sales Order (Localized) screen. You need to complete Standard Applications Order form. On saving the Sales Order in the standard applications, data required for the localized Sales Order will get created. Based on the tax defaulting set ups, the localization taxes will get calculated automatically. For defaulting the taxes are depended on the tax defaulting set up hierarchy mapped for localization taxes. Taxes can get defaulted based on the association of Item Category to the Customer Sites or based on the Tax Category set up. You have an option to Delete or Add localization taxes if you need to modify the defaulted taxes. Deletion of taxes will be restricted if the taxes intended for deletion has an impact on the tax precedence calculation.

The India Local Sales Order is a view form, shows the Item, UOM, Quantity Ordered, Item Category List, Unit Price, Order Line amount, which are defaulted from Standard Apps Sales Order form. However, you can change the defaulted Service Type before closing or shipment of the order.

Tax Amount, Line Amount and Assessable Value will be defaulted and are also displayed but you can modify that in the India Local Tax Details form through Taxes.

You need to use the same screen for creating Sales Orders and RMA Orders.

If the Customer has a Letter of Credit and shipment against such Order is to be matched against a Letter of Credit, then the Order must be marked as LC enabled by ticking on the LC Flag.

Creating Sales Order and RMA Orders

In Oracle Financials for India, navigate to the India Local Sales Order window from India Local Order Management > Orders , Returns > Orders/returns (Localized)

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header level</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customer Name/Number</td>
<td>(Displayed)</td>
<td></td>
<td>The Customer Name and the Number will be displayed here from Standard Apps Sales Order Form.</td>
</tr>
<tr>
<td>Order Type</td>
<td>(Displayed)</td>
<td></td>
<td>The Order Type selected in the Standard Apps Sales Order Form will be displayed here.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------</td>
<td>-----------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Order Number</td>
<td>(Displayed)</td>
<td></td>
<td>The Order Number allotted in the Standard Apps Sales Order Form will be displayed here.</td>
</tr>
<tr>
<td>Order Date</td>
<td>(Displayed)</td>
<td></td>
<td>The Order Date of the Standard Apps Sales Order Form will be displayed here.</td>
</tr>
<tr>
<td>Ship To Location</td>
<td>(Displayed)</td>
<td></td>
<td>Ship To Location Id of the Customer will be displayed here from Standard Apps Sales Order Form.</td>
</tr>
<tr>
<td>Order Line total</td>
<td>(Displayed)</td>
<td></td>
<td>The Order Line Amount appearing in the Standard Apps Sales Order Form in will be displayed here.</td>
</tr>
<tr>
<td>Tax total</td>
<td>(Displayed)</td>
<td></td>
<td>This field shows the total of the Localization taxes worked out for the Sales Order/Sales Returns Order.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Excise Exempt Type</td>
<td>(Optional)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If you need to carry out an exempted transaction, the Exemption Type needs to be picked up in this field. For transactions on payment of duty, this field need to be left as null. Whenever you pick for an Excise-Exempted Transaction you need to enable the Excise-Exempted Flag in the line level. The excise exemption options are:

CT2 IND

This option needs to be mapped to the requirements under Rule 20 of the Central Excise Rules. This Amount will not be accounted in the Receivable.

CT2 OTH IND

In case the Customer needs to be Debited for the Excise Duty under of the Central Excise Rules, this option need to be used. As per the provisions of the above rule, Duty debited should not be debited to the Customer.

CT3 IND.

This option needs to be picked up for clearance of goods to 100% Export Oriented Units without payment of Duty against CT 3 Certificate.

Excise Exempted Certificate IND / Excise Exempted Certificate - Others - IND

This option may be used for transactions without payment of duty.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LC Flag</td>
<td>(Optional)</td>
<td>CHECK BOX</td>
<td>This field should be ticked for marking the Order as a LC enabled Order.</td>
</tr>
<tr>
<td>Exemption Ref. No.</td>
<td>(Required/Optional)</td>
<td></td>
<td>You can use this field to input the details of the Document/Transaction on which Exemption is claimed from payment of Duty.</td>
</tr>
<tr>
<td>Excise Exempt date</td>
<td>(Required/Optional)</td>
<td></td>
<td>You need to enter date CT2 Form, CT3 Form, Excise Exemption Certificate respectively.</td>
</tr>
<tr>
<td>VAT Exemption Type</td>
<td>(Optional)</td>
<td></td>
<td>If you need to carry out a VAT Exempted Transaction, the Exemption Type needs to be picked up in this field. For Transactions where VAT is payable, this field needs to be left as null. Whenever you pick for a VAT Exempted transaction, all the lines get the VAT exempted flag and the VAT Exemption type defaulted. If for any line, VAT Exemption is not applicable, then you can uncheck the VAT Exemption for such line. The VAT Exemption types are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• VAT Exemption Item</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Export</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Inter State Sale</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Sale to Specified parties, Transfer</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>VAT Exemption Date</td>
<td>(Required/Optional)</td>
<td></td>
<td>This field becomes required when VAT Exemption Type is selected.</td>
</tr>
<tr>
<td>VAT Exemption Refno</td>
<td>(Required/Optional)</td>
<td></td>
<td>This field becomes required when VAT Exemption Type is selected.</td>
</tr>
<tr>
<td>Order Total</td>
<td>(Displayed)</td>
<td></td>
<td>The Total Order Amount including Order Line Amount and the Tax Amount for all the Items in an Order will be displayed here.</td>
</tr>
<tr>
<td>Line Number</td>
<td>(Displayed)</td>
<td></td>
<td>The Line Number appearing in the Standard Apps Sales Order Form will be displayed here.</td>
</tr>
<tr>
<td>Shipment Line Number</td>
<td>(Displayed)</td>
<td></td>
<td>The Shipment Line Number appearing in the Standard Apps Sales Order Form in will be displayed here.</td>
</tr>
<tr>
<td>Item</td>
<td>(Displayed)</td>
<td></td>
<td>The Item selected in the Standard Apps Sales Order Form for a line will be displayed here.</td>
</tr>
<tr>
<td>Item Description</td>
<td>(Displayed)</td>
<td></td>
<td>The description of the item Standard Apps Sales Order Form for a line will be displayed here.</td>
</tr>
<tr>
<td>UOM</td>
<td>(Displayed)</td>
<td></td>
<td>The UOM for the above Item appearing in the Standard Apps Sales Order Form in will be displayed here.</td>
</tr>
<tr>
<td>Quantity</td>
<td>(Displayed)</td>
<td></td>
<td>The Quantity entered in the Standard Apps Sales Order Form for a line in will be displayed here.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------</td>
<td>--------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Tax Category</td>
<td>(Displayed)</td>
<td></td>
<td>The Tax Category associated to the above item in the Item Category List will be displayed here.</td>
</tr>
<tr>
<td>Unit Price</td>
<td>(Displayed)</td>
<td></td>
<td>The Unit Price of the Item will be displayed here.</td>
</tr>
<tr>
<td>Assessable Value</td>
<td>(Displayed)</td>
<td></td>
<td>The Assessable Price as defined in the system for this Item will be displayed here.</td>
</tr>
<tr>
<td>Extended Price</td>
<td>(Displayed)</td>
<td></td>
<td>Extended Amount is the multiplication of Quantity and Unit price for a item appearing in a line.</td>
</tr>
<tr>
<td>Tax Amount</td>
<td>(Displayed)</td>
<td></td>
<td>Tax Amount for a item in a line is displayed here. If you modify the tax lines, then the modified Tax Amount for a item from the India Local Tax details form will be displayed here.</td>
</tr>
<tr>
<td>Line Amount</td>
<td>(Displayed)</td>
<td></td>
<td>The Line Amount is the total of Extended Amount and the Tax Amount for a line.</td>
</tr>
<tr>
<td>Excise Exempted</td>
<td>CHECK BOX</td>
<td></td>
<td>If a Line Item is exempted from Excise Duty, then you need to enable this Flag. This is enabled only if you select an Excise Exempted Transaction.</td>
</tr>
<tr>
<td>VAT Exemption Flag</td>
<td>CHECK BOX</td>
<td></td>
<td>Once at header level a Order is marked as VAT Exempt, this check box will get checked. If any particular line is not supposed to be VAT Exempt, the box should be unchecked.</td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| VAT Exemption Type      | (Optional)    |        | If you need to carry out an VAT Exempted Transaction, the Exemption Type needs to be picked up in this field. For Transactions where VAT is payable, this field need to be left as null. Whenever you pick for an VAT exempted transaction, all the lines get the VAT Exempted flag and the VAT Exemption type defaulted. If for any line, VAT Exemption is not applicable, then you can uncheck the VAT exemption for such line. The VAT Exemption types are:  
  • Vat Exemption Item  
  • Export  
  • Inter State Sale  
  • Sale to Specified parties  
  • Transfer |
| VAT Exemption Date      | (Required/Optional) |        | This field becomes required when VAT Exemption Type is selected.                                                                                                                                              |
| Refno                  | (Required/Optional) |        | This field becomes required when VAT Exemption Type is selected.                                                                                                                                              |
| Refno                  | (Displayed)   | EDIT   | The reference number of the item on the sales order                                                                                                                                                           |
| []                     | (Optional)    | EDIT   | Enter line-specific additional detail and Save.                                                                                                                                                              |

**Important:** The Sales Order will display following message when for any line the Tax Setup is not made and as a result does not have taxes. This is useful mainly to ensure that all the items entered in the Sales Order have appropriate tax setup.
India Local Tax Details - Sales Order

India Local Tax Details screen displays Taxes for the current line in the Sales Order-Localized screen. All the Taxes related to that Sales Order line could be viewed by clicking the Taxes Button. You can view the Taxes defaulted for the Item and have an option to Update/Add/Delete the taxes defaulted. If you make some changes in the defaulted taxes, you need to click the apply button to make the tax modifications effective. After applying the Tax modifications, you need to save the record.

You can check the Tax Name, Tax Type, Tax Rates, Unit of Measurement, Precedence logic for calculation of taxes and the taxes calculated for each line item. No precedence logic and tax rates will be available for an adhoc type of tax.

Specifying Tax Details

In Oracle Financials for India, navigate to the India Local Tax Details window from India Local Order Management > Orders > Returns > Sales Order (Localized) > Taxes

All the above fields are displayed as per the taxes defined in the window for an item associated with a respective customer.

**Important:** System will show the following message & open the tax window in display mode based on status of the Sales Order line.

Similarly Taxes will be shown in a display mode when a Sales Order line status is reflected as ‘SHIPPED’. Please refer the Alert.

- In any event of data inconsistency where the taxes in the above tax window do not match with the taxes as displayed in the India Local Sales Order the base shipment will be stopped with the following message:

  - "ORA-20405 - Taxes are not matching in JA_IN_SO_LINES and JA_IN_SO_TAX_LINE FOR LINE_ID"

- Under this condition, Query the Sale Order & open the above tax window. Correct the tax lines & then carry out Shipment.

- When deleting defaulted taxes, you need to click on Apply and Save to save the deletions prior to adding new taxes. No doing so will result in deletion of newly added taxes as well.

Returns (Localized)

In Oracle Financials for India, the localized information of the Sales Return Order can be
viewed from the India Local Sales Order screen and the fields are discussed in earlier. You need to click the return tab region to view the tax related information/localized item information pertaining to a Sales Return Order.

Taxes on Sales Return Order appears as default and displayed in read only mode when the Return corresponds to a delivery detail id. The Tax details are opened in editable mode only when such Return is made without reference and taxes are based on the setup definitions.

The Screen can be invoked through India Local Order Management > Orders, Returns > Sales Order (Localized) > Return Tab

Line Level Details:

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Number</td>
<td>(Displayed)</td>
<td></td>
<td>The Line Number appearing in the Standard Apps Sales Order Form will be displayed here.</td>
</tr>
<tr>
<td>Delivery Detail id</td>
<td>(Required)</td>
<td></td>
<td>The Delivery Detail id against which this RMA Line is being entered. Taxes from Shipment are supposed to be based on the delivery Detail id entered here.</td>
</tr>
<tr>
<td>Item</td>
<td>(Displayed)</td>
<td></td>
<td>The Item selected in the Standard Apps Sales Order Form for a line will be displayed here.</td>
</tr>
<tr>
<td>Item Description</td>
<td>(Displayed)</td>
<td></td>
<td>description of the item in the Standard Apps Sales Order Form for a line will be displayed here.</td>
</tr>
<tr>
<td>UOM</td>
<td>(Displayed)</td>
<td></td>
<td>The UOM for the above Item appearing in the Standard Apps Sales Order Form in will be displayed here.</td>
</tr>
<tr>
<td>Quantity</td>
<td>(Displayed)</td>
<td></td>
<td>The Quantity entered in the Standard Apps Sales Order Form for a line in will be displayed here.</td>
</tr>
<tr>
<td>Unit Price</td>
<td>(Displayed)</td>
<td></td>
<td>The Unit Price of the Item will be displayed here.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assessable Value</td>
<td>(Displayed)</td>
<td></td>
<td>The Assessable Price as defined in the system for this Item will be displayed here.</td>
</tr>
<tr>
<td>Line Amount</td>
<td>(Displayed)</td>
<td></td>
<td>Line Amount is the multiplication of Quantity and Unit Price for a Item appearing in a line.</td>
</tr>
<tr>
<td>Service Type</td>
<td>(Displayed)</td>
<td></td>
<td>The Service Type entered in the Standard Apps Sales Order Form for a line in will be displayed here.</td>
</tr>
<tr>
<td>Allow Excise Tax</td>
<td>CHECK BOX</td>
<td></td>
<td>Unchecking this would mean that the Credit Note generated against such RMA Order should be without Excise Duty</td>
</tr>
<tr>
<td>Allow Sales Tax</td>
<td>CHECK BOX</td>
<td></td>
<td>Unchecking this would mean that the Credit Note generated against such RMA Order should be without Sales Tax</td>
</tr>
<tr>
<td>[ ] (Optional)</td>
<td>EDIT</td>
<td></td>
<td>Enter line-specific additional detail and Save.</td>
</tr>
</tbody>
</table>

**RMA Return/Receipt (Localized)**

RMA Receipts should be created using the new screen (common for PO Receipts and RMA Receipts). You should navigate from this screen to the base receiving screen and complete the RMA receipt transaction. You should capture additional details related to the receipt, such as RMA Type, Excise Invoice details etc. in the India Localization screen.

The user has the facility to use the "Populate Defaults" feature. This feature allows the users to populate same Excise Invoice number and date for multiple lines.

Localization will create entries depending on Return Type.
Return Type | Effect in RG Registers and accounting
--- | ---
Production Input | Update Register for Quantity depending on Item Class. Update RG 23 A part II information CENVAT Flag Is Checked and corresponding accounting are passed. This Type need to be used by units who will be using the Sales Returns as their Raw Materials. For e.g., Foundry Units, where a casting is returned as defective due to air crack, the defect cannot be cured, but the defective casting can be recycled. For this type of transactions, the Organization needs to file declarations and get the consent/acknowledgment from the Local Excise Authorities.

Return Under 173L | This Option is no Longer valid due to changes in Excise Laws.

Scrapped | No RG Register update will be made. Excise Expenses account will be debited for Excise Amount.

FG Return | No RG Register update will be made. Excise Expenses account will be debited for Excise Amount.

Following are the Accounting entries passed based on the Return type.
RMA Receipts considered as 'Production Input’
CENVAT Credit For Excise and CVD Taxes

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>CENVAT A/c</td>
<td>Tax Amount</td>
<td></td>
</tr>
<tr>
<td>Excise Paid Payable Account</td>
<td>Tax Amount</td>
<td></td>
</tr>
</tbody>
</table>

RMA Receipts considered as 'Finished Goods Return’
Localization accounting entry for Excise Tax treatment
Excise duty paid will be written off as Excise expense Account.
RMA Receipts considered as 'Scrap'

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scrap Cost a/c</td>
<td>Item cost</td>
<td></td>
</tr>
<tr>
<td>Sub Inventory a/c</td>
<td></td>
<td>Item cost</td>
</tr>
</tbody>
</table>

Localization accounting entry for Excise Tax treatment

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excise Expense a/c</td>
<td>Excise Amount</td>
<td></td>
</tr>
<tr>
<td>Excise Paid Payable Account</td>
<td>Excise Amount</td>
<td></td>
</tr>
</tbody>
</table>

(Excise Duty Paid will be written off as an expense account)

**RMA Return/Receipt - Trading Item**

The following are the possible scenario in the case of Customer Return for a Trading Item in a Trading Organization

Transaction/Description

RMA Receipts - The goods are totally damaged and the Customer is not looking for any replacement. RG23D- Receipts entry will be passed for the Rejected Qty. Ref. Document: The Customer Invoice for returning the goods.

RMA Receipts - Customer is looking for Replacement. No RG23D Entry RMA Receipts as well return to Customer will be handed through separate D.C or valid documents.

RMA Return - For the above RMA Receipts No RG23D Entry RMA return to Customer will be handed through separate D.C or valid documents.
**Important:** The Dealers need to inform to the Range Superintendent regarding the Goods Returns.

**Use of LC Functionality**

Oracle Financials for India also provides the LC functionality. The following are the details how the user can use the LC Functionality.

**Create LC Master**

LC Master holds the Master Information. You can record the details of the Letter of Credits received by the Organization. He should be able to make amendments, view the transactions against each LC and the Balance available at any point of time.

Navigation: India Local Order management > Letters of Credit > Letters of Credit > Master

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LC Number</td>
<td>(Displayed)</td>
<td></td>
<td>The LC Number is system generated, once the details are entered and saved to create an LC.</td>
</tr>
<tr>
<td>Reference Number</td>
<td>(Required / Protected)</td>
<td>/ EDIT</td>
<td>Reference Number is required to be entered while creating a new LC.</td>
</tr>
<tr>
<td>LC Type</td>
<td>(Required / Protected)</td>
<td>/ PICK</td>
<td>The LC Type has to be chosen from available LOVs. This enables you to record the type of LC as one of 'Revolving', 'Revocable', 'Irrevocable' and 'Confirmed Revocable'. There is no change in behavior based on LC Type.</td>
</tr>
<tr>
<td>Customer Name/Number</td>
<td>(Required)</td>
<td>EDIT</td>
<td>You can pickup a valid Customer for whom Localization setup exists and his Number.</td>
</tr>
<tr>
<td>Description</td>
<td>(Required)</td>
<td>EDIT</td>
<td>Description of the LC is entered. This is not protected from updation and can be edited latter on.</td>
</tr>
<tr>
<td></td>
<td>(Optional)</td>
<td>EDIT</td>
<td>Enter line-specific additional detail and Save.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------</td>
<td>--------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>Original Amount</td>
<td>(Required)</td>
<td>EDIT</td>
<td>LC is opened with an Initial Amount.</td>
</tr>
<tr>
<td>Balance Amount</td>
<td>(Displayed)</td>
<td></td>
<td>This Balance Amount is defaulted after each matching against the LC.</td>
</tr>
<tr>
<td>Start Date</td>
<td>(Required/Protected)</td>
<td>/ EDIT</td>
<td>Start Date From which the entered LC is effective.</td>
</tr>
<tr>
<td>End Date</td>
<td>(Required/Protected)</td>
<td>/ EDIT</td>
<td>End Date till which the entered LC is effective</td>
</tr>
<tr>
<td>Negotiation Days</td>
<td>(Required/Protected)</td>
<td>/ EDIT</td>
<td>Negotiation Days as per the LC</td>
</tr>
<tr>
<td>Last Negotiation Date</td>
<td>(Required/Protected)</td>
<td>/ EDIT</td>
<td>Last Negotiation Date of the LC</td>
</tr>
<tr>
<td>Credit Period</td>
<td>(Required/Protected)</td>
<td>/ EDIT</td>
<td>Credit Period for the LC</td>
</tr>
<tr>
<td>Last Ship Date</td>
<td>(Required/Protected)</td>
<td>/ EDIT</td>
<td>Last Date until which Shipment can be carried out against this LC</td>
</tr>
<tr>
<td>Issue Bank Name / Issue branch Name / Issue Bank Address</td>
<td>(Required/Protected)</td>
<td>/ EDIT</td>
<td>Issue Bank Details of the LC</td>
</tr>
<tr>
<td>Negotiation Bank Name / Negotiation branch Name / Negotiation Bank Address</td>
<td>(Required/Protected)</td>
<td>/ EDIT</td>
<td>Negotiation Bank Details of the LC</td>
</tr>
<tr>
<td>Remarks</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>Remarks of the LC can be entered. Not Protected from updation.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Qty. Amendment</td>
<td>Button</td>
<td></td>
<td>This screen has been provided to amend Quantity matched, for any possible user mistake.</td>
</tr>
<tr>
<td>Amendments</td>
<td>Button</td>
<td></td>
<td>This screen has been provided to amend LC Values and details, for any possible user mistake.</td>
</tr>
<tr>
<td>View Transactions</td>
<td>Button</td>
<td></td>
<td>This screen has been provided to view all transaction done against the specific LC.</td>
</tr>
</tbody>
</table>

### Quantity Amendment

To refer the Screen Navigate through : India Local Order Management - Letters of Credit - Letters of Credit - Master - Qty Amendment Button.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order Header</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>Order Number</td>
</tr>
<tr>
<td>Order Line</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>Order Line id</td>
</tr>
<tr>
<td>Qty Released</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>Quantity Received against the Order.</td>
</tr>
<tr>
<td>Qty Matched</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>Quantity Matched against the LC</td>
</tr>
<tr>
<td>LC Type</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>The LC Type against which matching is done</td>
</tr>
<tr>
<td>LC Number</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>The LC Number for which the record is being displayed</td>
</tr>
<tr>
<td>Amount</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>The Amount matched against the particular LC</td>
</tr>
</tbody>
</table>

### Amendments

To refer the Screen Navigate through : India Local Order Management - Letters of
Credit - Letters of Credit - Master - Amendment Button.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SL / No</td>
<td>(Required)</td>
<td>EDIT</td>
<td>SL No of the Amendment</td>
</tr>
<tr>
<td>LC Number</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>LC Number against which Amendment is to be entered</td>
</tr>
<tr>
<td>Amd Date</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>Date of Amendment</td>
</tr>
<tr>
<td>Amd Amount</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>Revised / New LC Amount</td>
</tr>
<tr>
<td>Negotiation Date</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>New Negotiation Date as per Amendment.</td>
</tr>
<tr>
<td>Shipment Date</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>Revised Last Shipment Date as per Amendment</td>
</tr>
<tr>
<td>Description</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>Description for the Amendment.</td>
</tr>
</tbody>
</table>

View Transactions

To refer the Screen Navigate through: India Local Order Management - Letters of Credit - Letters of Credit - Master - View Transactions Button.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SL / No</td>
<td>(Display)</td>
<td></td>
<td>SL No of the Transaction</td>
</tr>
<tr>
<td>Customer Id</td>
<td>(Display)</td>
<td></td>
<td>Customer Number against which LC pertains</td>
</tr>
<tr>
<td>Order Header</td>
<td>(Display)</td>
<td></td>
<td>Order Number</td>
</tr>
<tr>
<td>Order Line Num</td>
<td>(Display)</td>
<td></td>
<td>Line Number of the Order</td>
</tr>
<tr>
<td>Qty Released</td>
<td>(Display)</td>
<td></td>
<td>Quantity Released against the Order</td>
</tr>
<tr>
<td>Qty Matched</td>
<td>(Display)</td>
<td></td>
<td>Quantity Matched against this LC</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------</td>
<td>--------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td>LC Type</td>
<td>(Display)</td>
<td></td>
<td>LC Type for the given LC</td>
</tr>
<tr>
<td>LC Number</td>
<td>(Display)</td>
<td></td>
<td>LC Number to which the Order line is matched</td>
</tr>
<tr>
<td>Amount</td>
<td>(Display)</td>
<td></td>
<td>Amount of the Order Line for this LC</td>
</tr>
</tbody>
</table>

**LC Matching**

Navigation: India Local Order management - Letters of Credit - Letters of Credit - Matching

This will be displayed as entered in the Base Apps Sales Order Screen. LOV’s are available.

At Line Level

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Name</td>
<td>Required</td>
<td></td>
<td>Name of the Customer will be entered for the LC transactions to be matched.</td>
</tr>
<tr>
<td>Customer Number</td>
<td></td>
<td></td>
<td>Number of the Customer will be entered for the LC transactions to be matched.</td>
</tr>
<tr>
<td>SL / No</td>
<td>(Display)</td>
<td></td>
<td>SL No of the Transaction</td>
</tr>
<tr>
<td>Order Number</td>
<td>(Required)</td>
<td>LOV</td>
<td>Order Number which needs to be Matched</td>
</tr>
<tr>
<td>Order Line Number</td>
<td>(Required)</td>
<td>LOV</td>
<td>Order Line Number which needs to be Matched</td>
</tr>
<tr>
<td>Delivery Detail ID</td>
<td>(Required)</td>
<td>LOV</td>
<td>Delivery Detail ID which needs to be Matched</td>
</tr>
<tr>
<td>Item Name</td>
<td>(Display)</td>
<td></td>
<td>Item Name</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------</td>
<td>--------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Qty Released</td>
<td>(Display)</td>
<td></td>
<td>Quantity Released against the Order</td>
</tr>
<tr>
<td>Qty Matched</td>
<td>(Required)</td>
<td></td>
<td>Quantity to be Matched against this LC</td>
</tr>
<tr>
<td>LC Type</td>
<td>(Display)</td>
<td></td>
<td>LC Type for the given LC</td>
</tr>
<tr>
<td>LC Number</td>
<td>(Display)</td>
<td></td>
<td>LC Number to which the Order line is matched</td>
</tr>
</tbody>
</table>

**Important:** If an Order is LC enabled, the Delivery needs to be matched fully with a LC for the Customer prior to fulfilling orders, else system will prevent the Shipment from taking place, till such Matching is completed.

If the Matched Quantity is not equal to the quantity being shipped, the base shipment will be stopped with the following message:

' ORA-20401 LC Matched Quantity - X should be equal to Shipped Quantity - Y for LC enabled Orders'

In the given case match the balance quantity & then try shipping.

If the Order is Attached to Bond Register / LUT (Letter of Undertaking) Excise Duty and Excise Cess will not be considered for LC Matching.

LC Matching can be carried out provided the LC Balance is equal or more than the Order Amount.

**Fulfilled Orders (Localized)**

The Fulfilled Orders India Localization form is used to search and display the shipment information for both the shippable and non-shippable items. It also supports GL drilldown of journal lines, viewing and update of tax information for non-shippable items, generating VAT accounting and VAT invoice number and import Order and tax information for non-shippable items

You can enter any one of the following fields, such as Departure Name, Customer, Order Number, Batch Name, Ship date, Delivery Name, Warehouse, Order type, Waybill to help in specific query of records in the Fulfilled Orders Screen.

Before dispatching the goods, the Sales Order needs to be released and the shipping need to be Confirmed through the standard application. You need to take enough care to ensure that the correct taxes are defaulted in the Sales Order before
Releasing/Confirming the shipment of the Order.

**Warning:** The localization taxes cannot be modified once the Order is Released/Shipped

Immediately on order fulfilment, Excise related records get updated. You can view the Excise and Other Tax Information related to the Shipment using Fulfilled Orders - Localized screen. You can query for an existing Shipment based on the Order Number/Delivery Number.

You have an option to add any taxes of tax type Freight in the tax region of the Fulfilled Orders localized screen. The freight added in this screen will be considered while running the Auto Invoice program and the same will get accounted in the Receivables Module.

**Confirming Shipment**

In Oracle Financials for India, navigate to the Shipment Confirmation India Localization window as follows:

Shipping > Confirm Shipments > Fulfilled Orders (Localized) > Find

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating Unit</td>
<td>(Required)</td>
<td>(Pick)</td>
<td>The Operating Unit for which the Shipment needs to be queried.</td>
</tr>
<tr>
<td>Header level</td>
<td>(Display only)</td>
<td></td>
<td>Relevant Shipping Information like Delivery Name, Order Number, Customer Name, Order Type, Ship To, Excise Exemption Type, Way Bill Number, Line Total, Excise Exemption Reference Number, Excise Exemption Date, Tax Total, Order Total Amount, Currency, Item Name, Excise Invoice No and VAT Invoice No are displayed. Checking the Matching Items Only flag returns only those items that match the shipment details entered.</td>
</tr>
</tbody>
</table>

Fields discussed below pertains to the localized information.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excise Exemption Type</td>
<td>(Display only)</td>
<td></td>
<td>Excise Exemption Type will be displayed if an Order is against CT2, CT3 and Exemption Certificate.</td>
</tr>
<tr>
<td>Excise Exemption Ref No</td>
<td>(Display only)</td>
<td></td>
<td>Excise Exemption Reference Number of CT2, CT3 and Exemption Certificate will be displayed if an Order is against CT2, CT3 and Exemption Certificate.</td>
</tr>
<tr>
<td>Excise Exemption Date</td>
<td>(Display only)</td>
<td></td>
<td>Date of CT2, CT3 and Exemption Certificate will be displayed if an Order is against CT2, CT3 and Exemption Certificate.</td>
</tr>
<tr>
<td>Tax amount</td>
<td>(Display only)</td>
<td></td>
<td>Total Tax for the Shipment will be displayed.</td>
</tr>
<tr>
<td>Total amount</td>
<td>(Display only)</td>
<td></td>
<td>Total Amount (Total Line Amount + Total Tax Amount) for the Shipment will be displayed.</td>
</tr>
<tr>
<td>Item Name</td>
<td>(Display only)</td>
<td></td>
<td>You can use this field to query in all Orders with the Item entered here. On executing this query the system would fetch all Shipments that have the specified item in the lines.</td>
</tr>
<tr>
<td>Matching Items Only</td>
<td>(Display only)</td>
<td></td>
<td>You can use this field in combination with 'Item Name' field. On executing a query with this field checked in combination with Item Name, the system would fetch all shipments that contain this Item. The lines would be restricted to the queried Item.</td>
</tr>
<tr>
<td>Excise Invoice No</td>
<td>(Display only)</td>
<td></td>
<td>You can use this field query on all shipments. On querying on the Excise Invoice No. all shipments with this Excise Invoice Number would be retrieved.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------</td>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VAT Invoice No (Display</td>
<td>(Display only)</td>
<td></td>
<td>You can use this field query on all shipments. On querying on the VAT Invoice No. all shipments with this VAT Invoice Number would be retrieved.</td>
</tr>
<tr>
<td>Shipped</td>
<td>(Display only)</td>
<td></td>
<td>Checking this flag states that the item is shippable.</td>
</tr>
<tr>
<td>Line number</td>
<td></td>
<td></td>
<td>Line Number of the Item displayed against the delivery will be displayed</td>
</tr>
<tr>
<td>Order Line No</td>
<td></td>
<td></td>
<td>Order Line number of the item displayed against the delivery.</td>
</tr>
<tr>
<td>Item Name</td>
<td></td>
<td></td>
<td>Item Code of the Item shipped against the line covered under the delivery will be displayed.</td>
</tr>
<tr>
<td>VAT Exemption Date</td>
<td>(Display Only)</td>
<td></td>
<td>Displays the VAT Exemption Date.</td>
</tr>
<tr>
<td>Reference no.</td>
<td>(Display Only)</td>
<td></td>
<td>Reference number of the item shipped against the line will be displayed.</td>
</tr>
<tr>
<td>VAT Invoice No</td>
<td>(Display only)</td>
<td></td>
<td>VAT Invoice No. of the shipment will be displayed.</td>
</tr>
<tr>
<td>[ ]</td>
<td>(Optional) EDIT</td>
<td></td>
<td>Enter line-specific additional detail and Save.</td>
</tr>
</tbody>
</table>

**Important:** If tax details do not get populated in the above screen, (even due to invalid / disabled triggers) the same is treated, as Shipment without taxes and taxes will not flow to Accounts Receivable Module. In such cases, User has to raise a Debit Note for Tax Amounts in Receivables & pass Manual Entries in Excise Registers.
Note: You can view the GL Drilldown accounting lines by clicking Show transactions on the Tools menu of the Confirm Shipment India Localization form.

Bond Register

In the Sales Order if you select an Order Type associated with the 'Bond Register' Excise Transaction Type, duty will not be debited in any of the duty paying registers. Instead, the duty will be debited to the running bond account balance.

Shipment created based on these Order Types would be considered for the update to Bond Register. A record would be created in the Bond Register on running the 'Excise Invoice Generation' program. The Bond Amount would be reduced by the Amount of Transaction.

The system would raise an application error and interface trip stop would complete with an error, whenever, the amount of Bond Credit is lesser than the Excise Duty applicable to the Export Transaction. The same would not be applicable to the Bonds that have been checked as LUT’s.

The system would also raise application error where the Shipment Date is greater than the Bond Expiry Date.

You can view the Transactions under Bond through the View Bond Register screen. The duty amount debited in the Bond Register can be credited on admission of the proof of export by the Excise Authority.

To view the transactions related to the Bond, select the Organization, Location and Bond Number. The lines would reflect the transactions related to the Bond. Bond Amount entered in the Define Bond Register screen would be shown as the Bond Credit. This would be the first transaction. A record would be created for every shipment transaction with the Transaction Name as 'Bond Sales'. Register Balance would be reduced to the extent of this Excise Duty on the transaction.

India Local Order Management - Setup - Registers - Bond Register Summary

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating Unit</td>
<td>(Required)</td>
<td>(Pick)</td>
<td>The Operating Unit for which the Bond Register is being queried.</td>
</tr>
<tr>
<td>Organization Name</td>
<td>(Enter)</td>
<td></td>
<td>The Inventory Organization for which you want to check the Bond Register</td>
</tr>
<tr>
<td>Location</td>
<td>(Enter)</td>
<td></td>
<td>The Inventory Location for which you want to check the Bond Register</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bond Number</td>
<td>(Enter)</td>
<td></td>
<td>User can select appropriate Bond Number from the list of LOV's. User can select a value in this field only after selecting the Organization and Location.</td>
</tr>
<tr>
<td>Bond Expiry Date</td>
<td>(Displayed)</td>
<td></td>
<td>Value in this field would be displayed on selecting the Bond Number.</td>
</tr>
<tr>
<td>Letter of Undertaking</td>
<td>(Displayed)</td>
<td>Check box</td>
<td>This would be a display field and would indicate whether the Bond is a Letter of Undertaking.</td>
</tr>
<tr>
<td>Transaction Name</td>
<td>(Displayed)</td>
<td></td>
<td>The Transaction Name will be displayed here for the transaction line.</td>
</tr>
<tr>
<td>Transaction Amount</td>
<td>(Displayed)</td>
<td></td>
<td>The Transaction Amount will be displayed here for the transaction line.</td>
</tr>
<tr>
<td>Register Balance</td>
<td>(Displayed)</td>
<td></td>
<td>The Register Balance post the given transaction</td>
</tr>
<tr>
<td>Order / Invoice Number</td>
<td>(Displayed)</td>
<td></td>
<td>Whether the transaction has come from an Order or a Manual Invoice from AR Module.</td>
</tr>
<tr>
<td>Order Invoice Number</td>
<td>(Displayed)</td>
<td></td>
<td>The Order / Invoice Number will be displayed here for the transaction line.</td>
</tr>
<tr>
<td>Transaction Type</td>
<td>(Displayed)</td>
<td></td>
<td>The Transaction Type will be displayed here for the transaction line.</td>
</tr>
<tr>
<td>Excise Invoice Number</td>
<td>(Displayed)</td>
<td></td>
<td>The Excise Invoice Number will be displayed here for the transaction line.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Export Approval No</td>
<td>(Displayed)</td>
<td></td>
<td>The Export Approval Number will be displayed here for the transaction line under which the proof of export is admitted.</td>
</tr>
</tbody>
</table>

On receipt of proof of export for a particular transaction, you can take credit of the Bond amount in the view Bond Register. This you can do by navigating to Tools, Enter Approval Number. This would display a sub window where you can record the Approval Number. On saving the record, the duty amount will get credited in the running Bond Account.

Tools - Enter Approval Number.

This displays the sub window where the user can record the Approval Number. On saving the record, the duty amount will get credited in the running bond account.

**Running Bond Register**

In Oracle Financials for India, navigate to the Bond Register Summary India Localization window as follows:

India Local Order Management > Setup > Registers > Bond Register Summary > Tools > Enter approval No

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization/Location</td>
<td>(Displayed)</td>
<td></td>
<td>The Inventory Organization and its Location will be displayed here from the transaction line.</td>
</tr>
<tr>
<td>Transaction Type</td>
<td>(Displayed)</td>
<td></td>
<td>The Transaction Type will be displayed here from the transaction line.</td>
</tr>
<tr>
<td>Order Invoice Number</td>
<td>(Displayed)</td>
<td></td>
<td>The Invoice Number will be displayed here from the transaction line.</td>
</tr>
<tr>
<td>Transaction Amount</td>
<td>(Displayed)</td>
<td></td>
<td>The Transaction Amount will be displayed here from the transaction line.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export Approval No</td>
<td>(Required)</td>
<td>ENTER</td>
<td>You can record the AR4 Number and the document reference under which the proof of export is admitted.</td>
</tr>
</tbody>
</table>

**Important:** The Number once entered is not allowed to be changed and due care needs to be taken while entering the same to enter the correct value.

The facility provided is to enter the number against each invoice only and group entry features are not possible.

### Excise Exempted Sales Orders

By selecting an Excise Exemption Type from the Localized Sales Order, you clear excisable goods without payment of duty under specific conditions. Excisable goods can be cleared from the factory without payment of duty to a 100% Export Oriented Unit against CT 3 Certificates under the cover of AR3. Excise Exemption options available for the users.

See Also: The features of excise exemption are discussed in detail under the topic Sale Order - Localized.

### AR3 A Form Receipts

Clearance without payment of Duty under AR-3A needs to be tracked for Receipt of Re-warehousing Certificate. This legal requirement can be mapped through this functionality. All clearances under Excise Exemptions will be recorded in this screen and on Receipt of the Authenticated Document, the receipt date can be recorded. By viewing this screen, you can monitor the Re-warehousing certificates that need to be received from the Customers at any point of time.

Through the find query form you can view the AR3A forms to be received for a particular Customer or all Customers.

### Tracking AR3 Form Receipts

In Oracle Financials for India, navigate to the India Local AR3 Form Receipt Tracking window as follows:

India Local Order Management > Customers > AR3 A form Receipts Tracking
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Block</td>
<td></td>
<td></td>
<td>Details regarding the Customer will be displayed.</td>
</tr>
<tr>
<td>Customer Name</td>
<td>(Displayed)</td>
<td></td>
<td>Customer Name will be displayed.</td>
</tr>
<tr>
<td>Customer Number</td>
<td>(Displayed)</td>
<td></td>
<td>Customer Number of the above Customer will be displayed.</td>
</tr>
<tr>
<td>Customer Site</td>
<td>(Displayed)</td>
<td></td>
<td>Customer Site (Ship to) will be displayed.</td>
</tr>
<tr>
<td>Transaction Block</td>
<td>(Displayed)</td>
<td></td>
<td>Details regarding the transaction will be displayed.</td>
</tr>
<tr>
<td>Type</td>
<td></td>
<td></td>
<td>Type of transaction either Order or Invoice will be displayed.</td>
</tr>
<tr>
<td>Source</td>
<td>(Displayed)</td>
<td></td>
<td>Source for the above type of transaction will be displayed.</td>
</tr>
<tr>
<td>Number</td>
<td>(Displayed)</td>
<td></td>
<td>Number of the transaction will be displayed.</td>
</tr>
<tr>
<td>Form Block</td>
<td></td>
<td></td>
<td>Details regarding CT2, CT3 and Excise Exemption Certificate will be displayed.</td>
</tr>
<tr>
<td>Form</td>
<td>(Displayed)</td>
<td></td>
<td>Form Type like CT2, CT3 and Excise Exemption will be displayed.</td>
</tr>
<tr>
<td>Number</td>
<td>(Displayed)</td>
<td></td>
<td>Number of CT2, CT3 and Excise Exemption Certificate will be displayed.</td>
</tr>
<tr>
<td>Date</td>
<td>(Displayed)</td>
<td></td>
<td>Date of the CT2, CT3 and Excise Exemption Certificate will be displayed.</td>
</tr>
</tbody>
</table>
### Field Description | Type | Action | Description
--- | --- | --- | ---
AR3A details block |  |  | Details of AR3A Forms for a transaction will be displayed here and once the AR3A forms is received back from a Customer, the same can be entered in this block in received date column.

Delivery Number | (Displayed) |  | Delivery Number will be displayed.

Delivery Name | (Displayed) |  | Delivery Name will be displayed.

Delivery Date | (Displayed) |  | Delivery Date will be displayed.

AR3A Form Number | (Displayed) |  | AR3A Form Number will be displayed.

Date | (Displayed) |  | AR3A Form Date will be displayed.

Received Date | (Enterable) |  | The Date on which the AR3A forms were received back from the Customer. After receipt of an AR3A form, it will be removed from the outstanding list of AR-3A form to be received from a Customer.

**Important**: Delivery Number, Name and Date will be visible only for Order Management transactions and will not show any value for Manually entered Receivable transactions.

In the Find window, Order/Invoice refers to query option of querying for an Order entered through Order Management or Invoice entered through Transactions (Localized) in Receivables. Invoice does not list Imported Invoices against Order Management.

### Reports

This section provides overview and detailed descriptions of these reports:

- Commercial Invoice
- India - Excise/VAT Invoice Template
**Commercial Invoice**

This report gives you the Commercial Invoice that covered "ISSUE OF INVOICE UNDER CENTRAL EXCISE RULE 57G OR 57T". This section is no longer valid, however the report is not dropped so that the fields appearing in the report can be used as an example or base for client required output to generate and print Invoices.

**Report Submission**

Use the Submit Requests (India Local AR and OM Modules) form and enter India-Commercial Invoice Report in the Name field to submit the report.

**Report Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Required/Optional</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>Enter the organization from which delivery of goods is made.</td>
<td>Optional</td>
<td>Pick</td>
</tr>
<tr>
<td>Location</td>
<td>Enter the location of the organization.</td>
<td>Optional</td>
<td>Pick</td>
</tr>
<tr>
<td>Customer</td>
<td>Enter the customer name.</td>
<td>Optional</td>
<td>Pick</td>
</tr>
<tr>
<td>Order/Invoice</td>
<td>Quick field for this field are Order and Invoice.</td>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Invoice</td>
<td>Commercial Invoices that the user wants to print.</td>
<td>Required</td>
<td></td>
</tr>
</tbody>
</table>

**India - Excise/VAT Invoice Template**

This report gives you the Invoice Template, provided as an example of the Excise/VAT Invoice that is to be generated. Fields appearing in the report can be used as an example or base for Customer required output to generate and print Invoices. You can use this template to customize your requirement of invoice printing as appropriate.

**Note:** The format of the actual invoice is left to the manufacturer to decide and hence only a generic template is provided.
This report is primarily based on Shipping data, and will not handle the following:

- Standalone AR Invoices (entered through Transactions Localized)
- Invoices for Bill Only Workflow
- Excise Invoice generated for RTV
- Excise Invoice generated for Manual PLA and RG23A/C, RG1 entry

**Report Submission**

Use the Run Reports from India Order Management module to be invoked from the order management reports request group and enter India Excise/VAT Invoice Template in the Name field to submit the report.

**Report Parameters**

<table>
<thead>
<tr>
<th>Report Parameter</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization Name</td>
<td>Required</td>
<td>PICK</td>
<td>The Inventory organization for which the report is being generated. This allows all Inventory organizations and does not restrict based on Operating Units attached to the user.</td>
</tr>
<tr>
<td>Location</td>
<td>Optional</td>
<td>PICK</td>
<td>The Inventory Location for which the report is being generated. This needs to be left blank if all locations are to be printed. This gets enabled only if the Inventory Organization is selected.</td>
</tr>
<tr>
<td>Report Parameter</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>From Date and To Date</td>
<td>Required</td>
<td></td>
<td>Start Date and End Date for which the report is being run. This can be used leaving the number blank in case you want to generate the report for a range of transactions. This field is however required to restrict printing of invoices to a specific year when there are same numbers across various years in the given organization location combination.</td>
</tr>
<tr>
<td>Delivery</td>
<td>Optional</td>
<td>PICK</td>
<td>LOV shows list of all available Deliveries based on From Date and To Date entered. Selecting a value in this field indicates user wants to print a single document for which he already has the number.</td>
</tr>
</tbody>
</table>

*Note:* When a Single Delivery has both excisable and non-excisable material to be shipped together, the same would display in a single invoice split into two. This is because the Excise Invoice number is a header level field in the report but stored at line level in the current product architecture, when a invoice which has both excisable and non excisable items being shipped together, the report will show All excisable lines as one invoice with Excise Invoice number in header and will show all non-excisable lines as a separate invoice with Excise Invoice number appearing as blank.
This chapter covers the following topics:

- Transactions (Localized) Overview
- Managing TCS Transactions
- TCS Settlement
- Tracking of ST Forms Receipts
- AR 3A Form Receipt Tracking Overview
- RG Consolidation
- Supplementary Transactions Overview
- Duty Drawback Processing
- TDS Certificates Received Overview
- Setting Up Concurrent Programs
- Managing Receivables Transactions
- Using Sales Tax Declaration Forms - Receipt Tracking
- Reports

**Transactions (Localized) Overview**

You can create transactions with localized taxes in the Receivables module. The taxes would be calculated for the item, based on Tax defaulting setup. You will also have a facility to add localization taxes manually.

Where information flows into Transactions while running the auto invoice program, the localization taxes defined in order management module would flow into Transactions (localized) window.

The Transactions (Localized) functionality lets you satisfy all your needs related to Tax calculation required for an Accounts Receivables Transaction. You can:
• Define Item categories to Customer and Customer sites. This would be the basis for taxes defaulting to Transactions.

• Assign assessable prices to items. This price would be the basis for excise duty calculation. The Assessable Price lists can be attached selectively to Customer Sites.

• Create Transactions from Localization window. This would automate tax defaulting and calculation.

• Taxes so defaulted can be changed by the user.

• Payment Register is defaulted based on the precedence logic and can be changed manually if required.

• Import transactions by running auto invoice program. This would default taxes defined for a Sales Order to Transactions (Localized).

• Match Receipts in case of Trading Organization, to pass on the Excise Duty Credit to the transaction

• Generate sequential Excise Invoice number

• Update the excise registers. Based on the set up in Bond register, excise transactions will get recorded in the respective excise records and excise Invoices can be created.

• VAT taxes can be attached if the Invoice has lines with Inventory item, which has been defined as VAT attribute 'Applicable'.

• Completion of the Invoice would result in generation of VAT Invoice number based on the setup carried out.

• Option of calculation of VAT taxes based on VAT Assessable value is possible based on setup at Customer Additional Site level setup.

• An Invoice can be marked as VAT Exempt from the seeded types of exemption.

• Service Tax type of Taxes can be attached to a Transaction being created.

**Major Features**

**Defaulting Taxes to Receivables Invoice**

You have an option to use Localization taxes while creating an invoice in the Receivables module. These taxes can either be defaulted based on the Tax Defaulting Rules or can be attached manually. The automatic Tax Defaulting would be based Item Category assigned to the Customer, Customer Site or based on the Item Class assigned to the Tax Category.
Manual Changes to Defaulted Taxes to Receivables Invoice

The Taxes defaulted can be changed manually, if required. You can also change the defaulted Service Type before completing the transaction.

Note: In case the transactions are imported from Order Management, Service Type cannot be changed using this form.

Generation of Excise Invoice

If the Invoice that you have created has excise type of taxes, you can generate an Excise Invoice for the transaction. All excise related registers will get updated on completion of the transaction.

Generation of VAT Invoice

If the Invoice that you have created has VAT type of taxes, and the item is marked as VAT able you can generate an VAT Invoice for the transaction. The tax repository will get updated on completion of the transaction.

Update of Excise Registers

Update of Excise Registers would be based on the set up of Bond registers. Based on the Bond Register that is attached to the Transaction Type (in the Bond Register Setup) used for the transaction, corresponding excise records would be updated.

Tax Base Amount

You can define precedence logic for calculation of Tax Base Amount on which the Tax Rate would be applied. The Tax Base Amount can either be the line amount or line amount including other taxes calculated for the transaction.

Match Receipts

If the creating the Invoice for a trading organization, you can match the Invoice line to a Receipt. On doing this the excise amount would be proportionately passed on to the Invoice line.

Taxes on Credit / Debit Memo created against a Receivable Invoice

When the receivables Invoice created has the taxes applicable, and if the Credit Memo or Debit Memo is created against the given Invoice, then it will also consider all the taxes applicable for the Invoice (proportional to the quantity or percentage as specified).

Record Excise Exemptions

You can choose the Exemption Type applicable to the transaction. The effect on the Accounting entries and excise registers would vary based on the option chosen in this field.

Record VAT Exemptions

You can choose the Exemption Type applicable to the transaction. The VAT tax will be changed to Zero if the same is marked as VAT Exempt.
Choose Update of RG Registers

You have an option to update the Payment Registers selectively. This you can do by un-checking the Update RG Flag.

Choose Register Preferences

By default, the duty will get debited in the register based on the register preference set up in the Additional Organization Information. User has an option to change the duty paying register for each transaction.

Reports

Receivables generates these reports for India:

**India- Debtors Ledger Report** - Lists all the transactions with the Customer to arrive at the net liability for the Customer. You can use this report to get Debtors Sub-Ledger.

**India-Debtors Trial Balance Report** - Lists the closing balance for Customers as on date.

**Total Sales Report** - Lists the Sales transactions made from an Inventory Organization during the selected period.

Managing TCS Transactions

Order to Cash Cycle

1. Enter a normal sales order with TCS Taxes. Save and Book it.

   **Note:** If the customer billing exceeds Threshold limits, the Order will not show the Surcharge. This is because Order entry or booking is not a financial transaction and the event, when surcharge is applicable, is Shipping and invoicing only. Also, as Surcharge needs to be reversed when the total Threshold decreases, such surcharge is not displayed in the order even after shipping or closure of order line.

When booking a sales order with TCS Tax, setup the following after DTC:

- Define a calendar for TDS Financial year in the Payables responsibility. Calendar type should be year and specify full financial year as one period.

- Attach the above calendar to TCS regime by adding a row.

2. Pick Release and fulfil the order. When you fulfil the order with Surcharge limit exceeded, the Surcharge and Cess get auto-assigned.
3. Run Autoinvoice for this Order, which will import the Invoice into Receivables. Run the India Local Concurrent for Processing Order Lines to AR, which will populate these taxes in Oracle Receivables. You can query the AR invoice from the IL screen using the transaction number.

The invoice number is inserted for imported invoices for transactions only after running the India-local concurrent for processing order lines to AR.

**TCS Product Impact Support Patch**

Oracle Financials for India now supports Tax Collected at Source (TCS) sale of certain minerals, cash sale of bullion and jewelry which that are released as part of the budget changes announced by the Federal Government of India in March, 2012.

**Bill Only Cycle**

1. Enter a normal 'Bill Only' sales order with TCS Taxes. Save and Book it.

   **Note:** If the customer billing exceeds Threshold limits, the Order will not show the Surcharge. Book this order. In bill only cycle, surcharge and cess on surcharge get included and computed on running the AutoInvoice.

2. Run Autoinvoice for this Order, which will import the Invoice into Receivables. Run the India Local Concurrent for Processing Order Lines to AR, which will populate these taxes in Base Receivables.

**Standalone Receivables Invoice**

1. Navigate to Transactions Localized, Open and create the transaction.

2. Then?

**Advance Receipts**

1. Create a normal receipt with Payment Method as Receipt for TCS.

2. Navigate to View > Zoom before saving the receipt. This will open the India Local Cash Receipts window.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Name</td>
<td>Display</td>
<td></td>
<td>The customer for whom the receipt is being entered.</td>
</tr>
<tr>
<td>Customer Number</td>
<td>Display</td>
<td></td>
<td>The customer number for which the receipt is being entered.</td>
</tr>
<tr>
<td>Customer Site</td>
<td>Display</td>
<td></td>
<td>The customer site for which the receipt is being entered.</td>
</tr>
<tr>
<td>Receipt Number</td>
<td>Display</td>
<td></td>
<td>The receipt number that is being entered.</td>
</tr>
<tr>
<td>Receipt Amount</td>
<td>Display</td>
<td></td>
<td>The receipt amount that is being entered.</td>
</tr>
<tr>
<td>Organization</td>
<td>Required</td>
<td>PICK</td>
<td>The Inventory Organization against which this receipt is being entered.</td>
</tr>
<tr>
<td>Item Classification</td>
<td>Required</td>
<td>PICK</td>
<td>The Item class for which this concurrent is being run.</td>
</tr>
<tr>
<td>Tax Category</td>
<td>Required</td>
<td>PICK</td>
<td>The Tax Category for this receipt based on which Taxes will be deducted.</td>
</tr>
</tbody>
</table>

**Note:** Only Tax Categories with TCS Tax Type will be displayed in the LOV.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCS Document No.</td>
<td>Display</td>
<td></td>
<td>The TCS document that gets generated for this receipt.</td>
</tr>
<tr>
<td>Total Tax Amount</td>
<td>Display</td>
<td></td>
<td>The Total TCS Tax amount that got charged to this receipt.</td>
</tr>
</tbody>
</table>

3. Enter Organization, Item Classification and Tax Category and click on Taxes. If the taxes are found in order, click Confirm and close the taxes window.

   **Note:** For a confirmed Receipt, taxes will be view only and cannot be modified.

   TCS is charged only when you Confirm the Taxes. If you do not confirm the receipts, the same will be shown in the TCS Exception Report. You must navigate to the Receipt and Confirm the taxes, else these receipts will be nullified during settlement.

   **Note:** Once the Settlement Process is carried out, the Receipt cannot be cancelled.

4. Run the AutoInvoice program for TCS Debit Memo.

   **Note:** The Debit memo created will only be visible in Transactions and not in the Transactions Localized screen.

---

**TCS Settlement**

1. Run TCS Settlement Report
2. TCS Settlement
3. Validate and pay AP invoice
4. Update Payment Additional Information
5. Finalize Settlement
6. Run India - Generate TCS Certificates

Run TCS Settlement Report

You must run the TCS Settlement Report before carrying out the actual settlement process. Navigate to View > Request > Submit a New Request from India Local Receivables or India Local Payables responsibility.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAN No</td>
<td>Required</td>
<td>PICK</td>
<td>The TAN No. for which this concurrent is being run.</td>
</tr>
<tr>
<td>Organization Name</td>
<td>Optional</td>
<td>PICK</td>
<td>The Inventory organization for which TCS Settlement is being run.</td>
</tr>
<tr>
<td>Settlement Date</td>
<td>Required</td>
<td></td>
<td>Settlement date for which this concurrent is being run.</td>
</tr>
<tr>
<td>Item Classification</td>
<td>Required</td>
<td>PICK</td>
<td>The Item class for which this concurrent is being run.</td>
</tr>
</tbody>
</table>

Running the TCS Settlement report can give you the following information to be verified:

- Exception: Cash Receipts where TCS is applicable but taxes have not been confirmed.

  **Note:** TCS applicability of these receipts will be nullified if you proceed with settlement without confirming the taxes.

You can ignore this exception only if you specifically intend to remove TCS applicability for the receipts listed. This exception will not be reported again as the second run will assume you intend to remove the TCS applicability for such receipt.

- Warning: Cash Receipts where TCS is applicable and taxes have been confirmed but have not been fully applied.

- Warning: Invoices with TCS applicability are not complete.
• List of transactions in the settlement period.

• List of documents for surcharge adjustment at Threshold change.

• Exception: Documents generated for TCS not yet imported.
  Any document generated for TCS but not yet imported i.e. present in interface tables will be shown here. You must import such documents before initiating TCS Settlement.

**TCS Settlement**

After verifying the India TCS Settlement Report output, perform the TCS settlement by navigating to India Local Receivables > Period End > Settlement.

Settlement Date can be entered only upto sysdate-1 i.e. yesterday’s date. A settlement cannot be carried out on current date as there can be some transactions carried out in current date after settlement, which will then remain pending in the system.

The Process button will be active only when the Net Balance Amount (Payable amount) is shown Negative. If the Credits are more than the Debits and there is no payment due, then you cannot process a settlement. In such cases the Process button will appear disabled.

**Note:** When the TCS Settlement process is carried on the TCS repository, feeding any new data to the repository will result in data inconsistency. TCS Settlement carried out once cannot be reversed.

Clicking Process will invoke a concurrent of Localization Payables Open Interface Import (Payables Open Interface Import), which will create an AP Invoice on the TCS authority selected.

**Validate and Pay AP Invoice**

Login with Payables responsibility and validate and pay the AP invoice in Oracle Payables.

**Updating Payment Additional Information**

To update payment additional information, navigate to India Local Receivables > India TCS/VAT/Service Tax > Period End > Additional Payment Information.

**Note:** Clicking New will let you enter details for new Payment to be made. Find let’s you search for existing payment details.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header information</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tax Authority Type</td>
<td>Display</td>
<td></td>
<td>This needs to be set to 'India TCS Authority' for TCS settlement.</td>
</tr>
<tr>
<td>Tax Authority</td>
<td>Display</td>
<td></td>
<td>The Vendor name which was used for making the TCS Challan at time of TCS Settlement.</td>
</tr>
<tr>
<td>Tax Authority Site</td>
<td>Display</td>
<td></td>
<td>The Vendor site which was used for making the TCS Challan at time of TCS Settlement.</td>
</tr>
<tr>
<td>Item Classification</td>
<td>Display</td>
<td></td>
<td>The TCS Item class for which TCS Settlement was carried out.</td>
</tr>
<tr>
<td>Line Information</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Settlement Date</td>
<td>Display</td>
<td></td>
<td>The Date when TCS Settlement was carried out</td>
</tr>
<tr>
<td>TAN Number</td>
<td>Display</td>
<td></td>
<td>The Organization TAN Number for which Settlement was carried out.</td>
</tr>
<tr>
<td>TCS Amount</td>
<td>Display</td>
<td></td>
<td>The basic TCS Amount that was settled.</td>
</tr>
<tr>
<td>Surcharge Amount</td>
<td>Display</td>
<td></td>
<td>The Surcharge on TCS Amount that was settled.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Education Cess Amount</td>
<td>Display</td>
<td></td>
<td>The Education Cess on the TCS and the Surcharge amount that was settled.</td>
</tr>
<tr>
<td>Total TCS Amount</td>
<td>Display</td>
<td></td>
<td>The Total TCS amount that got settled. This is sum of the TCS Amount, surcharge amount and Education Cess amount shown in the preceding three columns.</td>
</tr>
<tr>
<td>Check Date</td>
<td>Display</td>
<td></td>
<td>The Check date with which this settlement was paid.</td>
</tr>
<tr>
<td>Check Number</td>
<td>Display</td>
<td></td>
<td>The Payment Document number using which the TCS settled amount was paid.</td>
</tr>
<tr>
<td>BSR Code</td>
<td>Required</td>
<td></td>
<td>This is a seven digit numeric code that is required to be printed on the TCS Certificate and in eTCS returns</td>
</tr>
<tr>
<td>Check Deposit Date</td>
<td>Required</td>
<td>PICK</td>
<td>The date when the Check was deposited with TCS Authority</td>
</tr>
<tr>
<td>Bank Name</td>
<td>Required</td>
<td>PICK</td>
<td>The Bank Name that would get printed on the TCS Certificate.</td>
</tr>
</tbody>
</table>
**Finalize Settlement**

To finalize the TCs settlement, navigate to India Local Receivables > India TCS/VAT/Service Tax > Period End > Settlement Payment Details.

**Run India - Generate TCS Certificates**

Run the India - Generate TCS Certificates from View > Requests > Submit a new Request, from India Local Receivables or India Local Payables responsibility. Running this request will generate TCS Certificate numbers against each customer for the settlement. If you want to issue certificates quarterly and settlement is carried out monthly, then run this request every quarter and not after each settlement.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Date</td>
<td>Required</td>
<td></td>
<td>From Date for which TCS Certificates that needs to be generated.</td>
</tr>
<tr>
<td>To Date</td>
<td>Required</td>
<td></td>
<td>To Date for which TCS Certificates that needs to be generated.</td>
</tr>
<tr>
<td>TAN Number</td>
<td>Required</td>
<td>PICK</td>
<td>TAN Number for which TCS Certificates that needs to be generated.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------</td>
<td>--------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Tax Authority</td>
<td>Required</td>
<td>PICK</td>
<td>Tax Authority under whose jurisdiction TCS Certificates needs to be generated.</td>
</tr>
<tr>
<td>Tax Authority Site</td>
<td>Required</td>
<td>PICK</td>
<td>Tax Authority site under whose jurisdiction TCS Certificates needs to be generated.</td>
</tr>
<tr>
<td>Customer Name</td>
<td>Optional</td>
<td>PICK</td>
<td>Customer for whom TCS Certificates that needs to be generated.</td>
</tr>
<tr>
<td>Customer Site</td>
<td>Optional</td>
<td>PICK</td>
<td>Customer Site for which TCS Certificates that needs to be generated.</td>
</tr>
</tbody>
</table>

**Tracking of ST Forms Receipts**

**Introduction**

You can use this feature to track sales tax concessional forms to be received from the customers. On receipt of the form, the details of the concessional forms received can be recorded in this window.

This form can be effectively used to monitor and track the Sales tax Forms that need to be received from Customers.

**Basic Business Needs**

The ST Forms Receipt Tracking functionality lets you track the Concessional forms due from Customers. You can:

- Setup Declaration Form names that have to be issued to avail the concessional rate of Sales Tax.
- Assigning Form Names to appropriate Tax Codes while defining these Taxes.
• Keep track of Invoices to against which Sales Tax Declaration forms have to be issued to the Supplier

• Facilitates recording details of Forms received from Customer and the Invoices included in each form receipt

• Provides you with a facility to query Received Forms and view Form details and the Invoices included in these Forms

• Generates Report to view the Invoices for which Concessional forms have been received and also are yet to be received.

• Form Tracking can also be carried out for 0% Sales Tax codes based on attachment to Transaction.

Reports

Receivables generates this report for India:

**India - ST Form Customer Report** - Use Sales Tax Form Customer Report to track customers for whom you have given Sales Tax discount and you have not yet received the ST Forms for an Invoice. Where the Form has been fully or partially received against Invoices.

AR 3A Form Receipt Tracking Overview

Material Clearance without payment of duty under AR-3A needs to be tracked for receipt of re-warehousing certificate. AR-3A Receipt Tracking feature of Oracle Financials for India can be used to meet this requirement. All clearances under excise exemptions will be recorded in this screen and on receipt of the authenticated document; the receipt date can be recorded. By viewing the contents of this screen, users can monitor the re-warehousing certificates that need to be obtained from customers at any given point of time.

The AR-3A Receipt Tracking functionality enables you to keep track of the AR-3A forms due from Customers. Using this functionality, you can:

• Track AR-3A forms to be received from Customers.

• You can also enter the date on which the form was received.

• Generate a report to view the AR-3A forms pending from each Customer.

Using the find query form, the User can view the AR3A forms to be received for a particular customer or all customers.

Navigate to India Local Receivables > Customers > AR3 A form Receipts Tracking

The field wise description of the screen is given below.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Name</td>
<td>(Optional/Required)</td>
<td></td>
<td>The User can enter Customer Name from whom the AR3A Forms are to be received. If nothing is specified here, then all the outstanding AR3A form for all the Customer will be shown / displayed.</td>
</tr>
<tr>
<td>Customer Number</td>
<td>(Displayed)</td>
<td></td>
<td>Customer Number of the above Customer will be displayed here.</td>
</tr>
<tr>
<td>Customer Site</td>
<td>(Optional)</td>
<td></td>
<td>If the User wants to view the outstanding AR3A for a specific Customer Site (Ship to), then he can specify this field.</td>
</tr>
<tr>
<td>Order/Invoice</td>
<td>(Optional)</td>
<td></td>
<td>Quick field are Order or Invoice</td>
</tr>
<tr>
<td>Order/Invoice No</td>
<td>(Optional)</td>
<td></td>
<td>A specific Order / Invoice Number can be specified for which the User wants to view the outstanding AR3A.</td>
</tr>
<tr>
<td>Excise Exemption</td>
<td>(Optional)</td>
<td></td>
<td>CT2, CT2 others, CT3 can be specified</td>
</tr>
<tr>
<td>AR-3A form</td>
<td>(Optional)</td>
<td></td>
<td>AR-3A form number can be specified Through AR-3A form, India Local Receipts Tracking the user can enter the receipt of AR3A form from a Customer.</td>
</tr>
<tr>
<td>Customer Block</td>
<td>(Displayed)</td>
<td></td>
<td>Details regarding the customer will be displayed.</td>
</tr>
<tr>
<td>Customer Name</td>
<td></td>
<td></td>
<td>Customer Name will be displayed.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Customer Number</td>
<td>(Displayed)</td>
<td></td>
<td>Customer Number of the above Customer will be displayed.</td>
</tr>
<tr>
<td>Customer Site</td>
<td>(Displayed)</td>
<td></td>
<td>Customer Site (Ship To) will be displayed.</td>
</tr>
<tr>
<td>Transaction Block</td>
<td></td>
<td></td>
<td>Details regarding the transaction will be displayed.</td>
</tr>
<tr>
<td>Type</td>
<td>(Displayed)</td>
<td></td>
<td>Type of transaction either Order or Invoice will be displayed.</td>
</tr>
<tr>
<td>Source</td>
<td>(Displayed)</td>
<td></td>
<td>Source for the above type of transaction will be displayed.</td>
</tr>
<tr>
<td>Number</td>
<td>(Displayed)</td>
<td></td>
<td>Number of the transaction will be displayed.</td>
</tr>
<tr>
<td>Form Block</td>
<td></td>
<td></td>
<td>Details regarding CT2, CT3 &amp; Excise Exemption Certificate will be displayed.</td>
</tr>
<tr>
<td>Form</td>
<td>(Displayed)</td>
<td></td>
<td>Form Type like CT2, CT3 &amp; Excise Exemption will be displayed.</td>
</tr>
<tr>
<td>Number</td>
<td>(Displayed)</td>
<td></td>
<td>Number of CT2, CT3 &amp; Excise Exemption Certificate will be displayed.</td>
</tr>
<tr>
<td>Date</td>
<td>(Displayed)</td>
<td></td>
<td>Date of the CT2, CT3 &amp; Excise Exemption Certificate will be displayed.</td>
</tr>
<tr>
<td>AR3A details block</td>
<td></td>
<td></td>
<td>Details of AR3A forms for a transaction will be displayed here and once the AR3A forms is received back from a Customer, the same can be entered in this block in received date column.</td>
</tr>
<tr>
<td>Delivery Number</td>
<td>(Displayed)</td>
<td></td>
<td>Delivery number will be displayed.*</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------</td>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Delivery Name</td>
<td>(Displayed)</td>
<td></td>
<td>Delivery Name will be displayed*</td>
</tr>
<tr>
<td>Delivery Date</td>
<td>(Displayed)</td>
<td></td>
<td>Delivery Date will be displayed*</td>
</tr>
<tr>
<td>AR3A Form Number</td>
<td>(Displayed)</td>
<td></td>
<td>AR3A Form Number will be displayed</td>
</tr>
<tr>
<td>Date</td>
<td>(Displayed)</td>
<td></td>
<td>AR3A Form Date will be displayed</td>
</tr>
<tr>
<td>Received Date</td>
<td>(Enterable)</td>
<td></td>
<td>The Date on which the User received back the AR3A form from the Customer. After receipt of a AR3A form, the same will be removed from the outstanding list of AR-3A form to be received from a customer.</td>
</tr>
</tbody>
</table>

Delivery Number, Name & Date are visible only for Transactions, which are imported from Order Management Responsibility and not applicable to Manual Transactions entered in Receivables using Transactions (Localized) Form.

**Reports**

Receivables generate this report for India:

**India - AR3A Status Report** - Lists all the exempted sales transactions against while an Acknowledged AR-3A form is pending from customer.

**RG Consolidation**

The excise rules allow monthly settlement of liabilities arising during the period. Oracle Financials for India provides a feature 'Allow Negative Balance', using which you are allowed to complete a sales transaction; even-though the register balances are not adequate. The PLA Register will be updated irrespective of a negative balance.

To calculate the net liability during monthly settlement, you can use the RG Consolidation feature. The RG Consolidation window:

- Displays the balance in each register for a selected organization.
- Allows you to transfer the credit available in CENVAT accounts to PLA.
• Creates a PLA Payment and AP Invoice for the net liability to change the negative amount to zero.

You can also transfer a part of the available credit to offset negative PLA balance. To do this, specify the amount that needs to be maintained in the CENVAT accounts on completion of the transaction. Accordingly, the system will make Debit entries in the CENVAT registers and credit entries will be generated in the PLA register. For the balance amount, system will create a PLA Invoice.

The RG Consolidation feature lets you completes sales transactions in spite of inadequate credit balance. You can:

• Settle Excise Liability Quarterly

• Automate creation of PLA Payment and AP Invoice based on the intended PLA balance.

**Major Features of RG Consolidation**

**Allow Negative Balance**

You can enable update of PLA with debit transactions even when the PLA balance is negative.

**Track Register balances for each Organization, Location combination**

RG Consolidation window provides you an overview of the balances of Excise Registers and PLA. You can try a combination of transfers and see its corresponding effect on PLA balance.

**Create PLA Payment and AP Invoice**

On saving the changes in RG Consolidation, based on the intended balance of PLA a PLA Payment and AP Invoice are created. However, the PLA Register will not be updated with this transaction until the Invoice is paid and the PLA Payment is acknowledged.

Enabling the 'Allow negative balances in PLA' checkbox in the Additional Organization Information screen allows you to run his PLA Account with negative balances. The Excise Duty liability needs to be adjusted on fortnightly basis and an RG Consolidation screen is provided to adjust the Credit Balance available in CENVAT Accounts while working out the actual amount that needs to be paid on account of Excise Liability. You can specify the amount that needs to be maintained in the CENVAT Accounts and PLA Account on completion of the transaction. Accordingly, the system will make Debit Entries in the CENVAT registers and Credit entries will be generated in the PLA Register. For the balance amount, system will create a PLA Invoice.

**Important:** The RG Consolidation functionality is not supposed to be used for creation of Positive balance in PLA.
This is to be only used to make the Negative PLA Balance to Zero by consolidating the Positive Balances available in RG 23A & C Registers or making a payment for the Negative PLA Balance after consolidation.

The backdated RG Consolidation feature lets you specify a Consolidation Date and will only return those transactions or balances that were created till the supplied date. To be able to do this, you must have enabled the ‘-Ve Balance in PLA’ checkbox for the Organization Location combination by navigating to the Accounting Info tab under India Local Inventory ->Setup ->Organizations ->Additional Information. In the Register Preferences tab, set up PLA as preference 1. While it is possible to do a backdated RG Consolidation without the mandatory setup but skipping it will result in negative RG Register balances post consolidation and the same cannot be rectified as it has cascading effect on balances, registers and accounting.

Once the PLA Invoice is generated by the RG Consolidation transaction, you must make the payment before submitting fresh transactions. The system will disallow any subsequent RG Consolidation transaction till payment is made for the Invoice generated by the previous transaction.

Navigate to India Local Receivables > India Localization > Registers > RG Consolidation Screen. The field wise description for this screen is given below.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating Unit</td>
<td>(Required)</td>
<td>(Pick)</td>
<td>Operating unit for which the RG Consolidation is being carried out.</td>
</tr>
<tr>
<td>Organization Name/Location Name</td>
<td>(Required)</td>
<td>(Pick)</td>
<td>Select Organization and Location name.</td>
</tr>
<tr>
<td>Consolidation Date</td>
<td></td>
<td></td>
<td>The Date on Consolidation needs to be recorded</td>
</tr>
<tr>
<td>Previous consolidation date</td>
<td></td>
<td></td>
<td>System will display the Previous Consolidation Date</td>
</tr>
<tr>
<td>Closing balance as on date</td>
<td></td>
<td></td>
<td>The closing balance of different duty paying registers as on date will be displayed in this field</td>
</tr>
<tr>
<td>Closing balance as on consolidation date</td>
<td></td>
<td></td>
<td>The closing balance of different duty paying registers as on consolidation date will be displayed</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------</td>
<td>-------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Desired closing balance</td>
<td>closing</td>
<td></td>
<td>User needs to input the desired values on completion of the transaction</td>
</tr>
<tr>
<td>Net Debit</td>
<td></td>
<td></td>
<td>Debit from each register for the transaction will be displayed</td>
</tr>
<tr>
<td>Remarks</td>
<td></td>
<td></td>
<td>This field displays the remarks for set off entries</td>
</tr>
<tr>
<td>User remarks</td>
<td></td>
<td></td>
<td>User can enter the transaction text in this column</td>
</tr>
<tr>
<td>Authority/Location</td>
<td></td>
<td></td>
<td>Name and Site of the Excise Authority needs to be picked in this field</td>
</tr>
<tr>
<td>TR6 Challan Number / TR-6 Date</td>
<td></td>
<td></td>
<td>User needs to record the TR6 Challan Number and date through PLA amount is being credited</td>
</tr>
<tr>
<td>Payment id</td>
<td></td>
<td></td>
<td>On saving the record, a batch id will be created and the same will be displayed.</td>
</tr>
</tbody>
</table>

**Important:** On completion of the transaction Debit Entries will be generated in the CENVAT Registers and corresponding Credit Entries will be generated in the PLA Register. Apart from that PLA will be credited with the amount of PLA Invoice generated through the transaction. Users need to ensure that payment towards this Credit is made on the same day.

For Creating a positive PLA Balance please use the PLA Invoice.

**Note:** You can view the GL Drilldown Accounting lines by clicking the Show Transactions button on the Tools menu in RG Consolidation form.

**Supplementary Transactions Overview**

There would be instances in your business where the customer balances are affected by
price and tax rate changes for a retrospective period. For all such changes you can use the Supplementary Transactions feature of Oracle Financials for India. Using this feature, you can identify the source documents affected by these changes, calculate the amount for which an Invoice or a Credit Memo has to be raised and automate creation of such Invoice or Credit Memos.

The Supplementary Transactions feature of Oracle Financials for India helps you in tracking and accounting the price and tax changes. You can:

- Identify the transaction for which Supplementary Invoice or Credit Memos are to be raised on account of Price/Tax/Assessable Price changes.

- Identify the source documents affected by the price and tax rate changes for a retrospective period.

- Verify the calculation and the method followed to arrive the amount for which Supplementary Invoice or Credit Memo will be raised.

- Have an Option to raise/not to raise a Supplementary Invoice or Credit Memos.

- Automate or manually create such Invoice or Credit Memos.

**Major Features**

- **Track Price and Tax Changes**: You can use the Mapping screen to track the previous Price List and Tax Codes. You can initiate the program to identify the transactions for which the Supplementary Invoice or Credit Memo can be raised. You can generate a report to list such transactions.

- **Raise Supplementary Invoice / Credit Memo**: You have the option to raise a Supplementary Invoice, for the identified transactions. The option of not raising the Invoices would be useful in scenarios where you would not be raising Supplementary Invoice for some customer transactions. You also have an option of creating Manual Invoices and Credit Memos for price revisions and tax rate changes.

- **Foreign Currency Fluctuations**: This feature includes the provision to add daily exchange rate on the processing date for raising Supplementary Invoice or Credit Memo. This is required in a scenario where you have used Foreign Currency Price list for raising Invoices.

- **Revised Price List**: In the case of Standalone AR, you must enter a Separate Revised Price List into the System through Price List Menu.

Supplementary Transactions can be raised on account of the following

- Price Change for a retrospective period
• Change in Tax Rate for retrospective period

In both cases either a Supplementary Invoice or Credit Memo will be raised based on the retrospective changes. The transactions, which will have an effect on account of Price changes, will be listed through the following Mapping Type.

• Price List (where OE and AR instances are available).

• Invoice Price List (where standalone AR is available).

• Assessable value/transaction value Price List where there is change in the Assessable value.

Cases Handled

Consider the following products and the following cases:

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Original Price (In rupees)</th>
<th>Revised Price (In rupees)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prod.A</td>
<td>100.00</td>
<td>120.00</td>
</tr>
<tr>
<td>Prod.B</td>
<td>100.00</td>
<td>90.00</td>
</tr>
</tbody>
</table>

Also, consider the following:

<table>
<thead>
<tr>
<th>Tax code</th>
<th>Original Rate</th>
<th>Revised Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Code - Excise</td>
<td>10%</td>
<td>12%</td>
</tr>
<tr>
<td>Tax Code - LST</td>
<td>8%</td>
<td>2%</td>
</tr>
<tr>
<td>Tax Code - Sales tax</td>
<td>5%</td>
<td>3%</td>
</tr>
<tr>
<td>Tax Code - Octroi</td>
<td>3%</td>
<td>5%</td>
</tr>
</tbody>
</table>

The following are the possible scenarios and treatment on the above cases.

Case I

Only Price Revision (Increase) but no change in Tax rate.

Invoice with original price for 100 Quantity of Prod.A raised on March 20, 1999 and a revised price list has been introduced with retrospective effect from March 15, 1999 and the user need to raise a Supplementary Invoice.
## Parameter Table

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Original Price (in rupees)</th>
<th>Revised Price (in rupees)</th>
<th>Supplementary Invoice</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net sales (100 x 100)</td>
<td>10000.00</td>
<td>12000.00</td>
<td>2000.00</td>
</tr>
<tr>
<td>Add : Taxes</td>
<td>1000.00</td>
<td>1200.00</td>
<td>200.00</td>
</tr>
<tr>
<td>Tax code - Excise (10%)</td>
<td>550.00</td>
<td>660.00</td>
<td>110.00</td>
</tr>
<tr>
<td>Tax code - Sales tax (5%)</td>
<td>346.50</td>
<td>415.80</td>
<td>69.30</td>
</tr>
<tr>
<td>Total</td>
<td>11896.50</td>
<td>14275.80</td>
<td>2379.30</td>
</tr>
</tbody>
</table>

**Supplementary Invoice may be raised for RS. 2379.30**

If the user decides to raise a Supplementary Invoice, then the following accounting entry will be passed in this case.

- Dr. Receivable a/c 2379.30
- Cr. Revenue a/c 2000.00
- Cr. Excise duty a/c 200.00
- Cr. Sales Tax a/c 110.00
- Cr. Octroi duty a/c 69.30

### Case II

Only Price Revision (Decrease) but no change in Tax Rate.

Invoice with original price for 100 Quantity of Prod.B raised on March 20, 1999 and a revised price list has been introduced with retrospective effect from March 15, 1999 and the user need to raise a Credit Memo.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Original Price (in rupees)</th>
<th>Revised Price (in rupees)</th>
<th>Credit Memo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net sales (100 x 100)</td>
<td>10000.00</td>
<td>9000.00</td>
<td>1000.00</td>
</tr>
<tr>
<td>Add : Taxes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Original Price (in rupees)</td>
<td>Revised Price (in rupees)</td>
<td>Credit Memo</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------</td>
<td>---------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Tax code - Excise (10%)</td>
<td>1000.00</td>
<td>900.00</td>
<td>100.00</td>
</tr>
<tr>
<td>Tax code - Sales tax (5%)</td>
<td>550.00</td>
<td>495.00</td>
<td>55.00</td>
</tr>
<tr>
<td>Tax code - Octroi (3%)</td>
<td>346.50</td>
<td>311.85</td>
<td>34.65</td>
</tr>
<tr>
<td>Total</td>
<td>11896.50</td>
<td>10706.85</td>
<td>1189.65</td>
</tr>
</tbody>
</table>

Credit Memo may be raised for Rs. 1189.65

If the user decides to raise a Credit Memo, then the following accounting entry will be passed in this case.

Dr. Revenue a/c 1000.00  
Dr. Excise Duty a/c 100.00  
Dr. Sales Tax a/c 55.00  
Dr. Octroi duty a/c 34.65  
Cr. Receivable a/c 1189.65

**Case III**

Change in Tax Rate but no Change in Price.

Invoice with original price for 100 Quantity of Prod.A raised on March 20, 1999 with Original Tax Rate and revised Tax Rate has been put into use w.e.f from March 15th 1999 and the user need to raise a Supplementary Invoice.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>With Original Rate</th>
<th>Original Tax</th>
<th>Revised Tax Rate</th>
<th>Supplementary Invoice</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net sales (100 x 100)</td>
<td>10000.00</td>
<td>10000.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>Add: Taxes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tax code - Excise (10%)</td>
<td>1000.00</td>
<td>(12%) 1200.00</td>
<td>200.00</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>With Original Tax Rate</td>
<td>Revised Tax Rate</td>
<td>Supplementary Invoice</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------</td>
<td>------------------</td>
<td>----------------------</td>
<td></td>
</tr>
<tr>
<td>Tax code- Sales tax (5%)</td>
<td>550.00</td>
<td>(3%) 336.00</td>
<td>-214.00</td>
<td></td>
</tr>
<tr>
<td>Tax code - Octroi (3%)</td>
<td>346.50</td>
<td>(5%) 576.80</td>
<td>230.30</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>11896.50</td>
<td>12112.80</td>
<td>216.30</td>
<td></td>
</tr>
</tbody>
</table>

Supplementary Invoice may be raised for Rs. 430.30
Credit Memo may be raised for Rs. 214.00

**Case IV**
Change in Tax Rate but no Change in Price.
Invoice with original price for 100 Quantity of Prod.A raised on March 20, 1999 with Original Tax Rate and Revised Tax Rate has been put into use w.e.f from March 15th 1999 and the user needs to raise a Credit Memo.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>With Original Tax Rate</th>
<th>Revised Tax Rate</th>
<th>Credit Memo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net sales (100 x 100)</td>
<td>10000.00</td>
<td>10000.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Add : Taxes

<table>
<thead>
<tr>
<th>Parameter</th>
<th>With Original Tax Rate</th>
<th>Revised Tax Rate</th>
<th>Credit Memo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax code - Excise (10 %)</td>
<td>1000.00</td>
<td>(12%) 1200.00</td>
<td>200.00</td>
</tr>
<tr>
<td>Tax code- Sales tax (8%)</td>
<td>880.00</td>
<td>(2%) 224.00</td>
<td>-656.00</td>
</tr>
<tr>
<td>Tax code - Octroi (3%)</td>
<td>356.40</td>
<td>(5%) 571.20</td>
<td>214.80</td>
</tr>
<tr>
<td>Total</td>
<td>12236.40</td>
<td>11995.20</td>
<td>241.20</td>
</tr>
</tbody>
</table>

Credit Memo may be raised for Rs. 656.00
Supplementary Invoice may be raised Rs. 414.80.

**Case V**
Change in Price and also change in Tax Rate.

Invoice with original price for 100 Quantity of Prod.A raised on March 20, 1999 with Original tax rate. The Revised Price and Revised Tax Rate has been put into use w.e.f from March 15, 1999 and the User need to raise the Supplementary Invoice.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>With Original Tax Rate</th>
<th>Revised Price or Tax Rate</th>
<th>Credit Memo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net sales (100 x 100)</td>
<td>10000.00</td>
<td>(120%) 12000.00</td>
<td>2000.00</td>
</tr>
</tbody>
</table>

Add : Taxes

<table>
<thead>
<tr>
<th>Tax code</th>
<th>With Original Tax Rate</th>
<th>Revised Price or Tax Rate</th>
<th>Credit Memo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excise (10%)</td>
<td>1000.00</td>
<td>(12%) 1440.00</td>
<td>440.00</td>
</tr>
<tr>
<td>Sales tax (8%)</td>
<td>880.00</td>
<td>(2%) 268.80</td>
<td>-611.20</td>
</tr>
<tr>
<td>Octroi (3%)</td>
<td>356.40</td>
<td>(5%) 685.44</td>
<td>329.04</td>
</tr>
<tr>
<td>Total</td>
<td>12236.40</td>
<td>14394.24</td>
<td>2157.84</td>
</tr>
</tbody>
</table>

Supplementary Invoice may be raised for Rs. 2769.04.
Credit Memo may be raised for RS. 611.20.

**Price / Tax changes**

The user can decide and execute the kind of mapping he likes to do to identify the transaction which are having impact on account of Price / Tax changes this screen

In Oracle Financials for India, navigate to India Local Receivables > Transactions > Supplementary Transactions > Price/Tax Changes.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ledger</td>
<td>(Required)</td>
<td>PICK HELP</td>
<td>Ledger name needs to be entered by the user from LOV to view the transaction.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Organization</td>
<td>(Optional)</td>
<td>PICK HELP</td>
<td>The Organization name can be entered / selected by the user from LOV to view the transaction. If this is left blank then the transaction for all the Organization will be displayed.</td>
</tr>
<tr>
<td>Customer Name</td>
<td>(Optional)</td>
<td>PICK HELP</td>
<td>The Customer name can be entered by the user from LOV to view the transaction related to a particular Customer. If this is left blank then the transaction for all the Customer will be displayed.</td>
</tr>
<tr>
<td>Customer Site</td>
<td>(Optional)</td>
<td></td>
<td>The Customer Site can be entered by the user from LOV to view the transaction related to a particular Customer Site. If this is left blank then the transaction for all the Customer will be displayed.</td>
</tr>
<tr>
<td>Batch Id</td>
<td>(Optional)</td>
<td></td>
<td>The User can specify the Batch Id to view the Supplementary Transactions corresponding to the Batch Id.</td>
</tr>
</tbody>
</table>

By invoking the new button, the user can perform the desired mapping:

In Oracle Financials for India, navigate to India Local Receivables > Transactions > Supplementary Transactions > Price/Tax Changes > New/Find.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header Level</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ledger</td>
<td>(Required)</td>
<td>PICK HELP</td>
<td>The Ledger name needs to be entered by the user from LOV.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Organization</td>
<td>(Optional)</td>
<td>PICK HELP</td>
<td>The Organization name can be entered by the user from LOV. If this is left blank then the transaction for all the Organization will be considered.</td>
</tr>
<tr>
<td>Functional Currency</td>
<td>(Displayed)</td>
<td></td>
<td>Functional Currency in a Set of Book will be displayed here.</td>
</tr>
<tr>
<td>Customer Name</td>
<td>(Optional)</td>
<td>PICK HELP</td>
<td>Users can select Customer Name from LOV. If Customer Name is left blank then the transaction for all Customers will be considered in the mapping.</td>
</tr>
<tr>
<td>Customer Site</td>
<td>(Optional)</td>
<td>PICK HELP</td>
<td>Users can select Customer Site from LOV. If Customer Site is left blank then the transaction for all Customers will be considered in the mapping.</td>
</tr>
<tr>
<td>Batch Id</td>
<td>(Displayed)</td>
<td></td>
<td>Generates Batch Id for set of mapping and displayed in these fields. Based on this Batch Id, the user can run the concurrent program to raise Supplementary Transactions.</td>
</tr>
<tr>
<td>Line Level</td>
<td>(Required)</td>
<td>PICK HELP</td>
<td>The Quick fields available for Mapping Type are Price List, Assessable Price List, Invoice Price List, and Tax.</td>
</tr>
</tbody>
</table>

Mapping Type: The Usability of the Quick fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price List</td>
<td>used for mapping between Price Lists: OE and AR instances</td>
</tr>
</tbody>
</table>
India Local Receivables

Field Description
Assessable Price List used for mapping between Assessable Price Lists: case OE and AR instances
Invoice Price List used for mapping to identify Invoices due to price changes in the case of standalone AR instances
Tax This will used to do mapping between Tax Codes.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Existing Name</td>
<td>(Required)</td>
<td>PICK HELP</td>
<td>This can be an Existing Price List or Tax Codes depending upon the Mapping type selected by the user.</td>
</tr>
<tr>
<td>New Name</td>
<td>(Required)</td>
<td>PICK HELP</td>
<td>This can be a New (Revised) Price List or Tax Codes depending upon the Mapping type selected by the user.</td>
</tr>
<tr>
<td>Conversion Rate</td>
<td>(Optional)</td>
<td>ENTER</td>
<td>If any foreign currency Price List is considered for mapping, then the user needs to specify the Conversion rate here.</td>
</tr>
<tr>
<td>Effective from Date</td>
<td>(Required)</td>
<td>ENTER</td>
<td>This meant for the retrospective date from this the tax / Price list has been changed.</td>
</tr>
<tr>
<td>Effective to Date</td>
<td>(Required)</td>
<td>ENTER</td>
<td>This meant for the end date up to which the mapping will be done.</td>
</tr>
</tbody>
</table>

After entering the proper details the User needs to save this screen and system will generate a batch id.

Concurrent Request

After entering mapping details, user has to run a concurrent request to identify the transactions, which are to be considered for raising Supplementary Invoices, Credit
Memo & Debit Memo by specifying the respective Batch_Id.

In Oracle Financials for India, navigate to India Local Enter Transaction from India Local Receivables > Reports > Other > Run > Single Request > India > Generate Suggestive Supplementary Transactions.

Choose Batch ID. This should be number generated in the 'Batch id' field of Price/Tax/Assessable Value changes window.

**Generate / Memos / Invoices**

After running the concurrent request, you can find the Supplementary Transaction for which the Supplementary Debit Memos and Credit Memos will be raised.

In Oracle Receivables - India Localization, navigate to the Supplementary transactions window as follows:

India Local Receivables > Transactions > Supplementary Transaction > Generate DR/CR Memos/Invoices

<table>
<thead>
<tr>
<th><strong>Field Description</strong></th>
<th><strong>Type</strong></th>
<th><strong>Action</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Ledger</td>
<td>(Required)</td>
<td>PICK HELP</td>
<td>Ledger name needs to be entered by the user from the LOV in which the user wants to view the Supplementary Transaction.</td>
</tr>
<tr>
<td>Customer Name</td>
<td>(Optional)</td>
<td>PICK HELP</td>
<td>If the User wants to view the supplementary transactions, which are related to a particular Customer, then he can specify that Customer name here by selecting from the LOV.</td>
</tr>
<tr>
<td>Customer Site</td>
<td>(Optional)</td>
<td>PICK HELP</td>
<td>If the User wants to view the Supplementary Transactions that are related to a particular Customer Site, then he can specify that Customer Site here by selecting from the LOV.</td>
</tr>
<tr>
<td>Organization</td>
<td>(Optional)</td>
<td>PICK HELP</td>
<td>If the User wants to view the Supplementary Transactions which are related to a particular Organization, then he can specify that Organization here by selecting from the LOV.</td>
</tr>
</tbody>
</table>
### Field Description | Type | Action | Description
---|---|---|---
Invoice No | (Optional) | PICK HELP | If the User wants to view the Supplementary Transactions which are related to a particular Invoice, then he can specify that Invoice Number here by selecting from the LOV.
Invoice Date | (Optional) | PICK HELP | If the User wants to view the Supplementary Transactions for specific Invoice Date, then he can specify that Invoice Date.
Status | (Optional) | PICK HELP | This represents the status of the Supplementary Transactions. The quick fields available are 'Invoice Raised' and 'Invoice not raised'.
Processed Date | (Optional) | PICK HELP | If the User wants to view the Supplementary Transactions for specific Process Date, then he can specify that Date.
Supplementary transactions | (Optional) | PICK HELP | This represents type of Supplementary Transactions. The quick fields available are 'Supplementary Invoice', 'Credit Memo' and 'Debit Memo'.
Suppl. Inv. Type |  |
Batch Id | (Optional) | PICK HELP | This represents Batch Id for which the Supplementary Transactions are processed.

The User can view the calculated Supplementary Invoices and Credit Memos through this screen and generate Supplementary Invoice and Credit Memos.

In Oracle Financials for India, navigate to the India Local Supplementary Transaction from India Local Receivables > Transactions > Supplementary Transaction > Generate DR/CR Memos/Invoices

The following facilities are available in this screen for the user:

- View Line details and Tax details for a particular transaction.
• View details for Existing Invoice as well Revised Invoice Amount

• The user can modify Tax line only in the following manner by:

• Deleting a particular tax line to be excluded from being charged for a specific case.

• Updating the tax amount by inserting a calculated figure in the Tax Amount column.

The User can select all the transaction or an individual transaction for which Supplementary Invoice/Credit Memo will be raised. In addition, the user can consolidate two or more transaction and raise a single Supplementary Invoice/Credit Memo. After the user confirms a Supplementary Transaction, that transaction can be exported to AR transactions form.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplementary transaction block</td>
<td></td>
<td>CHECK</td>
<td>Once the User confirms a Supplementary Transaction, then he can enable this check box to export that transaction to AR transactions</td>
</tr>
<tr>
<td>Raise Invoice</td>
<td>(Required)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supplementary Invoice Type</td>
<td>(Displayed)</td>
<td></td>
<td>The supplementary transactions type like 'Supplementary Invoice', 'Credit Memo' and 'Debit Memo' will be displayed here.</td>
</tr>
<tr>
<td>Invoice Number</td>
<td>(Displayed)</td>
<td></td>
<td>The Original Invoice Number will be displayed here.</td>
</tr>
<tr>
<td>Invoice Date</td>
<td>(Displayed)</td>
<td></td>
<td>The Original Invoice Date will be displayed here.</td>
</tr>
<tr>
<td>Customer Number</td>
<td>(Displayed)</td>
<td></td>
<td>Customer Number for whom the Original Invoice was raised will be displayed here.</td>
</tr>
<tr>
<td>Customer Name</td>
<td>(Displayed)</td>
<td></td>
<td>Customer Name for whom the Original Invoice was raised will be displayed here.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------</td>
<td>-------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Existing Amount</td>
<td>(Displayed)</td>
<td></td>
<td>Original Invoice Line Amount + Tax&lt;br&gt; line amount of the Original Invoice will be displayed here.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Important:</strong> The details for this Existing amount can be seen in the Existing Amount details Block.</td>
</tr>
<tr>
<td>Revised Amount</td>
<td>(Displayed)</td>
<td></td>
<td>Revised Amount + Revised Tax&lt;br&gt; amount on account of Price/Tax/Assessable Price changes will be displayed here.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Important:</strong> The details for this Revised amount can be seen in the Revised Amount details Block.</td>
</tr>
<tr>
<td>Line Difference</td>
<td>(Displayed)</td>
<td></td>
<td>Line Amount Difference on account of Price changes will only be displayed here.</td>
</tr>
<tr>
<td>Excise Difference</td>
<td>(Displayed)</td>
<td></td>
<td>Excise amount Difference on account of Price/Tax/Assessable Price changes will only be displayed here.</td>
</tr>
<tr>
<td>Other Tax Difference</td>
<td>(Displayed)</td>
<td></td>
<td>Taxes other than Excise amount Difference on account of Price/Tax/Assessable Price changes will only be displayed here.</td>
</tr>
<tr>
<td>Suppl Inv.Status</td>
<td>(Displayed)</td>
<td></td>
<td>The Status like 'Invoice Raised' and 'Not Raised' will be displayed here.</td>
</tr>
<tr>
<td>Set of Book Name</td>
<td>(Displayed)</td>
<td></td>
<td>Set of Book Name will be displayed here.</td>
</tr>
<tr>
<td>Customer Site</td>
<td>(Displayed)</td>
<td></td>
<td>Customer Site (Bill to) will be displayed here.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------</td>
<td>--------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Functional Currency</td>
<td>(Displayed)</td>
<td></td>
<td>Functional currency for a Set of Book will be displayed here.</td>
</tr>
<tr>
<td>Organization</td>
<td>(Displayed)</td>
<td></td>
<td>Organization Name will be displayed here.</td>
</tr>
<tr>
<td>Process date</td>
<td>(Displayed)</td>
<td></td>
<td>Process date will be displayed here.</td>
</tr>
<tr>
<td>Existing amount</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Existing Net Sales</td>
<td>(Displayed)</td>
<td></td>
<td>The Original Invoice Line amount will be displayed here.</td>
</tr>
<tr>
<td>Existing Excise</td>
<td>(Displayed)</td>
<td></td>
<td>The Original Invoice Tax amount of excise type alone displayed here.</td>
</tr>
<tr>
<td>Existing other taxes</td>
<td>(Displayed)</td>
<td></td>
<td>The Original Invoice Taxes amount other than of Excise Type will be displayed here.</td>
</tr>
<tr>
<td>New amount Block</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Net Sales</td>
<td>(Displayed)</td>
<td></td>
<td>The New Invoice Line amount will be displayed here.</td>
</tr>
<tr>
<td>New Excise Amount</td>
<td>(Displayed)</td>
<td></td>
<td>The New Invoice Tax amount of excise type alone displayed here.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>New other taxes</td>
<td>(Displayed)</td>
<td></td>
<td>The New Invoice Taxes amount other than of Excise Type will be displayed here.</td>
</tr>
<tr>
<td>Select All Button</td>
<td></td>
<td></td>
<td>After verifying the Supplementary transaction, if the user wants to mark all the transaction which are to be exported to AP Invoices, then he can use this button.</td>
</tr>
<tr>
<td>Consolidate</td>
<td>CHECK BOX</td>
<td></td>
<td>If the User wants to consolidate two or more supplementary Invoices or Credit Memos, then he needs to enable consolidate check box after marking the respective transaction lines.</td>
</tr>
<tr>
<td>Export Button</td>
<td></td>
<td></td>
<td>The marked transaction will be exported into AR transaction table through this button.</td>
</tr>
<tr>
<td>Line Details button</td>
<td></td>
<td></td>
<td>Users can view the Lines details form</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header Details block</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Invoice Number</td>
<td>(Displayed)</td>
<td></td>
<td>Original Invoice Number will be displayed here.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------</td>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Supplementary Invoice Type</td>
<td>(Displayed)</td>
<td></td>
<td>The corresponding Supplementary Invoice Type will be displayed here.</td>
</tr>
<tr>
<td>Existing Amount</td>
<td>(Displayed)</td>
<td></td>
<td>Original Invoice Line Amount + Tax line amount of the Original Invoice will be displayed here.</td>
</tr>
<tr>
<td>Revised Amount</td>
<td>(Displayed)</td>
<td></td>
<td>Revised Amount + Revised Tax Amount on account of Price/Tax/Assessable Price changes will be displayed here.</td>
</tr>
<tr>
<td>Line Details block</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line No</td>
<td>(Displayed)</td>
<td></td>
<td>Line No of an Original Invoice will be displayed here.</td>
</tr>
<tr>
<td>Item</td>
<td>(Displayed)</td>
<td></td>
<td>Item in a line of original Invoice will be displayed here.</td>
</tr>
<tr>
<td>Description</td>
<td>(Displayed)</td>
<td></td>
<td>Description of an Item in a line of the original Invoice will be displayed here.</td>
</tr>
<tr>
<td>Quantity</td>
<td>(Displayed)</td>
<td></td>
<td>Number quantity of an Item in a line of the original Invoice will be displayed here.</td>
</tr>
<tr>
<td>UOM</td>
<td>(Displayed)</td>
<td></td>
<td>UOM of the above item will be displayed here.</td>
</tr>
<tr>
<td>Old Selling Price</td>
<td>(Displayed)</td>
<td></td>
<td>Existing selling price as appearing in the original Invoice will be displayed here.</td>
</tr>
<tr>
<td>New selling price</td>
<td>(Displayed)</td>
<td></td>
<td>New selling price as per the Revised Price List for an item will be displayed here.</td>
</tr>
<tr>
<td>Difference Amount</td>
<td>(Displayed)</td>
<td></td>
<td>Line Amount Difference on account of Price changes will only be displayed here.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Difference Excise</td>
<td>(Displayed)</td>
<td></td>
<td>Excise amount Difference on account of Price/Tax/Assessable Price changes will only be displayed here.</td>
</tr>
<tr>
<td>Difference other Tax</td>
<td>(Displayed)</td>
<td></td>
<td>Taxes other than Excise amount Difference on account of Price/Tax/Assessable Price changes will only be displayed here.</td>
</tr>
<tr>
<td>Tax Details button</td>
<td></td>
<td></td>
<td>User can view the Tax details for a Line by invoking the Tax Details button as well as modify the tax line amount and delete unwanted Tax lines.</td>
</tr>
<tr>
<td>Line No</td>
<td>(Displayed)</td>
<td></td>
<td>The respective Line No of the Tax screen will be displayed here.</td>
</tr>
<tr>
<td>Existing Tax</td>
<td>(Displayed)</td>
<td></td>
<td>The Existing Tax Code will be displayed here.</td>
</tr>
<tr>
<td>Existing Tax Type</td>
<td>(Displayed)</td>
<td></td>
<td>The Existing Tax type will be displayed here.</td>
</tr>
<tr>
<td>Existing Tax Rate</td>
<td>(Displayed)</td>
<td></td>
<td>The Existing Tax rate will be displayed here.</td>
</tr>
<tr>
<td>Qty Rate</td>
<td>(Displayed)</td>
<td></td>
<td>In the case UOM type of tax, Tax Rate per UOM will be displayed here.</td>
</tr>
<tr>
<td>UOM</td>
<td>(Displayed)</td>
<td></td>
<td>UOM for a Existing Tax will be displayed here.</td>
</tr>
<tr>
<td>New Tax</td>
<td>(Displayed)</td>
<td></td>
<td>The Revised (new) Tax Code will be displayed here.</td>
</tr>
<tr>
<td>New Tax Type</td>
<td>(Displayed)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The Revised Tax type will be displayed here.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Tax Rate</td>
<td>(Displayed)</td>
<td></td>
<td>The Revised Tax rate will be displayed here.</td>
</tr>
<tr>
<td>New Qty Rate</td>
<td>(Displayed)</td>
<td></td>
<td>In the case UOM type of tax, Revised Tax Rate per UOM will be displayed here.</td>
</tr>
<tr>
<td>New UOM</td>
<td>(Displayed)</td>
<td></td>
<td>UOM for a Revised Tax will be displayed here.</td>
</tr>
<tr>
<td>Existing Tax Amount</td>
<td>(Displayed)</td>
<td></td>
<td>Existing Tax amount as per the Original Invoice tax lines will be displayed here.</td>
</tr>
<tr>
<td>New Tax Amount</td>
<td>(Displayed)</td>
<td></td>
<td>Revised Tax amount as per the Revised Invoice tax line will be displayed here.</td>
</tr>
<tr>
<td>Difference Amount</td>
<td>(Displayed/Editable)</td>
<td></td>
<td>Difference amount in the Tax lines will be displayed here.</td>
</tr>
</tbody>
</table>

You can modify the Tax line only in the following manner:

- Delete a particular tax line, which you do want to charge for a specific case, or
- Update the tax amount by inserting a calculated figure in the Tax Amount column.

In addition, the user needs to save the tax screen after verifying the Tax calculation.

By using the Export Button, a user can transfer the supplementary Invoices to the AR transaction screen and needs to run the Auto Invoice Program to raise the Supplementary Invoice/Credit Memo.

Proper transaction sources needs to be defined in receivables for supplementary transactions. For set up, please refer to the post installation setups.

If you wish to consolidate two or more supplementary Invoices or Credit Memos, you must enable the consolidate checkbox after marking the respective transaction lines.

The transactions to be consolidated should have the same transaction currency; otherwise the consolidated Invoice will be incorrect.
Reports

Receivables generates these reports for India:

**Supplementary Transaction Details Report** - Lists Supplementary Invoices and Credit Memos raised or to be raised for the Original Invoice.

**Supplementary Invoice Consolidation Report** - Lists the Consolidated Supplementary Invoice raised for the period.

Duty Drawback Processing

Drawback means the rebate on duty chargeable on any imported material or excisable material used in manufacture or processing of goods that are manufactured in India and exported out of India. The duty drawback is equal to sum of

- Custom Duty paid on Imported Inputs.
- Excise Duty paid on Indigenous Inputs.

No Duty Drawback is allowed if

- The input is obtained without payment of any Custom Duty under various exemptions schemes, OR
- CENVAT credit is claimed on the indigenous inputs OR
- If there is a negative value addition to the goods i.e. the value of exported goods is less than the imported goods.

Basic Business Needs

In your Business you should be able to:

- Associate Proof of Export (POE) details for export type of Sales Invoice, Calculate Duty drawback by, identifying the lowest level components used in production of finished goods and then trace the receipt of each component and corresponding document of payment of duty.
- Ensure that an Invoice is considered only once for claim.
- Ensure that a receipt is considered only to the extent not claimed.
- Reverse the CENVAT claimed if duty drawback is to be claimed.
- Print duty drawback claim report giving Invoice wise details of input component, details of Excise/Customs Duty payment document and claim amount.

Major Features

**Maintenance of Proof of Export (POE)**

For export type of removals, you are able to associate POE details.
Maintenance of Duty Drawback claimable

You are provided with option to capture duty drawback claimable with each tax name of type 'Customs' or 'CVD'.

Submission of Duty Drawback claims

You are provided with facilities for Generation of Duty drawback claims (Automatic) this will give you choice of receipt selection method, i.e. FIFO or LIFO Generation of Duty drawback claims (Manual) in addition to choice of receipt selection this will give you choice of selection of individual Receipt.

Report to help tracking duty draw back.

Duty drawback processing will:

Ensure that an Invoice is considered only once for claim.

Ensure that a receipt is considered only to the extent not claimed.

Reverse the CENVAT claimed if duty drawback is to be claimed.

TDS Certificates Received Overview

For certain sales where Tax Deduction at Source is applicable, the customer would make provision for such deduction and issue a Certificate in Form 16A. You can use the TDS Certificates feature of Oracle Financials for India to record the details of the Certificate received and the deduction details. In addition, the user can create Credit Memo through Auto Invoice in the Interface menu by specifying Request name as Auto Invoice Master Program, Invoice source as TDS Credit Memo, From / to Customer for whom he wants to create the Credit Memo and default date. It is imperative that 'Customer Additional Information' is setup along with Transaction source & Transaction Type as specified in this document to successfully import the TDS Credit Memo. The feature is only for recording of TDS Certificates received from Customers and is not for any issue of TDS Certificates to Customers for deducting TDS against Discounts/Schemes/Credit Memo etc.

The TDS Certificates feature lets you track the TDS Certificates received from the customer. You can:

- Record details of TDS Certificates received
- Generate Credit Memos based on the Certificate information. This would reflect the appropriate Customer balance.

In Oracle Financials for India, navigate to India Local Receivables > India Localization > Collections > TDS Certificates.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Name</td>
<td>(Required)</td>
<td>EDIT</td>
<td>HELP  The used needs to select Customer Name from the LOV. Only those Customers who have Localization setup are shown here.</td>
</tr>
<tr>
<td>Customer Number</td>
<td>(Defaulted)</td>
<td></td>
<td>This will be a default value or the user can select from LOV. Only those Customers who have Localization setup are shown here.</td>
</tr>
<tr>
<td>Location</td>
<td>(Required)</td>
<td>EDIT</td>
<td>HELP  The user needs to specify the Location of the customer from LOV. Only those Customer Locations having Invoices are shown here.</td>
</tr>
<tr>
<td>Memo Line</td>
<td>(Optional)</td>
<td>EDIT</td>
<td>PICK  The user needs to specify the Memo line from LOV which help in determination of Accounting segments when auto accounting is used.</td>
</tr>
<tr>
<td>Name</td>
<td>Required</td>
<td>EDIT</td>
<td>TDS Certificate Name can be entered in this field</td>
</tr>
<tr>
<td>Number</td>
<td>Required</td>
<td>EDIT</td>
<td>TDS Certificate Number can be entered for recording TDS Certificate number</td>
</tr>
<tr>
<td>Certificate Date</td>
<td>Required</td>
<td>EDIT</td>
<td>PICK  The TDS Certificate Date is to be entered here</td>
</tr>
<tr>
<td>Received Date</td>
<td>Required</td>
<td>EDIT</td>
<td>PICK  The Date of receipt of TDS Certificate is to be entered here</td>
</tr>
<tr>
<td>Amount</td>
<td>Required</td>
<td>EDIT</td>
<td>TDS Certificate Amount that has been received</td>
</tr>
<tr>
<td>Description</td>
<td>Required</td>
<td>EDIT</td>
<td>TDS Certificate Description / user enterable details against this TDS Certificate.</td>
</tr>
</tbody>
</table>
Reports

Receivables generates this report for India:

**India - Receivable Tracking Report** - This report lists the certificates received from the customers and its corresponding details.

Setting Up Concurrent Programs

- India - Local Concurrent for processing order lines to AR
- India - Importing Excise Invoice Numbers to AR
- India - ST Forms Receipt Processing
- India - Program to Generate eTCS Quarterly Returns
- India - Program to Generate eTCS Annual Returns

**India - Local Concurrent for processing order lines to AR**

The India - Local Concurrent for processing order lines to AR program handles localization tax flow from Order Management to Receivables. This program captures localization taxes in Shipments and inserts Tax lines in AR Invoices and Credit Memos imported from Order Management. You have to schedule the concurrent to submit the request at suitable intervals. Please make it mandatory to Schedule this concurrent program.

The concurrent 'AR Tax and Freight Defaultation' would automatically run to Insert Tax lines in AR Invoices created manually.

India Local Receivables - Reports - Other - Submit Requests - Select 'India Local Concurrent For Processing Order Lines to AR' - Schedule

**Important:** You can schedule this concurrent either for the current Operating Unit or for all Operating Units. In order to run this for all Operating Units, enter 'Yes' in 'Process for All Operating Units' parameter.

If the Concurrent is being run / scheduled for all Operating Units, the Parameter for Process for All Organizations has to be set as "No" else it will result in data inconsistency.

This Request will not process Records that are revenue recognized / GL Posted and hence it is imperative that this Request be run prior to revenue recognition & GL Posting. Any errors should be cleared prior to GL Posting.
Setting Incompatibilities

- This program should be set incompatible to
- Auto Invoice Import
- Itself

The invoice number is inserted for imported invoices for transactions only after running the India-local concurrent for processing order lines to AR.

**India - Importing Excise Invoice Numbers to AR**

From ONT Patchset 'H', when interface trip stop happens, first Order Management Interface occurs and then the Inventory Interface occurs. This is reverse to what was happening prior to ONT patchset 'H'.

Due to this reason when shipment is done, interface trip stop gets executed and in case the inventory interface goes into warning due to reasons unknown, the delivery id of the shipment does not feature in the excise Invoice generation programs parameter.

As the Order Management interface is completed, this order is interfaced to AR and an AR Invoice is created.

When Excise Invoice number generation happens after the AR Invoice is created, localization AR tables do not have Excise Invoice number imported from Localization Shipping Tables. In short, Excise Invoice Number present in fulfilled orders localized screen is not imported to AR localization tables.

This program is encapsulated as a stored procedure and takes the Start Date, End Date and Invoice number as the parameter. This parameter shows a list of all Invoice numbers where Excise Invoice number is generated in shipment but is not present in the AR tables.

The concurrent program can be invoked by submitting a single request from the Other Reports request group in India Local Receivables Responsibility. You can also schedule this concurrent request in case these issues are frequent in your instance.

**India - ST Forms Receipt Processing**

Submitting 'India - ST Forms Receipt Processing' concurrent program would generate Invoice details required for Receiving Sales Tax Forms.

This concurrent program is available in India Local Receivables Responsibility. This request would check for all Invoices that have Sales Tax with concessional Form applicability. Only validated Invoices would be considered for processing. The Invoice would be considered for Processing only if it was not processed earlier. Processed Invoices would be considered conditionally based on the changes to the document. This concurrent is for processing data and does not result in any printable output.
You can submit this request from:

India Local Receivables - Reports - Other Reports - 'India - ST Forms Receipt processing'

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating Unit</td>
<td>(Display Only)</td>
<td>Value</td>
<td>Value determined from the Profile values</td>
</tr>
<tr>
<td>From Date</td>
<td>Mandatory</td>
<td>Low Value</td>
<td>Low Value of Invoice Date to filter the Invoices</td>
</tr>
<tr>
<td>To Date</td>
<td>Mandatory</td>
<td>High Value</td>
<td>High Value of Invoice Date to filter the Invoices</td>
</tr>
<tr>
<td>Process for All</td>
<td></td>
<td>All</td>
<td>If you select 'Yes' in this field, then, the program would process Invoices</td>
</tr>
<tr>
<td>Operating Units?</td>
<td></td>
<td>All</td>
<td>corresponding to all Operating Units defined in the system. Else, only those</td>
</tr>
<tr>
<td></td>
<td></td>
<td>All</td>
<td>related to the Operating Unit determined from Profile would be processed.</td>
</tr>
<tr>
<td>Customer</td>
<td></td>
<td>This</td>
<td>This will be used to filter the data related to given Customer, otherwise</td>
</tr>
<tr>
<td></td>
<td></td>
<td>will</td>
<td>all Customer's related data is processed.</td>
</tr>
<tr>
<td>Customer Site</td>
<td></td>
<td>This</td>
<td>This will be used to filter the data related to given Customer site, otherwise</td>
</tr>
<tr>
<td></td>
<td></td>
<td>related</td>
<td>all Customer Site's related data is processed.</td>
</tr>
<tr>
<td>Enable Trace</td>
<td></td>
<td>On selecting</td>
<td>On selecting 'Yes' in this field, a Raw Trace File would be generated for this</td>
</tr>
<tr>
<td></td>
<td></td>
<td>'Yes' in the</td>
<td>this request.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>request.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>It is a prerequisite to have 'Enable Trace' checked for 'India - ST Forms Issue</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Processing'</td>
<td>Processing' Concurrent Program.</td>
</tr>
</tbody>
</table>

**India - Program to Generate eTCS Quarterly Returns**

Use the Submit Requests from India Local Receivables and enter India - Program to Generate eTCS Quarterly Returns in the Name field to submit the concurrent request.

**Concurrent Parameters**
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legal Entity</td>
<td>Required</td>
<td>PICK</td>
<td>The Legal Entity for which the report is being generated.</td>
</tr>
<tr>
<td>Org TAN Number</td>
<td>Required</td>
<td>PICK</td>
<td>The Organization TAN Number for which the report is being generated.</td>
</tr>
<tr>
<td>Organization</td>
<td>Required</td>
<td>PICK</td>
<td>The Inventory Organization for which the report is being generated.</td>
</tr>
<tr>
<td>Financial Year</td>
<td>Required</td>
<td>PICK</td>
<td>The Financial year for which the report is being generated.</td>
</tr>
<tr>
<td>Quarter of the Fiscal Year</td>
<td>Required</td>
<td>PICK</td>
<td>The Quarter of the Fiscal year for which the report is being generated.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Collection Code</td>
<td>Required</td>
<td>PICK</td>
<td>The Collection code for which the report is being generated. This can be any of the following values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Alcoholic liquor for human consumption</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Timber obtained under a forest lease</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Timber obtained under any mode other than forest lease</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Any other forest product not being timber or tendu leave</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Scrap</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Parking Lot</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Toll Plaza</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Mining and Quarrying</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Tendu Leaves</td>
</tr>
<tr>
<td>Tax Authority</td>
<td>Required</td>
<td>PICK</td>
<td>The Tax authority for which the report is being generated.</td>
</tr>
<tr>
<td>Tax Authority Site</td>
<td>Optional</td>
<td>PICK</td>
<td>The Tax authority site for which the report is being generated.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Seller Name</td>
<td>Required</td>
<td></td>
<td>The Seller Name that needs to appear on the report.</td>
</tr>
<tr>
<td>Seller State</td>
<td>Required</td>
<td>PICK</td>
<td>The Seller State that needs to appear on the report.</td>
</tr>
<tr>
<td>Address Changed since Last Return?</td>
<td>Required</td>
<td>PICK</td>
<td>Enter 'Yes' or 'No' to the question of 'Address Changed since last return'.</td>
</tr>
<tr>
<td>Collector Status</td>
<td>Required</td>
<td>PICK</td>
<td>The Collector Status of 'Central Government' or 'Others' that needs to appear on the report.</td>
</tr>
<tr>
<td>Person Responsible for Collection</td>
<td>Required</td>
<td></td>
<td>The Name of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Designation of Person Responsible</td>
<td>Required</td>
<td></td>
<td>The Designation of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Address of the Person Responsible</td>
<td>Required</td>
<td></td>
<td>The Address of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>State of the Person Responsible</td>
<td>Required</td>
<td></td>
<td>The State of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>PIN of the Person Responsible</td>
<td>Required</td>
<td></td>
<td>The PIN Code (Postal Code) of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>------------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Responsible Person’s Address Changed</td>
<td>Required</td>
<td></td>
<td>Enter ‘Yes’ or ‘No’ to the question of ‘Responsible Person’s address changed since last return’.</td>
</tr>
<tr>
<td>since Last Return?</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start Date</td>
<td>Optional</td>
<td></td>
<td>The start date from which this report needs to be printed. This date should pertain to the same quarter as entered in earlier parameter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>End Date</td>
<td>Optional</td>
<td></td>
<td>The end date till which this report needs to be printed. This date should pertain to the same quarter as entered in earlier parameter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Provisional Receipt Number</td>
<td>Optional</td>
<td>PICK</td>
<td>The Provisional Receipt Number in case the return has been filed earlier.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Path</td>
<td>Required</td>
<td>PICK</td>
<td>The file Path where the Flat file needs to be located. Ensure that write permission exists for the given file path.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Name</td>
<td>Required</td>
<td>PICK</td>
<td>The name of the Flat file that is generated.</td>
</tr>
</tbody>
</table>
### India Local Receivables

**5-49**

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Event</td>
<td>Required</td>
<td>PICK</td>
<td>The Concurrent can be run with any one of the following three parameters:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• F – Generate the Flat File</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• H - Generate the Flat File with Headers</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• V – Validate the Data</td>
</tr>
</tbody>
</table>

This concurrent will not generate a report output but would generate a flat file at your specified location, which can be used to file eTCS Quarterly returns.

**India - Program to Generate eTCS Yearly Returns**

Use the Submit Requests from India Local Receivables and enter India - Program to Generate eTCS Yearly Returns in the Name field to submit the concurrent request.

**Concurrent Parameters**

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legal Entity</td>
<td>Required</td>
<td>PICK</td>
<td>The Legal Entity for which the report is being generated.</td>
</tr>
<tr>
<td>Org TAN Number</td>
<td>Required</td>
<td>PICK</td>
<td>The Organization TAN Number for which the report is being generated.</td>
</tr>
<tr>
<td>Organization</td>
<td>Required</td>
<td>PICK</td>
<td>The Inventory Organization for which the report is being generated.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Financial Year</td>
<td>Required</td>
<td>PICK</td>
<td>The Financial year for which the report is being generated.</td>
</tr>
</tbody>
</table>
| Collection Code   | Required     | PICK    | The Collection code for which the report is being generated. This can be any of the following values:  
|                   |              |         |  
|                   |              |         | • Alcoholic liquor for human consumption  
|                   |              |         | • Timber obtained under a forest lease  
|                   |              |         | • Timber obtained under any mode other than forest lease  
|                   |              |         | • Any other forest product not being timber or tendu leave  
|                   |              |         | • Scrap  
|                   |              |         | • Parking Lot  
|                   |              |         | • Toll Plaza  
|                   |              |         | • Mining and Quarrying  
|                   |              |         | • Tendu Leaves  
<p>| Tax Authority     | Required     | PICK    | The Tax authority for which the report is being generated. |</p>
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Authority Site</td>
<td>Optional</td>
<td>PICK</td>
<td>The Tax authority site for which the report is being generated.</td>
</tr>
<tr>
<td>Seller Name</td>
<td>Required</td>
<td></td>
<td>The Seller Name that needs to appear on the report.</td>
</tr>
<tr>
<td>Seller State</td>
<td>Required</td>
<td>PICK</td>
<td>The Seller State that needs to appear on the report.</td>
</tr>
<tr>
<td>Address Changed since Last Return?</td>
<td>Required</td>
<td>PICK</td>
<td>Enter 'Yes' or 'No' to the question of 'Address Changed since last return'.</td>
</tr>
<tr>
<td>Collector Status</td>
<td>Required</td>
<td>PICK</td>
<td>The Collector Status of 'Central Government' or 'Others' that needs to appear on the report.</td>
</tr>
<tr>
<td>Person Responsible for Collection</td>
<td>Required</td>
<td></td>
<td>The Name of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Designation of Person Responsible</td>
<td>Required</td>
<td></td>
<td>The Designation of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Address of the Person Responsible</td>
<td>Required</td>
<td></td>
<td>The Address of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>State of the Person Responsible</td>
<td>Required</td>
<td></td>
<td>The State of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-----------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PIN of the Person Responsible</td>
<td>Required</td>
<td></td>
<td>The PIN Code (Postal Code) of Person responsible which needs to be printed</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>on the report.</td>
</tr>
<tr>
<td>Responsible Person’s Address Changed</td>
<td>Required</td>
<td></td>
<td>Enter ‘Yes’ or ‘No’ to the question of ‘Responsible Person’s address changed</td>
</tr>
<tr>
<td>since Last Return ?</td>
<td></td>
<td></td>
<td>since last return’.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Optional</td>
<td></td>
<td>The start date from which this report needs to be printed. This date should</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>pertain to the same quarter as entered in earlier parameter.</td>
</tr>
<tr>
<td>End Date</td>
<td>Optional</td>
<td></td>
<td>The end date till which this report needs to be printed. This date should</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>pertain to the same quarter as entered in earlier parameter.</td>
</tr>
<tr>
<td>Provisional Receipt Number</td>
<td>Optional</td>
<td>PICK</td>
<td>The Provisional Receipt Number in case the return has been filed earlier.</td>
</tr>
<tr>
<td>File Path</td>
<td>Required</td>
<td>PICK</td>
<td>The file Path where the Flat file needs to be located. Ensure that write</td>
</tr>
<tr>
<td>File Name</td>
<td>Required</td>
<td>PICK</td>
<td>permission exists for the given file path.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The name of the Flat file that is generated.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Generate Headers</td>
<td>Required</td>
<td>PICK</td>
<td>The Concurrent can be run with any one of the following two parameters:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- No – Generate the Flat File</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Yes - Generate the Flat File with Headers</td>
</tr>
</tbody>
</table>

This concurrent will not generate a report output but will generate a flat file at your specified location, which can be used to file eTCS Annual returns.

**Managing Receivables Transactions**

This Section elaborates Transaction cycles in India Localization Accounts Receivables Module. This section gives further details on using Transactions (Localized), AR-3A Form Tracking, Supplementary Invoices and TDS Certificates Received.

**Transactions (Localized)**

Transactions with localized taxes can be created in the Receivables Module. The taxes will get calculated for the item based on the tax defaulting set ups or taxes can be added to the transactions manually.

Transactions in AR with can be created through the Auto Invoicing where the transactions done in Order Management Module will get interfaced to the Receivables Module. The taxes from the Order Management Module will be interfaced to AR while running the Auto Invoice Program.

The other option is to create stand-alone AR transactions in AR with localization taxes. Based on the tax defaulting set up the localization taxes and freight will get calculated for the transaction. Based on the set up in Bond Register, Excise transactions will get recorded in the respective Excise Records and Excise Invoices can be created. User needs to select appropriate transaction sources which are associated with bond register for updating the excise related registers and records. If the user selects a transaction source that is not associated with the Bond Register no updates will be done in the Excise Registers and no Excise Invoice will get generated for the transaction.

**Important:** If a transaction is created with Excise Duty and completed
by clicking the complete button, user should not un apply the transactions. If the user un applies the transaction, the excise taxes debited in the Excise Registers will not be reversed and this might lead to further complications in adhering to the Excise Rules and Procedures.

Also note that base applications recalculates taxes on the event of Incompletion and Completion. Thus localization taxes would be replaced with ZERO if user Incompletes and Completes an already Completed Invoice. The Incompletion feature should not be used for making corrections to Invoice imported from Order Management else the taxes would get replaced with zero in the base applications screen.

In India Localization, navigate to the Enter Transactions window as follows:

India Local Receivable > India Localization > Transactions > Transactions (Localized)

The User can navigate through the Select Receipts button to perform the Matching of Receipts quantity. Once the user saves the Matching Screen, Excise Tax Amount will be replaced by the Excise Amount from the Receipt Tax Line for the proportionate quantity.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating Unit</td>
<td>(Required)</td>
<td>(Pick)</td>
<td>The Operating Unit for which the Transaction is being entered.</td>
</tr>
<tr>
<td>Organization</td>
<td>(Required)</td>
<td>EDIT</td>
<td>HELP PICK</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The user needs to specify the Inventory Organization name from LOV in which the transactions is going to be accounted</td>
</tr>
<tr>
<td>Location</td>
<td>(Required)</td>
<td>EDIT</td>
<td>HELP PICK</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The user needs to specify the Location of an Inventory Organization from LOV in which the transaction is going to be accounted</td>
</tr>
</tbody>
</table>

After entering the above information the user can navigate to Enter Invoice Standard Apps form where the transaction Number, Customer details and Item details will be entered to create a transaction, save and complete the Standard Apps transaction. Depending upon the Tax category attached to the item for the customer, the tax lines will be defaulted.

**Important:** If the user enters a Transaction using Transactions screen directly without navigating through Transactions (Localized) screen,
the above Organization & Location are not captured for the mentioned transaction. This would result in such transaction not being query enabled on the Transactions (Localized) Screen even at a latter date.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Name</td>
<td>(Defaulted)</td>
<td></td>
<td>The Customer name will be defaulted here after the Transaction has been entered in Standard Applications form.</td>
</tr>
<tr>
<td>Customer Number</td>
<td>(Defaulted)</td>
<td></td>
<td>This will be the defaulted Customer Number.</td>
</tr>
<tr>
<td>Transaction Number</td>
<td>(Displayed)</td>
<td></td>
<td>The Transaction number will be displayed here once the user has entered and saved the data in the Standard Apps Form.</td>
</tr>
<tr>
<td>Transaction Type</td>
<td>(Displayed)</td>
<td></td>
<td>This will be displayed depending upon the transaction type selected in the Standard Apps Form.</td>
</tr>
<tr>
<td>Source</td>
<td>(Displayed)</td>
<td></td>
<td>This will be displayed depending upon the source selected in the Standard Apps Form.</td>
</tr>
<tr>
<td>Excise Exemption Type</td>
<td>(Required/Optional)</td>
<td></td>
<td>If the user needs to carry out an exempted transaction, the exemption type needs to be selected from this field. For transactions on payment of duty, this field needs to be left as null. Whenever the user picks for an Excise Exempted Transaction the user needs to enable the excise exempted flag in the line level.</td>
</tr>
<tr>
<td>Excise Exemption date</td>
<td>(Required/Optional)</td>
<td></td>
<td>The user needs to enter date CT2 form, CT3 form, Excise Exemption Certificate respectively.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Excise Exemption Ref. No.</td>
<td>(Required/Optional)</td>
<td></td>
<td>The user can enter CT2 Form No., CT3 Form No., Excise Exemption Certificate Number based on the above Exemption type he selected.</td>
</tr>
</tbody>
</table>
| VAT Exemption Type         | (Optional)          |        | If you need to carry out an VAT Exempted Transaction, the exemption type needs to be picked up in this field. For transactions where VAT is payable, this field need to be left as null. Whenever you pick for an VAT Exempted Transaction, all the lines get the VAT Exempted Flag and the VAT Exemption type defaulted. If for any line, VAT exemption is not applicable, then you can uncheck the VAT exemption for such line. The VAT Exemption types are:  
  Vat Exemption Item  
  Export  
  Inter State Sale  
  Sale to Specified parties  
  Transfer |
| VAT Exemption Date         | (Required/Optional) |        | This field is required when VAT Exemption Type is selected.                                                                                    |
| VAT Exemption Refno        | (Required/Optional) |        | This field is required when VAT Exemption Type is selected.                                                                                    |
| Tax Amount Block           |                     |        |                                                                                                                                             |
| Tax Total                  | (Displayed)         |        | Tax amount of the Standard Apps Form will be displayed here.                                                                                   |
| Line Total                 | (Displayed)         |        | Total amount of the transaction including tax for a line will be displayed here.                                                               |
| Transaction Total          | (Displayed)         |        | The total transaction amount will be displayed here.                                                                                         |
### Field Description

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update RG Flag</td>
<td>(Displayed)</td>
<td></td>
<td>This will be enabled only when the transaction batch source is having an association with any of the Four Register Types being Bond Register (For Exports), Domestic with Excise, Domestic without Excise, Export with Excise for that Organization and Location. The user can update the flag when the check box is checked to make it unchecked. The vice versa is not possible.</td>
</tr>
<tr>
<td>Important:</td>
<td></td>
<td></td>
<td>By default, the duty will get debited in the register based on the register preference set up in the Additional Supplier Information. User has an option to change the duty paying register for each transaction.</td>
</tr>
<tr>
<td>Line block</td>
<td>(Conditionally Required)</td>
<td></td>
<td>In the case of CT2 and CT3 Transaction, Form AR3A needs to be accompanied with the shipment, then the User needs to specify the AR3A form Number in this field. AR3A form tracking will be done for Customer wise which will be useful to the User to follow up the outstanding AR3A form from his Customer in order to submit to the Excise Dept.</td>
</tr>
<tr>
<td>Line Number</td>
<td>(Displayed)</td>
<td></td>
<td>The line number is displayed here.</td>
</tr>
<tr>
<td>AR 3 A form Date</td>
<td>(Conditionally Required)</td>
<td></td>
<td>AR3A form date needs to be entered here by the User.</td>
</tr>
<tr>
<td>Exempted Flag</td>
<td>(Conditionally Required)</td>
<td>CHECK BOX</td>
<td>The user needs to enable this Flag to do a transaction under any of the above exempted type for a line item.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------</td>
<td>------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VAT Exemption Flag</td>
<td>CHECK BOX</td>
<td>Once at header level a Invoice is marked as VAT Exempt, this check box will get checked. If any particular line is not supposed to be VAT Exempt, the box should be unchecked.</td>
<td></td>
</tr>
</tbody>
</table>
| VAT Exemption Type (Optional) | | If you need to carry out an VAT Exempted Transaction, the exemption type needs to be picked up in this field. For transactions where VAT is payable, this field need to be left as null. Whenever you pick for an VAT Exempted Transaction, all the lines get the VAT exempted flag and the VAT Exemption type defaulted. If for any line, VAT Exemption is not applicable, then you can uncheck the VAT exemption for such line. The VAT exemption types are:  
  - Vat Exemption item  
  - Export  
  - Inter State Sale  
  - Sale to Specified parties  
  - Transfer |
| VAT Exemption Date (Required/Optional) | | This field is required when VAT Exemption Type is selected. |
| VAT Exemption Refno (Required/Optional) | | This field is required when VAT Exemption Type is selected. |
| [] | Optional EDIT | Enter line-specific additional detail and Save. |

The following buttons are available in the Enter Transaction India Localization form and their features.
<table>
<thead>
<tr>
<th>Button name</th>
<th>Description</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Button</td>
<td>For creating transactions in stand alone AR with localization taxes, user needs to navigates to the Standard Application transaction screen only through the Transaction - Localized Screen. Before opening the Standard Application Transaction Screen, user needs to specify the Organization and Location in the Localization Screen.</td>
<td>The user can open Standard Apps Transaction form through this button.</td>
</tr>
<tr>
<td>Select Register</td>
<td>User needs to open the select register button only if he needs to change the Duty Paying Registers, which are being defaulted.</td>
<td>The user can select Excise Register, which is to be for a transaction. The Register will be defaulted as per the preference set in Organization Additional Information but the user is empowered to change the Register by using this button. Such change can only be made if It is a inventory item and the balance in register is sufficient to cover the Excise Duty Payment</td>
</tr>
<tr>
<td>Taxes</td>
<td>User needs to verify the taxes that are being defaulted based on the tax defaulting set ups. He can modify the taxes if required. This can be done by clicking the taxes button.</td>
<td>The user can view tax lines and modify the tax lines for a transaction.</td>
</tr>
</tbody>
</table>

After entering the above information, the user can navigate to Enter Invoice Standard Apps form through that the Transaction Number, Customer details and Item details will be entered. Save and Complete the Standard Apps form and depending upon the Tax Category attached to the Item for a Customers, the tax lines will be defaulted.

If the Tax lines has Excise Type of Tax then the System by itself will default the Excise Record to be used for the transaction depending upon the Order of Reference defined for Excise Record in the Organization Accounts Information. However, the user can change the Register and Excise Invoice Number will be allotted once the transaction is completed in the Enter Transaction India Localization Form. After Save and Close the above Standard Apps Form.
If the ‘Taxes’ Button is clicked for a once completed Transaction, System will show the following message:

It is imperative that Taxes are available on the Invoice prior to completion. Hence On trying to complete a Invoice when the concurrent ‘AR Tax and Freight Defaultation’ is running, System will show the following message:

In the above case, you need to allow the concurrent to complete, query the Invoice and then complete.

On similar lines, it is required that the Localization taxes get processed prior to GL Posting. Hence if you try to Post a record to GL when the Taxes for the same are not yet processed, GL Posting will result in the following error:

‘AR-ARGLTP: -20131 ORA-20131: India Taxes found in ja_in_temp_lines_insert table. ”

This is as per intended behavior of the product to stop you from GL Posting AR Transactions where India Localization Tax processing is pending. The above error is applicable for both Manually entered transactions as well as Imported transactions from Order Management. You can find details of such transaction by running the following query for the month where you are trying to GL Post:

Select * from ja_in_temp_lines_insert;

\[Note: You can view the GL Drilldown Accounting entries by clicking Show Transactions on the Tools Menu in Enter Transaction India Localization form.\]

**Reprocessing Errored OM Tax Records**

The concurrent ‘India Local Concurrent for processing Tax Lines to AR’ for processing of Tax Lines for Invoices created through Order Management runs in batch mode. Whenever, some of the Tax Lines remain unprocessed due to some error, the error message is captured by localization. This feature provides with an option to view these error records and corresponding messages and mark them eligible for Reprocess. You would also have an option to delete these records.

To view the error records, navigate to

India Local Receivables - Control - India - Resubmit AR Tax and Freight

The form shows Invoice Number, Number of distribution Lines, Customer Id, Customer Name, Total Tax Amount, Last Updated Date and Error Message for all Tax Lines (grouped by Invoice Number) that have ended in an error during ‘India Local Concurrent for processing Tax lines to AR’ program.

The user can check the records for resubmitting only one at a time

**For Resubmission of the Error Invoices**

Check ‘Re-Submit’ for the Invoices that need to be resubmitted Click on ‘Submit’ button.
Submit the concurrent 'India Local Concurrent for processing Tax lines to AR' for these Invoices to get processed.

For Deletion of the Error Invoices

Check 'Delete' for the Invoices that need to be deleted.

Click on Submit button.

The above delete option is mainly useful in cases where the Debit Memo for Taxes has already been raised for the Tax Amount & the Tax Line is no longer required to be processed. This marks the line as deleted & does not show the record next time as eligible for reprocessing.

**Important:** The form would merely show / display the Invoices eligible for reprocessing. You have to explicitly run the concurrent 'India Local Concurrent for processing Tax lines to AR' for these Invoices to get processed.

**Caution:** It is advisable to check this Form Prior to Running GL Posting and clear all the records from this Form. Base Applications Revenue Recognition Program does not post a tax line if it does not have a revenue attached and hence if resubmission option is used for a record post GL Posting then such record remains as an unposted tax line & interferes with period closing. In case of such event happening, the only option is to mark such tax line as posted with a data fix & pass manual entries for the tax amount in GL.

Resubmission of a record post GL Posting will not result in processing of the record & will remain stuck in the form. The only option post GL posting is to delete the record using this Form & pass manual Debit Memo for the tax portion to rectify the receivable amount.

With the current architecture, GL Posting is stopped for a transaction if the taxes are found to be stuck in the above form. GL Posting would show the following error:

"AR-ARGLTP: -20131 ORA-20131: India Taxes found in ja_in_temp_lines_insert table. "

You need to either get the taxes processed or deleted (post necessary correction of receivable amount) prior to GL Posting such stuck records.

**Using Sales Tax Declaration Forms - Receipt Tracking**

Sales by Registered Dealers, to Registered Dealer would be eligible for Concessional Rate of Sales Tax. This would require identification of transactions that are eligible for such rates. Also, the Declaration Form to be issued by the Buyer in order to avail such rate.

You can record details of Sales Tax declaration forms for each of the Sales Invoice. India
Localization provides you with a feature to define Form Names, Define Taxes with Declaration Forms attached, Tracking Invoices for which these Forms have to be received, Record details of Forms received and query and view the Received Form details.

**Prerequisites**

Before creating the Transactions with Concessional Rates of Sales Tax, following setups need to be done:

- Define Form Names
- Define Taxes with Form Names attached
- Define Customer Additional Information
- Define Tax Categories with this Tax Code
- Define Item Categories with this Tax Categories

Before you record details of Concessional Forms to be issued to Supplier, following need to be done:

- Complete Shipment with Sales Taxes with Form Names attached
- Create AR Transactions for these Orders
- Ensure that Transaction lines are created to account for Localization Taxes.
- Complete the Invoice.
- Submit 'India - ST Forms Receipt Processing'

**Recording details of Sales Tax Declaration Forms:**

To record details of Sales Tax Declaration forms, navigate to 'Define Sales Tax Form Details' window as follows

India Local Receivables - Customers - Receipt ST Forms

In 'Find ST Form Details' screen, enter the Customer Name, Customer Site and Form Type in order to query for Invoices against which Forms are not yet received. You can enter other query criteria to find specific Invoice.

Details to enter in each of the fields would form criteria for the records fetched.

You can fetch specific records based on the values entered in the query criteria.

The field wise description for the screen "Find Sales Tax Form Details" to receive the ST Forms is given below
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find ST form Details</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Issue/Receipt</td>
<td>(Display only)</td>
<td></td>
<td>This field gets populated as Issue / Receipt based upon the Responsibility Selected. Issue in case of Payables and Receipt in case of Receivables.</td>
</tr>
<tr>
<td>Party Name</td>
<td></td>
<td></td>
<td>Party Name as defined in the ST form related data. Compared against the Party Name as available in the Invoices to which Sales Tax Forms is applicable.</td>
</tr>
<tr>
<td>Party Site</td>
<td></td>
<td></td>
<td>Party Site as available in the Invoices to which Sales Tax Forms is applicable.</td>
</tr>
<tr>
<td>Form Type</td>
<td></td>
<td></td>
<td>Form Type's which are applicable to the Sales Tax attached to the Invoices.</td>
</tr>
<tr>
<td>Invoice from Date</td>
<td></td>
<td></td>
<td>Invoices having Invoice Date starting from this date onwards would form a part of the query criteria for matching. Viewing matched records. Should be a valid date in 'DD-MON-YYYY' format</td>
</tr>
<tr>
<td>Invoice To Date</td>
<td></td>
<td></td>
<td>Invoices having Invoice Date till this date would form a part of the query criteria for matching. Viewing matched records. Should be a valid date in 'DD-MON-YYYY' format</td>
</tr>
<tr>
<td>Fin Year</td>
<td></td>
<td></td>
<td>Fin year as applicable to the ST Form related data for querying already entered Forms.</td>
</tr>
<tr>
<td>Form Number</td>
<td></td>
<td></td>
<td>Form Numbers that are issued to the Supplier, Supplier Site and Form Type that was earlier entered in system.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------</td>
<td>-------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Issue/Receipt Date</td>
<td></td>
<td></td>
<td>Enter a Date, which might match with the Receipt Form’s Transaction Date.</td>
</tr>
<tr>
<td>View Forms Button</td>
<td></td>
<td>Button, which upon being clicked</td>
<td>Button, which upon being clicked invokes the 'View Sales Tax form Details' Screen</td>
</tr>
<tr>
<td>Issue/Receive Forms</td>
<td></td>
<td>Button, which upon being clicked</td>
<td>Button, which upon being clicked invokes the 'Define Sales Tax form Details' Screen</td>
</tr>
</tbody>
</table>

Based on the query criteria, the system fetches the Invoices to be matched. This information would be displayed in ‘Define Sales Tax Forms Details’ screen.

The find window serves the dual purpose of entry of new forms by querying of Transactions where form entry is pending and the purpose of querying already entered forms to check details.

This screen has Header and Detail sections

**Header Section**

This section allows you to create form detail like Fin year, Form Number Form Amount, Form Date and Transaction date. These details can be entered for a combination of Customer Name, Customer Site, Form Type and Operating Unit.

The Customer Name, Customer Site and Form Type are populated as the context information from the Query Find Screen.

It’s mandatory to enter Fin Year, Form Number Form Date and Transaction date fields before proceed to the detail section to select Invoices.

You may choose to key in the Form Amount and proceed to the detail section for selecting Invoices to match the Form Amount. Else, you can leave the form amount to be automatically populated upon save, based on the sum of all Invoice level Form Amounts.

**Match All**

On checking Match All field, the system automates matching based on the header form amount.

To use this feature, it would be a pre-requisite to enter Fin Year, Form Number, Form Amount, and Form Date and Transaction Date fields.

The Match all Checkbox is unchecked, by default.

Un-checking the checkbox causes the detailed Invoice level form amount to be set to zero.
Queried Amount

Queried Form Amount fields displays the total Form Amount that can be matched across all unmatched Invoices.

This is a display only field and cannot be modified.

Detail Section

This section displays unmatched Invoices in Receipt Tab Page. The records would be grouped based on the combination of Invoice and Transaction Id.

The sum of all Invoices level Form Amounts entered is displayed at the bottom in the Total Form Amount display field.

**Important:** It is mandatory that the sum of detail level Invoice Form Amounts match with header Form Amount. This is applicable only when you enter the Form Amount.

In case of Invoices with negative tax target amounts the form amount entered should exactly be equal to that of the Tax target amount.

The amount to be tracked (Tax Target amount) reflects the base amount on which Sales Tax is calculated and does not include the sales tax amount. Viz., the amount will be net of sales tax amount and not the Invoice value.

On saving the entered details, the Header Block is refreshed and the Form details are set to blank. Also, the Detail block is refreshed and only unmatched and partially matched records are fetched. The cursor returns to the header.

Issued Forms can be viewed through the 'View Sales Tax Form Detail' Screen

The field wise description for the screen 'View Sales Tax Form Detail' to receive the ST Forms is given below

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define Tax Form</td>
<td>Sales</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Header Block</td>
<td>Form</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Matching Header)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Party Name</td>
<td>(Display only)</td>
<td></td>
<td>Context Information carried over from Query Find Screen</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Party Site</td>
<td>(Display only)</td>
<td></td>
<td>Context Information carried over from Query Find Screen</td>
</tr>
<tr>
<td>Form Type</td>
<td>(Display only)</td>
<td></td>
<td>Context Information carried over from Query Find Screen</td>
</tr>
<tr>
<td>Fin Year</td>
<td>Required</td>
<td></td>
<td>User defined Fin Year Value to be selected from list of values as defined in the Tax Year Setup</td>
</tr>
<tr>
<td>Form Number</td>
<td>Required</td>
<td></td>
<td>Sales Tax Form Number to be defined by the user. This needs to be unique for a Party Name , Party Site, Org ID, Form Type , Party Type and Fin year combination</td>
</tr>
<tr>
<td>Form Amount</td>
<td></td>
<td></td>
<td>The form Amount needs to exactly match with the sum of all Invoice level detailed form amounts.</td>
</tr>
<tr>
<td>Form Date</td>
<td>Required</td>
<td></td>
<td>Should be a valid date in 'DD-MON-YYYY' format</td>
</tr>
<tr>
<td>Transaction Date</td>
<td>Required</td>
<td></td>
<td>Should be a valid date in 'DD-MON-YYYY' format</td>
</tr>
<tr>
<td>Match All</td>
<td>Default Value 'N'</td>
<td></td>
<td>Requires a valid value for Fin Year , Form Number, Form Amount, Form Date and Transaction Date when checked. Matches all the Invoice level records based on the form amount value. When unchecked, sets all detail level Invoice form amount to 0.</td>
</tr>
<tr>
<td>Queried Form Amount</td>
<td>(Display only)</td>
<td></td>
<td>Displays Total Form Amount that can be matched across all unmatched Invoices</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>--------------------</td>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sales Tax Form Detail Block (Matching</td>
<td></td>
<td></td>
<td>Indicates whether the record is an Order or an Invoice. Values are 'ORDER', 'INVOICE'.</td>
</tr>
<tr>
<td>Detail) - Receipt Side</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Order/Invoice</td>
<td>(Display only)</td>
<td></td>
<td>Indicates whether the record is an Order or an Invoice. Values are 'ORDER', 'INVOICE'.</td>
</tr>
<tr>
<td>Invoice Number</td>
<td>(Display only)</td>
<td></td>
<td>This is the Invoice Number</td>
</tr>
<tr>
<td>Source Type</td>
<td>(Display only)</td>
<td></td>
<td>This field displays the Transaction Type related to the record.</td>
</tr>
<tr>
<td>Order Number</td>
<td>(Display only)</td>
<td></td>
<td>This field displays the Order Number. This would not be displayed for Manual AR Invoices.</td>
</tr>
<tr>
<td>Tax Target Amt</td>
<td>(Display only)</td>
<td></td>
<td>This field displays the Taxable Basis for used for calculating Sales Tax.</td>
</tr>
<tr>
<td>Matched Amount</td>
<td>(Display only)</td>
<td></td>
<td>This field displays the Matched Amount based on the previous matches.</td>
</tr>
<tr>
<td>Form Amount</td>
<td></td>
<td></td>
<td>Form Amount for each record cannot be greater than Matched Amount reduced from Tax Target amount for that record.</td>
</tr>
<tr>
<td>Total Form Amount</td>
<td>(Display only)</td>
<td></td>
<td>Sum of all Invoice level Form amounts.</td>
</tr>
</tbody>
</table>
Viewing Received Forms

You can view the Sales Tax Forms Received by clicking on the 'View Forms' button on the 'Find ST Forms Details' window. This would open 'View Sales Tax Form Details' window.

You will have to enter Customer, Customer Site and Form Type Details before you query for the Issued Forms.

This window has three sections Header, Details and Sub-Details.

**Header Section**

The section shows Customer Name, Customer Site and Form Type. These details are populated as the context information from the Query Find Screen.

**Sales Tax Form Details**

This section displays Form details based on the query criteria specified in the Query Find screen.

**Sales Tax Form Sub-Details**

This section displays all matched Invoice grouped by combination of Invoice Number and Transaction Number.

For each Invoice the Tax Target amount verses the Matched Amount is displayed based on the above grouping.

The field wise description for the screen 'View Sales Tax Form Details' form is given below.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Sales Tax Form</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Header Block</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Party Name (Display only)</td>
<td>(Display only)</td>
<td>Context Information carried over from Query Find Screen</td>
<td></td>
</tr>
<tr>
<td>Party Site (Display only)</td>
<td>(Display only)</td>
<td>Context Information carried over from Query Find Screen</td>
<td></td>
</tr>
<tr>
<td>Form Type (Display only)</td>
<td>(Display only)</td>
<td>Context Information carried over from Query Find Screen</td>
<td></td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-------------------</td>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>View Sales Tax Form Detail Block</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fin Year</td>
<td>(Display only)</td>
<td></td>
<td>Fin Year as created from the Match Detail Screen.</td>
</tr>
<tr>
<td>Form Number</td>
<td>(Display only)</td>
<td></td>
<td>Form Number as created from the Match Detail Screen.</td>
</tr>
<tr>
<td>Form Date</td>
<td>(Display only)</td>
<td></td>
<td>Form Date as created from the Match Detail Screen.</td>
</tr>
<tr>
<td>Transaction Date</td>
<td>(Display only)</td>
<td></td>
<td>Transaction Date as created from the Match Detail Screen.</td>
</tr>
<tr>
<td>Form Amount</td>
<td>(Display only)</td>
<td></td>
<td>Form Amount as created from the Match Detail Screen.</td>
</tr>
<tr>
<td>View Sales Tax Form Sub Detail Block - Receipt Side</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Order/Invoice</td>
<td>(Display only)</td>
<td></td>
<td>Indicates whether the record is an Order or an Invoice. Values are 'ORDER', 'INVOICE'.</td>
</tr>
<tr>
<td>Invoice Number</td>
<td>(Display only)</td>
<td></td>
<td>This is the Invoice Number</td>
</tr>
<tr>
<td>Source Type</td>
<td>(Display only)</td>
<td></td>
<td>This field displays the Transaction Type related to the record.</td>
</tr>
<tr>
<td>Order Number</td>
<td>(Display only)</td>
<td></td>
<td>This field displays the Order Number. This would not be displayed for Manual AR Invoices.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Target Amt</td>
<td>(Display only)</td>
<td></td>
<td>This field displays the Taxable Basis for used for calculating Sales Tax.</td>
</tr>
</tbody>
</table>

### Reports

This section provides overview and detailed descriptions of these reports:

- Commercial Invoice
- ST Form Customer Report
- Total Sales Report
- India - Debtors Ledger Report
- Debtors Trial Balance Report
- Supplementary Transaction Details Report (AR)
- Supplementary Invoice Consolidation Report (AR)
- Status of AR3 A form Report
- Duty Draw Back Report
- India - Cash/Bank Book Report
- India - Service Tax Pending Liability Report
- India - Service Tax Pending Recovery Report
- India - Service Tax ST3 Report
- India ER1 Report
- India TCS Certificate
- India - TCS Form 27B
- India - TCS Quarterly Report
Commercial Invoice

This Report gives you the Commercial Invoice's generated.

PCDATA cannot be inserted: This report was for "ISSUE OF INVOICE UNDER CENTRAL EXCISE RULE 57G OR 57T ". This section is no longer Valid, however the report is not dropped so that the fields appearing in the report can be used as an example / base for Client required output to generate and print Invoices. This is applicable for Trading Invoice only and not for Invoice under Manufacturing Organization.

Report Submission

Use the Other Reports in India Local Receivables form and enter India-Commercial Invoice Report in the Name field to submit the report.

Report Parameters

Organization (Optional) PICK

Enter the Organization from which delivery of goods is made

Location (optional) PICK

Enter the Location of the Organization.

Customer (Optional) PICK

Enter the Customer Name

Order/Invoice (optional)

Invoice (Required)

Commercial Invoice the user wants to take

Report Headings

Report headings provide you with general information about the contents of the report and the user entered parameters.

Column Headings

This reports provides following information

Item

Item Classification

Quantity

Total Amount

Duty Amount

Duty Per Unit
ST Form Customer Report

Use Sales Tax Forms due from the Customers to track Customers for whom you have given Sales tax discount and you have not yet received the ST Forms for an Order/Invoice.

Report Submission

Use the Submit Requests (India Local Receivables Module) form and enter India ST Forms Customer Report in the Name field to submit the report.

Report Parameters

From Date (Required)

Enter a date from which you wish to take the Sales Tax Forms Report. The date is based on the transaction date of the Invoice.

To Date (Required)

Enter an end date till which you wish to take the Sales Tax Forms Report. The date is based on the transaction date of the Invoice.

Matching Info ? (Required) PICK

This decides the type of report output

Following are the options available:

M - Matched Amount (Partial & Fully Matched) (When Matched Amount is not Zero)
P - Partially Matched (When Tax Target Amount is not equal Matched Amount)
F - Fully Matched (When Tax Target Amount not equal Matched Amount)
U - Unmatched ST forms details (When Matched Amount is 0).

Party (Optional ) PICK

Enter the party for which you wish to take the Sales Tax Forms Customer Report. It displays a list of Customer Names for those Customers for whom Localization setup is done. If not entered it will result in picking of all Customers where details are available.

Party Site (Optional) PICK

Enter the party site for which you wish to take the Sales Tax Forms Customer Report. It displays a list of Customer Sites for which Localization setup is done. If not entered it will result in picking of all sites pertaining to the Customer based on details available.

Organization (Optional ) PICK

Enter the Organization for which you wish to take the Sales Tax Forms Customer Report. It displays a list of Organizations for which Localization setup is done. If not entered it will result in picking of all Organizations based on details available.

Location (Optional ) PICK

Enter the Location for which you wish to take the Sales Tax Forms Customer Report. It
displays a list of Locations for which Localization setup is done for the Organization selected earlier. If not entered it will result in picking of all locations based on details available.

Report Headings

Report headings provide you with general information about the contents of the report. Oracle lists Organization Information based on User parameter input. Organization Name, Address on the Top left Corner Organization’s LST Registration Number and CST Registration Number on the Top Right Corner

Column Headings

Party No.
Customer Number to whom the Sale was made.

Name of Customer
Name of Customer to whom the Sale was made.

Customer site
Name of Customer Site.

Order Number
The Sales Order Number is displayed in this column for a Auto Invoiced Invoice. For a manual AR Invoice, it displays "N/A"

Order Date
The Sales Order Date for the Sales Order associated with the Invoice is displayed in this column for a Auto Invoiced Invoice. For a manual AR Invoice, it displays "N/A"

Invoice Number
Invoice Number of the Invoice is displayed here. This is same as the Transaction number available in AR.

Invoice Date
Invoice date of the Invoice is displayed here. This is same as the Transaction date available in AR.

Excise Invoice Number
Excise Invoice Number for the Invoice is displayed here. This is based on the Excise Invoice Number available in AR.

Excise Invoice Date
Excise Invoice Date for the Invoice is displayed here. This is based on the Excise Invoice Date available in AR.

Invoice Amount
Displays the Total Invoice Amount of the Invoice. It includes Line amount and tax amount.
Item
Description of Item sold.

Form Type
Displays the Sales Tax Form type attached to the tax.

Tax Rate
Sales tax rate for the particular Invoice Line.

Taxable Amount
Displays the amount based on which the sales tax is calculated.

In addition to the above, the following columns are displayed in case of Matched ST Forms.

Matched Amount
This column displays the amount matched.

Form Number
This column displays the form number, which was matched.

Form Date
This column displays the form date of the form the matching was done.

Form Amount
This column displays the form amount, which was matched.

Report Order
Report is printed in the order of Inventory Organization, Customer, Customer Sales Tax Registration Number, Form type and Invoice Date for the selected parameters.

India Total Sales Report
This report gives you the total sales made from a Inventory Organization for a given period with tax details.

Report Submission
Use the Other Reports India Local Receivables form and enter India - TotalSales Report in the Name field to submit the report.

Report Parameters

Organization (Required) PICK
India Localization displays the Default Organization (default). Enter an Organization, you wish to take the Total Sales Report for.

Location (Optional) PICK
Enter a Location (Skip for all), you wish to take the Total Sales Report for.
Period of report (Optional)
Enter the period for which you wish to take the Total Sales report for. If From & To dates are not entered then all Sales till date will be reported.

Report Style (Optional) PICK
Following options are available 'Show Both Detail and Summary', 'Show only Detail' and 'Show only Summary'

Report Headings
Report headings provide you with general information about the contents of the report. Oracle lists Organization information based on User parameter input.

Column Headings
Sales Invoice No. & Date
Invoice Number and Date of Sales.

Sales Tax Registration No. of Customer
Central Sales Tax Registration No. of Customer as entered in Customer Entry Form.

Name of Customer
Name of the Customer to whom the sale was made.

Gross Amount
Gross Amount as entered in Invoice.

Line Amount
Line Amount for a line for which LST or CST exists.

Sales Tax Rate
Sales tax rate for the particular Invoice Line.

Sales tax Amount
Total sales tax amount for the ST rate for the particular Invoice Line.

Certificate Type & Number
ST Form Type & Number, if any, for the particular Invoice Line.

Report Totals
Invoice Total & Sales Tax total for the chosen period.

Report Summary
This section of the report lists the summary (Tax summary) of Rate wise total for Sales Taxes for Total Sales.

Total for <Tax type> @ rate %
Total for the Sales Tax Rate for the chosen period.
Tax Total
Total Tax for the chosen period.

Report Order
Report is printed in the order of Invoice Date and Tax Type for the selected Organization.

Important: It is mandatory to have Ship to Address for an Invoice to appear as a Transaction in this report. The Customer should have setup of Customer Additional Information at site level.

The Invoice Created should have Sales Tax / CST or VAT type of Tax. If such type of tax is not chargeable, a Tax with 0% needs to be attached to the transaction for the same to appear in this report.

India - Debtors Ledger Report
Use this Report to get Debtor Ledger with complete details of Invoices, Debit Memos & Receipts.

Report Submission
Use the Other Reports (India Local Receivable module Only) form and enter India - Debtors Ledger Report in the Name field to submit the report.

Report Parameters

Customer Name (Optional) PICK
If the User wants Debtor Ledger for a specific Customer, then he need to enter Customer Name here otherwise Ledger for all the Customers for a given period will be reported.

Customer Number (Defaulted) PICK
Customer Number of the above Customer will be defaulted here.

Customer Type (Optional)
If the User wants Debtor Ledger for a specific Customer Type, then he need to enter Customer Type in this field otherwise Ledger for all the Customers for a given period will be reported.

Start Date (Required)

End Date (Required)

Org ID (Optional) PICK
If the User wants Debtor Ledger for a specific Inventory Organization, then he needs to enter Org ID in this field otherwise Ledger for all the Organizations for a given period will be reported.
Report Headings

Report headings provide you with general information about the contents of the report. Oracle lists Company Name based on User parameter input.

Column Headings

The Opening Balance for a Customer Multiple Currency wise will be sorted first and the Transaction for the period will be considered and the Closing Balance will be arrived in Multiple Currency.

GL Date

GL Date for the transaction will be reported.

Order No

Sales Order Number will be reported

Trx Number

Trx Number is meant for the respective Invoice, Debit Memo, Credit Memo Numbers.

Trx Date

Transaction date will be reported.

Receipt Number

Receipt Number will be reported

Receipt Date

Receipt Date will be reported

Remarks

Remarks in the respective transaction will be reported

Account Code

Respective account code of a transaction will be reported

Description

Account Code Description will be reported

Currency

Transaction currency will be reported

Exchange Rate

Payment Voucher Invoice No and Date will be reported

Transaction Dr Amt

Debit Amount in a foreign currency transaction will be reported.

Transaction Cr Amt

Credit amount in a foreign currency transaction will be reported.
**Functional Dr Amt**
Rupee equivalent for the Debit amount will be reported.

**Functional Cr Amt**
Rupee equivalent for the Credit amount will be reported.

---

**Debtors Trial Balance Report**

**Report Submission**
Use the Submit Requests (India Local AR modules Only) form and enter India-Debtors Trial Balance in the Name field to submit the report.

**Report Parameters**

**Customer Name (Optional) PICK**
If the User wants Debtor Trial Balance for a specific Customer, then he need to enter Customer Name here otherwise Trial Balance for all the Customers for a given period will be reported.

**Customer Number (Defaulted) PICK**
Customer Number of the above Customer will be defaulted here.

**Customer Type (Optional)**
If the User wants Debtor Trial Balance for a specific Customer Type, then he need to enter Customer Type in this field otherwise Debtor Trail balance for all the Customers for a given period will be reported.

**Start Date (Required)**
**End Date (Required)**

**Report Headings**
Report headings provide you with general information about the contents of the report. Oracle lists Company Name based on User parameter input.

**Column Headings**

**Sl.No**
Serial Number of the Trial Balance will be reported.

**Customer Type**
Customer Type will be reported

**Customer Name**
Customer Name will be reported.

**Customer Code**
Customer Code (Number) will be reported.
Currency
The Transaction currency will be reported.

Entered Amount
Closing Balance of a Customer in Foreign currency will be reported.

Rupee Amount
Rupee equivalent of a Customer will be reported

Supplementary Transaction Details Report (AR)
This Report gives the Supplementary Invoices, Credit Memos raised/to be raised for the Original Invoice

Report Submission
Use the Submit Requests (India Local AR modules Only) form and enter India-Supplementary Transactions Details Report in the Name field to submit the Report.

Report Parameters
Customer Name (Optional) PICK
If the User wants this Report for a specific Customer, then he need to enter Customer Name here otherwise this report give details for all the Customers for a given period will be reported.

Customer Number (Defaulted) PICK
Customer Number of the above Customer will be defaulted here.

Invoice Number (Optional)
If the User wants to see Supplementary Transaction for a specific Invoice, then he, need to enter that here.

Process Date (Optional)
For a Process date, the user can take the Report.

Supplementary Invoice Type (Optional)
Quick code are : Supplementary, Invoice, Credit Memo, Debit Memo

Report Headings
Report headings provide you with general information about the contents of the report. Oracle lists Company Name based on User parameter input.

Column Headings
Sl. No
Serial Number of the Trial Balance will be reported.
Invoice
Original Invoice will be reported

Date
Date of the Original Invoice will be reported.

Amount
Amount of the Invoice will be reported.

Supplementary Invoice Type
Type like Supplementary Invoice, Credit Memo and Debit Memo will be reported. Amount of the Invoice will be reported.

Net Sales
Net Sales amount of the Supplementary Transaction will be reported.

Excise
Excise duty of the Supplementary Transaction will be reported.

Sales Tax
Sales Tax of the Supplementary Transaction will be reported.

CST
CST of the Supplementary Transaction will be reported.

Others
Others taxes of the Supplementary transaction will be reported.

Effective Amount
This is the amount for which the Sup.Inv, Credit Memo, debit Memo is raised.

Order By
Original Invoice Number

**Supplementary Invoice Consolidation Report (AR)**
This report gives you the Consolidated Supplementary Invoice raised for a period

**Report Submission**
Use the Submit Requests (India Local AR modules Only) form and enter India-Supplementary Invoices Consolidation Report in the Name field to submit the Report.

**Report Parameters**

**Customer Name (Optional) PICK**
If the User wants this Report for a specific Customer, then he need to enter Customer Name here otherwise this report give details for all the Customers for a given period
Customer Number (Defaulted) PICK  
Customer Number of the above Customer will be defaulted here.

Process Date (Optional)  
For a Process date, the user can take the Report.

Supplementary Invoice Date (Optional)  
For a particular Supplementary date, this report can be requested.

Supplementary Invoice No (Optional)  
For a particular Supplementary Number, this report can be requested.

Supplementary Invoice Type (Optional)  
For a particular Supplementary Type of Invoices, this report can be requested.

Report Headings  
Report headings provide you with general information about the contents of the report. Oracle lists Company Name based on User parameter input.

Column Headings  
Sl. No  
Serial Number of the Line will be reported.

Item  
Item name will be reported.

Description  
Description of the Item name will be reported.

Line Amount  
Excise  
Excise duty of the Supplementary Invoice (Consolidated) will be reported.

Sales Tax  
Sales Tax of the Supplementary Invoice (Consolidated) will be reported.

CST  
CST of the Supplementary Invoice will be reported.

Others  
Others taxes of the Supplementary Invoice will be reported.

Total Amount  
This is the amount for which the Sup. Inv, Credit Memo, Debit Memo is raised.
Status of AR3 A form Report

This Report gives you the details about the AR 3A forms to be received from Customer.

Report Submission

Use the Submit Requests (India Local AR modules Only) form and enter India-AR3A Status Report in the Name field to submit the Report

Report Parameters

Organization/Location (Optional) PICK

If the User wants this Report for a specific Organization/Location, then he need to enter Organization Name here otherwise this report give details of AR3 A for dispatches made from all the Org/Location.

Customer Name (Optional) PICK

If the User wants this Report for a specific Customer, then he need to enter Customer Name here otherwise this report give details for all the Vendors for a given period will be reported.

Customer Number (Defaulted) PICK

Customer Number of the above Customer will be defaulted here.

Transaction Type (Optional )

Invoice / Order can be selected by the User.

Process Date (Optional)

For a Process date , the user can take the Report.

Invoice Number (Optional)

For Specific Invoice this report can be taken.

Excise Exemption Type (Optional)

CT2 or CT3

Status (Optional)

Quick fields are ALL, RECEIVED & NOT RECEIVED

Order

To be filled

Report Headings

Report headings provide you with general information about the contents of the report. Oracle lists Company Name based on User parameter input.

Column Headings

Customer Name
<table>
<thead>
<tr>
<th>Customer site</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Type</td>
</tr>
<tr>
<td>Transaction Number</td>
</tr>
<tr>
<td>Transaction Date</td>
</tr>
<tr>
<td>Delivery Name</td>
</tr>
<tr>
<td>Delivery Number</td>
</tr>
<tr>
<td>Delivery Date</td>
</tr>
<tr>
<td>Excise Exempt Type</td>
</tr>
<tr>
<td>Excise Exempt Date</td>
</tr>
<tr>
<td>AR3 A Form No</td>
</tr>
<tr>
<td>AR3 A Form Date</td>
</tr>
<tr>
<td>Received Date</td>
</tr>
</tbody>
</table>

Date on which the AR3A form received back from the Customer.

**Others**

Others taxes of the Supplementary Invoice will be reported.

**Total Amount**

This is the amount for which the Sup. Inv, Credit Memo, debit Memo is raised.

---

### Duty Draw Back Report

**Report Submission**

Use the Submit Requests *(OE & AR Modules)* form and enter **India - Duty Drawback Report** in the Name field to submit the Report.

**Report Parameters**

**Organization (Required) PICK**

Enter the Organization for which you wish to take the Duty Drawback Report for.

**Location (Required) PICK**

Enter the Location for which you wish to take the Duty Drawback Report for.

**From date (Optional)**

India Localization prints all claims for Duty drawback for the selected Organization starting with the date you enter for this parameter.

**To date (Optional)**

India Localization prints all claims for Duty drawback for the selected Organization up to the date you enter for this parameter.
**Report Headings**

Report headings provide you with general information about the contents of the report. India Localization prints Organization related information, Report date and Sheet number on all pages, along with report heading on all pages.

**Column Headings**

AR4 No.
Number of Proof if export certificate (AR4).

Date of Removal
Date of removal of Export Goods from the Factory.

**Item Description**

Description of Item being exported.

**Destination**

Destination for the goods being exported.

**Quantity**

Quantity of items being exported.

**UoM**

Unit of Measure of items being exported.

**Value**

Value of Goods being exported.

**Item code**

Imported Item code.

**CET Code**

CET Code of Imported Item.

**Item description**

Description of Item that was imported for Manufacturing export item.

**Rev**

Revision No./name of Imported Item.

**Quantity**

Quantity of Items Imported.

**UoM**

Primary Unit of Measure of Items Imported.

**BoE No.**

Bill of Entry Number of Imported Item.
BoE date
Date of BoE of Imported Item.

Item code
Imported Item code.

Duty Drawback Amount
Amount of Duty paid on Imported Item that is being claimed back.

Total Duty Drawback Amount
AR4 number wise Total duty drawback amount.

Grand Total
Report’s Total duty drawback amount.

Report Order
Report is printed in the order of Shipment Date of Exported Items and Imported Item Description.

Journal Voucher Report
This report provides the Listing of Journals created for a given period with the respective sources.

Report Submission
Use the Submit Requests form (India AP and AR modules) and enter India - Journal Voucher in the Name field to submit the Report.

Report Parameters
Source (Optional) PICK
The user wants to take journals of a particular source, then he can specify that name.

JV No (optional) PICK
Specific Journal Number, the user wants to take a report, otherwise left blank.

Period Order/Invoice (Required)
Start Date and End Date

Report Headings
Report headings provide you with general information about the contents of the report and the user entered parameters.

Column Headings
GL Date
JV Number
JV Date/GL Date
India - Cash / Bank Book Report

The user takes Cash/Bank Book as per his requirement for a range of period.

Report Submission

Use the Submit Requests (India Local AP & AR Module Only) form and enter India-Cash/Bank Book Report in the Name field to submit the Report.

Report Parameters

Bank Name (Required) PICK
Bank Name for which the User wants to take the Bankbook for a given period.

Account Number (Required) PICK
Account Number of the Above bank for which the User wants to take the Bank book for a given period.

Book Type (Required)
Either 'B' meant for Bank Book or 'C' meant for Cash book can be selected by the User from the LOV. This does not have an impact on the printout other than changing of the heading of the report.

Start Date (Required)

End Date (Required)

Report Headings

Report headings provide you with general information about the contents of the report. Oracle lists Company Name based on User parameter input.

Column Headings

GL Date
GL Date for the transaction will be reported.

Voucher No & Date
Voucher Number and Date will be reported

Check Number & Date
Check Number and Check Date will be reported
Bill No & date
Supplier Bill No & Date will be reported

Vendor Name/Customer Name
In the Case of Payments, the vendor Name will be reported. In the Case of Receipts, the Customer Name will be reported. For charges in the Bank Book, this field won’t be having any details.

PO Number & Date
PO Number for the respective purchase will be reported

Remarks/Narration
Remarks / Narration appearing in the Receipts and Payments vouchers will be reported

Account Code
GL Account for the respective Receipts and Payments will be reported.

Description
Description of the GL Account for the respective Receipts and Payments will be reported.

Receipts
Receipts Amount will be reported into this column.

Payments
Payments Amount will be reported into this column.

Balance
Balance Amount in the Cash/Bank will be reported into this column.

Important: Cash Book Report will be generated by specifying the Book Type ‘C’

India - Service Tax Pending Liability Report
This Report gives you the details of Service Tax Pending Liability. This Report shows all the unpaid / partly paid AR Invoices for which Service Tax Liability has not yet arisen.

Report Submission
Use the Other Reports form (India Local Receivable module) and enter India - Service Tax Pending Liability Report in the Name field to submit the Report.

Report Parameters
Registration Number (Required) PICK

The Registration Number for which the report is being generated.
Organization (Optional) PICK
The Operating Unit for which the report is being generated.

As on Date (Required)
The Date as on which the report is being generated.

India - Service Tax Pending Recovery Report
This Report gives you the details of Service Tax Pending Recovery. This Report shows all the unpaid / partly paid AP Invoices for which Service Tax Recovery (Credit) has not yet been availed.

Report Submission
Use the Other Reports form (India Local Receivable module) and enter India - Service Tax Pending Recovery Report in the Name field to submit the Report.

Report Parameters
Primary Registration Number (Required) PICK
The Registration Number for which the report is being generated.

As on Date (Required)
The Date as on, which the report is being generated.

Report Sample:

India - Service Tax ST3 Report
This Report gives you the details for filing the Service Tax return in ST3 Form.

Report Submission
Use the Other Reports form (India Local Receivable module) and enter India-Service Tax ST3 Report in the Name field to submit the Report.

Report Parameters

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registration Number</td>
<td>Required</td>
<td>PICK</td>
<td>The Registration Number for which the report is being generated.</td>
</tr>
<tr>
<td>From Date and To Date</td>
<td>Required</td>
<td></td>
<td>Start Date and End Date for which the report is being run.</td>
</tr>
</tbody>
</table>
### India ER1 Report

This Report gives you the detailed data for submission of ER1 report.

**Report Submission**

Use the Other Reports form ([India AR module](#)) and enter **India ER1 Report** in the Name field to submit the Report.

**Report Parameters**

**Organization (Optional) PICK**

The Inventory Organization for which the report is being generated.

**Location (Optional) PICK**

The Inventory Organization for which the report is being generated. This needs to be left blank if all locations are to be printed. This gets enabled only if the Inventory Organization is selected.

**Start Date and End Date (Required)**

Start Date and End Date for which the report is being run.

**Service Tax Registration Number (Optional) PICK**

The Service Tax Registration Number for which the report is being generated.

**Operating unit (Optional) PICK**

The Operating Unit for which the report is being generated. This gets enabled only if the Service Tax Registration Number is selected.

**Name of the Assessee (Optional)**

The Name of the Organization which needs to be printed on the report. This is the actual name to be printed and would not be picked from Organization setups.

**Group Quantitative Data (Required) PICK**

<table>
<thead>
<tr>
<th>Organization</th>
<th>Optional</th>
<th>PICK</th>
<th>The Inventory Organization for which the report is being generated.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Type</td>
<td>Optional</td>
<td>PICK</td>
<td>List of all available Service Types, as selecting a value in this field indicates user wants to print report for a single Service type</td>
</tr>
</tbody>
</table>
The Report can be either printed for the Inventory Items or for Item Tariff. The values to be selected are 'I' for Item or 'T' for Tariff. Please see the note below for report behavior on selection of this value.

**Important:** Report Behavior for Group Quantitative Data : Item: When Item is selected Quantitative data in report is grouped based on individual inventory item and column 'Description of goods' will be displaying the Inventory Item description. Tariff: When Tariff is selected Quantitative data in report is grouped based on Item Tariff provided in India Item Attributes setup (related to Excise) and further grouped based on distinct primary UOM. In this case the column 'Description of goods' will be left blank as the Tariff description is currently not captured by India Localization. User needs to enter the Item Tariff description in such cases.

**India TCS Certificate**

Use the Submit Requests from India Local Receivables and enter India TCS Certificate in the Name field to submit the report.

**Report Parameters**

<table>
<thead>
<tr>
<th>Report Parameter</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legal Entity</td>
<td>Required</td>
<td>PICK</td>
<td>The Legal Entity for which the report is being generated.</td>
</tr>
<tr>
<td>Financial Year</td>
<td>Required</td>
<td>PICK</td>
<td>The Financial year for which the report is being generated.</td>
</tr>
<tr>
<td>TAN Number</td>
<td>Required</td>
<td>PICK</td>
<td>The TAN Number for which the report is being generated.</td>
</tr>
<tr>
<td>Report Parameter</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Collection Code</td>
<td>Required</td>
<td>PICK</td>
<td>The Collection code for which the report is being generated. This can be any of the following values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Alcoholic liquor for human consumption</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Timber obtained under forest lease</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Timber obtained under any mode other than forest lease</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Any other forest product not being timber or tendu leave</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Scrap</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Parking Lot</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Toll Plaza</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Mining and Quarrying</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Tendu Leaves</td>
</tr>
<tr>
<td>Certificate Nos. from</td>
<td>Optional</td>
<td>PICK</td>
<td>The Certificate Nos. from for which the report is being generated.</td>
</tr>
<tr>
<td>Certificate Nos. to</td>
<td>Optional</td>
<td>PICK</td>
<td>The Certificate Nos. to for which the report is being generated.</td>
</tr>
<tr>
<td>Report Parameter</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Certificates from Date</td>
<td>Optional</td>
<td></td>
<td>The Certificates from date for which the report is being generated.</td>
</tr>
<tr>
<td>Certificates to Date</td>
<td>Optional</td>
<td></td>
<td>The Certificates to date for which the report is being generated.</td>
</tr>
<tr>
<td>Customer</td>
<td>Optional</td>
<td>PICK</td>
<td>The Customer for which the report is being generated.</td>
</tr>
<tr>
<td>Name of Signee</td>
<td>Optional</td>
<td></td>
<td>The Name of Signee which needs to be printed on the report.</td>
</tr>
<tr>
<td>Designation</td>
<td>Optional</td>
<td></td>
<td>The Designation of Signee which needs to be printed on the report.</td>
</tr>
<tr>
<td>Place</td>
<td>Optional</td>
<td></td>
<td>The Place where TCS Certificate is issued and which needs to be printed on the report.</td>
</tr>
<tr>
<td>Organization</td>
<td>Required</td>
<td>PICK</td>
<td>The Inventory Organization for which the report is being generated.</td>
</tr>
</tbody>
</table>

**India - TCS Form 27B**

Use the Submit Requests from India Local Receivables and enter India - TCS Form 27B in the Name field to submit the report.

**Report Parameters**
<table>
<thead>
<tr>
<th>Field</th>
<th>Requirement</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legal Entity</td>
<td>Required</td>
<td>PICK</td>
<td>The Legal Entity for which the report is being generated.</td>
</tr>
<tr>
<td>Org TAN Number</td>
<td>Required</td>
<td>PICK</td>
<td>The Organization TAN Number for which the report is being generated.</td>
</tr>
<tr>
<td>Organization</td>
<td>Required</td>
<td>PICK</td>
<td>The Inventory Organization for which the report is being generated.</td>
</tr>
<tr>
<td>Financial Year</td>
<td>Required</td>
<td>PICK</td>
<td>The Financial year for which the report is being generated.</td>
</tr>
<tr>
<td>Quarter</td>
<td>Optional</td>
<td>PICK</td>
<td>The Quarter of the Fiscal year for which the report is being generated.</td>
</tr>
<tr>
<td>Previous Receipt Number</td>
<td>Required</td>
<td>PICK</td>
<td>The Previous Receipt Number in case the return was filed earlier.</td>
</tr>
<tr>
<td>Collection Code</td>
<td>Required</td>
<td>PICK</td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>----------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Collection code for which the report is being generated. This can be any of the following values:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Alcoholic liquor for human consumption</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Timber obtained under forest lease</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Timber obtained under any mode other than forest lease</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Any other forest product not being timber or tendu leave</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Scrap</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Parking Lot</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Toll Plaza</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Mining and Quarrying</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tendu Leaves</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Person Responsible</th>
<th>Required</th>
<th>PICK</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>The Name of Person responsible which needs to be printed on the report.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Responsible Person Designation</th>
<th>Required</th>
<th>PICK</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>The Designation of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Field</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Responsible Person</td>
<td>Required</td>
<td>The Address of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Address</td>
<td></td>
<td></td>
</tr>
<tr>
<td>City</td>
<td>Required</td>
<td>The City of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>State</td>
<td>Required</td>
<td>The State of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Pin</td>
<td>Required</td>
<td>The PIN code (Postal Code) of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Telephone</td>
<td>Required</td>
<td>The Telephone Number of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>email</td>
<td>Required</td>
<td>The email Address of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Optional</td>
<td>The start date from which this report needs to be printed. This date should pertain to the same quarter as entered in earlier parameter.</td>
</tr>
</tbody>
</table>
### India TCS Quarterly Report

Use the Submit Requests from India Local Receivables and enter `India - TCS Quarterly Report` in the Name field to submit the report.

#### Report Parameters

<table>
<thead>
<tr>
<th>Report Parameter</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legal Entity</td>
<td>Required</td>
<td>PICK</td>
<td>The Legal Entity for which the report is being generated.</td>
</tr>
<tr>
<td>Org TAN Number</td>
<td>Required</td>
<td>PICK</td>
<td>The Organization TAN Number for which the report is being generated.</td>
</tr>
<tr>
<td>Organization ID</td>
<td>Required</td>
<td>PICK</td>
<td>The Inventory Organization for which the report is being generated.</td>
</tr>
<tr>
<td>Fin Year</td>
<td>Required</td>
<td>PICK</td>
<td>The Financial year for which the report is being generated.</td>
</tr>
<tr>
<td>Quarter</td>
<td>Optional</td>
<td>PICK</td>
<td>The Quarter of the Fiscal year for which the report is being generated.</td>
</tr>
</tbody>
</table>

The end date till which this report needs to be printed. This date should pertain to the same quarter as entered in earlier parameter.
<table>
<thead>
<tr>
<th>Report Parameter</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collection Code</td>
<td>Required</td>
<td>PICK</td>
<td>The Collection code for which the report is being generated. This can be any of the following values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Alcoholic liquor for human consumption</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Timber obtained under forest lease</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Timber obtained under any mode other than forest lease</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Any other forest product not being timber or tendu leave</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Scrap</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Parking Lot</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Toll Plaza</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Mining and Quarrying</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Tendu Leaves</td>
</tr>
<tr>
<td>Tax Rates Type</td>
<td>Required</td>
<td>PICK</td>
<td>The Tax rate type for which the report is being generated i.e. 'Lower Rates' 'Standard Rates' or 'Exempt Rates'.</td>
</tr>
<tr>
<td>Report Parameter</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Provisional Receipt Number</td>
<td>Required</td>
<td>PICK</td>
<td>The Provisional Receipt Number in case the return has been filed earlier.</td>
</tr>
<tr>
<td>Person Responsible</td>
<td>Required</td>
<td></td>
<td>The Name of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Responsible Person Designation</td>
<td>Required</td>
<td></td>
<td>The Designation of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Responsible Person Address</td>
<td>Required</td>
<td></td>
<td>The Address of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Responsible Person City</td>
<td>Required</td>
<td></td>
<td>The City of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Responsible Person State</td>
<td>Required</td>
<td></td>
<td>The State of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Responsible Person Pin</td>
<td>Required</td>
<td></td>
<td>The PIN code (Postal Code) of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Responsible Person Telephone</td>
<td>Required</td>
<td></td>
<td>The Telephone Number of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Report Parameter</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Responsible Person email</td>
<td>Required</td>
<td></td>
<td>The email Address of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Optional</td>
<td></td>
<td>The start date from which this report needs to be printed. This date should pertain to the same quarter as entered in earlier parameter.</td>
</tr>
<tr>
<td>End Date</td>
<td>Optional</td>
<td></td>
<td>The end date till which this report needs to be printed. This date should pertain to the same quarter as entered in earlier parameter.</td>
</tr>
</tbody>
</table>

**India TCS Annual Report**

Use the Submit Requests from India Local Receivables and enter India - TCS Annual Report in the Name field to submit the report.

**Report Parameters**

<table>
<thead>
<tr>
<th>Report Parameter</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legal Entity</td>
<td>Required</td>
<td>PICK</td>
<td>The Legal Entity for which the report is being generated.</td>
</tr>
<tr>
<td>Org TAN Num</td>
<td>Required</td>
<td>PICK</td>
<td>The Organization TAN Number for which the report is being generated.</td>
</tr>
<tr>
<td>Report Parameter</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Organization ID</td>
<td>Required</td>
<td>PICK</td>
<td>The Inventory Organization for which the report is being generated.</td>
</tr>
<tr>
<td>Fin Year</td>
<td>Required</td>
<td>PICK</td>
<td>The Financial year for which the report is being generated.</td>
</tr>
<tr>
<td>Collection Code</td>
<td>Required</td>
<td>PICK</td>
<td>The Collection code for which the report is being generated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>This can be any of the following values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Alcoholic liquor for human consumption</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Timber obtained under forest lease</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Timber obtained under any mode other than forest lease</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Any other forest product not being timber or tendu leave</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Scrap</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Parking Lot</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Toll Plaza</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Mining and Quarrying</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Tendu Leaves</td>
</tr>
<tr>
<td>Report Parameter</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Tax Rates Type</td>
<td>Required</td>
<td>PICK</td>
<td>The Tax rate type for which the report is being generated i.e. ‘Lower Rates’ ‘Standard Rates’ or ‘Exempt Rates’.</td>
</tr>
<tr>
<td>Seller Address Changed?</td>
<td>Required</td>
<td>PICK</td>
<td>The Provisional Receipt Number in case the return has been filed earlier.</td>
</tr>
<tr>
<td>Responsible Person Name</td>
<td>Required</td>
<td></td>
<td>The Name of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Responsible Person Designation</td>
<td>Required</td>
<td></td>
<td>The Designation of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Responsible Person Place</td>
<td>Required</td>
<td></td>
<td>The Address of Person responsible which needs to be printed on the report.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Optional</td>
<td></td>
<td>The start date from which this report needs to be printed. This date should pertain to the same quarter as entered in earlier parameter.</td>
</tr>
<tr>
<td>End Date</td>
<td>Optional</td>
<td></td>
<td>The end date till which this report needs to be printed. This date should pertain to the same quarter as entered in earlier parameter.</td>
</tr>
</tbody>
</table>
This chapter covers the following topics:

- Fixed Asset Depreciation Calculation
- Transactions
- Reports

**Fixed Asset Depreciation Calculation**

Businesses in India, under the Income Tax Act, have to compute depreciation using the "Written Down Value" method. The depreciation percentage has to be applied on the Block of Assets and no depreciation can be claimed on individual assets.

Using India Localization, you can:

- Create Block of assets as required under the Income tax Act
- Record the block value of each Block of assets
- Define the depreciation percentage for each asset blocks
- Assign a block of asset to each asset addition
- Identify the block of assets for each asset, which are being retired during the year
- Perform adjustments in the opening written down value of any block and adjustments in the depreciation worked out in any year.

**Note:** It may be noted that localization provides only the reports showing the workings of depreciation based on block of assets. No accounting entries will be passed on the figures derived through localization will not be considered for any accounting entries automatically.
The Tax Handling functionality provides you with the information requirements under Income Tax Act. You can:

- Define multiple blocks of assets and associate individual assets to each block of assets.
- Define depreciation periods. These periods would be in sync with the financial year defined under the Income Tax Act.
- Specify multiple period rates for each depreciation period. You can define multiple periods and applicable rate percentage for each period. The depreciation amount would be proportionate to the rate percentage specified for each period.
- Specify date of commissioning and enable calculation of depreciation based on the date of commissioning.
- Define the opening written down balances along with depreciation rates at the beginning of the year during which you would be rolling out Oracle Assets with India Localization. This information would be used for the computation of depreciation for the year.
- Adjust opening written down value and depreciation amounts.
- Calculate depreciation in accordance with Income Tax Act.
- Generate depreciation schedule.

**Major Features**

- **Definition of Block of Assets**: User will be able to define block of assets by having the asset categories defined with highest level of details as required for Income Tax.

- **Opening Balance of Block of Assets**: User is provided with a facility to enter Opening balances for block of assets (one time facility). User is provided with a report, which will facilitate arriving at asset category wise, Gross Block of Assets and written Down Value as required for Income Tax purpose.

- **Periodical Closing Balances of Block of Assets**: User is provided with a facility generate monthly closing balances of Block of assets.

**Transactions**

Various Transactions India Localization Supports in Fixed Assets are mentioned in this section.

**Asset Additions**

While recording the additions of assets in Oracle assets, the user need to allocate the
individual asset to the Block of assets defined. The block details of the assets need to be assigned by recording the details in the flex field. You need to enter localization details in Asset Categories flexfield while additions through Quick Additions and New Additions. While you would be entering these details in Mass Additions Flex field while adding assets through Prepare Mass Additions. On recording the complete asset related information including asset book and cost of the asset, user need to click on the flexfield and select the context value as India B Assets.

Before you enter the Asset Additions, you must:

- Define Books
- Define Asset Category
- Define Quick Codes (for Block of Assets)
- Define Depreciation Period Details

Navigate to Assets > Asset Workbench > Quick Additions/New Additions > Asset Category.

User will have to complete the asset addition in Base FA and come to the India Localization screen to assign the block of asset and date of acquisition.

The user has the flexibility to assign a block name to multiple assets at one go which will increase the usability significantly.

Also, the date placed in service (which is given at the time adding the asset) will be defaulted as the Date of Acquisition. This date can be changed by the user.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block of Assets</td>
<td>PICK HELP</td>
<td></td>
<td>Users need to enter the relevant Block of Assets in which the asset will be classified as per Indian Income Tax Act.</td>
</tr>
<tr>
<td>Date of Acquisition</td>
<td></td>
<td></td>
<td>User need to record the date on which the asset was acquired</td>
</tr>
</tbody>
</table>

**Income Tax Depreciation Calculations**

The calculation of written down value of the Block of asset is worked out based on the prescribed calculations that need to be carried out under Income Tax Act.
Opening Written down value of the block (as at the beginning of the assessment year)

<table>
<thead>
<tr>
<th>Terms</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Additions during the assessment year</td>
</tr>
<tr>
<td>Less</td>
<td>Retirements of asset from each individual assets</td>
</tr>
<tr>
<td>Less</td>
<td>Depreciation on the opening written down value of the block</td>
</tr>
<tr>
<td>Less</td>
<td>Depreciation on the additions during the first half of the assessment year</td>
</tr>
<tr>
<td>Less</td>
<td>Depreciation on the additions during the second half of the assessment year</td>
</tr>
</tbody>
</table>

= Closing written down value of the block of asset

---

**Run Depreciation**

For calculating the depreciation under Income Tax Act, users need to run a concurrent program manually. The program is named as Income Tax Act fixed asset schedule. On completion of the program, users can view and print the output and the closing written down value will get updated.

**Income Tax Act fixed asset schedule concurrent program**

Users need to run Concurrent request to Calculate Depreciation for a Financial Year.

In India Localization, navigate to the Income Tax Act Fixed Asset Schedules concurrent program as follows:

**Request Name:** Income Tax Act Fixed Asset Schedules

The parameters for this request are described in the table below:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>

---
| Start Date | (Required) | Users need to enter start date from the LOV of a Financial year to run the depreciation calculation. Since the financial year for the Income Tax purpose is 1st April to 31st March this start date use to be 1st of April of a year. |
| End Name | (Required) | System will consider the End date as 12 month ending from the above start date. |
| Book Name | (Required) | The User need to enter Book Name where in the Depreciation Calculation is need to be done. |

After completion of Run Depreciation, users can view the Fixed Assets Schedule as per Income Tax Act (Block wise) through Reports. If the user needs to add an unplanned depreciation, it can be done in the Depreciation adjustment column of Opening WDV Balance form. Unplanned Depreciation amount will be shown separately in the report output.

**Reports**

Fixed Assets generates these reports for India:

- **India Income Tax Fixed Assets Schedule** - This report is a Fixed Asset Schedule as per Income Act, provides details of Block of Assets.

- **India Depreciation Detail Report** - This report provides information on depreciation calculated for each asset.

**India Income Tax Fixed Assets Schedule**

This report is a Fixed Asset Schedule as per Income Act, provides details of Block of Assets. Use the Submit Requests (India Local Fixed Asset ) form and enter India-Depreciation for one year in the Name field to submit the report.
• **F.Y Start Date:** Financial year start will be available in the LOV, Once the start date is entered, the system will take the end date as end of the Financial year. The user need to enter the relevant Corporate book name for which the Income Tax Fixed Assets schedule is to be taken. Report headings provide you with general information about the contents of the report. Oracle lists Corporate Book name and financial year details based on User parameter input.

• **S.No:** Serial Number for the Block of Assets will be reported

• **Type:** Block of Assets name will be reported

• **Period:** Depreciation period in a financial year will be reported

• **Opening WDV as on start date of a Financial year:** Opening Written Down Value for a Block will be reported

• **Addition during the year:** Addition made during the year to a Block will be reported

• **Deletion and Sale in the year:** Deletion and Sale during the year to a Block will be reported

• **Deletion and Sale in the year:** Deletion and Sale during the year from a Block will be reported

• **Total:** Total of WDV balance for a Block before applying depreciation Block will be reported

• **Rate of Depreciation:** Rate of Depreciation for a block will be reported

• **Depreciation for the year:** Depreciation for a block for the year will be reported

• **Closing WDV as on End date of a Financial year:** Closing Written Down Value for a Block will be reported

---

**India Depreciation Detail Report**

• **Start Date:** Financial year start will be available in the LOV, Once the start date is entered.

• **End Date:** End date as per User requirement can be entered.

• **Level of details:** The user can specify either a Detailed Report or a Summary Report according to his requirement. Detailed report will provide complete assets details and Summary Report will provide Block wise details for multiple years.

• **S.No:** Block of Assets name will be reported
• **Period:** Period for which report is submitted

• **Opening WDV as on start date of a Financial year:** Opening Written Down Value for a Block will be reported

• **Addition during the year:** Addition made during the year a financial year to a Block asset wise will be reported

• **Assets Number:** Assets Number added to a Block during the financial years will be reported

• **Deletion and Sale in the year:** Deletion and Sale during the financial years of an asset will be reported

• **Deletion and Sale in the year:** Deletion and Sale during the year from a Block for an asset will be reported

• **Total:** Total of WDV balance for a Block before applying depreciation Block will be reported

• **Rate of Depreciation:** Rate of Depreciation for a block will be reported. Depreciation for a block for the year will be reported

• **Closing WDV as on End date of a Financial year:** Closing Written Down Value for a Block will be reported
This chapter covers the following topics:

- Trading Functionality Overview
- Match Receipts Localized Overview
- Transactions
- Reports

Trading Functionality Overview

Every Dealer and Importer dealing in excisable goods is required to obtain Excise Registration to issue CENVATable invoices. This registration should be obtained for every warehouse of the dealer; and that the Superintendent of Excise has jurisdiction over the warehouse and will be the officer responsible to issue Central Excise Registration.

Dealers who register themselves with Central Excise will ensure that the Register in form RG23D is maintained in the warehouse and should be available for inspection by Central Excise Officers.

In a Trading Organization, the following are the essential requirements:

- Capture Registration details for Trading Activity.
- Maintain RG23D Register.
- Ensure Excise Duty per Unit to be constant figure on your Receipts as well Issue Tax lines.
- Match receipts quantity before making delivery.
- Enter Manual entries into RG23D to update the physical quantity discrepancies in the Book.
Major Features

- **Excise Registration details of Trading Organization**: Provision has been provided for the User to classify an organization location to be trading, in addition to the capturing of their excise registration particulars. This will be applicable for all sub inventories coming under trading organizations and user can also identify individual sub inventories as trading.

- **Provision to capture user definable excise invoice numbers for trading organization**: User will have a provision to capture Excise department approved numbers for Excise invoices being generated for shipments from these Trading Organizations.

- **Tracking original excise invoice of receipt with the shipments from these trading organizations**: User will have a provision to associate original excise invoice reference on the basis of LIFO or FIFO. There is a provision to specify the invoice number at the transaction, so as to allow override with each shipment (at the time of completing sale invoice, in the case of only AR installation) happening from trading organization location.

- **Maintenance of RG23D Register**: User will be able to maintain Register RG23D for each organization location, which is identified as trading. The following transactions are considered for the above register.

- **Print RG23D Register**: Provision to print Register RG 23D has been provided.

- **Manual entries to register RG 23D**: Provision has been made to add records manually to register RG23D. User will not be able to update or delete the existing records.

- **Stand Alone Accounts Receivables**: Provision has been made to add, delete or modify the tax lines after mapping of Receipts tax lines in the case of standalone AR instance.

Match Receipts Localized Overview

This functionality is designed to support the excise related transactions for a trading organization or location. If the organization or location is registered under Central Excise rules as a Dealer of Depot, you can pass down the credit of duty involved in the goods you are trading. The trading organization needs to track the duty involved in excise goods and the same needs to be tracked at the time of receipt.

The Match receipts functionality allows the user to satisfy all requirements related to a trading organization or location registered under the Central excise rules to pass on excise credit to your customers. The excise duty tracked while receiving the goods in a trading organization can be allowed as CENVAT credit for its customers. Before
confirming the shipment, the organization needs to allocate the excise duty involved during receipt of the excisable goods. While shipping from the trading organization, you are required to track the exact amount of duty paid by the original manufacturer for passing down the credit under CENVAT procedures. This can be done through match receipt for trading item screen. This Matching Receipts form provides the Information regarding available receipts from which the delivery quantity can be picked up. Once the receipt is matched then the Excise amount in the Fullfilled Order delivery lines will be the Excise amount from Receipt tax line for the respective delivery quantity. A new feature of Unmatch is provided which will enable the user to roll back the matching already made in case of either wrong matching or need for splitting etc.

**Major Features**

- **Facility to pick up available receipts**: You have an option to pick up any available receipts to which delivery quantity can be matched.

- **Find Delivery Details for Matching**: You can find the delivery lines for matching, by giving Organization, Order Type, Customer name, customer number, Delivery id or delivery detail id. Query can also be based on order number.

- **Automatic Matching**: A check box is provided to enable you to auto match all the delivery lines that satisfies the given inputs. This would match the selected delivery lines to the available receipts on a FIFO basis.

- **Unmatching**: You have an option of unmatching a delivery that is already matched provided the same is not yet shipped. This unmatch can be done for a full delivery or for a delivery detail line. On use of this feature, you can then split the delivery detail line into multiple lines, backorder the same, rectify wrong matching etc.

**Trading Sub inventory Location Set up**

The Sub inventories or Warehouses registered as Trading Warehouses are defined as 'Trading' Sub Inventory Locations.

India Local Inventory - Setup - Organization - SubInventory Locations

As a part of Localization setup, the sub-inventories need to be associated with Organization or Location combination. Excise related transactions and records would get updated only for those sub inventories, which are identified as TRADING for Trading organizations. By considering the transactions of a sub inventory, the check box for bonded/traded needs to be enabled.

India Local Inventory - Set up - Organizations - SubInventory Locations
### Field Description

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Header Level</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Organization</td>
<td>(Required)</td>
<td>PICK HELP</td>
<td>The inventory organization name and its respective Location will be selected by the User from the LOV.</td>
</tr>
<tr>
<td>Name/Location</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Line Level</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SubInventory</td>
<td>(Required)</td>
<td>PICK HELP</td>
<td>The User can select the Sub-inventory name from the LOV</td>
</tr>
<tr>
<td>Description</td>
<td>(Displayed)</td>
<td></td>
<td>The Description for the selected Sub-Inventory will be displayed here.</td>
</tr>
<tr>
<td>Bonded (Flag)</td>
<td>(Optional)</td>
<td>CHECK BOX</td>
<td>This field is Disabled for a Trading Organization and Location.</td>
</tr>
<tr>
<td>Trading Flag</td>
<td>(Required)</td>
<td>CHECK BOX</td>
<td>For all Sub-inventories in a Trading Organization/Location, this field shall be CHECKED by default.</td>
</tr>
</tbody>
</table>

### Trading Item Set Up

Items that are being used in a Trading Organization shall have specific Excise requirements. In order to meet these requirements, the Item shall be defined with the following flags in the India Items Classification screen.

- **Excise Flag** - 'YES'
- **Trading Flag** - 'YES'

The user can define templates, which can contain the item attributes that are common across many items.

These templates can be attached to multiple items at one go. This provides lot of flexibility to the user.

Optionally, the user can also define item attributes separately for an item.

### Shipment Register Set Up

The Trading Shipping transactions shall be controlled with the following Register types. The Shipping Order Types / Invoice Sources shall be assigned to the following Register
codes in the Trading Organization-Location from which the shipment takes place:

- Trading Domestic with Excise
- Trading Domestic without Excise
- Trading Export with Excise
- Trading Export without Excise

The Register types will be used to control the instances of RG23D register updation.

Transactions

Purchase Receipts / Returns

Purchase Receipts / Returns in a Trading Organization can be done in the same way as it is done in a manufacturing organization. If the Item is defined as Excisable and trading, the RG 23 D register shall be hit for the Receipts / Returns.

Based on the setup flag 'Excise in RG 23D ' in the Organization Additional Information Definition, the Excise amount on Receipt shall be debited to the RG23 D account or the Inventory account. By default, this flag is set to 'NO' and on delivery, if the Trading Organization is an Average Costing organization, the Inventory Cost shall contain the Excise Tax amount also. In the case of Standard Cost organizations, the Excise Tax amount shall be debited to the Purchase Price Variance account.

Shipment - Receipts Matching

In a Trading Organization each Shipment can be matched to the Purchasing Receipts so that the Excise Taxes could be passed on to the Customer. FIFO/LIFO method can be followed by the dealer while delivering the goods from the godown /store-room. The matching can be for shipment Lines or the Delivery itself.

Matching Receipts For Trading Item

This functionality is designed to support the excise related transactions for a trading organization/location. If the organization/location is registered under Central Excise rules as a Dealer of Depot, he can pass down the credit of duty involved in the goods with which he is trading. The trading organization needs to track the duty involved in excisable goods and the same need to be tracked at the time of receipt.

The excise duty tracked while receiving the goods in a trading organization can be allowed as CENVAT credit for its customers. Before confirming the shipment, the organization needs to allocate the excise duty involved at the time of receipt of the excisable goods. While shipping from the trading organization, the user need to track the exact amount of duty paid by the original manufacturer for passing down the credit under CENVAT procedures. This can be done through match receipt for trading item screen.

This Matching Receipts form provides the Information regarding available receipts.
from which the delivery quantity can be picked up. Once the receipt is matched then the Excise amount in the Fulfilled Order delivery lines will be replaced by the Excise amount from Receipt tax line for the respective delivery quantity.

It may be noted that the basic line price charged in a trading organization may be or may not be inclusive of the excise duty. If it is inclusive of excise duty, the excise duty matched through match receipt screen should not be accounted for the receivables. User needs to define adhoc taxes with excise type while creating the sales order and the taxes towards excise duty need to be maintained as zero in the sales order. On matching the exact excise duty will get updated as taxes. User need to take enough care not to attach any precedence logic to excise type of taxes in this type of set up.

On completion of ship confirmation from a trading organization, the RG 23 D register will get updated with the quantity matched.

Quantity matched could be unmatched before Shipment transaction is completed and the 'India - Excise Invoice Generation Program' is run. This shall take care of the Backordering scenarios and user mistakes while matching. However it is to be noted that unmatched is not allowed once the delivery is shipped and Excise invoice generations program is run.

In Oracle India Localization, navigate to the RG23 Register Entries India Localization window as follows:

India Local Order Management - Shipments - Trading (India) - Match Receipts

You can find out the receipts available for an item by querying through Find Customer Order Screen. The following are the fields in this Find Customer Order Screen.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match Type</td>
<td>(Required)</td>
<td></td>
<td>Match type field provides two options 'Match' or 'Unmatch'. Match shall be chosen for normal matching transactions and 'Unmatch' in cases where the already matched transaction needs to be reversed before the Shipment is made. Please note that the UNMATCH feature can not be used after completing the Shipment transaction.</td>
</tr>
<tr>
<td>Customer Name</td>
<td>(Optional)</td>
<td></td>
<td>Customer Name can be entered from the LOV.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------</td>
<td>--------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Customer Number</td>
<td>(Displayed)</td>
<td></td>
<td>Customer Number will be displayed here.</td>
</tr>
<tr>
<td>Delivery ID</td>
<td>(Optional)</td>
<td></td>
<td>Delivery ID may be entered by the user from LOV for which the matching of receipt is going to be done.</td>
</tr>
<tr>
<td>Delivery Detail ID</td>
<td>(Optional)</td>
<td></td>
<td>Delivery Detail ID may be entered by the user from LOV for which the matching of receipt is going to be done.</td>
</tr>
<tr>
<td>Order Number</td>
<td>(Required)</td>
<td>PICK HELP</td>
<td>Order Number must be entered by the user from LOV for which the matching of receipt is going to be done.</td>
</tr>
<tr>
<td>Line No</td>
<td>(Optional)</td>
<td></td>
<td>Line No. of an Order can be entered here.</td>
</tr>
<tr>
<td>Automatic Matching</td>
<td>(Optional)</td>
<td>Check</td>
<td>If this flag is checked, the system shall automatically match the Delivery detail lines with the available Receipts to the Subinventory based on a FIFO logic.</td>
</tr>
<tr>
<td>Clear</td>
<td>(Optional)</td>
<td></td>
<td>This button shall clear fields in the Find window.</td>
</tr>
</tbody>
</table>
Field Description | Type | Action | Description
--- | --- | --- | ---
Find / Auto / (Required) Unmatch |  |  | This button is used for directing the Transaction in 3 different action paths based on the values provided in the MATCH TYPE and 'AUTOMATIC MATCHING' fields:

If MATCH TYPE is MATCH and 'AUTOMATIC MATCHING' is UNCHECKED, the RG23 D Register Entries screen shall be opened for Delivery Detail level matching.

If MATCH TYPE is MATCH and 'AUTOMATIC MATCHING' is CHECKED, system shall match the Delivery lines against available Receipts on FIFO basis.

If MATCH TYPE is 'UNMATCH', the system shall rollback the matching previously done against the DELIVERY. Receipt for which the matching was done earlier shall again be available for matching for other deliveries. This feature is available only if the DELIVERY is NOT SHIPPED

After the above find screen, the cursor will be in the RG23D Register entries. Here the User has can match a respective receipt quantity in the following ways.

**Automatic Matching**

The System will automatically match the Receipt based on Matching method FIFO (First In First Out) or LIFO (Last In First Out).

**Manual Matching**

The User can manually match the Receipts quantity by moving the cursor to the respective receipts line. After matching receipts and save this screen, the User can view the Issue tax Lines in which Excise amount will be replaced by the Excise amount from Receipt tax line for the respective matched quantity.

RG23D Register entries Screen's field wise description and features are given for your ready reference.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header Level</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customer Name</td>
<td>(Displayed)</td>
<td></td>
<td>Customer Name will be displayed here.</td>
</tr>
<tr>
<td>Customer No</td>
<td>(Displayed)</td>
<td></td>
<td>Customer No will be displayed here.</td>
</tr>
<tr>
<td>Order Number</td>
<td>(Displayed)</td>
<td></td>
<td>Order Number will be displayed here.</td>
</tr>
<tr>
<td>Line No</td>
<td>(Displayed)</td>
<td></td>
<td>Line No. of an Order will be displayed here.</td>
</tr>
<tr>
<td>Sub-Inventory</td>
<td>(Displayed)</td>
<td></td>
<td>Sub-Inventory name will be displayed here.</td>
</tr>
<tr>
<td>Item</td>
<td>(Displayed)</td>
<td></td>
<td>Item in the respective line of an order will be displayed here.</td>
</tr>
<tr>
<td>Released Quantity</td>
<td>(Displayed)</td>
<td></td>
<td>Released quantity from an order will be displayed here.</td>
</tr>
<tr>
<td>Matched Quantity</td>
<td></td>
<td></td>
<td>Before matching this field will be blank and after matching this field will show the matched quantity.</td>
</tr>
<tr>
<td>UOM</td>
<td>Displayed)</td>
<td></td>
<td>UOM of an item will be displayed here.</td>
</tr>
<tr>
<td>Line level</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transaction Type</td>
<td>(Displayed)</td>
<td></td>
<td>Transaction type like Receipts and Return will be displayed here.</td>
</tr>
<tr>
<td>Supplier Invoice No.</td>
<td>(Displayed)</td>
<td></td>
<td>Supplier Invoice Number for a particular receipt will be displayed here.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Quantity in Receipt</td>
<td>UOM</td>
<td></td>
<td>UOM of the item in the Receipt line will be displayed here.</td>
</tr>
<tr>
<td>UOM</td>
<td>(Displayed)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Received</td>
<td>(Displayed)</td>
<td></td>
<td>Quantity received in a particular Receipt will be displayed here.</td>
</tr>
<tr>
<td>Available</td>
<td>(Displayed)</td>
<td></td>
<td>Available Quantity in a particular Receipt will be displayed here.</td>
</tr>
<tr>
<td>Apply</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quantity in Issue</td>
<td>UOM</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UOM</td>
<td>(Displayed)</td>
<td></td>
<td>UOM of the item in the Issue line will be displayed here.</td>
</tr>
<tr>
<td>Available</td>
<td>(Displayed)</td>
<td></td>
<td>Available Quantity in a particular Issue will be displayed here, this is equivalent to Available receipt quantity.</td>
</tr>
<tr>
<td>Apply</td>
<td>(Displayed)</td>
<td></td>
<td>This represents the match quantity.</td>
</tr>
<tr>
<td>Receipt Number</td>
<td>(Displayed)</td>
<td></td>
<td>Receipt Number will be displayed here.</td>
</tr>
<tr>
<td>Receipt Date</td>
<td>(Displayed)</td>
<td></td>
<td>Receipt Date will be displayed here.</td>
</tr>
<tr>
<td>BOE Number</td>
<td>(Displayed)</td>
<td></td>
<td>BOE Number will be displayed here in the case of Imported Receipt.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------------</td>
<td>--------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>Vendor</td>
<td>(Displayed)</td>
<td></td>
<td>Vendor Name will be displayed here.</td>
</tr>
<tr>
<td>Duty Per Unit</td>
<td>(Displayed)</td>
<td></td>
<td>Excise Duty per unit as per receipt line will be displayed here.</td>
</tr>
</tbody>
</table>

**Issue Tax Button**

Through this button, the User can view the Issue Tax lines after saving the Matching Screen wherein Excise amount will be replaced by the Excise amount from Receipt tax line for the respective matched quantity.

User will be able to view the matched excise duty in this receipt. The actual zero adhoc excise duty attached in the sales order will be over written with the matched excise amount.

**View Receipt Button**

Through this button the user can view all matched orders against a particular Receipt.

**Unmatching**

The User can do un-matching of receipts by entering Zero quantity in the Apply column, then the Available Receipt quantity will be reinstated. (Please note that this feature is available only before saving and closing the form. In order to unmatch already saved transactions, use the UNMATCH feature provided in the Find window).

**View RG 23 D Screen**

After Fulfilled Orders Delivery, the User can view the Issue transactions through Manual RG 23D, then the User can Run AR interface and Auto Invoice in Receivables Modules to generate Invoices.

**Unmatching Receipts - For Trading Item**

This functionality is specifically provided to rectify user errors at time of Matching of receipts. However such delivery can be unmatched only if the same is not shipped. Unmatch of Shipped deliveries is not possible as tax impact is already over.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match Type</td>
<td>(Required)</td>
<td>PICK</td>
<td>This is an LOV showing options of Match &amp; Unmatch</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Organization</td>
<td>(Required)</td>
<td>PICK</td>
<td>This shows a list of Trading Organizations based on Localization setup</td>
</tr>
<tr>
<td>Order Type</td>
<td>(Required)</td>
<td>PICK</td>
<td>This shows a list of Order Types that are available.</td>
</tr>
<tr>
<td>Delivery ID</td>
<td>(Optional)</td>
<td></td>
<td>Delivery ID may be entered by the user from LOV for which the matching of receipt is already done but not shipped.</td>
</tr>
<tr>
<td>Delivery Detail ID</td>
<td>(Optional)</td>
<td></td>
<td>Delivery Detail ID may be entered by the user from LOV for which the matching of receipt is done but not shipped. Leaving this blank will result in un-matching of all lines pertaining to the given delivery.</td>
</tr>
</tbody>
</table>

**Manual RG 23 D Entry**

RG 23D Manual Entry is a view / entry form that can be used to view/enter the Manual RG 23D transaction. It displays on query all the transactions that have an entry in the RG 23 D register sorted on the Year & Serial Number. Each Trading inventory organization is considered as Excise Unit. Thus, you need to specify the Organization Name and Location both for querying & for making manual entries into the register. Querying can be done based on certain fields on the Entry Block and also Transaction Details block.

The Remarks column is editable for all the transactions & can be effectively used for recording any comment to be made against specific Transactions.

India Local Order Management Setup Registers Manual RG23D Register Entry

The field wise description for the screen is given below.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>Required</td>
<td>PICK HELP</td>
<td>The User needs to enter Trading inventory organization name from the LOV for which he wants view the RG23D entries.</td>
</tr>
<tr>
<td>Location</td>
<td>(Required)</td>
<td>PICK HELP</td>
<td>The User needs to enter Location for the above Trading inventory organization from the LOV for which he wants view the RG23D entries.</td>
</tr>
<tr>
<td>Transaction Type</td>
<td>(Required)</td>
<td>PICK HELP</td>
<td>The User needs to specify the transaction type like Receipts, Return to Vendor, Issue, Return for which he wants view the RG23D entries.</td>
</tr>
<tr>
<td>Item</td>
<td>(Required)</td>
<td>PICK HELP</td>
<td>The User needs to specify the Item for which he wants view the RG23D entries.</td>
</tr>
<tr>
<td>Line Level</td>
<td></td>
<td></td>
<td>The following information will be displayed for a entered receipts for selected item in a Trading Organization Location.</td>
</tr>
<tr>
<td>SL.No</td>
<td>(Displayed)</td>
<td></td>
<td>System generated Serial Number will be displayed here.</td>
</tr>
<tr>
<td>Comm. Invoice Number</td>
<td>(Displayed)</td>
<td></td>
<td>Excise Invoice Number of the Supplier entered in the Receipt lines will be displayed here.</td>
</tr>
<tr>
<td>Date</td>
<td>(Displayed)</td>
<td></td>
<td>Date of the above Excise Invoice of the Supplier will be displayed here.</td>
</tr>
<tr>
<td>Bill of Entry Number</td>
<td>(Displayed)</td>
<td></td>
<td>Bill of Entry number for Import receipts will be displayed here.</td>
</tr>
<tr>
<td>Supplier Name</td>
<td>(Displayed)</td>
<td></td>
<td>Name of the Supplier will be displayed here.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Type</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------</td>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Supplier Address</td>
<td>(Displayed)</td>
<td></td>
<td>Supplier Address (Pay Site) will be displayed here.</td>
</tr>
<tr>
<td>Transaction Quantity</td>
<td>(Displayed)</td>
<td></td>
<td>Quantity in the transaction UOM will be displayed here.</td>
</tr>
<tr>
<td>Transaction UOM</td>
<td>(Displayed)</td>
<td></td>
<td>Transaction UOM will be displayed here.</td>
</tr>
<tr>
<td>Quantity Received</td>
<td>(Displayed)</td>
<td></td>
<td>Quantity transacted in Primary UOM will be displayed here.</td>
</tr>
<tr>
<td>Primary UOM</td>
<td>(Displayed)</td>
<td></td>
<td>Primary UOM of the transacted item will be displayed here.</td>
</tr>
<tr>
<td>Rate of Duty</td>
<td>(Displayed)</td>
<td></td>
<td>Rate of Duty will be displayed here.</td>
</tr>
<tr>
<td>Duty per Unit</td>
<td>(Displayed)</td>
<td></td>
<td>Excise Duty per unit for a particular receipt will be calculated and displayed here. This is allowed to be changed for a receipt if the same has not been matched to any delivery.</td>
</tr>
<tr>
<td>Total Duty Amount</td>
<td>(Displayed)</td>
<td></td>
<td>Total Excise Duty amount for a receipt will be displayed here. This will get recalculated if there is a change in Duty per Unit for an unmatched receipt.</td>
</tr>
<tr>
<td>Balance quantity</td>
<td>(Displayed)</td>
<td></td>
<td>Balance available quantity after a particular receipts will be displayed here.</td>
</tr>
<tr>
<td>Remarks</td>
<td>(Optional/Enterable)</td>
<td></td>
<td>Remarks regarding a transaction can be entered here.</td>
</tr>
</tbody>
</table>

**Note:** You can view the GL drilldown accounting entries using the Show transactions button on the Tools menu of the Manual Entry form.
**Reports**

**RG23D Register Report**

This Report gives the complete details of RG23 D Register as per Central Excise Act, for an Item.

**Report Submission**

Use the Request Reports others (OE & AR modules) form and enter India-RG23 D Report in the Name field to submit the report.

**Organization (Required, Default) PICK HELP**

Enter A Organization, you wish to take the RG 23D Register Report for.

**Location (Required, Default) PICK HELP**

Enter a Location, you wish to take the RG 23D Register Report for.

**Transaction From/To Date PICK HELP**

India Localization allows the user to print selectively the transactions from a given date onwards.

**Inventory Item (Optional) PICK HELP**

Enter a specific Item for which you want to take RG 23D, otherwise Report for all the items will taken.

**Report Headings**

Report headings provide you with general information about the contents of the report. Oracle lists information as given in the report format of RG RG23D Registers.

**Column Headings**

In the Receipt side

**S.No**

Serial Number for an Item in the Register will be reported

**Supplier Invoice and BOE No.**

Supplier Invoice (Excise Invoice) will be displayed here. If the Receipt is Import one, then BOE Number for the Receipt will also be reported

**Name and Address of the Supplier**

Name and address of the supplier and his Excise Registration details will be reported

**Quantity**

Receipt Quantity will be reported

**Rate of Duty**

excise_duty_rate will be reported
Amount of duty per amount
Excise Duty per Unit will be reported

Total Amount of duty
Total amount of Excise duty on receipt will be reported

In the Issue side

Name and Address of the Customer (Consignee)
Name and address of the Customer if he is a consignee will be reported here and his Excise Registration details will also be reported.

Name and Address of the Customer
Name and address of the Customer (Other than consignee) will be reported here and his Excise Registration details will also be reported.

Quantity
Issue Quantity will be reported

Amount of duty per amount
Excise Duty per Unit will be reported

Total Amount of duty
Total amount of Excise duty on receipt will be reported

Balance Quantity
Balance Quantity for an Item at the end of the report date will be displayed.

Quantity Remaining / Matched
Against a Receipt entry, the values of quantity available for matching against the particular receipt and quantity already matched shall be shown in this column.
India Local Projects

Projects Costing

Oracle Project Costing records and reports cost against a Project; and integrates with other Oracle E-Business Suite, including Oracle Purchasing, Oracle Payables, Oracle Inventory, Oracle Assets and Oracle General Ledger to account for costs. Costs reflected for a project may flow from different modules like Oracle Purchasing and Oracle Payables. These costs shown in Projects include non-recoverable portion of the India Localization taxes. There are two dimensions to the information reflected in Oracle Projects costing with respect to Purchasing and Payables Module.

- Commitments
- Actual Costs

Solution Flow

Non recoverable Financials For India Taxes in Projects Commitments

1. Enter Requisition/Purchase Order with Project Related Information. Taxes default and get calculated based on IL tax setups. There is no change in the tax defaulting hierarchy provided by India Localization.

2. You can view taxes by clicking Taxes on the localization Purchase Order. Non-recoverable taxes are indicated by the Modvat Flag. An unchecked Modvat Flag indicates a non-recoverable tax. Further, the destination type of the receipt also determines recoverability.

3. Approve the Purchase Order.

4. Run the PRC: Update Project Summary Amounts for a Single Project concurrent to view the commitments created in the Oracle Projects Module. Commitments in Project Status Inquiry form include the NonRecoverable tax component. The
Projects cost reflected in Project Raw Cost and Project Burdened Cost column are inclusive of Item cost, and Financials for India Non Recoverable Taxes.

**Note:** Commitments view in projects also gets updated with Financials for India Non recoverable taxes in case of Supplier invoices matched to Purchase order, prior to interface to Projects. In this case the tax lines appear as individual lines on the Project status inquiry form.

---

### Non-Recoverable Financials for India Taxes in Projects Costs

Costs Interfaced from Receipt or Invoice would be sent in as separate lines for the Item cost and Non-recoverable tax component to Projects.

1. Enter Purchase Order with Project Related Information.
2. Enter Receipt for the Purchase Order. You can view taxes by clicking Taxes on the localization receipt form.
3. Non-recoverable taxes are indicated by way of the "Recoverable Flag" checkbox. Further, as the destination type of this receipt is EXPENSE even the Central Excise taxes are considered as non-recoverable as per the India Localization functionality. Central Excise type of taxes is considered as recoverable only for Capital goods when the destination type is EXPENSE. All the receipts to destination type RECEIVING and INVENTORY are part of the Project Manufacturing transaction flow and not the Project Costing transaction flow.
4. Run the PRC: Interface Supplier Costs concurrent to import the actual costs from Oracle Purchasing or Oracle Payables module to in the Oracle Projects module.
5. On querying for the receipt in expenditure inquiry you would see the item cost as a separate line and the total of all non-recoverable financials for India tax amounts on the receipt as a separate line.

**Note:** Project costs include Financials for India Non recoverable taxes interfaced from Supplier invoices matched to Purchase order/Receipt. In this case each non-recoverable tax line appears as individual lines on the Expenditure inquiry form.

---

### Integrating with Purchasing

When you enter project-related transactions in Oracle Purchasing, you only need to enter project information on the source document; either the requisition or the purchase order. When you create purchase orders from requisitions using Oracle Purchasing AutoCreate feature, the project information from the requisition is copied to the
purchase order. India Localization taxes on the purchase document will be appropriately considered as Commitment Costs and Actual Costs in projects. The process below describes how each purchase document is handled in integration with India Localization taxes:

1. **Enter Requisitions**

   Enter project-related purchase requisitions using the Requisitions window in Oracle Purchasing. Enter default project information in the Requisitions Preferences window in the Project Information tab. This default information will be used to populate requisition distribution lines you create during your current session.

   The requisitions distribution line has a Project tab to enter project-related information. A requisition can have a combination of project-related and non-project-related distribution lines.

   India Localization taxes will default on the requisition based on its 3-Way tax defaulting mechanism. Non-recoverable taxes for project related distribution lines will be included in the commitment amount for the Project.

2. **Using AutoCreate**

   When you automatically create purchase orders from project-related requisitions in the AutoCreate Documents window, Oracle Purchasing copies the project information and accounting information from the requisition to the purchase order. You do not need to enter any additional project-related information on your purchase order when you use this feature. For further information, see: AutoCreate Documents Overview, Oracle Purchasing User’s Guide.

   You can change the project information on the purchase order that was copied from the requisition; the project information on the requisition is not updated.

   India Localization taxes will be copied from the requisition to the Purchase Order or taxes are redefaulted in the Purchase Order. Non-recoverable taxes for project related distribution lines would be included in the commitment amount for the Project. If the project information is changed from Requisition to Purchase Order, India Localization non-recoverable taxes will be included in the respective project as Commitment cost.

3. **Enter Purchase Orders**

   If your company does not use online requisitions or the AutoCreate feature, enter project-related information directly on your standard purchase orders using the Purchase Orders screen in Oracle Purchasing.

   When you use this window, you specify project-related information in the Project tabbed region of the distribution line. Based on the project-related information entered, the account information will be automatically created by the Account Generator. For further information, see: Overview of Purchase Orders, Oracle Purchasing User’s Guide.

   India Localization taxes will default on the Purchase Order based on its 3-Way tax
defaulting mechanism. Non-recoverable taxes for project related distribution lines will be included in the commitment amount for the Project.

4. **Enter Releases**

Enter project-related releases against blanket purchase agreements and planned purchase orders using the Enter Releases window in Oracle Purchasing. Specify if the release distribution line is project-related. If it is project-related, you continue to enter project information for the line. See: Entering Release Headers, Oracle Purchasing User’s Guide.

India Localization taxes will default on the Blanket Purchase Agreement and Planned Purchase Order based on its 3-Way tax defaulting mechanism. Non-recoverable taxes for project related distribution lines will be included in the commitment amount for the Project.

5. **Recording Receipts and Delivery**

You can track receipt and delivery of goods for project-related purchase orders using the Receipts window in Oracle Purchasing. You can report the delivery of purchased goods in your commitment reporting. Oracle Purchasing does not record the received goods as delivered for your project until the goods are delivered and assigned to a purchase order distribution line. See: Overview of Receipts, Oracle Purchasing User’s Guide.

When a purchase order line is flagged to accrue on receipt and the purchased goods are delivered to an expense destination, you can interface receipt accrual accounting entries from Oracle Purchasing to Oracle Projects as actual transactions. This allows you to recognize the cost to your project in the period in which it is incurred rather than in the period in which it is invoiced. For more information, see: Overview of Receipt Accounting, Oracle Purchasing User’s Guide, and Interface Supplier Costs, Oracle Projects Fundamentals.

India Localization taxes on receipts are derived from the Purchase Orders. User has the ability to modify the defaulted taxes at the time of making the receipt. You can add, delete or modify taxes on the receipts. Further, user can modify amounts of adhoc taxes as well. While interfacing costs from receipts to projects, India Localization non-recoverable taxes on receipts are also interfaced as actual cost transactions.

**Note:** Since the receipt is made to an expense destination, India Localization functionality considers recoverable Central Excise taxes (other than taxes on Capital Goods) as non-recoverable.

**Requisition Adjustments**

You can update project information on a requisition. If the requisition is included on a purchase order before you update the project information, the purchase order is not
updated with the new project information. If the requisition line is included on a new purchase order after you change the project information, Oracle Purchasing copies the new project information to the new purchase order.

The Account Generator builds a new account number value when you change the project information. The new project information is used in commitment reporting.

India Localization taxes will be included as commitment cost in the appropriate projects.

**Purchase Order Adjustments**

You can update project information on a purchase order, even after it is approved and invoiced. However, you cannot update project information if there has been any accounting activity on the purchase order (for example, if it is encumbered, or if it is accrued on receipt and the distribution has been received or billed). If the purchase order is invoiced before you update the project information, the invoice is not updated with the new project information. If the purchase order line is invoiced on a new invoice after you change the project information, Oracle Payables copies the new project information to the new invoice.

The Account Generator builds a new account number when you change the project information. The new project information is used in commitment reporting.

India Localization taxes will be included as commitment cost in the appropriate projects.

**Integrating with Payables**

When you match an invoice to a purchase order or receipt in Oracle Payables, the project information from the purchase order or receipt is copied to the invoice. When you enter new project-related invoices in Oracle Payables, you only need to enter project information on the source document, the invoice. If you use distribution sets with project information, Oracle Payables automatically supplies project information for your supplier invoice distribution lines.

**Matching Invoices**

If you use Oracle Purchasing and have already associated project-related information to a purchase order, and you are matching an invoice to a purchase order or receipt using the Invoices windows instead of manually creating invoice distribution lines, Oracle Payables automatically copies the project information from the purchase order or receipt to the invoice.

**Note:** You cannot change the project information that is copied from the purchase order to the invoice.

India Localization Taxes on Payables Invoice are interfaced based on matching to either Receipt or Purchase Order. In case of non-recoverable India Localization taxes, the
Projects details will be copied from the parent Item line in the Invoice Distributions. These non-recoverable taxes will be interfaced to Project Costing module as separate cost lines. From India Localization perspective, you must ensure the following:

- When a receipt is made, Payables invoice should always be matched to the receipt.
- When a receipt is made for the Purchase Order, the receipt should be interfaced to Project Costing module as Supplier Cost and not the Supplier Payables Invoice (this is controlled by way of parameter to concurrent program – PRC: Interface Supplier Costs to Projects.
- Third party taxes on receipts are not interfaced to Payables Invoice. To interface third party taxes (non-recoverable) to Project Costing, receipts should be interfaced to Project Costing module as Supplier Cost.
- Customs taxes on receipts are not interfaced to Payables Invoice. To interface Customs taxes (non-recoverable) to Project Costing, receipts should be interfaced to Project Costing module as Supplier Cost.

**Entering Invoices**

You can enter project-related invoices directly in the Invoices windows in Oracle Payables. You can enter project-related information in the Invoices window, which will default to all distributions you enter for the invoice. These values can be overridden. You also enter project-related information in the Distributions window. You can create a folder with project-related fields to be used for entering information. An invoice can have both project-related and non-project-related distribution lines. See: Entering Invoices Overview, Oracle Payables User Guide.

**Note:** You can also import through the Payables Open Interface tables projects-related invoices from the Invoice Gateway and other systems.

Currently, India Localization does not support taxes to be entered on Payables Invoices directly. Users should use Purchase Order or Receipt matched Payables Invoices for the transactions.

**Supplier Invoice Adjustments in Payables**

You can perform supplier invoice adjustments in Oracle Payables at any stage in the process flow.

**Adjusting project information for matched invoices**

If you have matched an invoice to a purchase order, you cannot directly change any of the project information copied from the purchase order. You may encounter cases in which you want to change the project information; in particular, you may want to change the expenditure item date that was copied from the purchase order, because the expenditure item date on the purchase order was not maintained.
If you want to change the project information in this case, there are two ways of making the change.

You can reverse the matching distribution line from the purchase order in the Distributions window in Oracle Payables, change the purchase order project information in Oracle Purchasing, and match the invoice to the purchase order again.

India Localization tax distributions (for non-recoverable) tax, derive the project information from the parent line distribution. If you wish to make any changes in the project information for parent distribution, please make sure that similar adjustment is carried out on the related India Localization tax distribution in order to achieve correct project cost.

Adjusting manually entered, unposted invoices

You can directly change any or all of the project information before an invoice is posted. The Account Generator derives a new account number based on the new project information that you enter. India Localization does not support taxes on manually entered payables invoices.

Adjusting manually entered, posted invoices

You cannot directly change any project information on a posted invoice. You must reverse the distribution line and create a new distribution line with the new project information using the Distributions window in Oracle Payables. India Localization does not support taxes on manually entered Payables invoices.

Interfacing Adjustment Lines to Oracle Projects

If the original invoice distribution line that was reversed was not yet interfaced to Oracle Projects, the Interface Supplier Invoices from Payables process does not interface the original or reversing items that are included on the same invoice, to Oracle Projects. These items are marked as net zero adjustment lines that are not to be interfaced to Oracle Projects. The new line with the correct project information is interfaced to Oracle Projects.

India Localization tax distribution (for non-recoverable tax) derives the project information from the parent line distribution. If you wish to make any changes in the project information for parent distribution, please make sure that similar adjustment is carried out on the related India Localization tax distribution to achieve correct project cost.

Supplier Invoice Adjustments in Oracle Projects

You can perform the following adjustments for supplier invoices in Oracle Projects:

- Transfer between projects/tasks
- Split expenditure item
- Adjust supplier invoice expenditure items
• Enter a miscellaneous pre-approved expenditure item to adjust the related discount amounts
• Reclassify item as billable or non-billable
• Reclassify item as capitalizable or non-capitalizable
• Edit comment
• Hold or Release from Billing

Project users can perform these adjustments in Oracle Projects because the actions do not change the amount of the invoice that is processed in Oracle Payables. These adjustment actions change the project information of the supplier invoice item, which is used in Oracle Projects processing.

After you have made adjustments to supplier invoice items, you must send the adjustment information back to Oracle Payables so the Payables distribution lines match what is recorded in Oracle Projects. Oracle Payables will interface adjustments that affect the GL account number to Oracle General Ledger. You run the following processes in Oracle Projects for supplier invoice adjustments:

• PRC: Distribute Supplier Invoice Adjustment Costs
• PRC: Interface Supplier Invoice Adjustment Costs to Payables

If you need to change the invoice amount, supplier, or expenditure type, organization, or item date for a supplier invoice line, reverse the line and create a new line in Oracle Payables. For further information, see: Adjusting Project Information for Matched Invoices, Oracle Projects User's Guide.

Restrictions to Supplier Costs Adjustments

Adjustments to supplier costs in Oracle Projects must adhere to the specific business rules for supplier invoices and receipt accruals.

Supplier Invoices

When Projects is integrated with Payables, you cannot adjust supplier invoices (either in Oracle Projects or in Oracle Payables) if the invoice is:

• **Cancelled**: When you cancel an invoice in Payables, reversing distribution lines are created for each distribution line, and the invoice amount is set to zero. The invoice status is set to Cancelled, and its distribution lines are posted to GL the next time the Transfer to General Ledger program is run in Payables. When an invoice has a status of Cancelled, it cannot be adjusted.

• **Paid**: If any of the following conditions apply:
  • The Payables setup option Allow Adjustments to Paid Invoices is disabled.
Oracle Payables provides a system-level control to prevent users from adjusting paid invoices. If you want to allow adjustments to paid invoices, enable the Allow Adjustments to Paid Invoices setup option in the Payables Options window.

- You are using the Prorate Expense or Prorate Tax discount distribution method. Oracle Payables does not allow adjustments to paid invoices if a prorated discount distribution method is used.

- You are using cash basis accounting.

- Prepaid, either fully or partially.

- Selected for payment.

**Note:** You cannot adjust an invoice selected for payment until the Confirm Payment Batch action has been performed.

**Receipt Accruals**

You cannot adjust the item in Oracle Projects when the item is interfaced from Oracle Purchasing. If the invoice is matched to accrue on receipt purchase order line and the invoice line (rather than the purchase order receipt) is interfaced, then the invoice line can be adjusted in Oracle Projects.

India Localization tax distributions are interfaced to Project Costing module as separate expenditure line items. User should not make any modifications to these expenditure lines and interface them back to Oracle Payables module.

**Integrating with Inventory**

You can perform inventory transactions related to projects – such as Issue to Projects, Issue from Projects etc. This is achieved by checking the "Project" check box at the time of defining User Inventory Transaction Types. These Inventory transactions related to Projects are also considered for appropriate quantity register update as per India Localization functionality. For e.g. Issue to Project inventory transaction for a raw material item will update the RG 23 Part I register, Issue to Project inventory transaction for a finished good item will update the RG I register.

**India Local Projects Billing**

This section provides an overview and details of each step involved in completion of setups required for India Localization support for Project Billing solution.

• Tax Defaults and Preferences setup

Setting Up Projects Billing Tax Defaults and Preferences

This setup determines the tax defaulting hierarchy to be used for defaulting tax categories on Projects related invoices. You can define tax defaulting hierarchy for each Distribution Rule used in Oracle Project Billing. Within the Distribution Rule, you can define tax defaulting hierarchy for Event Type, Project, Expenditure Type and Customer or Customer Site.

Tax defaults and preferences for Project Billing is setup in a new user interface called Tax Defaults. To access it, login with India Local Project Billing responsibility and navigate to India Local Tax Setup under Setup.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferences Tab</td>
<td>Use this tab region to define the tax defaulting hierarchy preference for Distribution Rule and Context Name.</td>
</tr>
<tr>
<td>Distribution Rule</td>
<td>Display the distribution rules as per Project Billing Setup.</td>
</tr>
<tr>
<td>Context Name</td>
<td>Display the following context names:</td>
</tr>
<tr>
<td></td>
<td>• Event Type</td>
</tr>
<tr>
<td></td>
<td>• Project</td>
</tr>
<tr>
<td></td>
<td>• Expenditure Type</td>
</tr>
<tr>
<td></td>
<td>• Customer/Site</td>
</tr>
<tr>
<td></td>
<td>Define the preference number for each of the context name. This preference number will determine the hierarchy of tax defaulting to be used.</td>
</tr>
</tbody>
</table>
**Field Description** | **Description**
--- | ---
Preferences | Enter Preference number. You can enter any unique number for a combination of Distribution Rule and Context Name. This preference number will determine the tax defaulting hierarchy.

For instance, consider the following setup:

- Event Type = 1
- Project = 2
- Expenditure Type = 3
- Customer/Site = 4

Tax Category defined in the Context Tab Region of the form for the Event Type in the invoice will take highest precedence for tax defaulting. If the tax category is not setup for Event Type, then the tax category at the Project level will be defaulted in the invoice.

**Header Section**

**Contexts Tab** | Use this tab region to define the tax categories to be used for each of these context names:
--- | ---
- Event Type
- Project
- Expenditure Type
- Customer/Site
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Context Name</td>
<td>• Event Type&lt;br&gt;• Project&lt;br&gt;• Expenditure Type&lt;br&gt;• Customer/Site&lt;br&gt;You can enter the above context names and query all the context values in the lines section.</td>
</tr>
<tr>
<td>Default Context Name</td>
<td>Use this Default button to query the default context name.</td>
</tr>
<tr>
<td>Tax Category</td>
<td>LoV contains all the defined tax categories.</td>
</tr>
<tr>
<td>Default Tax Category</td>
<td>If you select this radio button the Tax Category will be assigned to all the context values in the lines section where the tax category is empty. This will not override the current tax categories for any of the context values.</td>
</tr>
<tr>
<td>All, Override All Tax Categories</td>
<td>If you select this radio button the Tax Category will be assigned to all the context values in the lines section. This will override the current tax categories for any of the context values.</td>
</tr>
<tr>
<td>Lines Section</td>
<td></td>
</tr>
<tr>
<td>Context Name</td>
<td>• Event Type&lt;br&gt;• Project&lt;br&gt;• Expenditure Type&lt;br&gt;• Customer/Site&lt;br&gt;Pick the appropriate context name for which you want to assign a tax category.</td>
</tr>
</tbody>
</table>
Enter events or expenditures and distribute costs in Oracle Projects

For related information, see: Expenditures, Oracle Project Costing User Guide.

Generate draft revenue

Generate draft revenue wherever required. For more information, see: Processing Adjustments, Oracle Project Costing User Guide.

Generate Draft Invoices

Generate draft invoice using the Oracle Projects Billing concurrent program:

- PRC: Generate Draft Invoices for Single Project, or

- PRC: Generate Draft Invoices for Multiple Projects

This process will calculate and default India taxes on the India Draft Invoice Screen. The tax defaulting will take place based on the setup created. See Setting Up Projects Billing Tax Defaults and Preferences, for further information.

Invoice - India screen can be viewed from a separate menu option or from View > Zoom on the base Projects draft invoice screen. Login with India Local Projects Billing.
responsibility and navigate to Oracle Projects > Billing > Invoice Review > Find Invoices > Invoice Summary > Tools > India Invoice. In the Find Invoices screen, query your required invoices.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Projects Region</td>
<td></td>
</tr>
<tr>
<td>Project Number</td>
<td>Enter the project number by which you want to query the invoices.</td>
</tr>
<tr>
<td>Project Name</td>
<td>Enter the project name by which you want to query the invoices.</td>
</tr>
<tr>
<td>Invoices Region</td>
<td></td>
</tr>
<tr>
<td>Invoice Number</td>
<td>Enter the invoice number by which you want to query the invoices.</td>
</tr>
<tr>
<td>Invoice Status</td>
<td>Enter the invoice status by which you want to query the invoices.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>Enter the creation date by which you want to query the invoices.</td>
</tr>
</tbody>
</table>

| Customers         |             |
| Customer Number   | Enter the customer number by which you want to query the invoices. |
| Customer Name     | Enter the customer name by which you want to query the invoices. |

Based on the selected query criteria the invoices will be queried and displayed in the Invoice Review screen.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft Invoice Area</td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>Displays the invoice number.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Status</td>
<td>Displays the invoice status.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>Displays the invoice creation date.</td>
</tr>
<tr>
<td>Customer Area</td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>Displays the customer number related to the invoice.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the customer name related to the invoice.</td>
</tr>
<tr>
<td>Amount</td>
<td>Displays the invoice amount.</td>
</tr>
<tr>
<td>Tax Amount</td>
<td>Displays the invoice tax amount.</td>
</tr>
<tr>
<td>Currency</td>
<td>Displays the invoice currency.</td>
</tr>
<tr>
<td>Taxes</td>
<td>Indicate if there is any tax defaulted for this invoice.</td>
</tr>
</tbody>
</table>

Click Lines to display the invoice lines.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoice Region</td>
<td></td>
</tr>
<tr>
<td>Draft Invoice</td>
<td>Displays the Invoice number.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>Displays the creation date for the Invoice.</td>
</tr>
<tr>
<td>Invoice Status</td>
<td>Displays the invoice status for the Invoice.</td>
</tr>
<tr>
<td>Amount</td>
<td>Displays the invoice amount for the Invoice.</td>
</tr>
<tr>
<td>Tax Amount</td>
<td>Displays the tax amount for the Invoice.</td>
</tr>
<tr>
<td>Currency</td>
<td>Displays the currency for the Invoice.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Project Name</td>
<td>Displays the Project name for the Invoice.</td>
</tr>
<tr>
<td>Project Number</td>
<td>Displays the Project number for the Invoice.</td>
</tr>
<tr>
<td>Customer Name</td>
<td>Displays the Customer name for the Invoice.</td>
</tr>
<tr>
<td>Customer Number</td>
<td>Displays the Customer number for the Invoice.</td>
</tr>
<tr>
<td>Organization</td>
<td>Select the Inventory Organization for which you wish to update the Central Excise and Value Added Tax Registers.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Selecting Inventory Organization and Location is mandatory in this form. Organization and Location selected here will be used for updating the Central Excise and Value Added Tax registers. User will not be able to close this form unless Inventory Organization and Location is selected.</td>
</tr>
<tr>
<td>Location</td>
<td>Select the Location related to the Inventory Organization for which you wish to update the Central Excise and Value Added Tax Registers.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Selecting Inventory Organization and Location is mandatory in this form. Organization and Location selected here will be used for updating the Central Excise and Value Added Tax registers. User will not be able to close this form unless Inventory Organization and Location is selected.</td>
</tr>
<tr>
<td>Field Description</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Register details Region</td>
<td>Register Details Region will not display any values until the Projects Invoice is released. Draft Invoice generated in projects, this invoice is approved. User can modify any tax details after approval of the invoice as well. All the tax details will be frozen once the Invoice is released. Release of Invoice will also generate Excise and VAT Invoices. This will perform Central Excise and VAT Accounting and update the respective Central Excise Register and VAT repository as well. <strong>Note:</strong> Project Invoices do not have any link to items. Hence the quantity registers will not be updated. You should make manual entries for the required quantity register updates.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excise Invoice</td>
<td>Displays the excise invoice number generated related to this Project Invoice.</td>
</tr>
<tr>
<td>Excise Invoice Date</td>
<td>Displays the excise invoice date related to this Project Invoice.</td>
</tr>
<tr>
<td>Excise Register</td>
<td>Displays the excise register updated related to this Project Invoice. This register relates to the utilization of excise.</td>
</tr>
<tr>
<td>VAT Invoice</td>
<td>Displays the VAT invoice number generated related to this Project Invoice.</td>
</tr>
<tr>
<td>VAT Invoice Date</td>
<td>Displays the VAT invoice date related to this Project Invoice.</td>
</tr>
</tbody>
</table>

**Lines Section**

Field Name

- Tax Category
- Service Type

You can use this option to default the tax category on the invoice lines.
<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Value</td>
<td>LOV contains the values of tax category or service type, based on the Field Name selected.</td>
</tr>
<tr>
<td>Default for all the record</td>
<td>If you select this check box, then the default values are inserted for all the lines. If you leave this check box unchecked, then values are inserted only for those lines where the values are NULL.</td>
</tr>
<tr>
<td>Default</td>
<td>Use this button to default the values of Tax Category or Service Type based on Field Name selected.</td>
</tr>
<tr>
<td>Line Number</td>
<td>Displays the line number for the invoice line.</td>
</tr>
<tr>
<td>Description</td>
<td>Displays the description for the invoice line.</td>
</tr>
<tr>
<td>Line Amount</td>
<td>Displays the line amount for the invoice line.</td>
</tr>
<tr>
<td>Tax Amount</td>
<td>Displays the line tax amount for the invoice line.</td>
</tr>
<tr>
<td>Tax Category</td>
<td>Select a tax category here. This will override the tax category defaulted for the invoice line.</td>
</tr>
<tr>
<td>Service Type</td>
<td>Select the Service Type to be used for the invoice line.</td>
</tr>
</tbody>
</table>

Click Taxes to view taxes for the line.

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header Section</td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>Displays Projects as default value.</td>
</tr>
<tr>
<td>Document Type</td>
<td>Displays PROJECT_DRAFT_INVOICE as default value.</td>
</tr>
</tbody>
</table>
Document Number Displays Document Number.

Document Line Number Displays Document Line number.

Line Amount Displays the Line amount.

Lines Section

Line No Displays Tax Line number.

Tax Name Delete the tax line. You can also add a tax line by clicking on the next line.

Tax Type Displays Tax Type related to the line.

Precedences 1-10 Displays the precedences (from 1 to 10) for this tax line.

Tax Rate Displays Tax Rate for this tax line.

UOM Displays UOM for this tax line, only if the tax is UOM based.

Qty Rate Enter the quantity rate for this tax line. This will display only if the tax is UOM based.

Tax Amount Displays Tax Amount for this tax line.

**Note:** You can view the GL Drilldown Accounting lines by clicking the Show Transactions button on the Tools menu in Invoice Review India Localization form.

The Invoice - India form with localization tax details can also be viewed from the Tools special menu option on the Oracle Project Billing Invoice Review form.

Approve and release the invoice so that the invoice can be imported into Oracle Receivables.

**Note:** Once the invoice is released, none of the tax information can be modified.

Run the PRC: Interface Invoices to Receivables process to interface the invoices to Oracle Receivables and run AutoInvoice program to import the invoice into Oracle.
Receivables.

You must run the India - Import Projects Taxes to Receivables program to import India Localization taxes to Oracle Receivables. You can view the India Local taxes in Transactions Localized form after running the program.

Service Tax repository updates take place after performing these steps:

1. Apply receipt to the projects invoice with service taxes in Receivables (after running the India Import Project Taxes to Receivables.)

2. Run the India Service tax processing concurrent program.

Run the tie back to receivables process of Oracle Projects to complete the billing cycle.

Credit Memos and Foreign Currency Invoices

Credit Memos

For Invoices with "Accepted in Receivables" Status, write off or cancellation can be done. This generates a new draft invoice with negative amounts, which has negative India Local taxes. A credit memo is generated in Receivables for such write-offs and cancellations. Taxes are inherited from the parent invoice and you must not make any modifications to these taxes. Any such modification performed will create inconsistencies in Original Invoice taxes and Credit Memo taxes. All the processes described above are applicable for the negative draft invoice as well.

Foreign Currency Invoices

For foreign currency invoices in unapproved status, changes may be made to the exchange rate or currency. India taxes will be recalculated when such changes are made.
This chapter covers the following topics:

- India Local iProcurement Overview
- Processing iProcurement Transactions
- Requisitions
- Purchase Orders
- Receiving
- Reports

India Local iProcurement Overview

IL support for iProcurement satisfies all tax needs of corporate requestors by providing tax links in existing base iProcurement transactions. Tax Codes defined in India Localization setups can be used in iProcurement transactions. Taxes get defaulted on iProcurement Requisitions, Receipts including ISO Receipts, Returns and Receipts Correction transactions based on the India tax defaulting hierarchy. These taxes can be viewed or modified based on the user access authorization assigned to you.

Tax calculation and tax accounting operations available in India Local Purchasing are also applicable to iProcurement. You can view accounting entries passed for iProcurement Receiving transactions using the IL forms. In case of Excise and Value Added Tax (VAT) type of taxes, CENVAT and VAT recovery claim can be done using India Localization forms. Excise registers and VAT repository gets updated appropriately on completion of CENVAT and VAT claim process.

IL support to iProcurement also facilitates application of Bill of Entry (BOE) payments to Receipts created in iProcurement. The Receipt can be fetched in the Receipt Localized form for application of Customs Duty against the advance BOE payment made to the authority.
Major Features

- **User Authorization for Tax Review**: Only authorized users are allowed to modify sensitive tax information on iProcurement Requisitions and Receipts.

- **Defaulting Taxes to iProcurement Requisitions**: For Items that attract Localization Taxes, Taxes will be defaulted on the iProcurement Web UI when a Requisition is created. These taxes will be defaulted based on the Tax Defaulting Rules. Taxes would be defaulted automatically based on Item Category assigned to the Supplier – Supplier Site; Supplier – Null Site or based on the Item Class assigned to the Tax Category for the Supplier. Taxes applicable to an Agreement shall be defaulted on shopping a specific item attached to a Blanket Purchase Agreement / Contract. In case of Non-Catalog Requests, taxes need to be added manually as tax defaulting mechanism in IL is available only to items with Inventory Setups.

- **Manual Changes to Defaulted Taxes to iProcurement Requisitions**: Taxes defaulted during iProcurement Requisition can be modified manually in case of a need, depending on your Authorization. New taxes can be added or existing taxes modified or deleted based on your Authorization levels. You can define or modify precedence logic for calculation of Tax Base Amount on which the Tax Rate would be applied. The Tax Base Amount can either be the line amount or line amount including other taxes calculated for the transaction.

- **Taxes Applicable at the Time of Receipt**: When material is received against Requisitions, the taxes defined at the PO level get defaulted proportional to the quantity received. You can modify the taxes defaulted on Receipts based on your Authorization. Localization provides the functionality to modify the taxes at the time of receipt on completion of base iProcurement Receipt. Tax changes are not allowed once you commit the tax changes and initiates the tax accounting process. But taxes amounts are displayed against each receipt line to enable viewing.

- **CENVAT and VAT claims**: CENVAT and VAT claims can be made for the iProcurement Receipt using 'MODVAT on Receipts India' and 'VAT-Tax Claim' forms respectively. All India tax inputs provided in iProcurement shall be fetched to the receipt form automatically.

- **Application of Bill of Entry (BOE) at the Time of Receipt**: Provision to apply the BOE to the receipt is provided similar to CENVAT and VAT claims. You need to navigate to the IL Receipt form to identify and apply the BOE payment against the particular Receipt. The Bill of Entry can only be applied against the customs duty type of taxes (i.e. Basic, Counter veiling Duty and Additional Customs Duty) attached to the iProcurement Receipt.

- **Advance Shipment Notice (ASN) or Internal Sales Order (ISO) Receipts**: Oracle iProcurement supports multiple receipts against In-transit Shipments (ASN shipments and ISO receipts). IL only supports creation of single receipt against an
ASN / ISO. IL support to iProcurement defaults India taxes on these shipments on receiving.

- **Receipt Corrections**: iProcurement provides the functionality of receipt corrections. On performing receipt corrections to receipts in the base iProcurement application, corresponding modifications are made to the Cenvat or VAT or Tax costing entries as these taxes have already been processed in India Localization.

### Processing iProcurement Transactions

#### User Authorizations

A new profile name specific to iProcurement for India taxes is added to System Profile Values to restrict tax modification and entry. Authority to modify taxes in iProcurement is controlled by 'JAIN:Access iProcurement Tax information'. The default value for this profile is set to 'NO' implying No Access to modify India taxes during the iProcurement process flows. System Administrators should set the profile to each iProcurement user with appropriate values to ensure the proper user authorization levels.

#### iProcurement Transaction Flow

Oracle iProcurement module handles limited functions of procure to pay cycle. You have to switch between the forms and the self-service applications (SSWA) to complete the procurement function. You should note that any changes made in the India taxes either in Forms or SSWA would get reflected in the other immediately.

The iProcurement process flow:

1. Purchase Requisitions in SSWA
2. Auto Create Purchase Order in forms
3. Approve the Purchase Order in forms
4. Receipts or correction in SSWA
5. Apply BOE in forms or Accounting in SSWA
6. If you applied BOE, proceed to claim CENVAT in forms. If you chose accounting, proceed to update item cost for NR taxes
7. After claiming CENVAT, make register or accounting updates in forms
8. Claim VAT
9. Make accounting or repository update
Requisitions

Oracle iProcurement provides following functionality in requisitions:

- Reviewing Requisitions

- Creation of Requisition – Searching and adding items (from local or supplier catalogs) to the shopping cart can create Requisitions. On checking out, system creates a requisition using the items added to the shopping cart.

- Cancellation or Changing existing Requisition

Requisition Review

In the Requisition Review flow, India Localization tax button or links are made available in the following pages for authorized users against individual Requisition lines:

- My Requisitions page: Navigate to Indial Local iProcrement > Shops > Stores.

- Requisitions Summary page: Navigate to India Local iProcurement > Requisitions > Requisitions.

- Requisitions Lines page: Navigate to India Local iProcurement > Requisitions > Drill Down on Requisition Number.

Clicking these links, will display the India Localization Taxes for Requisitions page with the corresponding tax details.

**Note:** In the Requisition Review flow, tax details page will be displayed in View Only mode.

Requisition Creation

In the requisition creation flow, India Localization Taxes can be added during the check out process in the Checkout: Requisition Information page. Navigate to India Local iProcurement > Shop > Stores > Checkout: Requisition information. Click View/Update India taxes to navigate to the Oracle Financials for India Tax details page. India Localization Taxes page lets you add India Taxes with desired precedence for calculation. Taxes are defaulted automatically when Item or Tax categories are mapped to the Supplier, Supplier Site or Item Class. Apart from the defaulted taxes, you can add new tax lines through Add New Tax. You can also option to delete a particular tax line that is not required. Provision to modify the defaulted taxes is available only to
Authorized Users.

**Note:** Authority to modify taxes is based on the User Profile Options assigned to you. For more details on User Profile Options refer User Authorization, page 9-3.

Whenever India Local Taxes are applicable, Taxable field should always be set to 'NO' in the Billing section of Requisition Information page.

India Localization taxes can also be viewed and edited in the Checkout: Review Approver List page during the Checkout process. Navigate to India Local iProcurement > Shop > Stores > Checkout: Review Approver List.

**Requisition Review and Submit**

In the 'Checkout: Review and Submit Requisition' page during the Checkout flow, Localization taxes are displayed against each line item of the requisition with a facility to drill down to the detailed view. Taxes can be modified at this stage also depending on your user authorization. No further modifications are allowed on completion of Requisition checkout as the status is updated to 'Approved'. However you can view India tax amounts and the Tax details in the Requisitions Lines page. Total India tax amount is displayed for each requisition line in the Printable Page provided in 'Checkout: Review and Submit Requisition'. Navigate to India Local iProcurement > Shop > Stores > Checkout: Review and Submit Requisition.

**Requisition Change or Cancellation**

Oracle iProcurement provides facility to Change or Cancel the approved Requisitions. When Requisitions quantities are changed in iProcurement, all India Taxes get recalculated based on the revised quantity automatically. In case of Cancellation of Requisitions, India Taxes attached to the cancelled requisition are also cancelled simultaneously.

**Purchase Orders**

Purchase Orders can be auto-created based on the Purchase Requisitions created in iProcurement. The Taxes provided in the Requisition gets defaulted to the Purchase order automatically. You can modify these taxes using the IL Purchase Order form.

**Viewing Purchase Order Details**

Navigate to India Local iProcurement > Requisitions > Requisition Summary - Order Link. Oracle iProcurement provides links to view details of Purchase Orders created using iProcurement Requisition Summary page. India Localization tax links are also made available in the Purchase Order details page. India Localization tax amount and
details will be displayed in a view only mode for each purchase order line in this link page. You can navigate to the Purchase Order India Tax details page by clicking these links available in the Requisition summary page.

**Purchase Order Change Requests**

Navigate to India Local iProcurement > Requisitions > Requisition Summary > Change Requisition. Changes can be made to Requisitions on approving the Purchase Order created by submitting an iProcurement Requisition Change Request. The Change Request page accepts the modifications made by you and highlights the changes by indicating both Original and Changed values before Submission. In case of multiple changes, all modifications made to the requisition are displayed with appropriate icons to identify the last updated values.

**Approving Purchase Order Changes**

Navigate to India Local iProcurement > Requisitions > Notifications > Open Change Requisition Notification. Authorized Approver can Approve, Reject or Reassign the submitted Change Request by opening the appropriate Notification.

On Approval, all changes made to the Requisition are effected to the PO automatically. Existing India Localization functionality ensures that corresponding changes are done to related tax lines based on the changes affected to the Requisition.

On Rejection, changes made to the Requisition are deleted without affecting the Purchase Order details. Original Taxes that were calculated remain unaffected.

**Receiving**

Oracle iProcurement has following functionality in receiving:

- Create receipts – Users can create receipts against orders in Oracle iProcurement. For an order to appear in the receiving module it must have a receipt routing of Direct Delivery (cannot create receipts against orders with a receipt routing of Standard or Inspection). It is also possible to receive against In transit Shipments (ASN shipments and ISO receipts).

- Create Returns

- Perform Corrections

**Receipts Creation**

Navigate to India Local iProcurement > Receiving > Requisition to Receive > Receive. In the iProcurement receipt process flow, India tax entry or update interface will be available to you, depending on your User Authorization, after the base item receiving details are entered and the receipt process is completed. India taxes can be viewed or
updated using View/Update India taxes link available against each receipt line on confirming a base iProcurement receipt. Similar to Requisitions, Taxes are defaulted automatically based on the India Tax Defaulting Hierarchy – from Purchase Order as in the case of normal receipts created using the form-based functionality.

Navigate to India Local iProcurement > Receiving > Requisition to Receive > View/Update India Tax to open the India Tax page. You can add new tax lines and delete the defaulted taxes when not relevant. This page allows only Authorized Users to do receipt tax modification, particularly to add third party taxes, Supplier Name and Supplier Site depending on Organization level parameter Allow Tax change on Receipts and User Authorization. It also facilitates modification of tax precedence.

On completion of modification, the taxes can be recalculated and saved. Changed made to the India taxes can also be ignored when not necessary. This action should however be done before saving the changes. On Completion of the Receipt, accounting entries and costing for all non-recoverable taxes gets effected through India Local concurrent program 'India Receiving Transaction Processor' which is automatically launched on completion of the above mentioned web process.

**Note:** You must note the following in case of an iProcurement Receipt:

- CENVAT and VAT Claim need to be done using the existing India Localization forms as per the existing IL processes.

- BOE application process needs to be done separately in the BOE application form available in IL Receipts after the receipt is created in the iProcurement Web process.

---

### Advanced Shipping Notice and Advanced Shipping Billing Notice

Oracle iProcurement supports Receiving based on ASN/ASBN created from the iSupplier portal. Navigate to India Local iProcurement > Receive Items. You can receive items referring the ASN/ASBN Shipment Number created by the supplier in the supplier portal. The shipment number is defaulted against the Order with a facility to view the ASN/ASBN details.

If the ASBN is created using the India Localization iSupplier solution, India Localization taxes can be assigned to the ASBN. When receipt is created in iProcurement using such an ASBN number, taxes attached to the ASBN are defaulted to the receipt instead of directly from the Purchase Order.

**Note:** You should note the following in case of ASN / ASBN receipts

- The referred ASN/ASBN should be in 'PROCESSED' status in iSupplier. To make a receipt of the ASN/ASBN in India Local iProcurement you should run the 'RECEIVING TRANSACTION
• Taxes defaulted from the ASBN cannot be modified at the iProcurement Receipt. Further only third party or customs type of taxes can be added to an ASBN receipt.

• India Localization does not currently support creation of multiple Receipts against a single ASN/ASBN.

Receipt Corrections

iProcurement provides the functionality of receipt corrections in the Receiving home page. You can select "Correct Items" and proceed to correct an existing receipt. The existing India Localization process of running the concurrent "India Receiving Transaction Processor" after Receipt corrections is also applicable to iProcurement Receipt Corrections. You can run this concurrent using the IL Requests form after making necessary Receipt corrections. The concurrent will make the necessary modifications to the India Localization registers, accounting and costing records based on the receipt corrections done in iProcurement.

Returns

Navigate to India Local iProcurement > Receiving > Returns > Return Confirmation. iProcurement provides the functionality of receipt returns in the Receiving home page. You can select "Return Items" and proceed to return quantities of an existing receipt to the Supplier. Returns processing of India Localization Excise / VAT taxes must be done using the Return to Vendor (India) form by querying the concerned receipt.

Reports

India Localization support for iProcurement do not involve any additional reports at the iProcurement solution. Existing India Localization reports available in the form based functionality need to be used for all reporting purposes.
This chapter covers the following topics:

• iSupplier Overview
• Processing iSupplier Transactions
• Buyer Actions

iSupplier Overview

Oracle iSupplier (Supplier View) enables Suppliers to have real-time access to information (such as purchase orders and delivery schedules) and respond to the buying company with order acknowledgments, change requests, shipment notices, invoices and planning details. The major functions supported in this process are:

• Reviewing Supplier Agreements and Releases, Request for Quotations (RFQ)
• Viewing, Printing and Acknowledging Purchase Orders, Submitting Change Order Requests
• Viewing Shipments, Entering Advance Shipment Notice (ASN) / Advance Shipment and Billing Notice (ASBN)
• Viewing Receipts and Returns
• Viewing and initiating Invoices
• Supplier Profile Management
• Reviewing Planning and Inventory Information

Major Features

Ability for review of Purchase Agreements and Releases, RFQs
Oracle iSupplier provides facility to review the existing Purchase Agreements and corresponding releases. It also provides the facility to review any Request for Quotations from the buying company. India Localization taxes associated with the Purchase Agreement, Releases, RFQs etc. are displayed along with base document details on the iSupplier pages.

- In the Supplier Agreements Summary page, India Localization tax amounts released are displayed along with the base amounts released.

- In Blanket Agreement Details page that opens on drilling down from an Agreement number, India Localization taxes (without amounts) are displayed for the Price Breaks defined for the Blanket Agreement.

- In the Blanket Agreement Details page that opens on drilling down from an agreement, India Localization Tax Amounts are displayed along with the base amounts for each Blanket Release or related Standard Purchase Order (in case of a Global Blanket Agreement).

- Blanket Release/ Receipt/ Invoice Tax amounts are displayed along with base amounts in the Summary block in the Blanket Release details page that open up on drilling down from a Blanket Release number.

- Tax details are displayed in a view only mode for each blanket release line in the Blanket Release details page that opens up on drilling down from a Blanket Release number.

- India Localization Tax Amounts are displayed in the Receipts, Invoices and Payment details pages that open up from the Blanket Release ‘Related Information’ links.

- Cancellation and Change requests from Blanket release impacts India Localization taxes as in the case of Purchase Orders. Similarly Printable View displays PO report for the blanket Agreement / Release with India Localization tax amount.

**Viewing, Acknowledging and Printing Purchase Orders, Initiating Change Requests**

- India Localization Tax Amount is displayed along with base amount in the Purchase Order Summary page. Tax details are displayed in a view only mode for each Purchase Order line in the Purchase Order details page that opens up on drilling down from a Purchase Order Number.

- Purchase Order/ Receipt/ Invoice Tax amounts are displayed along with base amounts in the Summary block in the Purchase Order details page.

- PO Shipment level tax details are also displayed in the Purchase Order details page.

- India Localization Tax Amount and details are displayed in the Receipts, Invoices and Payment details pages that open up from the Purchase Order ‘Related
Information’ links.

- Tax details are displayed in a view only mode for each Purchase Order line in the Request Cancellation page that opens when you click Request Cancellation. On approval of the cancellation of the line or order initiated from iSupplier, related India Localization tax lines are also cancelled.

- Tax details are displayed in a view only mode for each purchase order line in the Request Changes page that opens up on pressing the 'Request Changes' button. On approval of the changes (Quantity or Price change, Shipment splitting etc.) initiated from iSupplier, related India Localization tax lines are also changed accordingly.

Shipments

In India Localization context, Suppliers shall be providing Excise / VAT Invoice Number, Excise /VAT Invoice Date while creating ASNs/ASBNs through iSupplier portal. This information is vital for India Localization receipt processing and the Buying Company may require that when receipts are created out of these ASNs/ASBNs, the Excise/VAT details be automatically populated to the relevant India Localization tables without having to re-enter these details. Suppliers also has an option of adding or modifying tax information while creating ASBNs through iSupplier portal. This information is vital for India Localization receipt processing and the buying company may require that when receipts are created out of these ASBNs, the tax details be automatically populated to the relevant India Localization tables without having to re-enter these details. This involves overriding the taxes specified at the PO level.

Create Advanced Shipment Notice (ASN) page

- Additional fields are provided in the iSupplier 'Create ASN Shipment Header' page to capture the Excise Invoice, Excise Invoice Date details

- On submitting the ASN, these details are interfaced to Purchasing to make it automatically available in the Receipt DFF.

Create Advanced Shipment Billing Notice (ASBN) page

- Additional fields are provided in the iSupplier 'Create ASBN Shipment Header' page to capture the Excise Invoice, Excise Invoice Date details

- On submitting the ASBN, these details are interfaced to Purchasing to make it automatically available in the Receipt DFF.

- Additionally, a feature is made available at ASBN level (in the ASBN Shipment lines page) to view the India Localization taxes (defaulted from Purchase Order), add, modify and delete the first party taxes (taxes pertaining to the Supplier) by the Supplier User. On submitting the ASBN, these taxes are automatically defaulted to the Receipts and Invoices created from the ASBN. No further modification is allowed to these taxes at the Receipt or Invoice level. Third Party taxes, mentioned in the PO if any , shall be defaulted to the ASBN in a view only mode.
View / Cancel ASN / ASBN page

• India Localization Excise Invoice details are available for viewing when Supplier user is viewing an ASN or ASBN. Tax details are displayed while viewing an ASBN.

• India Localization taxes are cancelled when an ASN or ASBN is cancelled. However the taxes can still be viewed in a read only mode for cancelled ASBNs, though these taxes shall not be available for any receipts / invoices created for the Purchase Order.

Receipts

Receipts and Returns can be viewed from iSupplier. The Supplier user will be able to see India taxes to be part of the Receipt while viewing the receipts. India Localization tax amount and details are displayed in the Receipt details page that opens on drilling down from the Receipt Number.

In the form based India Localization receipt functionality, tax defaulting is provided on the receipts created from ASBN. No modification is allowed to ASBN taxes at the receipt level. If ASBN has a Third party tax, it shall be modifiable to the extent of Vendor and Vendor Site fields in the Receipt form. However new Third party taxes can be added while creating a Receipt from an ASBN.

Invoices

Invoices initiated from the iSupplier are interfaced to Payables through the Payables Open Interface Import process. India Localization taxes get defaulted from the Purchase Order for such invoices imported from iSupplier.

India Localization taxes are included in the Invoices / Payment amounts displayed in the Invoice / Payment Summary pages.

In the form based India Localization functionality, invoice level tax defaults from PO to PO Matched Invoices, from Receipt to Receipt Matched Invoice and from ASBN for invoices created from ASBN.

Processing iSupplier Transactions

In the iSupplier Portal of the Supplier View you can view documents created by the Buyer, Accept the Documents and also make request for change in Delivery Schedules, Rate and Quantity etc. iSupplier View provides the following features:

• Reviewing Supplier Agreements and Releases, Request for Quotations (RFQ)

• Viewing, Printing and Acknowledging Purchase Orders, Submitting Change Order Requests

• Entering ASN / ASBN & Viewing Shipments
• Viewing Receipts and Returns

• Viewing Invoices and Payments

Request for Quotation (RFQ)

You can view the Requests for Quotation (RFQ) in which your organization is included as a Supplier. India Localization tax details (indicative taxes) can be viewed in the RFQ Details page in the iSupplier portal. Navigate to iSupplier > Orders > RFQ > Go. Clicking View India Taxes displays India Localization Taxes for each RFQ.

Blanket Purchase Agreements

In the iSupplier Portal, you can view blanket Purchase Agreements (BPA) created by the Buyer. In the iSupplier Portal, you can also make requests for change of the Rate, Quantity, Change the Delivery Schedule and Accept the BPA. After making such a request, document will be shown in Pending Status till the changes are accepted or rejected by the Buyer. India Localization taxes associated with the Purchase Agreement, Releases. are displayed along with base document details on the iSupplier pages.

• In the Supplier Agreements Summary page, India Localization tax amounts released are displayed along with the base amounts released.

• In Blanket Agreement Details page that opens on drilling down from an Agreement number, India Localization taxes (without amounts) are displayed for the Price Breaks defined for the Blanket Agreement.

• In the Blanket Agreement Details page that opens on drilling down from an agreement, India Localization Tax Amounts are displayed along with the base amounts for each Blanket Release or related Standard Purchase Order (in case of a Global Blanket Agreement).

• Tax details are displayed in a view only mode for each blanket release line in the Blanket Release details page that opens up on drilling down from a Blanket Release number.

• India Localization Tax Amounts are displayed in the Receipts, Invoices and Payment details pages that open up from the Blanket Release ‘Related Information’ links.

• Cancellation and Change requests from Blanket release impacts India Localization taxes as in the case of Purchase Orders. Similarly Printable View displays PO report for the blanket Agreement / Release with India Localization tax amount.

Navigate to iSupplier > Orders > BPA > PO Number. Clicking Taxes link will take you to the details of the taxes.
Standard Purchase Orders

In the iSupplier Portal, you can view and acknowledge the orders, request change of the Orders / cancellation of orders. Your requests for Cancellation or Changes related to the Orders have to be Accepted / Rejected by the Buyer for the changes to be effective India Localization iSupplier support provides an additional Column of 'Tax Amount' to enable you to view the tax details associated with the Purchase Order. The major features in India Localization context are:

- **India Localization Tax Amount** is displayed along with base amount in the Purchase Order Summary page. Tax details are displayed in a view only mode for each Purchase Order line in the Purchase Order details page that opens up on drilling down from a Purchase Order Number.

- PO Shipment level tax details are also displayed in the Purchase Order details page.

- India Localization Tax Amount and details are displayed in the Receipts, Invoices and Payment details pages that open up from the Purchase Order 'Related Information' links.

- Tax details are displayed in a view only mode for each Purchase Order line in the Request Cancellation page. On approval of the cancellation of the line or order initiated from iSupplier related India Localization tax lines are also cancelled.

- Tax details are displayed in a view only mode for each purchase order line in the Request Changes page that opens up on pressing the 'Request Changes' button. On approval of the changes (Quantity or Price change, Shipment splitting etc) initiated from iSupplier, related India Localization tax lines are also changed accordingly.

Advance Shipment Notice

An Advance Shipment Notice (ASN) is a notice to the Receiving Organization that a shipment is coming. The ASN contains details including shipment date, time, and identification number; packing slip data; freight information; item detail including cumulative received quantities; country of origin; purchase order number; and returnable container information.

Once you create an ASN in the iSupplier portal, the Buyer gets a notification about the shipment being arrived. Buyer has to execute the 'Receiving Transaction Processor' concurrent program to import the ASN details into the receiving tables.

After you have entered the ASN Header and Lines details and submitted it for processing, iSupplier show the Advance Shipment Notice Confirmation page.

**Navigation Path:** iSupplier -> Shipments -> Shipment Notices ->Create Advance Shipment Notice -> Shipment Header - > View / Update IL Info. India Localization iSupplier Support provides you a button to View / Update the IL Information on the ASN. The Excise details like the Excise Invoice Number and Excise Invoice Date can be
entered and saved by clicking this button.

After entering the Excise Details, if any, for the Shipment, click on Apply Changes to save the data on the View / Update India Tax Page and then click on Continue to complete the Transaction. The Excise Invoice Number and Excise Invoice Date entered on this page will default on to the 'Excise Invoice Number' and 'Excise Invoice Date' fields in the 'Receipt Localized' form, when Buyer creates the Receipts against this ASBN.

The View / Cancel Advance Shipment Notices Page displays all information pertaining to the shipments that have been carried out along with the Status of the Shipment.

You have the option to go back to the Shipment creation process without pressing the 'Continue' button. In such an event the ASN will be in a status 'Partially processed' and it will not be interfaced to the Receiving transaction interface and hence will not be available for receiving. You can query the ASN again using the 'View / Cancel Advance Shipment and Billing Notices' page, click on the 'View / Update IL Info', update the Excise details, if required and press the 'Continue' button to Complete the ASN process. After completion of the process, ASN gets the 'Pending' status and is ready for interfacing into receiving tables. After the Shipment is interfaced, the status is shown as blank in the Processing Status Column.

**Advance Shipment Billing Notice**

ASN containing Invoice and Tax information along with shipping information is an Advance Shipment Billing Notice (ASBN). Additional details available on ASBN are Invoice Number, Invoice Amount, Invoice Date, Payment Terms, Freight Amount, Currency, Tax Amount, and Remit To Site etc. An ASBN created in the iSupplier portal creates an invoice in the buyer's payables system.

You can enter an Advance Shipment cum Billing Notice, with the tax information. The taxes entered in the ASBN will be defaulted on to the Receipt and the Invoice created using the ASBN. The Taxes that have been defaulted from the ASBN cannot be modified or new first party taxes added on the receipt. Only new Third Party taxes can be added on such Receipts.

While Creating the ASBN, you will enter the Shipment Number, Shipment Date, Invoice Number etc. in the Shipment Header Page and the Quantity being shipped in the Shipment lines page.

On submitting the ASBN Pages, the ASBN will be created and you will be taken to the Advance Shipment Notice Confirmation page.

India Localization iSupplier support provides a new button viz. 'View / Update IL Info' in this page. On clicking on the button will take you to the View / Update India Tax Page, where you can enter the Excise Invoice Number and Date if the shipment has Excise Type of Taxes.

The Excise Invoice Number and Excise Invoice Date entered on this page will default on the India Receipt DFF when Buyer creates the Receipts against this ASBN. You can also modify the Taxes defaulted from the Purchase Order or add new taxes, if required.
Please note that the taxes specified by you are the final taxes and the same cannot be modified at the time of Receipt by the Buyer. If the PO has any third party taxes, they shall also be defaulted to the ASBN page, but they can only be viewed here – no modification / deletion is allowed for such taxes. After the changes are done, you need to press the 'Apply Changes' button to save the changes. (Ignore Changes' button shall clear all the changes done) You need to press the 'Complete' button to complete the process and make the ASBN available for interfacing into Receiving Tables.

You have the option to go back to the Shipment creation process without pressing the 'Complete' button. In such an event the ASBN will be in a status 'Partially processed' and it will not be interfaced to the Receiving transaction interface and hence will not be available for receiving. You can query the ASBN again using the 'View / Cancel Advance Shipment and Billing Notices' page, click on the 'View /Update IL Info', update the Excise details, if required and press the 'Complete' button to complete the ASBN process. After completion of the process, ASBN gets the 'Pending' status and is ready for interfacing into receiving tables After the Shipment is interfaced, the status is shown as blank in the Processing Status Column.

**Viewing ASN / ASBN Information**

Shipments created though ASN / ASBN can be viewed by you in the Supplier View. Clicking on the Shipment Number link in the Shipment Number Column will take you to the specific Advance Shipment Notice Page. India Localization iSupplier Support provides button viz. 'View / Update IL Info' on the View / Cancel Advance Shipment Notice Page. Clicking on button will take you to the View / Update India Tax Page. Clicking on the Continue Button will take you back to the View / Cancel Advance Shipment Notice Page. For Viewing the ASBN shipments, the process is the same but when you click on the View / Update IL Info, along with the Excise Invoice Details, the page will also show the Tax lines associated with ASBN. The page displayed here is in a view-only mode unless the ASN / ASBN has the status of 'Partially Processed' indicating that the India Localization ASN / ASBN process is not completed yet. In such a case, the page will open in an editable mode and the process can be completed by pressing the appropriate buttons (as mentioned in earlier sections on ASN / ASBN). The taxes displayed here are in View-Only Mode, if the ASBN is in a Pending / Blank status.

**Viewing Receipts and Returns**

iSupplier has following functionality in Receipts and Returns:

- View the Receiving and Returns information
- View the Quality (Inspection) information

Receipts and returns can be viewed from iSupplier. You can view India taxes also while viewing the receipts. India Localization tax amount and details will be displayed in the Receipt details page that opens on drilling down from the Receipt Number.

Navigate to iSupplier > Shipments > Receipts. On the Receipts Summary page, if the
Receipt has India taxes, the Tax Total will appear in the Tax Amount column as a link against the Receipt. Clicking on the Tax Amount Link takes to the detail page showing the taxes pertaining to the Receipt.

Alternatively, you can also click on the Receipt Number on the Receipts Summary Page of the iSupplier portal of the Supplier View.

Click View India Tax to view the detail tax lines of the receipt. In case of returns by the vendor to the supplier, you can view the same information against the receipt for which the buyer has made the returns.

**Note:** No India Localization tax information is provided on the Returns page as the same taxes on receipt are reversed during the return process.

**Viewing Invoices and Payments**

You can view the invoices created by the Buyer in the iSupplier Portal along with Indian Taxes on the Invoices Page. Navigate to iSupplier > Account > View Invoices.

You can also view the payments made against an invoice through the iSupplier Portal. On the Invoices summary page along with the Invoices, the Payment details are also displayed. If the payment has been made, the Check Number / Payment Document Number will appear in the Payment Number column. Drilling down the Payment Number on the Invoice Summary page will take you to the Payment Details Page. The amount paid here displays the India Taxes also.

**Buyer Actions**

As a Buying Company user, you can view order, receipt, invoice, and payment information using the Internal User View responsibility in Oracle iSupplier. You can also search for information across all suppliers, as well as respond to supplier change requests. Features include:

- Viewing Purchase Order and Purchase Agreement Information
- Viewing Purchase Order Acknowledgements and Change Requests, acting on these requests
- Viewing Shipment (ASN) and Receipts Information
- Viewing Account (Invoices and Payments) Information

Buying Company view is basically providing a web interface for viewing the Procure-to-Pay information. As you have access to the internal Oracle E-Business Suite and India Localization features, normal India Localization functions (form based) may be used for viewing of India Localization tax information on PO or Receipts or Invoices.
Hence no support is currently provided for this feature of iSupplier portal.

**Receipts from ASN / ASBN**

After the Supplier creates the ASN / ASBN, you will receive an intimation of the same along with the expected date of arrival. On the receipt of the Shipment, you will make a receipt as in the normal P2P cycle. Before creation of a Receipt, you have to run the concurrent "Receiving Transaction Processor" for interfacing the ASN / ASBN.

Create a receipt by navigating from the Receipt Localized form and click New, query the ASBN number in the Find Receipts form, and complete the Receipt header and line details. After the receipt is created, come back to the Receipt Localized window and in the Receipt Header section and Receipt Lines, Excise Invoice Number and Excise Invoice Date will be defaulted from the ASBN, if these details are filled in the ASBN.

From here on the process of making of the Receipt and Creation of the Invoice in Payables and making payments to the Supplier will follow the normal course of the P2P cycle.

For an ASN receipt, Taxes get defaulted from the Purchase Order to the Receipt and all the taxes can be modified, new Supplier Taxes or Third Party Taxes added (provided the Organization level parameter 'Allow Tax Change on Receipt' is set to YES for the Organization / Location combination).

For ASBN Receipts, the defaulting shall be from the ASBN (Supplier specified taxes) and no further addition / modification can be done to the Supplier specified taxes. Only Third party taxes are allowed to be added to the ASBN receipt. If the ASBN has a Third party tax (defaulted from PO, non-updateable in ASBN by Supplier), the same shall be defaulted to ASBN receipt – however such taxes also can not be modified except for changing the Vendor name or Vendor Site fields on the receipt. Please note here that the ASBN Invoice is created independent of the receipt and all the ASBN Supplier taxes are being defaulted directly to the ASBN Invoice. Any change in the ASBN receipt to the ASBN specified taxes shall result in a mismatch between the Receipt and Invoice tax details. This is the reason behind the control mechanism in ASBN receipt.

The same control mechanism is applicable even you make an ASBN receipt using the India Localization iProcurement solution (Please read the India Localization iProcurement solution User manual for more details).

**Creating ASBN Invoice**

Once the ASBN is created by the Supplier, you will get an intimation regarding the Invoice Number, Invoice Date, Date of Shipment, Taxes on the ASBN. In ASBN type of Shipments, the system will automatically create the ASBN Invoice when the 'Receiving Transaction Processor' is run if the Purchasing profile option 'PO: Create ASBN invoices using AP interface tables' is set to YES at the site level. If this profile option is set to NO, the ASBN Invoice need to be created using the 'Payables Open Invoice Import' program with the Source as 'Advance Shipment Billing Notice'.
After generating the ASBN invoice, query for the Invoice Number given by the Supplier in the Invoice form in India Local Payables Responsibility.

Navigate to India Local Payables > Oracle Payables > Invoice > Entry > Invoices > Query. On querying the same, the invoice will be found. You need to run the concurrent "India – To Insert Taxes for Pay on Receipt” to load the India Local Taxes to the Invoice distributions.

On completion of the concurrent, Supplier taxes specified in the ASBN shall be defaulted to the ASBN Invoice. Normal Invoice validation / approval / payment process can be adopted now to complete the Invoice process.
This chapter covers the following topics:
- Advanced Pricing Overview
- Assessable Value

Advanced Pricing Overview

Oracle Advanced Pricing provides the flexibility to meet the needs of complex pricing situations for a range of demanding industry business requirements. It provides advanced pricing capabilities that enable you to set up your pricing information and to model complex data relationships to determine the correct price.

You can perform the following functions with Oracle Advanced Pricing:
- Create a list price for an item or item hierarchy.
- Assign security privileges to pricing users to control their view or maintain access to price lists and modifiers. You can also control which operating units can use price lists or modifiers.
- Maintain price lists by performing tasks such as searching across a single or multiple price lists and updating the price, formula, or effective dates of price list lines.
- Set a list price and discounts at multiple levels of flattened hierarchies and use precedence to select the right price or discount.
- Create multiple currency conversion criteria for a single base currency price list.

Oracle application has built many advanced features on pricing. This includes defaulting of prices for a transaction based on specified rules and procedures. The functionalities related to pricing not only includes price defaulting based on the item, Item category but also defaulting the appropriate price based on advanced pricing features like modifiers, qualifiers etc. Oracle Application also has built in functionalities
for recalculation of prices at various business events.

Assessable Value

As per the current India localization functionality, the assessable value price lists need to be defined for every item. India Localization assessable value functionality supports creation of price list only with product attribute as Item Number. The standard price list functionality support creation of price list based on different attributes like Item number, Item category, all items etc. There were enhancement requests from customers to enhance the current India Localization functionality on assessable values where an assessable value can be defined either based on an item or an item category. The current India Localization functionality on assessable value need to be enhanced where the user should be allowed to associate a price list with product attribute as item category as an assessable value list. If the user opts as assessable value derived from a price list which is based on product attribute as Item category, the assessable value defined for the item category would be applicable for all the items classified under the specified Item category. This helps to derive the same assessable value for all the items classified under an item category. As per the current functionality, you need to create a price list with product attribute as item number, set up the price for every item and then associate the price list as an assessable value price list and associate to the parties. Once the Assessable value price list is associated to the party, for computation of taxes, system refers only the assessable value price list created for the tax regime for the party. With the current enhancement, user can associate an item category based price list as an assessable value list so that for tax computation purposes, system will fetch the price for all items classified under an item category.

Assessable Value Price Based on Item Category

India Localization assessable value functionality support creation of price list with Item or Item Category. If you create a price list with product attribute as item number, you will set up the price for each item and then associate the price list as an assessable value price list and associate to the parties. Once the Assessable value price list is associated to the party, for computation of taxes, system refers only the assessable value price list created for the tax regime for the party. However, if you create a price list with an item category based price list as an assessable value list; for tax computation purposes, system will fetch the price for all items classified under an item category.

Tax Assessment

India localization solution can compute taxes based on the line price or on the assessable value. India Localization computes taxes once the order is saved and support recalculation of taxes whenever the prices are altered. The assessable value based computation is available for taxes falling under Excise and VAT regime. Multiple Tax assessable value price lists can be created using the standard price list functionality and associate the price list to a party site (customer site or supplier site). If an assessable value list is associated to a party, taxes for those items included in the list would be
computed only based on the tax assessable value list ignoring the tax precedence logic. The assessable value list can be associated to every party for both Excise and VAT regimes.

For sales order lines derived out of a modifier, the system computes taxes based on the assessable values captured for the modifier. If the assessable values are not available for a modifier, the system assumes that no tax is applicable on the sales order line derived from the modifier. If assessable values are not defined for the modifier, taxes get defaulted based on the normal tax precedence logic which is derived based on the line price.
India Local Inclusive Tax

The Inclusive Tax feature is applicable to all modules of Oracle Financials for India.

In some business scenarios the purchase price is inclusive of all taxes or some taxes, Oracle Financials for India supports both scenarios. This means that the transaction price on documents such as purchase or sales orders is inclusive of all taxes applicable to the transaction.

The Inclusive tax feature of Oracle Financials for India supports tax inclusive computations in the ‘Order to Cash’ and ‘Procure to Pay’ cycles.

You can define a tax as inclusive in the tax code definition and attach this code as a part of tax categories. For transactions having these tax codes, the tax amounts are back calculated and reflected on the respective transaction. This enables correct computing, tracking, and accounting of inclusive taxes for financial and statutory reporting.

Prerequisites:

To use the Inclusive tax feature, you must:

1. Set Account Inclusive Tax to Yes on the TDS Period window.
   
   This one time setup of Account inclusive taxes determines whether transfer inclusive tax accounting into GL separately or not.

   Some additional accounting entries are passed into GL interface tables directly if Account inclusive taxes option is set to Yes.

Tax Definition Window

This window is used to define new taxes. This window shows details such as tax name, tax type, tax rate, credit percentage, and vendor information. In this window, a new check box, Inclusive Tax Flag, is introduced. This check box is editable only for new tax codes. For existing tax codes, this check box would be read only.
Note: Inclusive taxes cannot be created until the setup to account inclusive taxes is completed in the TDS Years window.

Inclusive Tax Option on Various Windows and Reports

The following windows include inclusive tax field:

Service Tax Repository

Purchasing
Tax Details
Requisitions
Tax Details
Quotations
Purchase Orders
Receipts

iProcurement
Stores
Requisitions
Tax Details

iSupplier
Purchase Orders
Tax Details

Order Management
Sales Order
Tax Details
Fulfil orders
RG23 D Register Entries

Project Billing
Invoice
Invoice Review

Receivables
Enter Transaction

Note: Inclusive taxes also impacts Project Costing and Inventory Item Costing. All inclusive taxes are automatically considered for costing by
the base costing program because they are part of the item price. If there are any inclusive taxes which are of recoverable in nature, the costing gets updated correctly by inserting a negative line.

The inclusive tax details are shown in the following India Localization reports:

- **India - Total Sales** report in Receivables displays the sum of non inclusive tax of AR transactions.
- **India - Commercial Invoice for AR** report in Receivables displays the non inclusive taxes of AR transactions in detail.
- **India - Excise/VAT Invoice Template:** report in Order Management displays the non inclusive taxes of Sales Orders in detail.

**Supporting Inclusive Tax**

The Tax code definition window includes a flag to identify a Tax as Inclusive. This ensures that the current logic of three-way defaulting of taxes is automatically used for Inclusive Taxes.

The Inclusive option is editable only when adding a new Tax code. Once the tax code is saved, the checkbox is grayed out. You cannot change a tax code from inclusive to exclusive and vice versa.

In case, you need to change the tax code type, retire the tax code with an end date. Then, define a new tax code with required inclusive or exclusive flag. You can use the current mass tax changes feature supported by Financials for India to modify newly created documents with revised tax code.

**Determining Base Tax Amount**

Base Tax Amount is determined based on precedence. For Inclusive tax computation, the following formulae are used to determine the base tax amount. For all the precedence greater than zero, the line number entered in precedence get added to the Base tax Amount.

For Excise and VAT Regime, zero precedence represents the Excise Assessable Price List and VAT Assessable Price List respectively when defined. For all other Tax regimes and types, zero precedence represents Base Selling or Purchase Price. The Base Selling or Purchase Price is used for Excise and VAT Regime also when the Assessable price lists has not defined. This remains same for both exclusive and inclusive taxes. For Adhoc and UOM based taxes, there is no option of entering the precedence and the same would continue for inclusive taxes.

**Determining Tax Rate**

This defaults from the Tax definition window.

Determining Tax Amount
For Exclusive Taxes, tax amount is derived as, Base Tax Amount x Tax rate / 100. This is applicable for taxes that have the Inclusive flag at tax code definition as Null and also for taxes that are based on Excise Assessable Price List and VAT Assessable Price List.

**Adhoc Taxes**

Adhoc tax is a tax amount that is directly entered on a transaction and has base tax amount as zero. Tax Rate and precedence are not applicable for such taxes. When the Tax is marked as inclusive, there is no impact on tax calculation of this tax. For determining the base tax amount, the amount determined by normal computation is divided by base tax amount to determine the factor that needs to be taken into account for computation of the derived base tax amount.

The Adhoc Tax cannot be defined with any precedence for exclusive taxes and the same continues for Inclusive taxes. The approach marks the tax code as inclusive. Adhoc Tax does not have any rate associated with it. The only difference between exclusive and inclusive Adhoc tax are the process that follows for adding or not adding of such tax line in the base document and handling the Financial reporting and costing. You can add Freight type of Taxes in Post shipment scenario. Such Freight can be either based on inclusive or exclusive rate, UOM based or Adhoc.

**UOM Based Taxes**

This tax is based on unit of measure of the transaction and the unit of measure rate. When the same are inclusive, there will be no impact on tax calculation, no backward calculation for this tax. The UOM Based Taxes cannot be defined with any precedence’s for exclusive taxes and the same would continue for Inclusive taxes. The approach would be to Mark the tax code as inclusive. UOM based tax has a rate associated with it but the same is based on the Quantity and not the price For determining the base tax amount, the amount determined by normal UOM based computation would be divided by base tax amount to determine the factor that needs to be taken into account for computation of the derived base tax amount.

The only difference between exclusive and inclusive UOM based tax would be in the process that we follow for adding or not adding of such tax line in the base document and handling the Financial reporting and Costing.

**Tax Category Definition**

Against each Tax code selected, the Inclusive Flag is displayed. This display is based on the Tax Code definition carried out.